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Foreword 

Thank you for choosing 
and using the 4957B RF 
analyzer developed and 
produced by Ceyear 
Technologies Co., Ltd.! 

With meeting your 
requirements as our duty, 
we will provide you with 
high-quality instruments 
as well as good after-sales 
service. Ceyear will insist 
on the consistent tenet of 
"high quality and 
considerate service‖ and 
the promise to provide our 
users with satisfactory 
products and services. 

Manual No. 

YQ2.732.1032SSCN 

 

Version 

A   2022.6  

Ceyear Technologies Co., 
Ltd. 

Manual Authorization 

The contents of this 
manual are subject to 
change without notice. 
The final right to interpret 
the contents and terms 
used in this manual 
belongs to Ceyear 
Technologies Co., Ltd. 

The copyright of the 
manual belongs to Ceyear 
Technologies Co., Ltd, no 
modification or alteration 
can be made to the 
manual contents by any 
unit or person without 
approval of the Institute, 
and no reproduction or 
propagation of the manual 
can be made for profits, 
otherwise, Ceyear 
Technologies Co., Ltd 
retains the right of 
pursuing legal 
responsibilities from any 
infringer. 

Product warranty 

The product warranty 
period is 18 months 
starting from the delivery 
completed. The instrument 
manufacturer will repair or 
replace the damaged 
components according to 
the user's requirements 
and actual conditions 
within the warranty period. 
For specific maintenance 
issues, see the contract. 

 

Product quality 

certificate 

We guarantee that the 
product can meet the 
indicator requirement in 
the manual upon delivery. 
The calibration and 
measurement are 
completed by measuring 
bodies with national 
qualification, with relevant 
data to be provided for 
reference by users. 

 

Quality/Environmenta

l Management 

This product complies with 
the quality and 
environmental 
management systems 
during R&D, 
manufacturing and testing. 
Ceyear Technologies Co., 
Ltd. already has the 
required qualifications and 
has passed the 
certification of ISO 9001 
and ISO 14001 
management systems. 

 

 

 

 

 

 

Safety precautions 

 

 

 

The symbol "Warning" 
indicates a hazard. It 
reminds the user to pay 
attention to a certain 
operation process, 
operation method or the 
like. Failure to observe the 
rules or incorrect operation 
may cause personal injury. 
Proceed to the next step 
only after fully 
understanding and 
meeting the warning 
conditions indicated. 

 

 

 

 

 

The "Notice" symbol 
indicates some important 
information which will not 
cause danger. It reminds 
the user to pay attention to 
a certain operation 
process, operation method 
or the like. Failure to 
observe the rules or 
operate correctly may 
cause damage to the 
instrument or loss of 
important data. Proceed to 
the next step only after 
fully understanding and 
meeting the caution 
conditions indicated. 

 

Warning !

       

Notice 
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1 Manual navigation 

This chapter introduces the user‘s manual functions, chapter structure and main contents of the 

4957B RF analyzer, as well as the instrument-related documents provided to users.  

  About the Manual .................................................................................................................... 1 

  Related Documents ................................................................................................................. 2 

1.1. About the Manual 

This manual introduces the basic functions and operation methods of the 4957B RF analyzer 

produced by Ceyear Technologies Co., Ltd. It describes such contents as product features, basic 

operations, configuration guide, menu description, remote control, maintenance, technical 

indicators and testing methods, etc. of the instrument to help users get familiar with and master the 

operation method and key points of the instrument as soon as possible. To facilitate your skillful 

use of the instruments, please read carefully this manual and follow its instructions for correct 

operation. 

This manual contains the following chapters: 

Overview 

This part introduces in general the main performance characteristics, typical application examples 

and safety instructions of the 4957B RF analyzer. The purpose is to enable users to have a 

preliminary understanding of the main performance characteristics of the instrument and to guide 

users to operate the instrument safely. 

Quick Start 

This chapter introduces the pre-operation inspection, instrument browsing, basic measurement 

methods, measurement window instructions and data storage of the 4957B RF analyzer. so that 

users can have a preliminary understanding of the instrument itself and its measurement 

processes as a preparation for the comprehensive introduction of the measurement operations of 

the instrument hereinafter. This section contains some contents consistent with the relevant 

sections in the Quick Start. 

Operation Guide 

It introduces in detail the operation methods of various measurement functions of the instrument, 

including configuring the instrument, starting the measurement process and obtaining the 

measurement results. This part mainly includes two parts: functional operation guide and 

advanced operation guide. For users who are not familiar with the 4957B RF analyzer, the basic 

operation guide introduces and enumerates each function systematically and in detail so that 

users can understand and master some basic usage of the RF analyzer. The advanced operation 

guide introduces relatively complicated testing processes and advanced operation skills for users 

who have basic knowledge about using the instrument but are not familiar with some special 

usage, and guides them to implement the measurement processes. 

Menus 

This part introduces the menu structure and menu items according to the functions to facilitate the 

users to query for reference. 

Troubleshooting and Repair 

This part includes the introduction of the working principles of the instrument, troubleshooting, 

error information description and repair methods. 
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Technical indicators and testing methods 

This part introduces the product features, main technical indicators and recommended test 

methods of the 4957B RF analyzer. 

Appendixes 

Necessary reference information related to the 4957B RF analyzer is provided, including term 

description, program-controlled command quick look-up table, menu quick look-up table, error 

information quick look-up table, etc. 

1.2 Related Documents 

Documents of the 4957B RF analyzer include: 

User‘s Manual 

Program Control Manual 

Quick Start Guide 

User’s Manual 

This manual describes the functions and operation methods of the instrument in detail, including 

configuration, measurement, program control and maintenance, etc. The purpose is to The 

purpose is to guide users to fully understand the functional characteristics of the product and 

master common testing methods of the instrument. Main chapters include: 

Manual Navigation 

Overview 

Quick Start 

Operation Guide 

Menus 

Remote Control 

Troubleshooting and Repair 

Technical indicators and testing methods 

Appendixes 

Program Control Manual 

This manual introduces remote programming basics, SCPI basics, SCPI, programming examples 

and I/O driver function library in detail. The purpose is to The purpose is to guide users to quickly 

and comprehensively master the program control commands and methods of the instrument. Main 

chapters include: 

Remote Control 

Program Control Commands 

Programming Examples 

Error Description 

Appendixes 

Quick Start Guide 

This manual introduces the basic methods for configuration and start-up measurement of the 

instrument to enable users to quickly understand the characteristics of the instrument, and master 

the basic settings and basic operation methods. Main chapters include: 

Get Prepared 

Typical Applications 

Get Help 
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2 Overview 

This chapter introduces the main performance characteristics, main applications and main 

technical indicators of the 4957B RF analyzer. It also gives introductions on correct operation the 

instrument and precautions such as electrical safety. 

 Product Overview…………………………………………………………………….………3 

 Safety operation instructions…………………………………………………………..……5 

2.1 Product Overview 

The 4957B RF analyzer has many advantages, such as high performance indexes, high sweep 

speed, many test functions, simple operation, etc. In terms of performance indexes, it has 

excellent average noise level, phase noise and high dynamic range. In terms of measurement 

modes, in addition to vector network analysis and spectrum analysis, abundant option 

measurement function modes are also provided, including cable and antenna feeder test, vector 

voltmeter, USB power measurement, interference analysis, demodulation analysis, channel 

sweep, field strength measurement, etc. Each measurement mode is provided with a variety of 

intelligent measurement functions. It adopts the integrated design of 8.4‖ liquid crystal and 

capacitive touch screen to improve the clarity of display and the convenience of operation. It is 

handheld, small in size, light in weight, flexible in power supply, easy to operate, and suitable for 

field use. 

 Product Features…………………………………………………………………………………3 

 Typical applications…………………………………………………….…………………………4 

2.1.1 Product Features 

The 4957B RF Analyzer adopts the design idea of high integration, modularization and 

standardization, and has excellent performance. 

2.1.1.1 Basic Functions 

1) Vector network analysis mode (VNA): For network S-parameter analysis (insertion loss and 
gain); 

2) Spectrum analysis mode (SA): For basic spectrum analysis of the signal, including field 
strength measurement, channel power, occupied bandwidth, adjacent channel power, spurious 
template, carrier-to-noise ratio, audio demodulation, IQ capture and other intelligent 
measurement functions; 

3) Antenna feeder test mode (CAT) (optional): For cable and antenna feeder test (return loss and 
failure positioning); 

4) Vector voltmeter mode (VVM) (optional): For amplitude, phase, standing wave ratio and 
impedance measurement;  

5) USB power measurement mode (USB-PM) (optional): For accurate measurement on 
continuous wave power via external USB power probe; 

6) Interference analysis function (optional): It provides such functions as waterfall chart and RSSI 
measurement; 

7) Demodulation analysis function (optional): It realizes the demodulation characteristic analysis 
of AM/FM/PM signal; 
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8) Channel sweep function (optional): It can realize the signal power measurement of multiple 
channels or frequencies; 

9) Field strength measurement function (optional): It can realize the functions of dot frequency 
measurement, frequency sweep measurement and list sweep measurement; 

10) Directional analysis function (optional): It is mainly used for positioning interference sources or 
unknown signal sources, and the direction of interference signals can be quickly positioned by 
using external receiving antenna and electronic compass; 

11) Signal analysis function (optional): It provides fast analysis of interference signals, and realizes 
the display and playback of historical data with the help of the waterfall chart. 

2.1.1.2 High Performance 

1) Explicit Average Noise Level: Up to -157dBm@1Hz RBW; 

2) Phase noise performance: -106dBm/Hz@100kHzfrequency deviation @1GHz carrier; 

3) Sweep speed: The minimum sweep time of 1GHz span <20ms; 

4) Resolution bandwidth: 1Hz～10MHz; 

5) The dynamic range of the system can reach above 95dB; 

6) 8.4-inch high-brightness and high-resolution touch screen LCD display, with view of 170° and 
sound visuality at direct sunlight conditions. 

2.1.1.3 Agility 

1) Small size, light weight and built-in lithium battery facilitating field operation;  

4) Perfect auto-diagnosis function and status self test;  

3) Intelligent power supply management function, with dump energy indication and low capacity 
warming;  

4) Multiple options to meet different customer‘s requirements 

5) Two types of USB2.0 ports available for portable storage device connection and PC 
communication respectively;  

6) One 10/100Mbps network port for local network establishment and remote control; 

7) Various auxiliary test interfaces: 10MHz reference input/output interface, GPS antenna 
interface, external trigger input interface, etc.; 

8) OI in both Chinese and English, with built-in operation instruction and only help information. 

2.1.2 Typical Applications 

2.1.2.1 Multiple-field test 

1) Filter performance test 

Test such indicators of the filter as insertion loss, ripple, and out-of-band suppression. 

2) Time domain measurement 

Test on cable length and failure positioning via cable and antenna analysis or time domain 
function of the vector network analysis mode. 

3) Radar and communication system performance test 

4) Measure radar network scattering parameter 

It can be used in the research and development of all kinds of military and civil radar systems 
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and communication systems. It can not only accurately test the frequency, power and phase 
noise of all kinds of signals in the process of signal generation, but also test the modulation 
characteristics of all kinds of spurious signals, parasitic signals, harmonic distortion and 
signals. 

5) Spectrum monitoring management 

It can be used to manage the airborne radio frequency signal in the control range, and quickly 
specify and search various interference signals. For example, it can monitor and manage the 
spectrum in such places as the military radio stations, broadcasting stations, communications 
equipment, airports, base stations and sensitive areas. It also has the audio demodulation 
function, which can be used for radio monitoring. 

6) Communication satellite monitoring 

It can be used for monitoring the signal spectrum quality, power and power control status of 
the communication satellite and discriminating and searching interference signals, ensuring 
security, reliability and stability of the communication satellite network. 

7) RF identification (RFID) test 

It can be used to test the transmitted stray radiation and field intensity of the interrogator, 
frequency deviation and occupied bandwidth, and measure the polling and timing of the RF 
identification system. 

8) Bluetooth field test 

2.1.2.2 Test on components, parts and the instrument 

It can be used for the DUT S-parameter amplitude, phase and group delay measurement, 

featuring efficiency, strong error correction capability, which is widely used in such  military and 

civilian fields as components, radar, aerospace, electronic jamming and countermeasures, 

communications, radio and television. 

It can be used for testing such  parameters as gain, frequency response, bandwidth, insertion 

loss, frequency conversion loss, isolation and distortion of such components and parts as the 

cable, connector, amplifier, filter, mixer, attenuator, isolator and coupler. 

It can be used to test various instruments and equipment on such performance indicators as the 

frequency, power, phase noise, parasitic, harmonic distortion and modulation characteristics 

during the R&D, production and maintenance of the signal generator. 

2.2 Safe Operation Instructions 

Please read carefully and strictly observe the following precautions! 

We will spare no effort to ensure that all production processes meet the latest safety standards 

and provide users with the highest safety guarantee. The design and testing of our products and 

the auxiliary equipment used meet relevant safety standards, and a quality assurance system has 

been established to monitor the product quality and ensure the products to always comply with 

such standards. In order to keep the equipment in good condition and ensure operation safety, 

please observe the precautions mentioned in this manual. If you have any questions, please feel 

free to consult us. 

In addition, the correct use of this product is also your responsibility. Please read carefully and 

observe the safety instructions before starting to use this instrument. This product is suitable for 

use in industrial and laboratory environments or field measurement. Always use the product 

correctly according to its restrictions to avoid personal injury or property damage. You will be 
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responsible for problems caused by improper use of the product or noncompliance with the 

requirements, and we will not be held responsible. Therefore, in order to prevent personal 

injury or property damage caused by dangerous situations, please always observe the 

safety instructions. Please keep the basic safety instructions and the product documentation 

properly and deliver them to end users. 

 Safety signs……………………………………………………………………………...……7 

 Operation Status and Locations…………………………………………………….………8 

 Electricity safety…………………………………………………………………….…………9 

 Operation precautions…………………………………………………………………………10 

 Maintenance………………………………………………………………………….…………11 

 Battery and power module………………………………………………………………….…11 

 Transportation……………………………………………………………………………………12 

 Waste Disposal/Environmental Protection………………………………………………..…12 
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2.2.1 Safety Signs 

2.2.1.1 Product-related Marks 

Safety marks on the products are described as follows (Table 2.1): 

Table 2.1 Products safety marks 

Symbol Meaning Symbol Meaning 

 

 

 

Notice, reminding users of 

information to be paid Special 

Notes to. 

It reminds users of the operation 

information or instructions to be 

paid attention to. 

 

    

 

 

Turn On/Off the power 

 

 

 

Notice, handling heavy equipment. 

 

 

 

 

Standby indication 

 

 

 

Danger! Hazard of electric shock. 

 

 

 

 

DC 

 

 

 

Warning! Hot surface. 

 

 

 

 

AC 

 

 

 

Protective conductive end 

 

 

 

 

DC/AC 

 

 

 

Grounding 

 

 

 

Reinforced insulation protection of the 

instrument 

 

 

 

Ground terminal  

 

 

EU mark for batteries and accumulators. 

Please refer to Item 1 of "2.2.8 Waste 

Disposal/Environmental Protection" in this 

section for specific instructions. 

 

 

 

Notice, please handle classical 

sensitive devices with care. 

 

 

 

 

EU mark for of separate collection of 

electronic devices. 

Please refer to Item 2 of "2.2.8 Waste 

Disposal/Environmental Protection" in this 

section for specific instructions. 

 

 

 

Warning! Radiation.Please refer to 

Item 7 of "2.2.4 Operation 

Precautions" in this section for 

specific instructions. 
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2.2.1.2 Manual-related Marks 

In order to remind users to operate the instrument safely and pay attention to relevant information, 

the following safety warning marks are used in the product manual, which are explained as 

follows: 

      

        

Danger mark, personal injury or equipment damage may be caused if not avoided. 

 

 

      

Warning mark, personal injury or equipment damage may be caused if not avoided. 

 

 

 

Caution mark, slight or medium personal injury or equipment damage may be caused if not 

avoided. 

 

 

The "Note" symbol indicates some important information which will not cause danger. 

 

 

      

Tips on information about the instrument and its operation 

2.2.2 Operation Status and Locations 

Please note before operating the instrument: 

1) Unless otherwise stated, the maximum altitude for operating the instrument shall not exceed 

4,600m, and the maximum altitude for transporting the instrument shall not exceed 4,500m. 

The range of actual supply voltage is ±10% of the marked voltage, and the range of supply 

frequency is±5% of the marked frequency. 

2) Unless otherwise stated, the instrument has not received any waterproof treatment, do not 

place the instrument on surfaces with water, vehicles, cabinets, tables and other objects that 

are not fixed and do not meet the load conditions. Please place the instrument securely and 

fix it on the surface of a solid object (e.g., an ESD workbench). 

3) Do not place the instrument in an environment where mist is easily formed, for example, 

Don‘t move the instrument in an environment where cold and heat are in alternation, where 

water droplets formed on the instrument may cause electric shock and other hazards. 

4) Do not place the instrument on the surface of a heat-dissipating object (e.g., a radiator). The 

Operation environment temperature shall not exceed the value specified in the description of 

relevant indicators of the product. Overheating of the product will lead to electric shock, fire 

and other risks. 

Danger !

       

Warning !

       

Caution !

       

Notice 

Tips 
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5) Do not insert any object into the instrument through the opening on the instrument casing, or 

Cover up any notch or opening on the product, which is used for internal ventilation and 

preventing the instrument from getting overheat. 

2.2.3 Electrical Safety 

Precautions for electrical safety of the instrument: 

1) Please adopt the AC-DC adapter delivered along with the instrument to supply power to the 

instrument. Improper use of the power adapter will cause damage to the internal hardware of 

the instrument. 

2) Adopt the 220V AC 3-core stabilized voltage supply for the instrument, so as to avoid any 

damage to the internal hardware to the instrument due to high-power peak pulse. 

3) Ensure good power supply grounding to avoid any damage to the instrument. 

4) If the instrument is powered by batteries or with batteries inside, please replace the battery 

with one of the same type or recommended equivalent type. Do not put any object into the 

instrument from the opening on the shell of the instrument, or pour any liquid onto or into the 

instrument shell or the instrument respectively, so as to avoid any internal short circuit or 

electric shock, fire or personal injury. 

5) Power off first before wiping the instrument to avoid any electric shock, and use dry or 

slightly-wet soft cloth to wipe the instrument surface. Do not try to wipe the internal of the 

instrument. 

6) Do not use the product with damaged power line. Check regularly the power line for normal 

condition. Take proper safety protection measures, and place the power line properly, so as to 

ensure it is free of damage and personnel will not be subject to power line tripping or electric 

shock. 

7) Before the instrument is powered on, the actual supply voltage shall match the required 

supply voltage of the instrument. 

8) Do not damage the power cord, otherwise electric leakage will be caused, resulting in 

damage to the instrument and even injury of the operators. If an external power cord or 

extension socket is used, it should be checked before use to ensure electrical safety. 

9) If the power supply socket does not provide an on/off switch, to cut the power of the 

instrument, you can just directly unplug the instrument, and therefore, it should be ensured 

that the power plug can be inserted or drawn conveniently. 

10) Do not use damaged power cords. Before connecting the instrument to the power cord, check 

the integrity and safety of the power cord, and properly place the power cord to avoid the 

impact due to human factors, such as, too long power cord that may trip the operator. 

11) Keep the socket clean and tidy, and ensure the plug and the socket in good contact and 

reliable engagement. 

12) Neither the socket nor the power cord can be overloaded, otherwise fire or electric shock will 

be caused. 
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13) The instrument shall comply with IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 

standards to connect with PC or IPC. 

14) Unless otherwise allowed, do not open the housing of the instrument, which may expose 

internal circuits and devices of the instrument and cause unnecessary damage. 

15) If the instrument needs to be fixed at the test site, a qualified electrician is required to install 

the protective earth wire between the test site and the instrument first. 

16) Take appropriate overload protections to prevent overload voltage (caused by lightning, for 

instance) from damaging the instrument or causing personal injury. 

17) When opening the housing of the instrument, do not place objects not belonging to the interior 

of the instrument, otherwise, short circuit, damage to the instrument and even personal injury 

may be caused. 

18) Unless otherwise stated, the instrument has not received any waterproof treatment, so keep 

the instrument from contacting with liquid to prevent damage to the instrument or even 

personal injury. 

19) Do not place the instrument in an environment where fog is easily formed, for example, 

moving the instrument in an environment where cold and heat are in alternation, where water 

droplets formed on the instrument may cause electric shock and other hazards. 

2.2.4 Operation Precautions 

1) Instrument operators need to have certain professional and technical knowledge, good  

psychological quality, and certain emergency response capabilities. 

2) Before moving or transporting the instrument, please refer to the relevant instructions in "2.2.7 

Transportation‖ of this section. 

3) The inevitable use of substances (e.g. nickel) in the production process of the instrument may 

cause allergy to personnel. If an operator of the instrument has allergic symptoms (e.g. rash, 

frequent sneezing, ophthalmia or dyspnea) during the operations, please seek medical care in 

time to find out the reason and solve the symptoms. 

4) Please refer to the relevant instructions in "2.2.8 Waste Disposal/Environmental Protection‖ of 

this section before disassembling this instrument for disposal. 

5) RF instruments will generate high electromagnetic radiation, during which period, pregnant 

women and operators with cardiac pacemakers need special protection. If the radiation level 

is high, corresponding measures may be taken to remove the radiation sources to prevent 

personal injury. 

6) In case of fire, the damaged instrument will release toxic substances. Therefore, the 

operators should wear appropriate protective equipment (e.g. protective masks and exposure 

suits) for safety. 

7) Laser products shall have different warning signs according to the laser category, because 

the radiation characteristics of laser and such equipment have high-intensity electromagnetic 

power characteristics, which will cause harm to human body. If the product is integrated with 

other laser products (e.g. CD/DVD driver), it will not provide other functions except the 
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settings and functions described in the product manual in order to prevent the injury of the 

laser beam to the human body. 

8) Electromagnetic compatibility level (in accordance with EN 55011/CISPR 11, EN 

55022/CISPR 22 and EN 55032/CISPR 32 standards) 

Class A equipment: 

The equipment can be used except in residential areas and low-voltage power supply 

environment. 

Note: Class A equipment is suitable for industrial operation environment, because it produces 

wireless communication disturbance in residential areas. Therefore, operators need to take 

relevant measures to reduce the impact of such disturbance. 

Class B equipment: 

Equipment need suitable for residential areas and low-voltage power supply environment. 

2.2.5 Maintenance 

1) Only authorized and specially trained operators are allowed to open the casing of the 

instrument. Before such operations, it is required to disconnect the power cord to prevent 

damage to the instrument or even personal injury. 

2) The repair, replacement and maintenance of the instrument should be performed by 

dedicated electronic engineers of the manufacturer, and the parts subject to replacement and 

maintenance should receive safety tests to ensure safe use of the product in the future. 

2.2.6 Batteries or Power Modules 

Before using batteries and power modules, carefully read the relevant information to avoid 

explosion, fire and even personal injury. In some cases, disused alkaline batteries (e.g. lithium 

batteries) shall be disposed of in accordance with EN 62133 standard. Precautions for use of 

batteries include the following: 

1) Do not damage the battery. 

2) Do not expose batteries and power modules to heat sources such as open fire; avoid direct 

sunlight and keep them clean and dry; clean the connection port of the battery or power 

module with a clean and dry soft cotton cloth. 

3) Do not short circuit the battery or power module. Do not store multiple batteries or power 

modules in cartons or drawers because the batteries are likely to cause short circuit due to 

being in contact with each other or other conductors; do not remove the original outer 

packaging of the battery and power module before use. 

4) Batteries and power modules must not be subjected to mechanical impact. 

5) If the battery fluid leaks, please do not touch the skin and eyes, otherwise wash it with a large 

amount of water and get medical treatment in time. 
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6) Please use the manufacturer's original batteries and power modules. Any incorrect 

replacement and charging of alkaline batteries (such as lithium batteries) is likely to cause an 

explosion. 

7) Discarded batteries and power modules shall be recycled and disposed of separately from 

other wastes. Due to the toxic substances inside the battery, they shall be properly discarded 

or recycled according to local regulations. 

2.2.7 Transportation 

1) If the instrument is heavy, please handle it with care. If necessary, use tools (a crane, for 

instance) to move the instrument so as to prevent damaging the body.  

2) The handle of the instrument is suitable for personal handling of the instrument and cannot be 

fixed on the transportation equipment when during the transportation of the instrument. In 

order to prevent property loss and personal injury, please follow the manufacturer's safety 

regulations on the transportation of the instrument. 

3) When operating the instrument on the vehicle, the driver should drive carefully to ensure 

transportation safety, and the manufacturer is not responsible for any emergencies during the 

transportation. Therefore, please do not use this instrument during the transportation, and 

reinforcement and preventive measures should be taken to ensure the transportation safety of 

the product. 

2.2.8 Waste Disposal/Environmental Protection 

1) Do not dispose of devices marked with batteries or accumulators together with unclassified 

waste; Instead, such devices should be collected separately and disposed of in a suitable 

collection location or through the customer service center of the manufacturer. 

2) Do not dispose of waste electronic devices together with unclassified waste; Instead, such 

devices should be collected separately. The manufacturer has the right and responsibility to 

help end users dispose of waste products. If necessary, please contact the customer service 

center of the manufacturer for corresponding disposal so as not to damage the environment. 

3) During mechanical or thermal processing of the product or its internal components, toxic 

substances (dust of heavy metals, such as lead, beryllium, and nickel, etc.) may be released. 

Therefore, specially trained technicians with relevant experience are required to disassemble 

the product to avoid personal injury. 

4) During the reprocessing, please refer to the safety operation rules recommended by the 

manufacturer to dispose of toxic substances or fuel released from the product with specific 

methods to avoid causing personal injury. 
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3 Operation Guide 

This chapter introduces the pre-operation precautions, front/back panel browsing, basic 

measurement methods, and data file management of the 4957B RF analyzer. so that users can 

have a preliminary understanding of the instrument itself and its measurement processes. This 

section contains some contents consistent with the relevant sections in Quick Start. 

 Get prepared………………………………………………………………………………13 

 Front panel and interface description……………………………………………………31 

3.1 Get Prepared 

Necessary preparatory work shall be carried out before the 4957B RF analyzer is ready for use. 

 Preparations before operation………………………………………………………………13 

 System configuration…………………………………………………………………………24 

 R o u t i n e  m a i n t e n a n c e  … … … … … … … … … … … … … … … … … … … … … … 2 9 

3.1.1 Preparations before Operation 

This section introduces the precautions before first setting and use of the 4957B RF analyzer. 

 

 

 

Avoid damaging the instrument 

Pay attention to the follow to avoid electric shock, fire and personal injury: 

Do not open the cabinet arbitrarily. 

Do not try to disassemble or refit any part of the instrument not mentioned in the manual. 

Otherwise, such consequences as reduced electromagnetic shielding property and internal 

component damage can occur, affecting product reliability. In this case, we will not provide any 

free maintenance any more even if the product is still in the warranty period. 

Please carefully read the relevant contents in "2.2 Safe Operation Guide" of this manual and the 

safety precautions therein for operation. Also please pay attention to the requirements for specific 

operating environment mentioned in the data page. 

 

 

 

 

Pay attention to the following when operating the instrument: 

Improper operating or measuring position can damage the instrument or the one connected to it. 

Pay attention to the following before powering on the instrument: 

In order to ensure that the fan blades and heat radiation holes are unobstructed, the instrument 

shall be at least 10cm away from the wall, and ensure that all fan vents are unobstructed. 

Keep the instrument dry; 

Keep the instrument level, and arrange it properly; 

Make sure the environment temperature meets with the requirement noted in the data page; 

Make sure the port input signal amplitude is within the range specified; 

Make sure the signal output port is connected properly, without any overload. 

Notice 

Warning !       



4957B RF Analyzer User Manuals 

Operation Guide 

14 / 248 

 

 

 

 

Electrostatic protection 

Take electrostatic protection measures at workplaces to avoid any damage caused by the 

instrument. For details, please refer to the relevant contents in "2.2 Safe Operation Guide" of the 

manual. 

 

 

 

 

Effect of electromagnetic interference (EMI) 

Since EMI can affect the measurement result, pay attention to the following: 

Select appropriate shield cables. For example, to use the double-shielded RF/network connection 

cable; 

Please close any cable connection port that is enabled but temporarily unused or connect a 

matching load to the connection port in time; 

  

Please refer to the EMC level labels in the Data Page. 

 Unpacking………………………………………………………………………………………14 

 Environmental requirements…………………………………………………………………15 

 Turning on/off the power…………………………………………………………………16 

 Proper operation of connectors………………………………………………………20 

 User inspection…………………………………………………………………………………23 

3.1.1.1 Unpacking 

1)  Visual examination 

Step 1.  Check whether the outer package and the shockproof packing of the instrument are 

damaged. If there is any damage, keep the outer package for standby, and proceed the 

inspection as per the steps below. 

Step 2.  Unpack the instrument and check the instrument and enclosed items for any damage; 

Step 3.  Carefully check whether the above items for any mistakes according to Table 3.1; 

Step 4.  In case of any outer package damage, or damage or problem to the instrument or articles 

provide in the package, never power the instrument on or start it up! Please contact our 

service consultation center according to the service hotline provided on the cover, and 

we will repair or change it as soon as possible accordingly. 

 

 

 

Handling: As the instrument is a valuable item, it shall be handled with care during handling. 

 

Notice 

Tips 

Notice 
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2) Model confirmation 

Table 3.1 Packing List of 4957B 

Name Quantity Function 

Mainframe:   

 4957B   

Standard Configuration:  

 3-core power cord   

 Power Adapter   

 CD-ROM (User's Manual)   

 Quick Start Guide   

 USB cable   

 Built-in rechargeable li-ion 

battery 

  

 Packing list   

 Product Certificate of 

Conformity 

  

Options:   

 USB Power Meter 1 Power measurement via external USB power 

probe 

3.1.1.2 Environmental Requirements 

In order to ensure the service life of 4957B and the validity and accuracy of measurement, please 
carry out the tests under the following environmental conditions: 

1) Operating environment 

The operating environment should meet the following requirements: 

Table 3.2 Operating Environment Requirements of 4957B 

Temperature -10°C ~ 50°C, 0°C ~ 45°C (battery powered) 

Temperature range 

during error 

adjustment 

23°C ±5°C (allowable temperature deviation during error 

adjustment < 1 ° C) 

Humidity Hygrometer measurement range at <+29°C: 20% ~ 80% 
(non-condensed) 

Elevation 0 ~ 4600 meters (0 ~ 15091 feet) 

Vibration Max. 0.21 G, 5 Hz ~ 500 Hz 

 

 

 

 

The 

 

Above environmental requirements are only applicable to the operating environment factors of the 

instrument, and are not with the scope of technical indicators. 

Notice 
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Since the storage temperature range of the battery equipped with the instrument is -20℃～60℃, 

the instrument should not work continuously for a long time when it is equipped with the battery at 

high temperature, so as to avoid danger caused by too high internal temperature. It is 

recommended to use an adapter for power supply. 

2) Heat dissipation requirements 

In order to ensure that the working environment temperature of the instrument is within the 

temperature range required by the operating environment, the following heat dissipation space 

requirements of the instrument shall be met: 

Table 3.3 4957B Heat Dissipation Requirements 

Instrument part Heat dissipation distance 

Back ≥180mm 

Left and right sides ≥60mm 

3) Electrostatic protection 

Static electricity is extremely destructive to electronic components and equipment. Usually we take 

two anti-static measures: conductive table mat and wrist strap; conductive floor mat and ankle 

strap. Using the above two anti-static measurements at the same time can provide good antistatic 

protection. If using one of them, only the former can provide antistatic protection. 1MΩ earth 

isolation resistor must be provided for the antistatic components at least for ensuring user safety. 

Correctly take the following antistatic measures to techniques to reduce electrostatic damages: 

Ensure all instruments are grounded properly, so as to avoid any static electricity; 

Let the internal/external conductor of the cable contact the ground shortly before connecting the 

coaxial cable with the instrument; 

Operators must wear anti-static wrist straps or take other antistatic measures before touching the 

joints, core or conducting any assembly. 

 

 

 

 

Voltage range 

The above-mentioned anti-static measures cannot be applied when the voltage exceeds 500V. 

 

3.1.1.3 Turning On/Off the power 

1) Precautions before turning on the power 

Pay attention to the following when turning on the power of the instrument: 

a) Confirming power supply parameters 

The 4957B RF analyzer is provided with the three-core power cord meeting the international 

Warning !       

Warning !       
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safety standard. During use, connector the instrument to a suitable power outlet with protective 
earthing, so as to connect the housing of the instrument to the ground via the power cord. It is 
recommended to use the power cord provided together with the instrument, and replace it with the 
same type of 250V/10A power cord if required. 4957B can be powered in three ways: 

AC power supply supplies power with an adapter 

When adopting AC power supply, the enclosed AC-DC adapter must be used. The input to the 
adapter is 220V/50Hz AC. 

To avoid overheating, please do not connect the AC-DC adapter to the analyzer when transporting 
or carrying it with a backpack. The voltage input range of the AC-DC adapter is wide. Please 
ensure that the power supply voltage is within the range required in Table 3.4. 

Table 3.4 shows the external power supply requirement for normal operation of the signal 

generator. 

Table 3.4 Working power parameter requirements of 1443 

 

 

 

 

Prevent mutual interference of power supplies  

To prevent mutual interference among multiple devices through power supplies, especially spike 

interference caused by high-power devices which may cause damage to instrument hardware, it is 

recommended to use a 220V or 110V AC stabilized power supply when using AC power supply to 

supply power with an adapter. 

 

DC power supply 

Voltage: 15V 

Current: 3A (min.) 

Built-in battery power supply 

4957B can be powered by rechargeable li-ion batteries. If the battery is left unused for a long time, 
it will be discharged by itself, so it must be charged before being used again. See Section III for 
details of battery usage. The basic parameters of the enclosed battery are as follows: 

Power supply 
parameter 

Applications 

Voltage, 
frequency 220V±10%，50 ~ 60Hz 110V±10%，50 ~ 60Hz 

Rated output 
current >1.7A >1.7A 

Power 
consumption 

(startup) 

Basic 
configuratio

ns 

All 
configurati

ons 

Basic 
configurations 

All 
configurations 

＜30W ＜50W ＜30W ＜50W 

Power 
consumption 

(standby) 
＜20W ＜20W 

Tips 
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Nominal voltage: 10.8V 

Nominal capacity: 7800mAh 

 

 

 

Rechargeable batteries should not be exposed to fire and high temperature (higher than 70℃), 

thrown into fresh water or salt water or wetted, and should be kept away from children. 

Rechargeable batteries can be reused and should be placed in suitable containers to avoid 

short-circuit. Heavy metals such as nickel and chromium in batteries will pollute the natural 

environment. Waste batteries should not be discarded casually, but should be put into a special 

battery recovery bins. 

b) Confirming and connecting the power cord 

The 4957B RF analyzer adopts three-core power cord interfaces, which conform to national safety 

standards. Before turning on the power of the RF analyzer, it is necessary to confirm reliable 

grounding of the ground wire in the RF analyzer, either floating ground or poor grounding may 

cause damage to the instrument and even cause injury to operators. Using a power cord without 

protective grounding is strictly prohibited. When the instrument is connected to a suitable power 

outlet, the power cord connects the housing of the instrument to the ground. The rated voltage 

value of the power cord should be greater than or 

equal to 250V, and the rated current should be greater than or equal to 1.7A. 

When connecting the instrument to the power supply: 

Step 1.  Confirm that the working power cord is not damaged; 

Step 2.  Connect the power plug of the rear panel of the instrument to a well-grounded three-core  

power socket with the power cord. 

 

 

 

Grounding 

Poor or wrong grounding may cause damage of the instrument or personal injury. Before turning 

on the power of the spectrum analyzer, make sure that the ground wire is in good contact with the 

ground wire of the power supply. 

Please use a power outlet with grounding protection. Do not use any external cable, power line or 

autotransformer without any protective grounding as the protective grounding line. If an 

auto-transformer is necessary, it is required to connect the common terminal to the protective 

grounding of the power connector. 

 

c) Battery installation and replacement 

The 4957B RF analyzer is provided with a high-capacity rechargeable lithium battery, with a 
cruising power of about 3h. Users can buy backup batteries for long-time out-field test, so as to 
avoid any test interruption due to insufficient battery capacity. It is recommended to buy a battery 
of the same model as the enclosed battery. 
 
 

Warning !       

Notice 
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In order to ensure the battery life, the battery should be taken out of the battery compartment 

during transportation and long-term storage. Try not to make the battery power reduce to less than 

5%, otherwise the battery may not be recharged. 
 
Battery installation and replacement 
The battery installation steps are as follows: 
Open the battery cover, put the battery into the battery cartridge, push the battery in, and close the 
battery cover. 
Checking the battery status 
The 4957B RF analyzer is provided with a battery, and its full battery power can achieve a standby 
time of about 2.5h. 
Users can view the battery status in any of the following ways: 
The first way is to check the battery icon on the system status bar and roughly check the battery 
power. When the battery icon shows 15% battery power, please change the battery or charge it in 
time; 
The second way is to remove the battery and press the button at the white point at the end of the 
battery, and the indicator lights above the button will go on to indicate the current remaining 
battery power. When only one indicator light is on, please charge the battery in time. 
Charging the battery 

 

The power indicator light is located inside the yellow power on button. 

 

The battery can be charged when the 4957B RF analyzer is turned off or working. The charging 
steps are as follows: 

Step 1.  First install the battery to be charged in the machine. 

Step 2.  Use the AC-DC adapter provided alongside to turn on the external power supply. 

Step 3.  In case of charging in the power-off state, the power indicator light in the lower left corner  

of the front panel of the machine is yellow and flashing, indicating that the battery is 
being charged, and the indicator light is normally yellow after charging. In case of 
charging in the power-on state, the power indicator is green and flashing, indicating that 
the battery is being charged, and the indicator light is normally green after charging. At 
this time, the battery icon on the right side of the system status bar of the instrument 
display screen will show fully charged state. 

In addition, for batteries with a battery power of more than 5%, the charging time in the power-off 

state is about 4h. 

2) Power-on for the first time 

Precautions for turning on/off the power of the instrument are as follows: 

a) Connecting the power supply 

Please confirm the power supply parameters and the power cord before power-on for the first time. 

For details, please refer to the Section ―3.1.1.3 Turning on/off the power‖ in the user‘s manual. 

Step 1. Connecting the power cord: Connect the AC-DC adapter with the power cord matched 

with the RF analyzer in the packing box or the three-core power cord meeting the 

requirements, connect the adapter with the external power interface of the RF analyzer 

(as shown in Figure 3.1), and connect the other end of the power cord with the AC power 

Notice 

Notice 
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supply meeting the requirements; observe that the power indicator light on the front panel 

turns yellow (as shown in Figure 3.2). 

Step 2. Turn on the power switch of the front panel: As shown in Figure 3.2, do not connect 

any equipment to the RF analyzer. If everything is normal, the instrument can be turned 

on, and then the power indicator light on the front panel will turn green. 

b) Turning on/off the power 

Gently press the yellow power switch key 【  】 on the front panel for more than 3s, observe that 

the front panel power indicator light turns green, and the display backlight goes on. You need to 

wait for about 30s for the display startup until the startup status interface is displayed. After 

warming-up for 10min, there shall be no alarm indication in the display interface. Press the yellow 

power switch key 【  】 at the lower left corner of the front panel of the 4957B RF analyzer for 

about 3s, and the RF analyzer will exit the measurement application program automatically and 

power off.  

Note: If the LED "flashes", it indicates that the internal battery is not fully charged and is being 

charged. 

c) Disconnecting the power supply 

In case of emergency, in order to avoid personal injury, the RF analyzer shall be powered off 

immediately. At this time, you need to unplug the power cord and remove the battery. Therefore, 

reserve sufficient operating space when operating the instrument to facilitate direct shutdown and 

battery removal when necessary. 

3.1.1.4 Proper operation of Connectors 

Connectors are often used in various tests of signal generators. Although the connectors of 

calibration pieces, test cables and analyzer measuring ports are designed and manufactured 

according to the highest standards, the service life of all these connectors is still limited. Due to the 

inevitable wear and tear during normal use, the performance indicators of the connectors will 

decrease or even be unable to meet the measurement requirements. Therefore, correct 

maintenance and measurement connection of the connectors can not only ensure accurate and 

repeatable measurement results, but also prolong the service life of the connectors and reduce the 

measurement costs. In actual use, the following aspects should be paid attention to: 

1) Connector check 

When conducting connector inspection, anti-static wrist band should be worn. It is recommended 

to use a magnifier to check the following items: 

a) Whether the electroplated surface is worn or not and whether there are deep scratches; 

b) Whether the thread is deformed; 

c) Whether there are metal particles on the threads and the joint plane of the connector; 

d) Whether the inner conductor is bent or broken; 

e) Whether the screw sleeve of the connector rotates improperly. 
 

 

 



4957B RF Analyzer User Manuals 

 Operation Guide 

 21 / 248 

 

 

 

 

Check the connector to prevent damaging ports of the instrument 

Any damaged connector may damage the good connector connected to it even when measuring 

the connection for the first time. In order to protect each interface of the signal generator itself, the 

connector must be checked before connector operation. 

2) Connection method 

Before the connection, the connectors should be inspected and cleaned to ensure cleanness and 

intactness. Anti-static wrist straps should be worn before connection. The correct connection 

method and steps are as follows: 

Step1. As shown in Figure 3.4, align the axes of the two interconnecting devices to ensure that the 

pin of the male connector slides concentrically into the socket of the female connector. 

 

Figure 3.4 Axes of interconnected devices are in a straight line 

Step2. As shown in Figure 3.5, move the two connectors leveled together so that they can be 

smoothly engaged. Rotate the screw sleeve of the connector (note, not the rotating 

connector itself) until it is tightened, and there can be no relative rotational movement 

between the connectors during the connection. 

 

 

Figure 3.5 Connection method 

Step3. As shown in Figure 3.6, tighten the connectors with a torque wrench to complete the 

connection. Pay attention that the torque wrench should not exceed the initial folding 

point. Use an auxiliary wrench to prevent the connector from rotating. 

 

Figure 3.6 Finishing the connection with a torque wrench 

Caution !

       

Keep Still 
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3) Disconnection method 

Step1. Support the connectors to prevent any connector from being twisted, shaken or bent; 

Step2. An open-ended wrench can be used to prevent the connector body from rotating; 

Step3. Loosen the screw sleeve of the connector with another wrench; 

Step4. Rotate the screw sleeve of the connector by hand to complete the disconnection; 

Step5. Pull the two connectors levelly apart. 

4) Usage of a torque wrench 

The use of a torque wrench is shown in Figure 3.7. The following points should be paid  

attention to when using it: 

a) Confirm that the torque of the torque wrench is correct set before use; 

b) Ensure that the angle between the torque wrench and another wrench (used to support a 

connector or a cable) is within 90o before applying force; 

c) Grasp the end of the torque wrench handle gently, and apply force in the direction 

perpendicular to the handle until reaching the folding point of the wrench. 

 

 

 

 

 

Figure 3.7. Usage of a torque wrench 

5) Use and storage of connectors 

a) The connectors should be covered by protective sleeves when not in use; 

b) Do not mix various connectors, air lines and standard calibration pieces in a box because this 

is one of the most common causes of connector damage. 

c) Keep the connectors and the analyzer at the same temperature. Holding a connector by hand 

or cleaning a connector with compressed air will significantly change its temperature. The 

connectors should be calibrated after its temperature is stable. 

d) Do not touch the joint plane of the connectors because the grease and dust particles on the 

skin are difficult to be removed from the joint plane; 

e) Do not put the contact surface of a connector downward on a hard table surface. Contact with 

any hard surface may damage the electroplated layer and the joint surface of the connector. 

f) Always wear anti-static wrist straps and work on a grounded conductive workbench pad, 

which can protect the analyzer and the connectors from electrostatic discharge. 

6) Connector cleaning 

When cleaning the connectors, always wear antistatic wrist straps and observe the following 

steps: 

a) Remove loose particles on the thread and joint plane of the connectors with clean 

low-pressure air, and thoroughly inspect the connectors. If further cleaning treatment is 

required, proceed as follows: 

b) Soak (but not thoroughly soak) a lint-free cotton swab with isopropyl alcohol; 

Torque 

direction 

Stop applying force when the 

handle is bent 
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c) Remove the dirt and debris from the joint plane and threads of the connectors with cotton 

swabs. When cleaning the inner surface of a connector, be careful not to apply external force 

to the central inner conductor and not to leave the fibers of cotton swabs on the central 

conductor of the connector. 

d) Let the alcohol volatilize, then blow the surface clean with compressed air; 

e) Check the connector to make sure that it is free of particles and residues; 

f) If any defects of the connector is still obvious after cleaning, it indicates that the connector 

may have been damaged and should not be used again. Make clear the cause of the 

connector damage before connection. 

7) Use of adapters 

When the measuring port of the RF analyzer and the connector type used are different, adapters 

must be used for the connection before measurement. In addition, even if the measuring port of 

the analyzer and the connector type of port of the tested piece are the same, it is also advisable to 

use adapters. Both cases can protect the measuring port, prolong its service life and reduce the 

maintenance cost. Before connecting an adapter to the measuring port of an analyzer, it is 

required to carefully check and clean the adapter. And a high-quality adapter should be used to 

reduce the influence of mismatching on measurement accuracy. 

8) Joint plane of connectors 

An important concept in microwave measurement is reference plane. And an analyzer, it is the 

benchmark reference plane for all measurements. During the calibration, the reference plane is 

defined as the plane where the measuring port and the calibration standard are engaged. Good 

connection and calibration depend on thorough and level contact between the connectors on the 

joint plane. 

 

 

Figure 3.8 Plane calibration 

3.1.1.5 User Inspection 

After the 4957B RF analyzer is powered on for the first time, it is necessary to check whether the 

instrument works normally to ensure subsequent measuring operations. 

 

 

 

Description of front panel hard keys and soft keys on menus 

The description form of the front panel hard keys and menu soft keys is as follows: 

Tip 
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1) Description form of hard keys: 【XXX】, XXX is the name of the hard key; 

2) Description form of soft keys:  [XXX], XXX is the name of the soft key. 

If the key corresponds to multiple states, an state with the font color of the selected value changed 

and the background color darkened is valid. For example: [Sweep Time Man Auto] indicates that 

the sweep time manual option is enabled. 

 

Connect the 4957B RF analyzer to the power supply or power it with a battery, and observe that 

the power indicator light on the front panel is yellow, indicating that the standby power supply is 

working normally. Gently press the yellow power switch key 【  】 on the front panel for more than 

3s, observe that the front panel power indicator light turns green, and the display backlight goes on. 

You need to wait for about 30s for the display startup until the startup status interface is displayed. 

After warming-up for 10min, there shall be no alarm indication in the display interface. 
The 4957B instrument is provided with a self test function, which can test the working status and 
internal environment temperature of each component in the RF analyzer and provide test 
information after the self test program is activated. 

Follow the step below to conduct the self test: 

a) Press [System]→[Self Test] to enable the self test program. The test result window will pop up 
after the self test; 

b) Click 【OK】to close the self test result window. 

3.1.2 System configuration 

This chapter introduces the 4957B RF analyzer, including version serial number, self test, sleep 

mode, automatic shutdown, display mode and brightness, GPS function, system language, time 

and date, network configuration, factory debugging and reference settings, as well as the menus 

and menu description of the system settings. 

3.1.2.1 Viewing version serial number 

Each 4957B is provided with a unique and fixed serial number and internal software version 
information, which is set by the manufacturer upon delivery, cannot be changed the user, and can 
be viewed by the following steps: 

a) Press [System]→[Version Information] to pop up the instrument serial number window,    

display such version information as the product model, serial number, application program 
and firmware program. 

b) Click 【OK】to close the window. 

3.1.2.2 Self Test 

The 4957B instrument is provided with a self test function, which can test the working status and 
internal environment temperature of each component in  the RF analyzer and provide test 
information after the self test program is activated. 

Follow the step below to conduct the self test: 

a) Press [System]→[Self Test] to enable the self test program. The test result window will pop up  

after the self test; 

b) Click 【OK】to close the self test result window. 
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3.1.2.3 Setting sleep mode 

The 4957B RF analyzer is provided with the power saving mode (including the auto sleep mode 
and auto shutdown mode), so as to prolong the operating time when the power is supplied via the 
battery. If no operations are conducted in the sleep time set with the auto sleep mode enabled, the 
RF analyzer will enter the sleep status, including such operations as closing the LED display and 
cutting off internal module power supply. Press any key to let the RF analyzer exit from the sleep 
mode and switch to the normal operation mode. 

a) Press [System]→[Power Saver], which is disabled in the sleep mode. 

b) Click [Sleep   Off] to enable the sleep mode. 

c) Enter the sleep time to be set via the number key, and press the time unit to confirm. 

3.1.2.4 Setting auto shutdown 

When the auto shutdown mode is on, the instrument starts to time it, and shuts down automatically 
when the time set for auto shutdown is reached. The instrument will pop up a countdown prompt 
10 s before entering the shutdown status and user cancel such shutdown process as per the 
prompt. Press [System]→[Power Saver] to enter the setting menu, and the auto shutdown function 
is disabled by default. 

a) Press the softkey to switch to [Shut Down/Off], and enable the auto shutdown mode to show  

current shutdown time. 

b) Enter the shutdown time to be set via the number key, and press the time unit to confirm. 

3.1.2.5 Display mode and brightness adjustment 

The RF analyzer is provided with three screen display modes to facilitate user‘s test in different 
conditions, namely, the outdoor, night and normal modes. Users can also adjust the screen 
brightness from five manual brightness adjustment levels as required. 

a) Press [System]→[Display] to enter the display mode and brightness adjustment menu. 

b) Switch current display mode as per corresponding modes. 

c) Press [Brightness  Auto / Man] to switch to the brightness adjustment mode. If in the manual 
mode, the brightness adjustment dialog box will pop up. Drag the scroll bar or use the rotary knob 
or up/down key to set the brightness. 

3.1.2.6 GPS function 

The 4957B instrument is provided with the GPS function for viewing such information as the 
receiver status, number of satellites in use, latitude and latitude hemispheres, longitude and 
longitude hemispheres, altitude and UTC date/time. 

a) Press 【System】→[Positioning System GPS] to open the GPS function menu. 

b) Press [GPS  Off/On] to switch the GPS status, and enable the GPS function. 

c) Press [GPS Info] to view detailed GPS information. 

3.1.2.7 System language selection 

a) Press [System]→[Language] to enter the language selection interface of the system. 

b) Press [Simplified Chinese] or [English] to set current interface operation language. 
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3.1.2.8 Setting date and time 

a) Press [System]→[Configuration]→[Date&Time] to pop up the date setting dialog box. 

b) Click corresponding zone in the calendar area to set the date. 

c)  Click corresponding zone in the time area to enter numerical value for time setting. 

d) Press 【OK】 to complete the setting and close the dialog box. 

3.1.2.9 Network setting 

It is used to set the RF analyzer network, with specific steps shown below: 

a) Press [System]→[Configuration]→[Network Setting] to pop up the network configuration 
dialog box. 

b) Click corresponding zone to enter numerical value for setting. 

c) Press 【OK】 to complete the setting and close the dialog box. 

3.1.2.10 Factory debugging 

The 4957B RF analyzer is provided with a program entry for factory debugging. 

a) Press [System]→[Manage] to pop up the ―Enter Password‖ dialog box, and enter the factory  

debugging menu after that. 

 

 

 

 

This function can be used only for factory debugging, and users cannot try to crack the password. 

Otherwise, the RF analyzer can be damaged. 

 

3.1.2.11 Setting frequency reference 

The 4957B RF analyzer is provided with both the internal frequency reference and external one. 
The external reference frequency must be 10MHz±100Hz and amplitude of 0dBm (limit range: 
-2dBm~+10dBm). The external reference frequency must be entered from the ―10MHz 
input/output‖ port on the cover plate. 

a) Press  [System]→[Page Down] to set the frequency reference, which is the internal  

frequency reference by default. 

b) The 4957B RF analyzer can also output the internal reference as follows:  

Press [Ref Output Off On] to enable or disable the reference output function. 

3.1.2.12 Setting reference output 

4957B can provide external device with a reference output of 10MHz via also the ―10MHz 
input/output‖ port on the cover plate, with the steps shown below: 

a) Press [System]→[Page Down] to set the frequency reference, the reference output function  

disabled by default. 

b) Press [Ref Output  Off/On] again to enable or disable the reference output function. 

Notice 
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3.1.2.13 System menu structure 

测量模式

系统

版本信息

自测试

显示

定位系统

语言

翻页1/2 >

>
GPS

关        开

定位系统

详细信息

冷启动

<    返回

节电模式

>

配置

时间同步

关 开

高斯坐标

关 开

定位系统
GPS >

GPS

定位系统

SBAS

北斗

信号跟踪

关         开
<    返回

>

QZSS

GLONASS

默认模式

显示

户外模式

夜视模式

亮度调节

自动     手动

<    返回

亮度设置
1  2  3  4  5

频谱分析

干扰分析

解调分析

信道扫描

信号跟踪

关         开
定向分析

>场强测量

信号分析

<    返回

>

>

>

简体中文

语言

English

<    返回

频率参考

内         外

系统

参考输出

关 开

风扇

自动  开  关

节电模式

错误日志

翻页2/2 >

>

关于

日期时间

配置

网络设置

<    返回

>

>

上一项

网络设置

下一项

IP设置

掩码设置

网关设置

<    返回

年

日期时间

月

日

时

分

秒

<    返回

节电模式

自动休眠

关           开

休眠时间

5分钟

自动关机

关           开

关机时间

10分钟

信号跟踪

关         开
<    返回

>
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3.1.2.14 System menu description 

测量模式

系统

版本信息

自测试

显示

定位系统

语言

翻页1/2 >

>

配置

>

 

·[Measurement mode]: Press 【system】→[Measurement Mode] 

to select such measurement modes as spectrum analysis, interference 

analysis, analog demodulation analysis, interference analysis, 

demodulation analysis, channel sweep, field strength measurement, 

directional analysis and signal analysis.  

·[Special Notes]: The measurement mode menu exists only in 

spectrum analysis mode, but not in other modes.  

·[Version Information]: Press 【System】→[Version Information] 

to view the system related information, including machine serial 

number, application software version, image customization version and 

other related information.  

·[Self-test]: Press 【System】→[Self Test] to check the operating 

status of each component in the RF analyzer and the internal 

environment temperature. 

·[Display]: Press 【System】→[Display] to set the display mode, 

including [Default Mode], [Outdoor Mode], [Night Vision Mode] and 

relevant settings of [Brightness Adjustment].  

·[Positioning System]: Press 【System】→[Positioning System] 

to pop up the soft menus related to the positioning system, including 

[GPS Off On], [Details], [Cold Start], [Time Synchronization Off On], 

[Gaussian Coordinates Off On], [Positioning System], which are used 

to select the positioning system and view the position details, as well 

as start the resetting.  Special Notes: The positioning system 

function is an optional function.  

·[Language]: Press 【System】→[Language] to select the 

language, including [Simplified Chinese] and [English].  

·[Configuration]: Press 【System】→[Configuration] to pop up the 

soft menus related to the system configuration. [Date&Time] is used for 

date and time setting, and [Network Setting] is used for network setting 

of the RF analyzer, including such soft menus as [Previous], [Next], [IP 

Setting], [Mask Setting] and [Gateway Setting].  
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频率参考

内         外

系统

参考输出

内         外

风扇

自动    开    关

节电模式 >

>

>

管理

翻页2/2 >

关于

错误日志

 

·[Freq Ref Int/Ext]: Press 【System】→[Frequency Reference 

Internal External] to select internal frequency reference or external 

frequency reference as needed.  

·[Ref Output Off/On]: Press 【System】→[Ref Output Off On] to 

select whether to turn on the internal reference function as needed 

when the frequency reference is the internal reference.  

• [Fan Auto On/Off]: Press 【System】→[Fan Auto On Off] to set 

the fan status, which is automatic by default.  

·[Power Saver]]: Press 【System】→[Power Saving Mode] to set 

the options of automatic sleep and automatic shutdown.  

·[Error Log]: Press 【System】→[Error Log] to view the relevant 

error messages.  

·[About]: Press 【System】→[About] to see the software version 

of the instrument, the Company's telephone number, E-mail, website 

and other information.  

·[Manage]: Press 【System】→[Manage] to enter the administrator 

password for the relevant management and setting of the system.  

·[Special Notes]: The system management function can be 

used only by the factory debugging personnel or technical 

supporting personnel rather than users. Otherwise, the 

instrument can be damaged.  

 

3.1.3 Routine Maintenance 

This section introduces the routine maintenance of the 1443 series vector signal generators. 

3.1.3.1 Cleaning 

1) Cleaning instrument surface 

Please follow the steps below when cleaning the surface of the instrument: 

Step 1.  Shut down the instrument and disconnect the power cord connected to it; 

Step 2.  Wipe the surface gently with dry or slightly wet soft cloth, and do not wipe the inside of 
the instrument. 

Step 3.  Do not use chemical cleaners, such as alcohol, acetone or dilutable cleaners. 

2) Cleaning the display 

After a period of use, the LCD display needs to be cleaned. Please follow the steps below: 

Step 1.  Shut down the instrument and disconnect the power cord connected to it; 

Step 2.  Dip a piece of clean and soft cotton cloth into the cleaner and then gently wipe the display 
panel; 

Step 3.  Dry the display with a piece of clean and soft cotton cloth; 

Step 4.  Connect the power cord only after the cleaner is completely dried. 
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There is an antistatic coating on the surface of the display. Do not use cleaners containing fluoride, 

acid and alkaline. Do not spray the cleaner directly onto the display panel, otherwise it may 

penetrate into the instrument and damage the instrument. 

3.1.3.2 Input/output port protection 

The standard impedance of the RF port of the 4957B RF analyzer is 50Ω, so the test signal shall 
be added or appropriate load impedance shall be connected in strict accordance with the port 
requirements to prevent damages to the post circuit. 

 

 

 

There is a maximum allowable input level at the RF input end of the RF analyzer, and it is strictly 
prohibited to inject a signal beyond the limit, otherwise it will cause damages to the instrument. 

 

  

Warning !

       



4957B RF Analyzer User Manuals 

 Operation Guide 

 31 / 248 

 

3.2 Front panel and interface description 

This chapter introduces the front panel and interface description and functions of the 4957B RF 

analyzer. 

3.2.1 Front Panel 

The front panel of the 4957B RF analyzer isFigure 3-5 as shown in Figure 3-5. 

 

Figure 3-5 Front panels 

 

In this manual, for primary menus, the keys on the front panel and the 

buttons on the bottom of the touch screen are represented by 【XXX】, 

with XXX being the key name, and the menu keys on the right are 

represented by [XXX], with XXX being the menu name. 

3.2.1.1 Display zone 

The 4957B RF analyzer has an 8.4‖ color touch screen. The parameter setting of the instrument 
and the display of a large amount of information can be realized at the touch of a finger, which 
saves the cumbersome steps of setting the soft and hard key menus and greatly simplifies the 
user's operation. 

When the instrument performs different functions, the display zone has the following display 
functions: Display multiple instrument windows, and display various settings and measurement 
data information of the instrument in the window; display the working status information of the 
instrument; display the current input data when such parameters as frequency are to be input; 
display the current working time of the system; display the menu information corresponding to the 
current effective operation of the instrument window; the specific introduction is as shown in Figure 
3-6:  

 

 

 

Notice 
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Figure 3-6 Display Zone 
The information display zone under the screen display zone of the 4957B RF analyzer displays 
various settings for current measurement and instrument status, which can be divided into 5 zones 
as per the position on the screen, namely, the top information display zone, measurement data 
display zone, left information display zone, soft key menu display zone and bottom function button 
zone. 

1) Top information display zone 

The top information display zone is on top of the screen to display such information as the system 
date, time, current power supply type and battery power and GPS status of the RF analyzer from 
left to right in sequence. 

Setting and change of system date and time: Set through 【System】→[Date&Time]. 

Change of date format: Set through 【System】→[Date Format]. 

The signs of the power supply type and battery status indicator on the right of the top information 
display zone vary with the situation that whether there is external power supply or the battery 
power. Signs corresponding to various power supply statuses of the RF analyzer are shown 
below: 

a) If the RFanalyzer is not provided with a battery and adopts an external power supply, it shows 

; 

b) When the RF analyzer is provided with a fully charged battery and isn't connected with an 

external power adapter, it shows .  

c) When the battery is fully charged and the external power adapter is connected, it shows 

. As the battery power decreases gradually due to use, the green zone of the 

battery power display will gradually decrease; 
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d) When the analyzer is provided with a battery and is connected with an external power adapter, 

when the battery power is less than 100%, the battery is in the charging state, and the 

charging icon is ;          

e) When the RF analyzer is not connected to an external power supply and the battery power is 

less than 20%, the battery is in the undervoltage state and it shows .  

When such an icon appears, please charge the battery in time. When the battery power is less 

than 10%, the RF analyzer can run for another 10min. Please save the measurement results in 

time because it will be shut down automatically after the power is used up.  

2) Measurement data display zone 

The measurement data display area can display the measurement data. The contents displayed 
vary with the measurement mode. The trace is displayed in coordinate grid in the vector network 
analysis and antenna test modes. Scale values and mark information are displayed in the left and 
upper right of the grid respectively. Measurement parameters are displayed on top of the grid, and 
the start/stop frequencies displayed at the bottom. The trace is displayed in coordinate grid in the 
spectrum analysis mode. The left side of the grid displays the scale values, the top shows the 
signal standard and marker information, and the bottom shows the center frequency and span 
information. 

3) Left information display zone 

This information area is located at the upper left of the screen. In the vector network analysis 
mode, it displays such information as start frequency, stop frequency, sweep time, sweep points 
and intermediate frequency bandwidth of the current measurement; in the spectrum analysis 
mode, it displays such information as reference level, attenuator setting, display scale, resolution 
bandwidth, video bandwidth and sweep time of the current measurement, each of which can be 
set through the corresponding function key; in the antenna feeder test mode, it displays such 
information as start frequency, stop frequency, sweep time, sweep points, intermediate frequency 
bandwidth of the current measurement; in the vector voltage measurement mode, it displays such 
information as current measurement type (reflection by default), measurement port (port 1 by 
default) and measurement format (dB by default); in the USB power measurement mode, it 
displays such information as zeroing, frequency, offset and relative measurement. You can quickly 
set the corresponding parameters by clicking these buttons on the touch screen. The contents 
displayed vary with the measurement mode. 

4) Soft key menu display zone 

In order to improve the operation flexibility of the 4957B RF analyzer and give full play to the 
advantages of the touch screen, the 4957B resident software is provided with eight gray touch 
keys on the right side, and the corresponding functions of these eight keys are directly displayed in 
the corresponding key zones. 

5) Bottom function button zone 

The function hardkeys on the main menu zone and the front panel are at the same level. For 
specific measurement mode, the main menu generally consists of a set of unique menu keys for 
supplementing the function hardkeys. It can display different menu names in different 
measurement modes to facilitate users to carry out the measurement. 

3.2.1.2 Numeric input zone 

The numeric input zone includes direction keys, knob, numeric keys, backspace key, cancel key 
and OK key. All inputs can be changed through keys and the knob in the input zone. The keys in 
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the input zone are described in detail below. 

a) Direction keys: The up/down key is used to increase or decrease the value, where there are no 
left and right keys, and the step value of the up/down key corresponds to the step of each 
parameter. 

b) Knob: It is used to increase or decrease the value. Turn the knob clockwise to increase the 
variable and vice versa. The knob can change the value together with the up/down key, and the 
step of the knob is the same as that of the up/down key. 

c) Numeric keys: They are used to enter numbers (including the negative sign). 

d) Backspace key: It can undo the last input data bit by bit according to the numeric input status. 

e) Cancel key: It cancels the currently input data that is not valid. 

f) OK key: It confirms the current parameter setting. 

3.2.1.3 Function key zone 

The function key zone is located at the bottom of the screen, and is used to change the 

measurement parameter setting, including six keys: 

a) 【Freq】: Set the center frequency, start/stop frequency, span and frequency step for  

measurement in the vector network analysis mode and spectrum analysis mode; 

b) 【Amplitude】: Set such parameters as the auto scale, reference level, reference position,  

scale and output power in the vector network analysis mode. Set the reference level, 
attenuator setting, scale display, unit and preamplifier control in the spectrum analysis mode; 

c) 【BW】: Set such parameters as the average, smooth and intermediate frequency bandwidth  

in the vector network analysis mode. Set such parameters as measurement RBW, VBW, 
detector type and average in the spectrum analysis mode; 

d) 【Mkr】: Set the specific parameters of the measurement marker in the vector network  

analysis mode and spectrum analysis mode; 

e) 【Measure】: Select the required S-parameter measurement mode, data format and time  

domain in the vector network analysis mode. In the Spectrum Analysis mode, it is used to 
select different measurement functions, including field strength measurement, channel 
power, OBW, AM/FM DM, ACPR, etc. or set signal source power output. 

f) 【Mode】: Set the working mode, including spectrum analysis, vector network analysis, cable  

and antenna feeder test, USB power measurement, vector voltmeter, etc.  

3.2.1.4 Reset key 

Press the 【Reset】 hard key system to perform the function of shutdown and power-on again. 

3.2.1.5 Power switch 

It is used for turning on and off the RF analyzer. If an external power adapter is used for power 
supply, when the instrument is in the "standby" state, the yellow indicator near the power switch is 
on; Press and hold the power switch for over 3 seconds, and the green indicator will be on, 
indicating that the instrument is in the "working" state. In the working state, press and hold the 
power switch for more than 3s to turn off the RF analyzer. 
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Note: If the LED "flashes", it indicates that the current battery is not fully charged and is being 
charged. 

3.2.2 Interface description 

The peripheral interfaces of the 4957B are mainly located on the top panel, as shown in Figure 3-7, 
which can be divided into three parts: power interface, test ports and digital interfaces. 

Power supply

USB

LAN

SD card

Headphone

VNA port 

10MHz Reference 
input/output

Trigger GPS

Mini USB

SA input VNA port

 

Figure 3-7 Interface Description 

3.2.2.1 Power Interface 

The power supply interface of the instrument can supply power to the RF analyzer through DC 
output of a AC-DC adapter or external DC power supply. The inner conductor of the external 
power interface is positive, and the outer conductor is grounded. 

3.2.2.2 Test Ports 

a) Spectrum input port: It is marked as ―SA RF In‖ and used for the input of the measured signal 
in the spectrum analysis mode. The test signal input port of the 4957B RF analyzer is a 50Ω and 
N-type female port.  

b) Network test port: The two test ports in the vector network analysis mode are two 50Ω and 
N-type female ports, which are marked with ―Port 1‖ and ―Port 2‖ respectively, and can be switched 
between the RF source and receiver, so as to measure the DUT in both directions.  

c) 10MHz input/output port: It is marked as "10MHz In/Out", 50Ω impedance, BNC female 
adapter, and can be externally connected with the 10MHz signal of other equipment as the 
reference signal of the analyzer; the internal 10MHz reference signal of the RF analyzer can also 
be output for use by the external equipment. 

d) Trigger input port: It is marked as "Trig In", and the 4957B can be set to the external trigger 
mode. The external trigger source is connected with the trigger input port of the RF analyzer, and 
the output range of the source shall be-5V~+5V. It can be set by the software whether to adopt the 
rising edge trigger or falling edge trigger. 

e) GPS antenna interface: It is marked as ―GPS antenna‖ and connected with the GPS antenna 
equipment, and can locate the current position of the RF analyzer. 

0402 
In order to better protect the RF analyzer, the test port of the instrument is provided 

with some symbols. When using the RFanalyzer, users must pay attention to the 

symbols, so as to avoid permanent damages to the instrument. 

  Warning ！ 
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3.2.2.3 Digital interfaces 

a) Mini USB interface: It is connected with the external PC, which carries out the program control 
of or data transmission to the 4957B through the program control instruction or program control 
function library. 

 
Install a device driver first before connecting the RF analyzer to the 

PC via the USB for the first time. 

b) USB A interface: It is connected with the USB peripherals, e.g. USB storage device, USB  

power probe, etc. 

c) LAN (network) interface: It is a 10/100Mbps network interface and can be connected through  

the network cable with the computer (PC), which carries out the program control of or data 
transmission to the 4957B through the program control instruction or program control function 
library. 

d) SD card slot: Micro SD card slot, which can be used for expanding the storage space of the  

instrument. 

e) Earphone jack: It is a standard 3.5mm/3-line earphone port for outputting the sound  

modulated via FM/AM/SSB. If the port is not connected to the earphone, the sound is output 
via the speaker of the RF analyzer; when it is connected to the earphone, the sound output is 
switched from the speaker to the earphone automatically. 

3.2.2.4 Instrument Symbols 

The instrument symbol (warning label) shown in the figure indicates the maximum input power 
from the test port and the maximum input DC level. The maximum input power is +27dBm, and the 
maximum input DC level is ±25VDC. When using the instrument, do not connect a signal 
exceeding this range to the port, otherwise, the instrument may be burnt down! 

 

 

 

4 Vector network analysis mode 

4.1 Introduction to typical measurements 

The vector network analysis mode (VNA) of the 4957B is the basic working mode of this product. 
This mode can measure the S parameters of the DUT and display them in such formats as return 
loss, standing wave ratio, polar coordinates and group delay, and it can also provide such 
functions as time domain measurement and gating. 

After startup, press 【Mode】 to pop up a mode selection dialog box, select [Vector Network 

Analysis], and press [OK] to enter the vector network analysis mode after the progress bar is 
completed.

Notice 
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Figure 4-1 Main Interface of Vector Network Analysis Mode 

 

 
 

All operations in this section are based on the premise of the selected 

vector network analysis mode, which will not be described separately 

later. 

4.1.1 Selection of measurement parameters 

The vector network analysis mode of the 4957B RF analyzer mainly measures the S parameters 

of the DUT, and you can press the 【Measure】 key to select the measurement parameters: 

Press 【Measure】→[S11] or [S12] or [S21] or [S22] to select different S parameters for 

measurement; 

Press 【Measure】→[Format>] to select different measurement parameters via the soft menu: 

[Log], to select the measurement parameter and display it in the log format; 

[Linear], to select the measurement parameter and display it in the linear format; 

[VSWR], to select the measurement parameter and display it in the VSWR format; 

[Phase], to select the measurement parameter and display it in the phase format; 

[Smith>], to select the measurement parameter and display it in the Smith circle diagram format; 

[Polar], to select the measurement parameter and display it in the polar format; 

[Group Delay], to select the measurement parameter and display it in the group delay format; 

Press 【Measure】→[Transform] to enter the time domain transform setting menu, and press 

relevant menu key to set relevant parameters.  

Press 【Measure】→[Gating] to enter the gating function, and press relevant menu key to set 

relevant parameters.  

Press【Measure】→[Advance>] to select the measurement parameters from A1, B1, R1, A2, B2 

and R2.  

4.1.2 Calibration 

After the measurement parameter and frequency setting, the 4957B RF analyzer must be subject 

Notice 
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to calibration first before measurement, so as to eliminate the system errors of the RF analyzer, 
and ensure the validity and correctness of the measurements. In case of any change in the 
instrument measurement setting (such as the frequency range and sweep points) or port 
extension cable added to the test port, recalibration is required. 

 

 
 

Calibration is conducted for parameters rather than channels. When a 

parameter is selected, the instrument will check the calibration data used 

and use the data of such parameter. For example, when conducting B/R 

transmission response calibration and S11 single-port calibration on A/R 

at the same time, the instrument keeps on calibration and correction for 

the parameter displayed. Once a specific parameter or input is 

calibrated, such parameter measurement will be calibrated at any 

channel provided the incentive value is coupled. Parameter must be 

selected first before response and isolation calibration. Parameters will 

be selected automatically for other correction processes. In case of any 

channel change during calibration, the process executed will be invalid. 

 

4.1.2.1 Error calibration types 

The calibration types can be divided into five categories, as shown in Table 4-1, in which the full 2 
ports calibration can eliminate reflection tracking error, transmission tracking error, directional 
error, source matching error and load matching error, ensure high-precision measurement and 
effectively eliminate all 12 correctable system errors.  

 
 Correction of all 12 system errors is not required in some measurements 

 

Table 4-1 Error correction classification 

Calibration 

Type 

Corresponding 

measurement 

type 

Error Standard 

piece 

Freq Resp. 

Transmission or 

reflection 

measurement 

(with low accuracy 

requirement). 

Freq Resp. 

Transmission via 

thorough method 

via reflection via 

the open or short 

device 

Response and 

isolation 

Measure the 

transmission of 

the high insertion 

loss device or 

reflection of the 

high return loss 

The transmission 

frequency 

response and 

isolation or 

reflection 

directivity. 

With the standard 

isolation piece 

(load) added in 

addition to the 

standard piece 

used for response 

Notice 

Notice 
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device. The 

measurement 

accuracy is lower 

than that of the 

single port or full 2 

ports. 

correction 

S11 single port 

Reflection 

measurement of 

any single-port 

piece or 

well-connected 

dual-port piece. 

Directivity, source 

matching and 

frequency 

response 

Open-circuit 

device, short 

device and load 

S22 single port 

Reflection 

measurement of 

any single-port 

piece or 

well-connected 

dual-port piece. 

Directivity, source 

matching and 

frequency 

response 

Open-circuit 

device, short 

device and load 

Full 2 Ports 

Transmission or 

reflection 

measurement of 

dual-port piece 

with higher 

accuracy. 

Directivity, source 

matching, load 

matching, 

isolation, 

frequency 

response, and 

forward and 

reverse directions. 

Open-circuit 

device, short 

device, load and 

circuit-closer (two 

loads adopted for 

isolation) 

 

4.1.2.2 Standard calibration kit 

Calibration kits are required in the calibration process. It is recommended to buy and use 20201 or 
31101 series high-performance coaxial calibration kits developed by Ceyear Technologies Co., 
Ltd. The frequency range and port type of such series calibration kits are as shown in Table 4-2.  

Table 4-2 Frequency range and port of such series calibration kits 

Model Frequency range Port type 

20201 DC～9GHz N-type 50Ω 

31101 DC～18GHz N-type 50Ω 

4.1.2.3 Frequency response error correction 

The frequency response errors of reflection measurement and transmission measurement can be 
eliminated by calibration: 
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1) Frequency response error correction of reflection measurement 

a) Select the measurement type in the vector network analysis mode: 

b) To measure reflection at port 1 (forward, S11), keep the default settings of the RF analyzer. 

c) If reflection measurement is required at port 2 (reverse, S22), press [Measure] →[S22]. 

d) Set other measurement parameters: Start frequency, stop frequency, output power, sweep 
points and intermediate frequency bandwidth. 

e) Press [Cal] to open the calibration menu. 

f) Press [Cal Kit] to select the correct calibration kit model through the soft menu, and press 
[OK]. 

g) Press [M Cal>]→[Freq Resp>]→[OPEN S11>], and the system will automatically prompt 
"Connect OPEN in P1, then press corresp. menu button to start!", then connect the open 
circuit device to port 1. 

h) After the trace is stable, press [OPEN] to prompt ―Calibrating standard piece measurement...‖ 
during standard piece measurement, and prompt ―Press [Done] to complete the 
measurement!‖ after measurement and error factor calculation. And the software menu will be 
underlined to indicate that the project has been tested, such as [OPEN]. 

i) Press [Done] to complete the error correction of reflection measurement, which allows for 
connection and measurement of the DUT. 

j) Similarly, repeat step e), select another frequency response error correction function, press 
[M Cal>] → [Freq Resp.>] → [SHORT S11>] or [OPEN S22>] or [SHORT S22>], and connect 
an open circuit or a short circuit device at the corresponding test port according to different 

prompts to perform steps f）g）. 

 
 

Only one calibration kit is allowed to be measured in case of 

calibration. If a wrong calibration kit is selected, return to 【Cal】→[M 

Cal]→[Freq Resp.] and select the correct standard piece. 

 

Figure 4-2 Calibration Kit Connection for Reflection Measurement Response 

2) Response error correction of transmission measurement 

a) Select the measurement type in the vector network analysis mode: 

b) If transmission measurement is required in the positive direction (S21), press 【Measure】   

→[S21]. 

c) If transmission measurement is required in the reverse direction (S12), press 【Measure】  

→[S12]. 

k) Set other measurement parameters: Start frequency, stop frequency, output power, number 

Open-circuit device 

RF Analyzer 

Short-circuit 

device 

Short-circuit 

device 

Open-circuit device 

or or 

For S22 response For S11 response 

Notice 
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of sweeping points or IF bandwidth. 

d) Press [Cal] to open the calibration menu. 

e) Select the frequency response error correction function, Press [M Cal>] → [Freq Resp>] →  

[THRU S12>] or [THRU S21>], and the system will automatically prompt "Connect Thru cable  

between P1 and P2, then press corresp. menu button to start!" Then connect N-type cable  

between ports 1 and 2. 

 
 

All adapters and cables to be used for device measurement shall be 

prepared, that is, to connect the standard device to the position for 

measurement. 

f) After the display trace is stable, press [THRU], the analyzer will display "Cal std measuring..."   

during the measurement of the standard piece, and after completing the measurement and  

calculating the error coefficient, the measured item will be underlined, e.g., [THRU], with the  

soft key [Done] displayed. 

g) Press [Done] to complete the transmission measurement error correction, and then connect  

the DUT for relevant measurements. 

 
 

Do not use open circuit device or short circuit device standard 

pieces for transmission response correction. 

 

 

Figure 4-3 Calibration Kit Connection for Transmission Measurement Response 

3) Error correction of transmission measurement response and isolation 

a) Select the measurement type in the vector network analysis mode: 

b) If transmission measurement is required in the positive direction (S21), press 【Measure】 

→[S21]. 

c) If transmission measurement is required in the reverse direction (S12), press 【Measure】 

→[S12]. 

d) Set other measurement parameters: Start frequency, stop frequency, output power, number 
of sweeping points or IF bandwidth. 

e) Open the calibration menu and press [Cal]. 

f) Select the frequency response error correction function, press [M Cal>]→[Resp.& Iso S12] 
or[Resp.& Iso S21] to pop up a prompt automatically ―Connect Thru cable between P1 and P2, 
then press corresp. menu button to start!‖, then perform cable connection at the point where 
you want to measure the DUT. 

 

Cable

Notice 

Notice 
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All adapters and cables to be used for device measurement shall be 

prepared, that is, to connect the standard device to the position for 

measurement. 

 

g) After the trace is stable, press [THRU] to prompt ―Calibrating standard piece measurement...‖ 
during standard piece measurement, and show underline (for example, [THRU]) indicating 
item test completion after measurement and error factor calculation and prompt ―Connect the 
load to P1 and P2, then press corresp. menu button to start!‖. ‖. 

h) then connect the impedance matching load to port 1 and port 2 of the  analyzer. 

i) After the trace display is stable, press [ISO] to prompt ―Calibrating standard piece 
measurement...‖ during standard piece measurement, and show underline (for example, [ISO]) 
indicating item test completion after measurement and error factor calculation and prompt 
―Press [Done] to complete the measurement!‖. [Done] is displayed at the same time. 

j) Press [Done], the system will calculate the isolation error coefficient, and the RF analyzer will 
display the corrected data record line, indicating that the data of this channel is enabled. 

k) In this way, you complete the response and isolation correction of the transmission 
measurement, and then connect the DUT for relevant measurements. 

 

Figure 4-4 Calibration Kit Connection for Transmission Measurement Response and Isolation 

4.1.2.4 One port reflection error correction 

a) Eliminate directional error during test component assembling 

b) Eliminate source matching error during test component assembling 

c) Eliminate frequency response during test component assembling 

d) Carry out single-port correction to the S11 or S22 measurement of the RF analyzer. 

a) Select the measurement type in the vector network analysis mode: 

To measure reflection at port 1 (forward, S11), keep the default settings of the RF analyzer.To 

measure reflection at port 2 (reverse, S22), press 【Meas】→[S22]. 

b) Set other measurement parameters: Start frequency, stop frequency, output power, number 
of sweeping points or IF bandwidth. 

c) Open the calibration menu, and press 【Calibrate】. 

【Cal】→[Cal Kit], and press the corresponding soft key to select the correct calibration kit 

model. Press [Back] to return to 【Cal】 menu bar, press [M Cal>] and select the type to be 

corrected. 

d) To measure reflection at port 1, press [S11 One Port]. 

e) To measure reflection at port 2 , press [S22 One Port]. 

f) At port 1, the system will prompt automatically ―Connect OPEN in P1,then press corresp. 

RF Analyzer 

Load 

RF Analyzer 

Load 
For response 

For isolation 

THR

Notice 
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menu button to start!‖ At this time, connect the standard connector of the open-circuit device 
to the port to be used as the test port (P1 for S11, and P2 for S22). 

 
 

All adapters and cables to be used for device measurement shall be 

prepared, that is, to connect the standard device to the position for 

measurement. 

 

g) After the display trace is stable, to measure the standard piece, press [OPEN], the RF 
analyzer will display "Cal std measuring..." during the measurement of the standard piece, 
and after completing the measurement and calculating the error coefficient, it will display the 
prompt "Connect SHORT in P1, then press corresp. menu button to start!" And the software 
menu will be underlined to indicate that the project has been tested, such as [OPEN]. 

h) To test the standard piece after the trace is stable, press [Short-circuit Device] to show 
―Measuring...‖ during standard piece measurement, and ―P1 short-circuit device 
measurement is finished. Connect load at P1, and press ‗Load‘‖ after measurement and error 
factor calculation. Connect LOAD in P1, press ‗LOAD‘‖, and the software menu will be 
underlined to indicate that the project has been tested, such as [Short-circuit Device]. 

i) Disconnect the short-circuit device, and connect the load to the test port. 

j) To test the standard piece after the trace is stable, press [SHORT] to show ―Calibrating 
standard piece measurement...‖ during standard piece measurement, and ―Connect LOAD in 
P1,, then press corresp. menu button to start!‖ after measurement and error factor calculation. 
And the software menu will be underlined to indicate that the project has been tested, such as 
[SHORT]. 

k) After the trace is stable, press [LOAD] to prompt ―Calibrating standard piece measurement...‖ 
during standard piece measurement, and prompt ―Press [Done] to complete the 
measurement!‖ after measurement and error factor calculation. At this time, underline of the 
menu indicates the item is tested completely, for example, [LOAD]. 

l) Record the error factor, and press [Done]to show the corrected data trace, indicating the 
correction is activated.  

m) That is to complete the single port calibration for reflected measurement. The DUT can be 
connected and measured at this time. 

 
 

The open-circuit device, short-circuit device and load can be 

measured in any sequence regardless that mentioned here. 

 

 

RF Analyzer 

Open-circuit device 

Short-circuit 

device 
Short-circuit 

device 

Open-circuit device 

For S22 response For S11 response 

Load 
Load 

Notice 

Notice 
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Figure 4-5 Single-port Reflection Calibration Kit Connection 

4.1.2.5 Full 2 ports error correction 

Full 2 ports error correction allows for correction of 12 error terms such as positive and reverse 
directivity, source matching, load matching, frequency response and isolation, etc. 

·Eliminate directional error during test component assembling in the forward and reverse 

directions 

·Eliminate source matching error during test component assembling in the forward and reverse 

directions 

·Eliminate load matching error during test component assembling in the forward and reverse 

directions 

· Eliminate isolation error during test component assembling in the forward and reverse directions 

· Remove the frequency response of the test component assembly in the forward and reverse 

directions 

 
 

This is a relatively accurate error correction process. The 

instrument updates the measurement trace once via forward and 

reverse sweep, which takes more time compared with other 

correction process. 

 

a) Set other measurement parameters: Start frequency, stop frequency, output power, number 
of sweeping points or IF bandwidth. 

b) Open the calibration menu and press 【Calibrate】 . 

c) Press [Cal Kit], and press corresponding soft key to select the correct calibration kit model. 

d) Press [Back]  and return to the 【Calibrate】  menu bar, press [M Cal] , select the type to be 

corrected, press [Full 2 Ports] , the system will prompt to ―press [Reflect] to start the 
corresponding measurement! ‖. 

e) To start reflection measurement, press [Reflect>] to prompt ―Connect OPEN in P1,then press  

corresp. menu button to start!‖. connect the open circuit device to test port 1 according to the 
diagram, and after the display trace is stable, press [P1 OPEN], the analyzer will display "Cal 
std measuring..." during the measurement of the standard piece, and after completing the 
measurement, it will display the prompt "Connect SHORT in P1, then press corresp. menu 
button to start!" And the software menu will be underlined to indicate that the project has been 
tested, such as [P1 OPEN]. 

f) Disconnect the open-circuit device, and connect the short-circuit device to test port 1. After 
the display trace is stable, to measure the standard piece, press [P1 SHORT], the RF 
analyzer will display "calibration standard measurement …" during the measurement of the 
standard piece, and after completing the measurement, it will display the prompt "Port 1 Short 
Measure Done. Connect LOAD in P1, press ‗P1 LOAD‘‖, and the software menu will be 
underlined to indicate that the project has been tested, such as [P1 SHORT]. 

g) Disconnect the short-circuit device, connect the load to test port 1, and press [P1 LOAD]  

after the trace is stable to prompt ―Calibrating standard piece measurement...‖ during 
standard piece measurement, and prompt ―Connect the load to Port 1, then press corresp. 
menu button to start!‖ after measurement. At this time, underline of the menu indicates the 
item is tested completely, for example, [P1 LOAD]. 

h) Disconnect the load from P1, connect the open-circuit device, short-circuit device and load to 
P2 as per the same standard method with P1 in sequence, and complete the measurement 
on such standard pieces as S22 OPEN, SHORT and LOAD. 

i) After reflection calibration on P1 and P2, the prompt ―Press [Done] to complete the 

Notice 
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measurement.‖ Press [Done], and the system will calculate the reflection factor automatically. 

j) Return to previous menu for transmission calibration. Press [Tr>] to prompt ―Connect Thru 
cable between P1 and P2, then press corresp. menu button to start!‖ connect test port 1 and 
test port 2 with cables. You can press [Auto Meas], and the system can automatically 
complete four transmission calibration tasks in turn, or press [Pos Match], [Pos Trans], [Rev 
Match] and [Rev Trans] in turn to complete each calibration task individually. When all four 
tasks are completed, the  full 2 ports transmission calibration is completed. 

k) Press [Back] to return to previous menu, and press [ISO] for isolation calibration. 

l) For isolation measurement, press [ISO] to prompt ―Connect LOADs in P1 and P2, then press 
corresp. menu button to start!‖. Connect the load to test port 1 and test port 2 respectively, 
press [Auto Meas] to complete isolation calibration on the two items automatically in turn, or 
press [Pos Iso] and [Rev Iso] to complete each isolation calibration independently. Or you can 
press [Ignore Iso] directly to ignore isolation calibration. 

m) Press [Done] to finish the full 2 ports calibration. After that, the prompt ―Calibration Off/On‖ 
shows in the prompt zone. Connect with the DUT for measurement. 

 

Figure 4-6 Standard piece correction for Full 2 ports error correction 

4.1.3 Marker function 

The 4957B RF analyzer is provided with up to eight markers to facilitate users to track the 
measurement results. 

Select the currently displayed marker by pressing 【Mkr】→[Sel Mkr]→[Mkr 1], [Mkr 2] ... [Mkr 6] or 

[More Mkrs>]→[Mkr 7], [Mkr 8]. 

Each marker has two operating modes, namely, normal and delta. 

Press 【Mkr】→[Max] or [Min] to let the RF analyzer search the max/min value of the measurement 

trace, and press 【Peak】 to search the marker peak value, including 【Mkr】, [Sub Peak], [Right 

Peak] and [Left Peak]. You can also move the marker with the [↑] /[↓] keys and the roller, or 
position the marker by setting the standard answer according to the pop-up marker position and 
inputting the numerical value when pressing [Normal Mkr] and [Delta Mkr]. 

4.1.4 Storage and recalling function 

The RF analyzer can save the setting status and measurement data to the internal memory, 
external USB or SD card, and recall the setting status and measurement data of the instrument 
from the internal memory, external USB or SD card. The specific operation is as follows: 

Open-circuit device 

RF Analyzer 

Short-circuit 

device 

Short-circuit 

device 

Open-circuit device 

For S22 response For S11 response 

Load Load 

RF Analyzer 

Load 

RF Analyzer 

Load 

For reflection For transmission For isolation 

THRU 
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Press 【File】→[Storage State] to save the current instrument status in the memory; 

Press 【File】→[Recall State>]→[State File>], and a list of state files will pop up to display all state 

files saved in the memory. Select corresponding file for quick setting of the instrument. Press 【File】
→[Recall State>]→[Last State] or [Default State] to select the last setting state before starting or 
the default state of the system; 

Press [File]  → [Save Trace >] , press the menu item to select the corresponding trace storage 
format (trace, s1p data, s2p data, csv data), enter the file name in the pop-up dialog box, Press 
[OK] to save the current sweep track data into the memory; 

Press [File]→[Recall Trace>] to pop up a data list showing all data files saved in the storage (trace 
format), and select relevant data file to recall the data from the data file to the memory for display 
and comparison. 

Press [File]→[Print Screen] to save the display area on the screen into jpg file format. Edit and 
enter the name of the file to be saved, and press OK to complete the saving. 

Press 【File】→[File Mgmnt] to perform file copy or file deletion. 

Press [File]  → [Location Int >]  and select the storage medium as internal FLASH, external USB 
disk or SD card. 

4.1.5 Measurement optimization 

The dynamic range refers to the delta between the max. power and min. measurable power (noise 
base) that can be entered to the RF analyzer. To lower the measurement uncertainty, the dynamic 
range of the RF analyzer shall be larger than the response range of the DUT. The measurement 
accuracy can be improved effectively only when the signal under test is 10dB higher than the 
noise base. In order to increase the dynamic range of the RF analyzer, the following methods are 
usually used for measurement optimization: 

4.1.5.1 Increasing the input power of the DUT 

Increasing the DUT input power can help the analyzer to detect the output power of the DUT with 
higher accuracy. But note that too high input of the RF analyzer can cause compression distortion 
or even damage the receiver. 

Press 【Amplitude】→[Power High>] to adjust the output power.  

 
 

Max. input level is marked on the panel of the RF analyzer, and the 

high output power of the RF analyzer can reach 0dBm at certain 

point. If the DUT has gains, use proper source power to prevent the 

input power from exceeding the max. input level. 

 

4.1.5.2 Decreasing the receiver noise base 

Random noise on the RF analyzer's receive path reduces measurement accuracy. ―Sweep 
average‖ and ―reducing intermediate frequency bandwidth‖ can be adopted to reduce trace noise, 
reduce noise base and obtain more accurate measurement results. 

1)  Sweep Average 

Sweep average reduces the impact of random noise on the measurement, and the RF analyzer 
calculates each measurement value by averaging the same measurement point through multiple 
sweeps. The setting of the average factor determines the number of consecutive sweeps. The 
larger the average factor, the more effectively the effect of noise on the measurement can be 
reduced. 

Trace averaging is applied to all measurement traces in the channel, and the channel that turns on 
the averaging function displays an average counter. 

Notice 



4957B RF Analyzer User Manuals 

 Vector network analysis mode 

 47 / 248 

 

If the sweep average is turned on, the average counter shows the average number of sweeps that 
have been performed, helping to select the appropriate average factor by observing the change in 
the trace and average number of times that have been performed. 

Sweeping average and reducing the IF bandwidth can reduce the noise. If you want to get very 
low noise, it is recommended to use the sweep average. In normal case, the sweep average is 
used to reduce the noise but the time required to reduce the IF bandwidth is longer, especially the 
average number of times is large. 

Steps for setting sweep averaging are as follow. 

Press [BW]  → [Avg Off On] , enter the average number of times with the numeric keys. 

2) Reduce IF bandwidth 

The RF analyzer converts the received response signal to the intermediate frequency signal for 
processing. The bandwidth of the intermediate frequency band pass filter is called the 
intermediate frequency bandwidth, and the RF analyzer supports the variable bandwidth IF filter, 
wherein the intermediate frequency bandwidth is set from 100kHz to 1Hz and changes in steps of 
1, 3 and 10. Reducing the IF bandwidth can lower the impact of the random noise on the 
measurements (reducing 10 times of the IF bandwidth can lower the noise base by 10dB), but it 
can prolong the sweep time. The effect of intermediate frequency bandwidth on measurements is 
shown in Figure 4-7: 
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Figure 4-7 Effect of Intermediate Frequency Bandwidth on Measurement Results 

Follow the steps below to set the IF bandwidth: 

a) Press  【BW】  → [IF Band] ； 

b) Press the [↑]  [↓]  key to move the marker bar to change the IF bandwidth value. 

 

 
 

Sweeping average and reducing the IF bandwidth can reduce the 

noise. If you want to get very low noise, it is recommended to use 

the sweep average. In normal case, the sweep average is used to 

reduce the noise but the time required to reduce the IF bandwidth is 

longer, especially the average number of times is large. 

 

4.2 Menu Structure 

The vector network analysis mode mainly includes 10 groups of primary menus, i.e. "Frequency", 
"Amplitude", "Bandwidth", "Marker", "Measure", "Sweep", "Calibrate", "Trace", "Peak" and "File". 
The "System" menu refers to the system settings of the machine in the Basic Operations of 
Chapter III, and the other menu structures are as follows: 

Notice 
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Figure 4-8 Structure of Measure Menu 
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Figure 4-9 Structure of Frequency, Amplitude, Bandwidth, Marker and Peak Menus 
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Figure 4-10 Structure of Trace Menu 
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Figure 4-11 Structure of Sweep Menu 
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S12

响应与隔离
S21

负载

完成

单端口Sxx

开路器

短路器

完成

响应与隔离

直通

隔离

短路S22

返回

校准

开路S11

短路S11

开路S22

直通S12

直通S21

反向匹配

正向匹配

传输

自动测量

正向传输

返回

反向传输

正向隔离

隔离

自动测量

忽略隔离

返回

反向隔离

完成

 

Figure 4-12 Structure of Calibrate Menu 
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文件管理

选择
源文件

选择
目的路径

开始拷贝

删除
源文件

返回

00

存储位置

SD 卡

USB

内 部

返回

调 用

上一页

下一页

调 用

删除全部

删 除

返回

文 件

存储状态

调用状态

存储迹线

屏幕截图

调用迹线

文件管理

存储位置

存储迹线

迹线

数据
(.csv)

返回

调用状态

上次状态

默认状态

状态文件

返回

 

Figure 4-13 Structure of File Menu 
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4.3 Menu Description 

 
 

In the subsequent description, the primary menu is the menu name 

+ "【】", e.g. 【Freq】, and the remaining submenus are the menu 

name + "[]", e.g. [M Cal]. 

4.3.1 Frequency menu 

Frequency range refers to the measurement frequency span. In the VNA mode, the 4957B RF 
analyzer must be set with proper measurement frequency range first before measurement and 
calibration regardless any measurement parameter is selected. Frequency range can be set in the 
following two methods: 

a) Specify the start frequency and stop frequency 

b) Specify the center frequency and span 

中心频率

频率

扫宽 

起始频率

终止频率

 

·[Start Freq]: Press 【Freq】→[Start Freq], use the numeric keys on 

the front panel, select the frequency unit, or use the 【↑】【↓】 keys and 

the knob for setting. 

·[Stop Freq]: Press 【Freq】→[Stop Freq], use the numeric keys on the 

front panel, select the frequency unit, or use the 【↑】【↓】 keys and the 

knob for setting. 

·[Center Freq]: Press 【Freq】→[Center Freq], use the numeric keys 

on the front panel, select [GHz], [MHz], [kHz] and [Hz] in the frequency 

unit menu, or use the 【↑】【↓】 keys and the knob for setting. 

·[Special Notes]: When using the 【↑】【↓】 keys and the knob, the 

size of the frequency step is the same as the set value of the [Step 

Freq Auto/Man]. After pressing [Step Freq Auto/Man] to switch to 

[Step Freq Auto/Man], you can use the numeric keys or the 【↑】

【↓】 keys and the knob to set the step frequency value. 

·[Span]: Press 【Freq】→[Span] to activate the span submenu. You 

can use the numeric keys, and then select the frequency unit to 

change. You can also use the 【↑】【↓】 keys and the knob to change 

the span. For the detailed information, please refer to the description of 

the [Span] menu. 

·[Special Notes]: Use the 【↑】【↓】 keys and the knob to change 

the span with a step of 1-2-5. 

 

Notice 
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4.3.2 Amplitude menu 

顶部

幅度

参考位置

刻度/格

输出功率

参考值

底部

自动比例

默认刻度

>

 

·[Top]: Press 【Amplitude】→[Top] to set the maximum scale in the top 

position of the vertical part of the display grid within the range of 

-499.9dB - +500dB. 

·[Bottom]: Press 【Amplitude】→[Bottom] to set the maximum scale in 

the bottom position of the vertical part of the display grid within the 

range of -500dB- +499.9dB. 

·[Auto Scale]: Press 【Amplitude】→[Auto Scale] to display the trace 

in the scale most suitable for the screen, 

·[Special Notes]: which is only valid in Cartesian coordinates. 

·[Default Scale]: Press 【Amplitude】→[Default Scale] to indicate that 

all options related to amplitude setting in the rectangular coordinate 

format are the default startup values. 

·[Ref Value]: Press 【Amplitude】→[Ref Value], and use the numeric 

keys on the front panel or the 【↑】【↓】 keys and the knob to set the 

reference level unit to dBm. 

·[Special Notes]: When the 【↑】【↓】 keys and the knob are used, the 

step is 10dB. 

·[Ref Pos]: Press 【Amplitude】→[Ref Pos], and use the numeric keys 

or the 【↑】【↓】 keys and the knob to change the reference position. 

·[Scale]: Press 【Amplitude】→[Scale], and use the numeric keys or 

the 【↑】【↓】 keys and the knob to set the scale within the setting range 

of 0.1dB - 20dB. 

·[Output Power]: It has three modes, i.e. high power, low power and 

manually set power. 

4.3.3 Output power menu 

高功率

输出功率

低功率

手动
-35~-10dBm

射频输出

关        开

< 返回

 

·[High Power]: Press [Output Power]→[High Power], and select [High 

Power] on the touch screen to set the output power to the high power 

state. 

·[Low Power]: Press [Output Power]→[Low Power], and select [Low 

Power] on the touch screen to set the output power to the low power 

state. 

·[Manual]: Press [Output Power]→[Manual], and the range is -35dB- 

-10dBm. Enter the numbers with the numeric keys or use the knob or 

press 【↑】【↓】 to adjust the manual power. 

·[RF Output]: Press [Output Power]→[RF Output Off On] to manually 

switch the RF output switch. 

·[Special Notes]: The manual power menu display range 

is-35~-10dBm, in order to ensure the setting range of power flatness 

index, the actual range can be set to -45 - 5dBm. If it is set to a value 

outside the range displayed by the menu item, there is a certain 

deviation in the power output at some frequency points. 
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4.3.4 Bandwidth menu 

带宽

平均

关 开

平均因子

平滑

关   开

平滑孔径

（%）

中频带宽

 

·[Ave Off On]: Press 【BW】→[Ave Off On]  to set it to on or off, and 

switch it via the touchscreen manually. 

·[Avg Factor]: Press 【BW】→[Avg Factor 16] and use the numeric 

keys or the 【↑】【↓】 keys and the knob to set the specific number. 

·[Smooth Off On]: Press 【BW】→[Smooth On/Off] to set it to on or off, 

and switch it via the touchscreen manually. 

·[Smooth Aperture (%)]: Press 【BW】→[Aperture (%) 10.00] to select 

the aperture percentage, and press the number key to set it, with the 

aperture range of 0.01%～20%. 

·[IF BW]: Press 【BW】→[IF BW], select from the touchscreen or press 

【↑】/【↓】 to change the IF BW value, and press [OK] to end it. 

·[Special Notes]: Use the 【↑】【↓】 keys and the knob to change the 

span, and set the bandwidth down from 100kHz to 1Hz, with a step of 

1, 3 and 10. 

4.3.5 Marker menu 

选择光标
[1]

光标

标准光标

差值光标

最大值

关闭

全部关闭

>

最小值

关联

数据   存储

 

·[Mkr 1]: Press 【Mkr】→[Sel Mkr [1]]→[Mkr 1], [Mkr 2], [Mkr 3], [Mkr 4], 

[Mkr 5], [Mkr 6] or [More Mkrs>]→[Mkr 7] and [Mkr 8] to select the marker 

displayed currently; 

·[Normal Mkr]: Press 【Mkr】→[Normal Mkr], the marker is in the normal 

mode, which can be moved via the knob, step key or numeric key; 

·[Delta Mkr]: Press 【Mkr】→[Delta Mkr] to set the marker activated 

currently to the delta mode with amplitude difference and frequency 

difference between the delta marker and reference marker shown in the 

marker display area on the screen, enter the frequency value of the delta 

marker directly via the number key, or move it via the rotary knob or step 

key; 

·[Off]: Press 【Mkr】→[Off] to turn off the currently activated marker. 

·[All Off]: Press 【Mkr】→[All Off] to turn off all markers that have been 

turned on. 

·[Max]: Press 【Mkr】→[Max] to search for the maximum value of the 

marker; 

·[Min]: Press 【Mkr】→[Min] to search for the minimum value of the 

marker; 

·[Link Data Mem]: Press 【Mkr】→[Link] to select the data or memory, 

and switch it via the touchscreen manually. 
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4.3.6 Measure Menu 

S11

测量

S12

S21

S22

测量格式 >

时域变换 >

门选通 >

高级 >

 

·[S11]: Press 【Measure】→[S11] to set the measurement parameter 

to S11. 

·[S12]: Press 【Measure】→[S12] to set the measurement parameter 

to S12. 

·[S21]: Press 【Measure】→[S21] to set the measurement parameter 

to S21. 

·[S22]: Press 【Measure】→[S22] to set the measurement parameter 

to S22. 

·[Meas Format]: Press 【Measure】→[Meas Format] to select the 

measurement format, including [Log Amp], [Linear Amp], [VSWR], 

[Phase], [Smith], [Polar], [Group Delay], etc. 

·[Special Notes]: The measurement format submenu is just a 

difference in the way it is displayed and is not specifically introduced. 

·[Transform]: Press 【Measure】→[Transform] to set the transform 

related parameters, including: 

[Transform Off On], [Start Time], [Stop Time], [Mode], [Set Freq 

Lowpass], [Window], [Velocity] and [Unit m ft]. 

·[Gating]: Press 【Measure】→[Gating] to set the gating related 

parameters, including: 

[Gating (Off On)] selection, [Gate Start Time], [Gate Stop Time] and 

[Gate Type (Pass-Band Stop-Band)] selection. The gate shape options 

include maximum, wide, standard and minimum. 

·[Advance]: Press 【 Measure 】 →[Advance>] to select the 

measurement parameters from [A1], [B1], [R1], [A2], [B2] and [R2]. 
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4.3.7 Sweep/setting menu 

扫描时间

自动 手动

扫描

扫描类型

连续 单次

编辑列表>

扫描点数
201

扫描类型

线性  列表

运行/保持

单次扫描

 

·[Swp Type Cont Single]: Press 【Swp】→[Swp Type Cont Single], 

and two sweep modes are provided in the vector network analyzer 

mode: Continuous sweep and sweep once. The underline marks the 

current state. The sweep mode setting determines how the analyzer 

sweeps and when it stops to enter into the hold state. 

·[Swp Once]: Press 【Swp】→[Swp Once], the sweep type is a single 

sweep, that is, the sweep is stopped after a single sweep. 

·[Swp Time Auto Man]: Press 【Swp】→[Swp Time Auto Man] to 

switch the sweep time between Auto and Manual. The underline 

marks the current state. If the sweep time is automatic, the RF 

analyzer automatically sets the sweep time to the fastest according to 

the current instrument status, and the screen displays the fastest 

sweep time under the current setting. If the sweep time is manually 

set, the sweep time value can be input at this time. Use the numeric 

keys to enter the sweep time value and select the time unit by 

pressing corresponding soft key to complete the setting. 

·[Swp Points]: Press 【Swp】→[Swp Points], and use the numeric 

keys on the front panel or the 【↑】【↓】 keys and the knob to set the 

sweep points. 

·[Special Notes]: The number of sweep points in the vector network 

analysis mode can be set from 11 to 10001. 

·[Swp Mode Lin List]: Press 【Swp】→[Swp Mode Lin List], and 

select the sweep mode to be linear or list via the touchscreen. When 

the sweep mode is list sweep, you can edit the list to add and delete 

segments. 

·[Edit List]: Press 【Swp】→[Edit List>] to add or delete segments via 

the touchscreen, edit the start frequency, stop frequency, sweep 

points and intermediate frequency bandwidth of the segment, and 

enter the parameter value via the numeric key. See the description of 

the [Swp Mode Lin List] menu for details. 

·[Special Notes]: When you press [Edit List], the sweep mode 

changes to list sweep by default. 

·[Run/Hold]: Press 【Swp】→[Run/Hold]. When you switch to run, the 

marker moves as per the sweep point, and when you switch to hold, 

the marker pauses at the current sweep point. 
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4.3.8 Edit list menu 

增加段

编辑列表

删除段

>

>

删除全部

存储列表

调用列表

返回

 

·[Add Seg]: Press [Edit List>]→[Add Seg] to select the start frequency, 

stop frequency, sweep points and intermediate frequency bandwidth of 

the segment to be edited via the touchscreen, enter the parameter 

value via the numeric key, and select the corresponding unit via the 

touchscreen. 

·[Del Seg]: Press [Edit List>]→[Del Seg] to click on any position of the 

segment to be deleted via the touchscreen, and then press [Del Seg] 

to delete it. 

·[Del All]: Press [Edit List>]→[Del All] to delete all the segments in the 

list. 

·[Save List]: Press [Edit List>]→[Save List] to save the segments in 

the list, and click to pop up a dialog box, enter the file name and press 

OK to save the list file +. 

·[Recall List]: Press [Edit List>]→[Recall List] to click on the list file to 

be recalled via the touchscreen, and click OK. 

·[Special Notes]: When the list is not saved, clicking [Recall List] will 

not display any list files. 

·[Back]: Press [Edit List>]→[Back] to return to the previous menu. 

 

4.3.9 Calibration menu 

校准

关 开

校准

校准件

机械校准

电子校准

>

继续校准 >

 

·[Cal Off On]: Press 【Cal】→[Cal Off On]  to turn the error correction 

on or off, and the calibration can only be turned on when the 

corresponding calibration is completed. 

·[Cal Kit]: Press 【Cal】→[Cal Kit] to enter the calibration kit selection 

dialog box, and select the calibration kit type. 

·[Special Notes]: The mechanical calibration kit types include 

31101A 31101B 31121 31123 

·[M Cal]: Press 【Cal】→[M Cal] to complete the relevant calibration 

according to the calibration steps, including one port S11, one port 

S22, full 2 ports, frequency response, response and isolation S12, 

response and isolation S21. 

·[E Cal]: Press 【Cal】→[E Cal] to enter the electronic calibration 

dialog box, and click the down arrow on the touchscreen to select the 

[Cal Port]: One port P1, one port P2, full 2 ports; click [Start], 

[Interrupt] and [Exit] for relevant operations of electronic calibration. 

·[Cal Cont]: Press 【Cal】→[Cal Cont], the submenu type is the same 

as the mechanical calibration, and the color invert is mainly 

completed. If the calibration is interrupted due to another menu is 

opened, press [Cal Cont] in the calibration menu to continue the 

calibration. 
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4.3.10 Mechanical calibration menu 

单端口S11

机械校准

单端口S22

全二端口

频率响应 >

响应与隔离
S12

响应与隔离
S21

返回

 

·[One Port S11]: Press [M Cal]→[One Port S11] to connect the 

circuit breaker, short circuiter and load according to the prompts in 

the dialog box, so as to complete the calibration of one port S11. 

·[One Port S22]: Press [M Cal]→[One Port S22] to select [OPEN], 

[SHORT] and [LOAD].  

·[Full 2 Ports]: Press [M Cal]→[Full 2 Ports] to complete the 

relevant calibration according to the calibration steps, including one 

port S11, one port S22, full 2 ports, frequency response, response 

and isolation S12, response and isolation S21. 

·[Freq Resp.]: Press [M Cal]→[Freq Resp.], open circuit S11, short 

circuit S11, open circuit S22, short circuit S22, straight through S12, 

straight through S21. Press [Back] to return to the previous 

submenu. 

·[Resp.&Iso@S12]: Press [M Cal]→[Resp.&Iso@S12] to select the 

response and isolation calibration. 

·[Resp.&Iso@S21]: Press [M Cal]→[Resp.&Iso@S21] to select the 

response and isolation calibration. 

·[Special Notes]: The measurement sequence for several different 

standard pieces to be measured at the same time can be ignored, 

for example, an open-circuit device, a short-circuit device and a 

load. Any standard piece can be remeasured before [OK] is pressed. 

Change in standard piece is normal during measurement. In case of 

a standard piece subjected to multiple measurement, correction 

shall be conducted on the latest measurement data. 

4.3.11 One port S11 menu 

开路

单端口S11

短路

负载

 

·[OPEN]: Press [One Port S11]→[OPEN] to select the calibration 

standard of OPEN. 

·[SHORT]: Press [One Port S11]→[SHORT] to select the calibration 

standard of SHORT. 

·[LOAD]: Press [One Port S11]→[LOAD] to select the calibration 

standard of LOAD. 

·[Special Notes]: The measurement sequence for several different 

standard pieces to be measured at the same time can be ignored, for 

example, an open-circuit device, a short-circuit device and a load. 

Any standard piece can be remeasured before [OK] is pressed. 

Change in standard piece is normal during measurement. In case of 

a standard piece subjected to multiple measurement, correction shall 

be conducted on the latest measurement data. 
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4.3.12 One port S22 menu 

It is the same as the [One Port S11] menu. 

4.3.13 Full 2 ports menu 

反射

全二端口

传输

隔离

 

·[Reflect]: Press [Full 2 Ports]→[Reflect] to set the reflection 

measurement for calibration of full 2 ports. It includes 6 sub-options: 

[P1 OPEN], [P1 SHORT], [P1 LOAD], [P2 OPEN], 

[P2 SHORT], [P2 LOAD] 

·[Special Notes]: P1 stands for one port and P2 for two ports. 

·[Tr]: Press [Full 2 Ports]→[Tr] to set the transmission measurement 

for calibration of full 2 ports. It includes [Pos Match], [Pos Trans], 

[Rev Match], [Rev Trans] and [Auto Meas]. 

·[Iso]: Press [Full 2 Ports]→[Iso] to set the isolation measurement for 

calibration of full 2 ports.[Pos Iso], [Rev Iso], [Auto Meas] and [Ignore 

Iso]. 

4.3.14 Frequency response menu 

开路S11

频率响应

短路S11

开路S22

短路S22

直通S12

直通S21

 

·[Special Notes]: In case of frequency response error calibration, 

the errors of reflection measurement and transmission measurement 

can be calibrated, open circuit and short circuit are selected in 

reflection measurement, and straight through is selected in 

transmission measurement. 

·[OPEN S11]: Press [Freq Resp.]→[OPEN S11] to select the 

calibration standard of S11 OPEN. 

·[SHORT S11]: Press [Freq Resp.]→[SHORT S11] to select the 

calibration standard of S11 SHORT. 

·[OPEN S22]: Press [Freq Resp.]→[OPEN S22] to select the 

calibration standard of S22 OPEN. 

·[SHORT S22]: Press [Freq Resp.]→[SHORT S22] to select the 

calibration standard of S22 SHORT. 

·[THRU S12]: Press [Freq Resp.]→[THRU S12] to select the 

calibration standard of S12 THRU. 

·[THRU S21]: Press [Freq Resp.]→[THRU S21] to select the 

calibration standard of S21 THRU. 

·[Special Notes]: After selecting the above menu, there will be a 

prompt on the interface: ―Please connect the circuit breaker (short 

circuiter) to the port, and press the corresponding menu key to start 

the measurement‖ 

 

4.3.15 Calibration continue menu 

It completes the remaining calibration steps, and is the same as the calibration menu. 
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4.3.16 Trace menu 

This menu is used to set the trace display mode, trace math and limit function. The memory must 
be saved with a trace first before conducting any trace calculation, and trace calculation is 
conducted via vector calculation on previous complex number data displayed in formatting. 

选择迹线
[1]

迹线

迹线数目

运算

极限

带宽搜索

统计

关   开
 

·[Select Trace]: Press 【Trace】→[Select Trace] to select the trace. 

The vector network analyzer provides 1, 2, 3 and 4 tracks, and the 

selected track sequence number and its status menu item will be 

displayed directly. 

·[Trace Num]: Press 【Trace】→[Trace Num 1×1>]→[1×1], [1×2], 

[1×3], [2×1], [3×1] or [4×1] to select the window number and trace 

number in the window; 

·[Trace Math]: Press 【Trace】→[Trace Math] to open the math menu 

of the trace. 

·[Special Notes]: The memory must be saved with a trace first before 

conducting any trace calculation, and trace calculation is conducted via 

vector calculation on previous complex number data displayed in 

formatting. 

·[Limit]: Press 【Trace】→[Limit] to edit and display the limit line and 

test to see if it is passed. 

·[Bandwidth Search]: Press【Trace】→[Bandwidth Search]: 

·[Stats Off On]: Press【Trace】→[Stats Off On] to turn on or off the 

statistics, and switch it manually. 

 

4.3.17 Math menu 

数据→存储

运算

数据

存储

数据&存储

数据-存储

数据+存储>

数据/存储

 

·[Data→Mem]: Press [Trace Math]→[Data→Mem] to save current 

measurement trace data to the memory; 

·[Data]: Press [Trace Math]→[Data] to display only the trace 

corresponding to the measurement data; 

·[Save]: Press [Trace Math]→[Save] to display only the trace 

corresponding to the saved data. 

·[Data&Mem]: Press [Trace Math]→[Data&Mem] to display the trace 

corresponding to both the measurement data and saved data at the 

same time. 

·[Data-Mem]: Press [Trace Math]→[Data-Mem] to display the trace 

corresponding to the measurement data minus the saved data. 

·[Data/Mem]: Press [Trace Math]→[Data/Mem] to display the trace 

corresponding to the measurement data divided by the saved data. 

·[Data+Mem]: Press [Trace Math]→[Data+Mem] to display the trace 

corresponding to the measurement data plus the saved data. 
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4.3.18 Limit menu 

极限

关 开

极限

报警

关 开

清除

编辑  >

存储

调用

返回

 

·[Limit Off On]: Press [Limit]→[Limit Off On] to choose whether to turn 

on the limit function. 

·[Alarm Off On]: Press [Limit]→[Audio Alarm Off On] to set audio 

alarm On/Off. If the audio alarm is on and the upper and lower limit line 

test is on, the function is effective. If the limit is out of range when the 

upper and lower limit lines are swept on the current screen, the buzzer 

will give a short sound. 
·[Clear]:  Clear the edited limit line displayed currently; 

·[Edit]: Press [Limit]→[Edit]→[Sel Point] to switch the limit point on the 
current limit; 

·[Edit]: Press [Limit]→[Edit]→[Value] to set current limit point 
frequency, enter the number via the numeric key, and select the 
frequency unit for completion; 

·[Edit]: Press [Limit]→[Edit]→[Add]to add the limit point on the current 
limit line; 

·[Edit]: Press [Limit]→[Edit]→[Delete] to delete the limit point 
displayed on the current limit; 

·[Edit]: Press [Limit]→[Edit]→[Clear]to clear all limit points saved on 
the current limit; 

·[Save]: Press [Limit>]→[Save], enter the name via the number key, 

and save the limit line edited just now to the system, which can be 

recalled by pressing [Limit>]→[Recall>], selecting such limit line via the 

touchscreen manually, and pressing [OK] for recalling when 

conducting the same test next time, avoiding repeated editing; 

·[Recall]: Press [Limit>] → [Recall] , manually select the limit line file 

with the touch screen and press [OK]  to complete the loading. If the 

number of limit line storage files is large, press [Limit>] → [Recall>] → 

[Page Up] , [Page Up]  and find the limit line file to be loaded by page, 

and press [Limit>] → [Load>] → [Delete] , [Del All]  to delete the single 

and all currently selected and stored limit line files. 
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4.3.19 Peak menu 

最大峰值

峰值

次峰值

右邻峰值

左邻峰值

最大值

最小值

峰值跟踪

关         开

高级

 

·[Max Peak]: Press【Peak】→[Max Peak] to place a frequency marker 

at the highest point of the trace and display the frequency and 

amplitude of the frequency marker in the upper right corner of the 

screen. 

·[Sub Peak]: Press 【Peak】→[Sub Peak] to move the active 

frequency marker to the next highest peak point on the trace that is 

associated with the current frequency marker position. Press the key 

again, and the user can find the lower peak point quickly. 

·[Right Peak]: Press 【Peak】→[Right Peak] to find the next peak to 

the right of the current frequency marker position. 

·[Left Peak]: Press 【Peak】→[Left Peak] to find the next peak to the 

left of the current frequency marker position. 

·[Max]: Press 【Peak】→[Max] to place a marker at the highest point of 

the trace and display the frequency and amplitude of the marker in the 

upper right corner of the screen. 

·Min Peak] Press 【Peak】→[Min] to place a marker at the lowest point 

of the trace and display the frequency and amplitude of the marker in 

the upper right corner of the screen. 

·[Peak Tracking Off On]: Press 【Peak】→[Peak Tracking Off On], 

and when peak tracking is on, the current marker will perform a peak 

search operation after each sweep. If peak tracking is off, no operation 

will be performed. 

·[Advance]: Press 【Peak】→[Advance] to pop up the marker search 

dialog box, which determines the peak value by setting the marker, 

search type and specific frequency band. 
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4.3.20 File menu 

存储状态

文件

调用状态

存储迹线

调用迹线

屏幕截图

>

文件管理

存储位置

[内部]

>

>

>

 

·[StoreStateFile]: Press 【File】→[Save State] to save the current 

sweep status parameters.   

·[Recall Status]: Press 【File】→[Advance] to pop up the [Status File] 

list, and such soft menus as [Page Up], [Page Down], [Recall], [Delete] 

and [Delete All] are used to read the existing status file and recall the 

corresponding state parameters to the current sweep. You can also 

select such operations as [Last State] and [Default State].  

·[Special Notes]: Select [Default State] to restore the factory setting 

state.  

·[StoreTraceFile]: Press 【File】→[Save Data] to save the trace data.  

·[Recall Trace]: Press 【File】→[Recall Status] to pop up the data file 

list, and such soft menus as [Page Up], [Page Down], [Immediate 

Recall], [Delete] and [Delete All] are used to read the existing status file 

and recall the corresponding data to the current sweep.  

·[Print Screen]: Press【File】→[Print Screen] to capture the current 

screen image.  

·[File Mgmnt]: Press 【File】→[File Mgmnt] to pop up the file 

management menu, including [Source File], [Target File],  [Start 

Copying], [Delete Files] and other relevant soft menus to copy and 

delete files.  

·[Storage location]: Press 【File】→[Storage Location] to select the 

storage location, the interior is the internal memory of the instrument, 

and the other optional locations are the memory and SD card of the 

USB interface. After the security feature option is selected, the internal 

memory cannot be selected.  

4.3.21 Storage location menu 

 

内部

存储位置

SD卡

USB

<    返回

 

·[Internal]: Press 【File】→[Storage Location]→[Internal], the [Internal] 

is in a gray state and cannot be saved internally.  

·[SDCard]: Press 【File】→[Storage Location]→[SD card], and select 

Store Data to the SD card.  

·[USB]: Press【File】→[Storage Location] →[USB]and select Store Data 

to USB.  
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5 Spectrum analysis mode 

This chapter mainly introduces the relevant contents of 4957B spectrum analysis mode, including 
some typical measurement functions and methods in the spectrum analysis mode. After reading 
this section, users using this instrument for the first time can have a general understanding of 
some typical applications of the spectrum analysis mode and the testing operation process, and 
are familiar with the use of the spectrum analysis mode. 

 
 

All operations in this section are based on the premise of the selected 

spectrum analysis mode, which will not be described separately later. 

4957B spectrum analysis mode has rich measurement functions, so it contains many and complex 
parameters. In addition to the most basic functional parameters, such as frequency parameters, 
amplitude parameters, bandwidth average parameters, trace parameters, sweep parameters, 
marker parameters, etc., it also has other characteristic function parameters, including signal 
tracking, noise marker, peak tracking, counter, list sweep, trigger, limit line, field strength 
measurement, channel power, occupied bandwidth, adjacent channel power, carrier-to-noise ratio, 
spurious template, IQ capture, audio monitoring, etc. 

a) Signal tracking 

If the measured signal is a drift signal, the activated marker is placed on the peak point of the 
signal using the signal tracking function of the spectrum analyzer, and the peak value of the 
marker will always be displayed on the center frequency of the spectrum analyzer, which can be 
easily measured. 

b) Noise marker 

The noise marker displays the noise power near the activation marker that is normalized to the 1 
Hz bandwidth. Turn on the noise marker and set the detector to the RMS detection mode. If the 
logarithmic mode (dBm, dBmV, dBuV, dBW, dBV, dBA, dBmA/dBuA) is selected as the amplitude 
unit, the unit of the mark reading will be automatically switched to dBm/Hz. If V is selected as the 
amplitude unit, the unit of the reading will be automatically switched to V/(Hz)

1/2
. If A is selected, 

the unit of the reading will be automatically switched to A/(Hz)
1/2

. If W is selected, the unit of the 
reading will be automatically switched to W/(Hz)

1/2
. 

c) Peak tracking 

If the peak tracking function is enabled, the marker will perform a peak search operation after each 
sweeping. 

d) Counter 

If the frequency counter function is enabled, the frequency counter function will make the reading 
of the marker more accurate, which is conducive to improving the accuracy of frequency 
measurement. The measurement accuracy can reach Hz level, and the error is less than 10Hz. 

e) List sweep 

In the list sweep mode, users can edit the sweeping frequency band, and the spectrum analyzer 
sweeps based on the frequency range and other parameters set by the edited list. 

f) Trigger 

Select the trigger modes of sweeping or measurement, including [freerun], [video trigger], [external 
trigger], [trigger polarity], [trigger delay]. The user can select the mode based on the actual 
demand. If the freerun is set after the last continuous sweeping or single sweeping, a new sweep 
or measurement will be started. Set the trigger mode to video trigger. As long as the positive slope 
of the input trigger signal passes the video trigger level set by the [trigger polarity plus/minus] 
command, sweeping will be triggered. In the external trigger mode, select sweeping and 
measurement to synchronize with the next voltage cycle. 

g) Limit line 

The limit line function is used to monitor the signal in a certain frequency band. The spectrum 
analyzer provides upper and lower limit lines, and the user can set the limit. If the amplitude of a 

Notice 
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signal in a certain frequency band exceeds the set upper limit or is less than the set lower limit, the 
spectrum analyzer will send out a audio alarm signal. 

h) Field strength test 

The spectrum analyzer provides the function of field strength measurement, including} [Field 
Strength Off On], [Recall Antenna], [Edit Antenna], [Save Antenna] and other related soft menus. 
With the corresponding test antenna, the field strength test can be carried out quickly. 

i) Carrier to noise ratio 

The carrier to noise ratio function is to measure the ratio of carrier power to noise power, including 
carrier bandwidth, noise bandwidth, offset frequency, sweep width, carrier power, noise power, 
carrier to noise ratio and other parameters. 

j) Stray template 

The function of stray template is to call the limit line as a template to measure whether the signal 
power is limited by the template. The template parameter is a limit line and assigned by recalling 
the limit line. The template can move up and down left and right according to the center frequency 
and reference power. The template always moves the center point of the limit line left and right to 
the center frequency, and moves the center point up and down to the reference power point 
according to the calculated reference power. The reference power is divided into peak power and 
channel power, and which one is selected depends on the reference power type. 

k) IQ capture 

IQ capture function is to capture IQ data and store them in the instrument through the capture time, 
sampling rate, capture mode and other parameters set by the user. 

l) Audio monitoring 

The spectrum analyzer has audio demodulation function used for radio monitoring. If the 
demodulation sound is poor, the sound effect can be improved by adjusting the resolution 
bandwidth. In the demodulation mode, the resolution bandwidth is set in the range of 300kHz ~ 
30kHz, which will bring the optimum effect. 

5.1 Introduction to typical measurements 

The spectrum analysis mode of 4957B is the basic working mode. After startup, press 【Mode】, a 

mode selection dialog box pops up. Then select [Spectrum Analysis Mode] in the box, and press 
[OK] to enter the spectrum analysis mode after completing the progress bar. 

This section will introduce some advanced typical measurement functions and methods of 
spectrum analysis mode of 4957B, including the following: 

a) Measurement of channel power. 

b) Occupied bandwidth measurement. 

c) Measurement of adjacent channel power. 

d) TOI measurement. 

e) Drift signal measurement. 

f) Noise signal measurement. 

g) Distortion measurement. 

h) Pulsed RF signal measurement. 

i) Signal generation measurement (option). 

j) Interference map (option). 

 

 

 

 

Press the 【Reset】 key on the front panel, and the RF analyzer will run 

again. In the following examples, unless otherwise specified, first press 

the 【Reset】 key. 

5.1.1 Measurement of channel power 

This Section illustrates how to use the channel power measurement function of the spectrum 

Notice 
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analysis mode of 4957B to measure the signal channel power by taking the application of 
measurement of channel power of the FM signal as an example. 

5.1.1.1 Definition of channel power 

Channel power measurement is one of the most common measurements in RF transmission 
systems. Therefore, channel power is defined as the power transmitted by a signal over a range of 
frequencies at a specified time interval. In the test of the power amplifier and the filter circuit, the 
system is faulty if the specific power is not measured. The communication transmitter is evaluated 
by measurement of channel power, and its quality of the RF transmission is determined by 
comparing it to specific communication protocol. The spectrum analysis mode of 4957B can be 
used to measure the channel power of FM signal. Since the FM signal and continuous wave signal 
differ in many respects, an accurate setting can make the measured FM signal more accurate. 

5.1.1.2 Measurement steps 

The steps of using the spectrum analysis mode of 4957B to measure the FM signal channel power 
are as follows: 

a) Set the signal generator to output the FM signal: 

b) Generate an FM signal with a signal generator, set the frequency to 1GHz, the power to - 
10dBm, the FM deviation to 500KHz and the modulation rate to 10kHz. Connect the output of 
the signal generator to the RF input end of the spectrum analyzer via a cable, as shown in 
Figure 5-1. Turn on the modulation output switch and the RF switch. 

 

Figure 5-1 Connection Between Signal Generator and Spectrum Analyzer 

c) Reset the spectrum analyzer to the default state: 

d) Press 【Reset】. 

e) Turn on the channel power measurement function: 

Press [Measure], [Ch Power >], [Ch Power Off On]. Enable the channel power measurement 
function. 

a) Set center frequency: 

b) Press 【Measure】, [Channel Power] and [Center Freq] and set the center frequency with the 

number keys. The center frequency of the spectrum analyzer is set to the frequency of the 
measured signal, i.e., 1GHz. 

c) Set the channel power bandwidth: 

d) Press 【Measure】, [Channel Power] and [Channel Bandwidth] and set the channel power 

bandwidth with the number keys to 1MHz. 

e) Set the span of channel power: 

f) Press 【Measure】, [Channel Power] and [Channel Span] and set the channel power span with 

the number keys to 2 MHz. 

g) Set the resolution bandwidth and video bandwidth with a spectrum analyzer: 

Signal Generator Adapter 

2.4mm cable 
Adapter 

RF Analyzer 
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h) Press 【BW】, [RBW Auto Man], set the resolution bandwidth to 30kHz; 

i) Press 【BW】, [VBW Auto Man] to set the video bandwidth to 30kHz or less. 

          

 

The channel power bandwidth is a frequency width of the power 

displayed by the spectrum analyzer within this bandwidth, while the 

channel power span is the frequency range over which the spectrum 

analyzer sweeps. The channel power span should be set to be greater 

than or equal to the channel power bandwidth. Otherwise, the spectrum 

analyzer will automatically set the channel span equal to the channel 

power bandwidth. The ratio of channel power span to channel power 

bandwidth remains constant (maximum: 10; minimum: 1) This ratio 

remains constant as the channel power bandwidth changes. Changing 

the channel power span can change this ratio. For example, when the 

channel power bandwidth is doubled, the spectrum analyzer will also 

increase the channel power span by the same factor. 

j) Enable the averaging function: 

Press 【BW】 and [Avg Off On], set the average number of times to 16 and enable the averaging 

function. 

After the channel power measurement function is enabled, if the detection mode is automatic, it 
will be set to the root mean square detection mode. The two vertical white lines displayed on the 
screen indicate the bandwidth of the channel power. The measurement results are displayed at 
the bottom of the screen. See Figure 5-2 for the channel power measurement interface. 

 

Figure 5-2 FM Signal Channel Power Measurement 

5.1.2 Occupied bandwidth measurement. 

This Section illustrates how to use the occupied bandwidth measurement function of the spectrum 
analysis mode of 4957B to measure the signal occupied bandwidth by taking the application of 
measurement of occupied bandwidth of the FM signal as an example. 

Notice 
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5.1.2.1 Definition of occupied bandwidth 

The occupied bandwidth refers to the frequency bandwidth corresponding to the total transmit 
power of a certain ratio of the energy, which is centered as the center frequency of the specified 
channel. The occupied bandwidth measurement of the spectrum analysis mode of 4957B can 
present the measurement results in a quick, clear and accurate manner. There are two methods 
for calculating the occupied bandwidth depending on the modulation method: 

a) Power percentage method: 

The occupied bandwidth of the signal is obtained by calculating the bandwidth of the portion 
of the frequency containing a certain percentage of the total transmitted signal power, and the 
percentage of power can be set by the user. 

b) Power drop XdB method: 

This calculation method defines the occupied bandwidth as: the distance between the two 
frequency points when the signal power drops by XdB on both sides of the frequency point 
where the peak power of the signal is located. The XdB of the signal power drop is set by the 
user. 

5.1.2.2 Test steps 

Steps for measuring the occupied bandwidth in the spectrum analysis mode of 4957B are as 
follows: 

a) Set the signal generator to output the FM signal: 

Use the signal generator to generate a frequency modulation signal, and set the frequency to 
1GHz, the power to -10dBm, the frequency modulation offset to 500kHz and the modulation 
rate to 10kHz. Connect the output of the signal generator to the RF input of the spectrum 
analyzer by cable, as shown in Figure 5-1. Turn on the modulation output switch and the RF 
switch. 

b) Reset the spectrum analyzer to the default state: 

Press 【Reset】. 

c) Set center frequency: 

Press 【Freq】 and [Center Freq] and set the center frequency with the number keys. The 

center frequency of the spectrum analyzer is set to the frequency of the measured signal, i.e., 
1GHz. 

d) Set resolution bandwidth: 

e) Press [BW], [RBW Auto Man] to set the resolution bandwidth to the appropriate value. 

f) Set video bandwidth: 

g) Press [BW], [VBW Auto Man] to set the video bandwidth to the appropriate value. 

In order to improve measurement accuracy, it is recommended that the ratio of resolution 
bandwidth to video bandwidth be greater than 10. Press [RBW/VBW] to change the ratio of 
resolution bandwidth to video bandwidth. 

h) Switch the spectrum analyzer to the occupied bandwidth measurement mode: 

i) Press [Measure], [OBW] , [OBW Off On]. 

After the occupied bandwidth measurement function is enabled, the spectrum analyzer 
switches to the occupied bandwidth measurement interface, and the measurement result is 
displayed at the bottom of the screen. See Figure 5-3 for the occupied bandwidth 
measurement. The two vertical white lines on the screen visually indicate the frequency range 
of occupied bandwidth. If the detection mode of the spectrum analyzer is automatic after the 
occupied bandwidth measurement function is enabled, it will automatically switch to the root 
mean square detection mode. Users can change the measurement method, occupied 
bandwidth, span and other parameters through the corresponding menu to get more accurate 
measurement results. 
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j) Select measurement method: 

k) Press 【Measure】, [Occupied Bandwidth] and [Measurement Method % XdB] to select the 

measurement method for occupied bandwidth. The measurement method can be set to the 
power percentage method, or the power drop XdB method, the underline marks the currently 
selected mode, and the default is the percentage method. 

 

Figure 5-3 Occupied Bandwidth Measurement 

l) Change percentage: 

If the measurement method is selected as the percentage method, press 【Measure】, 

[Occupied Bandwidth] and [% 99%] and use the numeric keys, up and down keys or the knob 
to change the percentage value. The percentage setting range is 10% to 99.99%, the 
minimum step is 0.01%, and the default is 99%. 

m) Change X dB: 

If the measurement method is selected as XdB method, press 【Measure】, [Occupied 

Bandwidth] and [XdB - 3.00dB], use the numeric keys, up and down keys or the knob to 
change the value of XdB. The range of XdB value is set from -0.1dB to -100dB, the minimum 
step is 0.01dB, and the default is -3dB. 

n) Change the occupied bandwidth span: 

Press 【Measure】, [Occupied Bandwidth] and [Channel Span], input the occupied bandwidth 

span with the numeric keys and press the corresponding soft key input unit. The default value 
is 3MHz. 

o) Disable occupied bandwidth measurement: 

Press 【Measure】,  [Occupied Bandwidth] and [OBW Off On], select Off to exit the occupied 

bandwidth measurement, and the interface switches back to the spectrum measurement 
interface. 

5.1.3 Measurement of adjacent channel power 

This Section illustrates the operation method of the adjacent channel power ratio measurement 
with the 4957B spectrum analyzer by taking the measurement of the adjacent channel power ratio 
of the FM signal as an example. 

5.1.3.1 Definition of adjacent channel power ratio 

The adjacent channel power ratio (ACPR), also called the adjacent channel leakage power ratio 
(ACLR), is the ratio of the transmit power of a channel to the radiated power of its adjacent 
channel. It is usually expressed by the ratio of the power in the specified bandwidth to the total 
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channel power at different frequency offsets of adjacent channels. The size of adjacent channel 
power mainly depends on the extension of the edge band and noise of the transmitter. 

The measurement method for adjacent channel power ratio can replace the traditional two-tone 
intermodulation distortion measurement method applied to the nonlinear system test, and the 
adjacent channel power ratio measurement result can be expressed as two different ways of 
power ratio or power density. 

5.1.3.2 Measurement steps 

In traditional measurements, for narrowband signals, two-tone intermodulation measurements are 
commonly used to evaluate the distortion performance of the transmitter. Wideband modulated 
signal that not only has very tight spectral components, but also has a very high peak signal 
(called a crest factor). These intermodulation products from the spectral components of the signal 
will locate around the spectrum. Since the intermodulation measurement of WBFM signals is very 
complicated, and the adjacent channel power ratio (ACPR) is closely related to intermodulation 
products caused by nonlinear distortion, the adjacent channel power ratio (ACPR) is a better 
method to measure the nonlinear distortion of WBFM signals. 

Steps for measuring the adjacent channel power ratio of the WBFM signal using the adjacent 
channel power ratio measurement function of 4957B spectrum analyzer are as follows: 

a) Set the output frequency of the signal generator: 

Use the signal generator to generate a frequency modulation signal, and set the frequency to 
1GHz, the power to -10dBm, the frequency modulation offset to 500kHz and the modulation 
rate to 10kHz. Connect the output of the signal generator to the RF input of the spectrum 
analyzer by cable, as shown in Figure 5-1. Turn on the modulation output switch and the RF 
switch. 

b) Reset the spectrum analyzer to the default state: 

Press 【Reset】. 

c) Set the reference level of the spectrum analyzer: 

Press 【Amplitude】, [Ref Level] and -10 [dBm]; 

Press 【Amplitude】and [Scale/Div] to set the scale to 10dB/div. 

d) Set the resolution bandwidth and video bandwidth: 

Press 【BW】, [RBW Auto Man], set the resolution bandwidth to 30kHz; 

Press 【BW】, [VBW Auto Man] to set the video bandwidth to 30kHz or less. 

e) Switch to adjacent channel power ratio measurement: 

Press 【Measure】, [Adjacent Channel Power] and [ACPR Off On] to switch to the 

measurement interface of adjacent channel power ratio. 

f) Set the center frequency of the main channel: 

Press [Center Freq] and set the center frequency of the main channel with the numeric keys 
to 1GHz. 

g) Set the main channel bandwidth: 

Press [Main Ch BW] and set the bandwidth of the main channel with the numeric keys to 
1MHz. 

h) h)  Set the adjacent channel bandwidth: 

Press [Adj Ch BW] and set the required adjacent channel bandwidth with the numeric keys to 
2MHz. 

i) Set the channel offset: 

Press [Ch Offset], set the desired channel offset with the numeric keys, and enter 1MHz. 

j) Turn on the adjacent channel power ratio test: 

Press [Adj Ch Power OFF ON], and the measurement results will be displayed at the bottom 
of the screen. See Figure 5-4 for the measurement of ACPR. 
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Figure 5-4 Measurement of ACPR 

k) Threshold setting: 

The threshold test function will facilitate the user to observe whether the adjacent channel 

power exceeds the set range. Press 【Measure】, [Adjacent Channel Power] and [Page Down 

1/2] to enter the ACPR threshold test setting menu. 

Press [Upper Ch Threshold] and use the numeric keys to enter the upper adjacent channel 
threshold; 

Press [Down Ch Threshold] and use the numeric keys to enter the lower adjacent channel 
threshold. 

l) Open the threshold test function: 

Press [Threshold Test Off On] to open the threshold test function. If the adjacent channel 
power ratio exceeds the set threshold, the screen will be marked with a red background. 

5.1.4 TOI measurement 

5.1.4.1 Definition of TOI 

In the crowded environment of the communication system, the mutual interference between 
devices is a common problem. For example, the problem of second-order and third-order 
intermodulation distortion is often encountered in the narrowband system. If a system has two 
signals (F1 and F2), both signals mix with the generated second harmonic distortion signals 
(2F1and 2F2) to generate TOI products 2F2-F1 and 2F1-F2 close to the original signal. High order 
intermodulation distortion will also occur. Most of these distortion products are produced by 
amplifiers and mixers in the system. 

The following describes how to measure the TOI, including illustrating how to display two signals 
simultaneously on the spectrum analyzer screen, and introducing how to set the resolution 
bandwidth, mixer level and reference level, as well as the use of some marker functions. 

5.1.4.2 Measurement steps 

a) Connect the tested instrument with the spectrum analyzer as shown in Figure 5-5: 

In this example, a 6dB directional coupler and two signal generators set to 1GHz and 1.001ghz 
respectively are used. Of course, the frequency of the signal generator may also be other 
values, but in this example, the frequency interval must be maintained at about 1MHz. 
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Figure 5-5 Connecting TOI Measurement System 

Set the output frequency of one signal generator to 1GHz and the output frequency of the 
other signal generator to 1.001GHz to keep 1MHz frequency interval between the two signals 
input to the spectrum analyzer. 

Set the output amplitude of the two signal generators to be equal (- 20dBm in this example). 

b) Set the spectrum analyzer to keep two signals displayed on the spectrum analyzer screen 
simultaneously: 

Press 【Reset】. 

Press 【Freq】, [Center Freq] and 1.001[GHz]. 

Press 【Frep】, [Span], 5 [MHz]. 

The user can see two signals in the center of the screen, as shown in Figure 5-6. If the 
frequency interval used is different from that used in this example, a span greater than three 
times the frequency interval of the signal generator should be selected. 

c) Reduce the resolution bandwidth until the distortion product is visual: 

Press 【BW】 and use the step key 【↓】  to reduce the resolution bandwidth: 

d) Adjust the two signal generators to ensure that the input signal amplitude is equal: 

Press 【Mkr】, [Difference Mode], 【Peak】, [Sub Peak], or [Left Peak] or [Right Peak]. Adjust 

the signal generator corresponding to the marker until the amplitude difference reading is zero. 
If necessary, reduce the video bandwidth. 

 

Figure 5-6 Signal in the Center of Spectrum Analyzer Display 
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e) Set the reference level and place the signal peak at the reference level: 

Press 【Peak】 and [Max Peak] to read the power value of the peak. 

Press 【Amplitude】, [Ref Level]. 

In order to obtain the best measurement accuracy, the generator should be set at the  

reference level as shown in Figure 5-7. 

 

Figure 5-7 Set the Signal Peak at the Reference Level: 

f) Set the second marker and measure the distortion product: 

Once the marker is activated, the difference marker function can generate a second marker 
and the difference between the two markers will be displayed. At this time, the relative 
measurement can be carried out conveniently. 

Press the 【Peak】 key to activate the marker 1. 

Press 【Mkr】[difference mode] to activate the marker 2. 

Press 【Peak】, and then press [Left Peak] or [Right Peak] to set the marker 2 on the peak  

point of distortion product next to the signal of signal generator. The frequency and amplitude  

differences of the two markers are displayed in the marker display area, as shown in Figure  

5-8, and the marker amplitude difference is the measured value of TOI. 
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Figure 5-8 Relative Measurement of Internal Modulation Distortion 

g) Calculation method of TOI: 

The ratio of distortion component level to signal level (expressed in dB) specifies the distortion 
of the system, which is not significant, unless the signal level is also specified. The concept of 
TOI can be used to specify and preestimate the distortion level of the system. The difference 
between the TOI component level and the fundamental wave signal level is twice that 
between the fundamental wave signal level and the TOI. Therefore, the TOI can be calculated 
by the following formula: 

2

dB
LTOI 3im

in




 

Where:Lin: two input signal levels, in dBm. 

   3im
dB

： the difference between the third-order intermodulation product and the input 

signal level, in dB. 

As shown in Figure 5-7, if the difference marker reading is -61.62dB and the signal level is  

-20.24dBm, the input TOI is: 

TOI= -20.24- (-61.62/2)=10.57(dBm) 

5.1.5 Measurement of drift signal 

5.1.5.1 Definition of drift signal 

If the measured signal is a drift signal, it can only be observed by changing the center frequency at 
different times when measured with a spectrum analyzer. If the signal tracking function of the 
spectrum analyzer is used, the marker peak will always be displayed on the center frequency of 
the spectrum analyzer for measurement. 

This part will introduce how to measure the drift signal, and use the signal tracking, marker 
function and maximum hold function of the spectrum analyzer to observe the amplitude track and 
occupied bandwidth of the drift signal. 
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5.1.5.2 Measure the frequency drift of the signal generator 

The spectrum analyzer can measure the short-term and long-term stability of the signal generator. 
With the maximum track hold function, the spectrum analyzer can display the maximum peak 
amplitude and frequency drift of the input signal. If you want to measure the occupied bandwidth of 
the signal, you can also use the maximum track hold function. 

In this example, the signal tracking function of the spectrum analyzer is used to keep the drift 
signal always displayed in the center, and the maximum track hold function of the spectrum 
analyzer is used to capture the drift. 

a) Set the signal generator to output the signal: 

Set the frequency of the signal generator to 300MHz and the amplitude to -80dBm. Connect 

the output of the signal generator to the input port of the spectrum analyzer, as shown in 

Figure 5-1, and enable its RF output.    

b) Set the center frequency, span and reference level of the spectrum analyzer: 

Press 【Reset】. 

Press [Frep], [Center Freq], 300 [MHz]. 

Press 【Freq】, [Span] and 10 [MHz]. 

Press 【Amplitude】, [Ref Level], -10[dBm]. 

c) Put the marker at the signal peak position, and enable the signal tracking function: 

Press 【Peak】 and [Peak Tracking Off On]. 

Press 【Freq】 and [Signal Tracking Off On].  

d) Reduce the span: 

Press 【Freq】, [Span] and 500[kHz] to see that the signal remains in the center all the time. 

e) Turn off the signal tracking function: 

a) Press[Frequency] and [Signal Tracking Off On]. 

f) Measure signal drift using the maximum hold function: 

Press [Trace] , [Max Hold] . 

If the signal changes, the maximum hold function will maintain the maximum response to the 
input signal. 

g) Activate trace 2 and set it to continuous refresh mode: 

Press 【Trace】, [Trace 1 2 3] and [Refresh Trace]. 

h) Change the output frequency of the signal generator: 

Slowly change the output frequency of the signal generator to keep it step by 1kHz and 

change at ±50kHz. The display of the spectrum analyzer is shown in Figure 5-9. 
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Figure 5-9 Observe the Drift Signal Using the Maximum Hold Function 

5.1.6 Noise signal measurement 

5.1.6.1 Definition of noise signal 

In communication system, the signal-to-noise ratio is usually used to characterize the noise. If the  
noise level added to the system is much larger, the signal-to-noise ratio will be worse, resulting in 
more difficult in demodulating the modulated signal. In a communication system,  the signal to 
noise ratio measurement also normally refers to the ratio measurement of carrier to noise. 

The following illustrates how to use the marker function of 4957B spectrum analyzer to measure 
the SNR and noise. The measurement of SNR when the signal (carrier) is in a single frequency 
point is described in the example. If the system under test is a modulation signal, the test process 
shall be modified to correct the level of the modulation signal. 

5.1.6.2 Measure SNR 

a) Set the signal generator to output the signal: 

Set the frequency of the signal generator to 1GHz and the power to -10dBm, connect the  

signal generator output to the input port of the spectrum analyzer, as shown in Figure 5-1, and  

turn on the RF switch. 

b) Set the center frequency, span, reference level and attenuator. 

Press 【Reset】. 

Press [Frep], [Center Freq], 1 [GHz]. 

Press 【Frep】, [Span], 5 [MHz]. 

Press 【Amplitude】, [Ref Level], -10[dBm]. 

Press 【Amplitude】, [Attenuator Auto Man], 40[dB] (the maximum attenuation value of 

4957BA/B/C is 30dB, and only 30dB attenuation is set). 

c) Place the marker at the peak position of the signal, then place the difference marker at the 
noise position with a frequency offset of 200 kHz: 

Press 【Peak】 and [Max. Peak]. 

Press 【Mkr】, [Difference Mode] and 200[kHz]. 

d) Enable the noise marker function to view the SNR: 
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Press [Mkr], [Noise Mkr Off On]. as shown in Figure 5-10. 

The reading of SNR is expressed in dB/Hz because the noise value is a value of noise 

bandwidth normalized to 1Hz. The ratio is decreased by 10 × log (BW). If it is desired to obtain  

noise values at different channel bandwidths, the measurement results will be corrected  

according to the current bandwidth. For example, if the data read by the spectrum analyzer is  

-85dB/Hz, and the channel bandwidth is 30kHz at this time, the signal-to-noise ratio is: 

S/N=85dB/Hz - 10×log（30kHz）=40.2dB/(30kHz) 

At this time, if the difference marker is less than a quarter of the signal peak-to-response edge 

distance, there is a potential error in the noise measurement. 

 

Figure 5-10 Measure SNR 

5.1.6.3 Measure noise with noise marker function 

The noise with a 1Hz bandwidth is measured with the noise marker function in the example, and 
1GHz external signal is used for measurement. 

a) Set the signal generator to output the signal: 

Set the frequency of the signal generator to 1GHz and the power to -10dBm. Connect the 

output of the signal generator to the input port of the spectrum analyzer, and turn on the RF 

switch. 

b) Set the center frequency, span, reference level and attenuator. 

Press 【Reset】. 

Press 【Freq】,  [Center Freq] and 999.98[MHz]. 

Press 【Freq】, [Span] and 1 [MHz]. 

Press 【Amplitude】, [Ref Level], -10[dBm]. 

Press 【Amplitude】, [Attenuator Auto Man], 40[dB] (the maximum attenuation value of 

4957BA/B/C is 30dB, and only 30dB attenuation is set). 

c) Activate the noise marker: 

Press 【Mkr】 -> [Noise Mk Off On] -> [Peak] -> [Max] , 

Note that the detection mode at this time will be automatically set to the root mean square  

detection mode. If you want to get the noise power values under different bandwidths, such  
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values will be corrected with the current bandwidth of 10×log (BW). For example, if you want  

to get the noise power in the 1 kHz band, please add 10 × log (1000) or 30 dB to the read  

data. 

d) Reduce the measurement error by increasing the sweep time. 

Press【BW】, [RBW Auto Man] and 100[kHz]. 

Press【Swp】, [Swp Time Auto Man] and 3[s]. 

If average detection is used, increase the sweep time to make the trace data average in a  

longer time interval and further reduce the measurement error. 

e) Move the marker to 1GHz. 

Press【Mkr】and turn the knob in the front panel to make the noise marker readout 1GHz. 

The noise marker value is calculated based on 5% of the entire sweep track points which are  

centered on the marker position. The position of the noise marker is not located at the peak  

point of the signal. Since the peak position of the signal does not have enough track points to  

calculate, so when the resolution bandwidth is narrow, the noise marker will also average the  

track point below the signal peak. as shown in Figure 5-11. 

 

Figure 5-11 Measure Noise with Noise Marker Function 

f) Set the span of the spectrum analyzer to zero with the marker position as the center. 

Press 【Peak】and [Mkr→Center Freq]. 

Press [Frep], [Span], [Span Zero]. 

Press 【Mkr】 . 

At this point the amplitude reading of the noise marker is correct because the average of all points 
is based on the same frequency and is not affected by the shape of the resolution bandwidth filter. 
The noise marker is calculated based on the average of the interested frequency points. When 
performing power measurements at discrete frequency points, it should first tune the spectrum 
analyzer to the interested frequency point and then measure the power at zero span. 

5.1.7 Distortion measurement 

In the crowded environment of the communication system, the mutual interference between 
devices is a common problem. For example, the problem of second-order and third-order 
intermodulation distortion is often encountered in the narrowband system. If a system has two 
signals (F1 and F2), both signals mix with the generated second harmonic distortion signals 
(2F1and 2F2) to generate TOI products 2F2-F1 and 2F1-F2 close to the original signal. High order 
intermodulation distortion will also occur. Most of these distortion products are produced by 
amplifiers and mixers in the system. Most transmission devices and signal generators contain 
harmonics, and the harmonic components often need to be measured. 



4957B RF Analyzer User Manuals 

Spectrum analysis mode 

82 / 248 

5.1.7.1 Identify the distortion generated by the spectrum analyzer 

The spectrum analyzer inputs a large signal, which will cause distortion of the spectrum analyzer 
and further affect the distortion measurement results of the real signal. Through the attenuator 
setting, you can determine which signal is the distorted signal generated inside the spectrum 
analyzer. In this example, the input signal generated by the signal generator will be used to explain 
whether the spectrum analyzer generate harmonic distortion. 

a) Set the signal generator to output the signal: 

Set the frequency of the signal generator to 200MHz and the power to 0dBm. Connect the  

output of the signal generator to the input port of the spectrum analyzer, as shown in Figure  

5-12, and turn on the RF switch. 

b) Set the center frequency and span of the spectrum analyzer: 

Press 【Reset】. 

Press 【Freq】, [Center Freq] and 400[MHz]. 

Press 【Freq】, [Span] and 500 [MHz]. 

It can be seen from the track of the spectrum analyzer that the harmonic distortion generated  

by the signal has 200MHz frequency offset from the original 200MHz signal, as shown in  

Figure 5-12. 

c) Set the center frequency of the spectrum analyzer to the position of the first harmonic 
distortion. 

Press 【Peak】and [Sub Peak]. 

Press 【Peak】and [Mkr→Center Freq]. 

d) Set the span to 50MHz and reset the center frequency. 

Press 【Freq】,  [Span] and 50 [MHz]. 

Press 【Mkr→】and [Mkr→Center Freq]. 

e) Set the attenuator to 0dB. 

Press 【Amp】， [Atten Auto/Man] and 0[dB]. 

Press 【Peak】 and [Peak Tracking Off On]. 

Press 【Mkr】and [Difference Mode]. 

 

Figure 5-12 Observed Harmonic Distortion 

f) Increase the attenuator setting to 10dB: 

Press 【Amp】， [Atten Auto/Man] and 10[dB]. 
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Observe the reading of the difference marker, as shown in Figure 5-13. This reading is the  

distortion difference generated by the attenuator at 0dB and 10dB. When the attenuator  

changes, if the difference frequency marker reading is greater than or equal to 1dB, it  

indicates that the spectrum analyzer has produced certain distortion. If the difference marker  

reading is unobvious, the attenuation can also be increased. 

 

Figure 5-13 Set the Attenuator to 10dB 

The amplitude reading of the difference marker comes from two sources: First, the increase of RF 
attenuation will reduce the signal-to-noise ratio, making the reading positive; Second, the 
harmonic distortion generated by the spectrum analyzer circuit is reduced, which will make the 
reading to be negative. The larger the reading, the greater the measurement error. The absolute 
amplitude of the difference marker reading can be reduced by changing the attenuator. 

5.1.7.2 Fast harmonic measurement method 

The harmonic component of the signal with the frequency of 1GHz and power of -10dBm 
generated by the signal generator is measured in this example. 

a) Set the signal generator to output the signal: 

Set the frequency of the signal generator to 1GHz and the power to -10dBm, connect the  

signal generator output to the input port of the spectrum analyzer, as shown in Figure 5-1, and  

turn on the RF switch. 

b) Set the start and stop frequencies of the spectrum analyzer. 

Press 【Reset】 key. 

Press 【Reset】, [Start Freq], 800 [MHz], [Stop Freq], 2.5 [GHz]. 

The fundamental wave and second harmonic wave are displayed on the screen, as shown in  

Figure 5-14. 
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Figure 5-14 Input Signals and Harmonics 

c) Set video bandwidth and smooth noise to improve resolution. 

Press 【BW】, [VBW Auto Man] to enable the manual mode. 

Use the step decrement key 【↓】 to reduce the video bandwidth. 

d) Set the fundamental wave peak level as the reference level to improve the measurement 
accuracy. 

Press 【Peak】, [Max Peak] to read the peak power. 

Press 【Amplitude】, [Ref Level] to set to the peak power. The results are shown in Figure  

5-15. 

 

Figure 5-15 Set the Signal Peak at the Reference Level to Obtain the Maximum 
Accuracy 

e) Activate the marker 2. 

Press 【Mkr】[Difference Mode] and 【Peak】[Sub Peak]. 

At this time, the fixed marker is marked on the fundamental wave, and the active marker 
is located on the peak point of the second harmonic, as shown in Figure 5-16. 
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Figure 5-16 Measure the Second Harmonic with marker difference 

f) Measure harmonic distortion (method 1). 

The figure shows that the amplitude difference between the fundamental wave and the  

second harmonic is about - 60dB, or the harmonic distortion is 0.1%. (see Figure 5-17). 
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Figure 5-17 Harmonic Distortion Amplitude Percentage Change 

To measure the third harmonic, press the [Right Peak] key again and continue reading 

the amplitude ratio of other harmonics to the fundamental wave. 

g) Measure harmonic distortion (method 2). 

Press 【Amp】, [Amp Unit] and [Volt]. 

At the moment, the difference marker unit automatically changes to volt. An easy way to  

determine the distortion percentage is to change the unit to volt. Move the decimal point of the  

scale shown by the difference marker to the right by two digits to get the distortion  

percentage. The minimum scale displayed is 0.01 or one percent. 
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5.1.7.3 Accurate harmonic measurement method 

The steps of this method are slightly tedious, but because each signal is measured within a small 
sweep width and resolution bandwidth, the signal-to-noise ratio is improved, and the measurement 
result is more accurate. The following describes how to measure the harmonic of 1GHz signal. 

a) Set the signal generator to output the signal: 

Set the frequency of the signal generator to 1GHz and the power to -10dBm, connect the  

signal generator output to the input port of the spectrum analyzer, as shown in Figure 5-1, and  

turn on the RF switch. 

b) Set the start and stop frequencies of the spectrum analyzer: 

Press 【Reset】 key. 

Press 【Reset】, [Start Freq], 800 [MHz], [Stop Freq], 2.5 [GHz]. 

c) Set video bandwidth and smooth noise to improve resolution: 

Press 【BW】, [VBW Auto Man] to enable the manual mode. 

Use the step decrement key 【↓】 to reduce the video bandwidth. 

d) Reduce the span by using the signal tracking function: 

Press 【peak】 key to activate the marker to search for the signal peak. 

Press 【Freq】 and [Signal Tracking Off On]. 

Press 【Freq】, [Span] and 100 [kHz]. 

e) Turn off signal tracking. 

Press 【Freq】 and [Signal Tracking Off On]. 

f) The best amplitude measurement accuracy can be obtained by moving the signal peak to the 
top line. 

Press 【Peak】, [Max Peak] to read the peak power. 

Press 【Amplitude】, [Ref Level] to set to the peak power. The results are shown in Figure 

5-18. 

 

Figure 5-18 Input Signal displayed within 100kHz Span 

g) Set the center frequency step as the fundamental wave signal frequency value. 

Press 【Freq】, [Step Freq Auto Man] and 1[GHz]. 

h) Measure the second harmonic. 

Press 【Mkr】, [Mkr→], [Mkr→Center Freq] and step key 【↑】. The central frequency of the  
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spectrum analyzer is shifted to the second harmonic by step operation. Press 【Peak】, [Max  

Peak] to read the peak power. 

Press 【Amplitude】, [Ref Level] to set to the peak power. Adjust the harmonic peak to the 

reference level, and the second harmonic amplitude is shown in Figure 5-19. 

 

Figure 5-19 Second Harmonic Amplitude 

i) Calculate harmonic distortion. 

The change in percent of distortion  between the second harmonic and the fundamental  

wave is shown in Figure 5-17. The unit can be converted into volt to read out the voltage ratio  

of the two signals. 

j) Measure other harmonics. 

Repeat steps (i) to (j) for other harmonics to be measured. Calculate the percentage of each  

harmonic distortion. 

The total harmonic distortion percentage of the signal is also a parameter that is to be tested  

often. To test this parameter, the amplitude of each harmonic must be measured in linear  

units (such as volt), instead of relative unit dBc. Press 【Amp】, [Amp Unit] and [Volt] The  

amplitude unit is volt. The measured signal amplitude value is used to calculate the total  

harmonic distortion in the following equation: 
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Where: 

A1 —— fundamental wave amplitude, unit: volt 

A2 —— second harmonic amplitude, unit: volt 

A3 —— third harmonic amplitude, unit: volt 

An —— Nth harmonic amplitude, unit: volt 

If the signal amplitude can be measured carefully in the steps in the previous example, the 
harmonic distortion percentage measured in this process is very accurate. 
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5.1.8 Pulsed RF signal measurement 

5.1.8.1 Definition of pulsed RF signal 

Pulsed RF signal is a series of RF pulses with the same repetition frequency, constant pulse width, 
constant shape and amplitude. Several methods for measuring the parameters of pulsed RF 
signals will be illustrated in this section. Such methods will explain how to measure the center 
frequency, pulse width and pulse repetition frequency. In addition, the measurement of peak pulse 
power will also discussed. 

The resolution bandwidth has a great influence on the measurement of pulsed RF signal. The 
relationship between resolution bandwidth and pulse repetition frequency must be understood. If 
the resolution bandwidth is narrower than the pulse repetition frequency, only individual frequency 
components of the pulsed RF signal are displayed on the screen, which is called as narrowband 
mode. If the resolution bandwidth is wider than the pulse repetition frequency, it is called as the 
broadband mode. At the moment, the spectrum envelope drawn by the pulse burst divided by the 
pulse repetition frequency can be seen. 

5.1.8.2 Measurement of center frequency, SLR and pulse width of pulsed RF signal 

a) Set the signal generator to output the signal: 

Set the frequency of the signal generator to 1GHz and the power to -20dBm. Connect the  

output of the signal generator to the input port of the spectrum analyzer, as shown in Figure  

5-1. The pulse modulation is set to the repetition frequency of 1kHz and the pulse width of  

900ns. Enable the pulse modulation and the RF output. 

b) Set the spectrum analyzer: 

The pulsed RF signal is generally measured in broadband mode. In order to ensure that the  

video filter does not interfere with the measurement results, the video bandwidth is set to  

3MHz. 

Press 【Reset】 key. 

Press [Frep], [Center Freq], 1 [GHz]. 

Press 【Freq】, [Span], 10[MHz], 【Swp】and [Swp Time Auto Man] 60[ms]. 

Press【BW】, [RBW Auto Man], 100[kHz],  [VBW Auto Man] and 100[kHz]. 

Press 【BW】, [Detection] and [Positive peak] to activate positive peak detection. 

Select the center frequency function and adjust the span so that the center side lobe and at  

least one pair of side lobes are displayed on the screen, as shown in Figure 5-20. 
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Figure 5-20 Main and Side Lobes 

Increase the sweep time (sweeping slows down) until the figure is filled and becomes a solid 

line, as shown in Figure 5-21. If the spectral line isn‘t filled in, the instrument is not in 

broadband mode. In this case, the following measurement steps for side lobe ratio, pulse 

width and peak pulse power are not applicable, and the resolution bandwidth has to be set to 

greater than 1kHz. 

 

Figure 5-21 Track Displayed in a Solid Line 

c) Read out the pulse center frequency and main lobe amplitude: 

Press [peak]; 

At this time, the marker reading is the pulse center frequency and main lobe amplitude. 

d) when the marker is at the center frequency of the main lobe, measure the side lobe ratio: 

Press 【Peak】,【Mkr】, [Difference Mode] 【Peak】and [Sub Peak]. 

The amplitude difference between the main lobe and the side lobe is the side lobe ratio, as  
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shown in Figure 5-22. 

 

Figure 5-22 The Marker Displays the Side Lobe Ratio 

e) Measure the pulse width, which is equal to the reciprocal of the frequency difference between 
the peak points of the two side lobe envelopes: 

Press 【Mkr】, [Difference Mode], 【Peak】[Right Peak] and [Right Peak]. 

At the moment, the reciprocal of the frequency difference of the difference marker is the pulse  

width, as shown in Figure 5-23. To obtain the most accurate pulse width value, you can  

manually adjust the marker position and measure the distance between two adjacent side  

lobes crossing the zero point. If the resolution bandwidth is reduced to make the zero crossing  

sharper, the measurement accuracy is higher. 

 

Figure 5-23 The Marker Displays the Pulse Width 

5.1.8.3 PRF measurement 

Pulse repetition interval (PRI) is the time interval between any two adjacent pulse responses. 

a) Set the signal generator to output the signal: 

Set the frequency of the signal generator to 1GHz and the power to -20dBm. Connect the  
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output of the signal generator to the input port of the spectrum analyzer. Set the pulse  

modulation to the repetition frequency of 1kHz and the pulse width of 900ns. Open the pulse  

modulation and the RF output. 

b) Set the spectrum analyzer: 

Press 【Reset】 key. 

Press 【Freq】and 1[GHz]. 

Press 【Freq】, [Span], 10[MHz], 【Swp】and [Swp Time Auto Man] 1.705[s]. 

Press【BW】, [RBW Auto Man] and 1[kHz]. 

Press 【BW】, [VBW Auto Man] and 3[MHz]. 

Press 【BW】,  [Detection] and [Positive Peak] to activate positive peak detection. 

Adjust the span so that the main lobe and at least one pair of side lobes are displayed on the  

screen. 

Readjust the output amplitude of the signal generator to keep it on the screen, and reduce the  

sweep time (i.e. speed up the sweep speed) until the display is similar to Figure 5-24. 

c) Measure the pulse repetition interval (PRI). 

Select 【Swp】and [Swp Type Cont Single]. 

Press 【Peak】,【Mkr】, [Difference Mode], 【Peak】and [Sub Peak]. The displayed difference  

between the two markers is equal to the pulse repetition interval (PRI), and its reciprocal is the  

pulse repetition frequency (PRF). 

 

Figure5-24 Measure the Pulse Repetition Frequency (PRF) 

5.1.8.4 Peak pulse power measurement 

Now that the main lobe amplitude and pulse width are given, and the resolution bandwidth of the 
spectrum analyzer can be easily got, thus the peak pulse power can be obtained from these 
parameters. 

If the spectrum analyzer is in broadband measurement mode: 

a) Peak pulse power = (main lobe amplitude) -（20 log Teff×BWi） 

Where: 

b) Teff  - pulse width, unit: Second 
c) BWi——Impact bandwidth,  Hertz (resolution bandwidth used to measure pulse width when 
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the value is 1.5) 

If the spectrum analyzer is in narrowband measurement mode: 

d) Peak pulse power = (main lobe amplitude) -(20 log Teff/T) 
Where: 

e) Teff  - pulse width, unit: Second 
T——pulse repetition frequency 

The phenomenon that the peak pulse power is not equal to the amplitude of the main lobe is called 
pulse desensitization. The pulse signal will not reduce the sensitivity of the spectrum analyzer. 
Specifically, the apparent desensitization is due to the fact that the power of the pulse modulated 
continuous wave (CW) carrier is allocated to a large number of spectrum components (i.e. carrier 
and sideband). Therefore, each spectrum component contains only a part of the total power. 

5.1.9 Signal generation measurement (option) 

The generation and measurement mode of signal source is independent source mode, and the 
independent source mode is point frequency source mode, which can realize the signal output of 
single frequency point and fixed power. 

5.1.9.1 Signal generation measurement 

In the signal generation measurement mode, the fixed frequency signal is output in the following 
steps: 

a) Press【Measure】→[Page Down 1/2]→[Signal Generation]→[Signal Generation Off On], 

and in the default state, select the point frequency source 3.25GHz output after the signal 

source switch is turned on. 

b) Press【Measure】→[Page Down 1/2]→[Signal Generation]→[Freq 3.25GHz] and set the 

frequency of the output signal. 

c) Press【Measure】→[Page Down 1/2]→[Signal Generation]→[High Power] to set the power of 

the output signal to high power output. 

d) Press【Measure】→[Page Down 1/2]→[Signal Generation]→[Low Power] to set the power of 

the output signal to low power output. 

e) Press【Measure】→[Page Down 1/2]→[Signal Generation]→[Manual Power -18dBm] to set  

the power of the desired output signal power according to the needs of users.The signal with 
output frequency of 1GHz and output power of 0dBm is shown in Figure 5-25 below: 

 
          

 

For measuring the main lobe amplitude, change the attenuator of 

the spectrum analyzer and verify that the main lobe amplitude does not 

change with it. If the change exceeds 1dB, the spectrum analyzer is in 

the gain compression state, and the attenuation of the attenuator must 

be increased. 

Notice 
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Figure 5-25 Point Frequency Source Output Signal 

5.1.10 Interference map (option) 

The interference map option can be used for RSSI test and ACPR test, and the test results can be 
marked on the map in real time according to time or distance. The test results on the map can be 
saved in the instrument for future recalling. Because the offline map is too large, the map stored 
internally when the instrument leaves the factory is the map of the user's province or country. 
Maps of other provinces or countries can be downloaded from the external network disk or the 
Company's website, and the downloaded maps are placed in the offline map folder of the 
instrument or SD card. 

5.1.10.1 RSSI measurement 

RSSI measurements are set as follows: 

a) Press 【Measure】→[Interference Map]→[Interference Map Off On]. By default, when the 

interference map switch is turned on, the measurement mode is RSSI measurement; 

b) Press 【Measure】→[Center Freq] to set the frequency of the signal to be measured. 

c) Press【Measure】→[Inference Map]→[Measure] →[RSSI] to set the colors marked on the map 

for different powers of the received signal. 

d) Press 【Measure】 →[Interference Map] →[Distance Time] → [Repetition Type Time Distance] 

to set the method according to time interval or moving distance when marking information on 
the map. 

e) Press 【Measure】 →[Interference Map] →[Distance Time] → [Repetition Time] to set the time 

interval of data marking on the map. 

f) Press 【Measure】 →[Interference Map] →[Distance Time] → [Repetition Time] to set the 

distance of data marking on the map. 

g) Press 【Measure】 →[Interference Map]→[Start Acquisition] to start RSSI test and mark the 

test results on the map. 

5.1.10.2 Adjacent channel power ratio (ACPR) measurement 

ACPR measurements are set as follows: 

a) Press 【Measure】→[Interference Map]→[Interference Map Off On]. By default, when the 
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interference map switch is turned on, the measurement mode is RSSI measurement; 

b) Press 【Measure】→[Center Freq] to set the frequency of the signal to be measured. 

c) Press【Measure】 →[Interference Map]→ [Measure]→[ACPR] to set the adjacent channel 

power ratio measurement. 

d) Press【Measure】 →[Interference Map]→ [Measure]→[ACPR] →[Main CHBW] to set the main 

channel bandwidth. 

e) Press【Measure】 →[Interference Map]→ [Measure]→[ACPR] →[Adj CHBW] to set the 

adjacent channel bandwidth. 

f) Press【Measure】 →[Interference Map]→ [Measure]→[ACPR] →[Ch Space] to set the 

channel space. 

g) Press 【Measure】 →[Interference Map] →[Distance/Time] → [Repetition Type Time Distance] 

to set the method according to time interval or moving distance when marking information on 
the map. 

h) Press 【Measure】 →[Interference Map] →[Distance/Time] → [Repetition Time] to set the 

time interval of data marking on the map. 

i) Press 【Measure】 →[Interference Map] →[Distance/Time] → [Repetition Time] to set the 

distance of data marking on the map. 

j) Press 【Measure】 →[Interference Map]→[Start Acquisition] to start ACPR test and mark the 

test results on the map. 
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5.2 Menu Structure 
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Figure 5-28 Structure of Frequency, Amplitude, Bandwidth and Marker Menu 
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Figure 5-29 Structure of Sweep, Trace and Limit Menu 
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存储状态

文件
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Figure 5-30 Structure of Peak and File Menu  
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Figure 5-31 Measure Menu Structure 
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Figure 5-32 Measure Menu Structure 
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5.3 Menu Description 

5.3.1 Frequency menu 1/2 

中心频率
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信道号
--

>

>

翻页1/2

 

·[Center frequency]: Press 【Freq】 → [Center Frequency], select 

[GHz], [MHz], [kHz] and [Hz] in the frequency unit menu with the 

numeric keys on the front panel, or use the 【↑】【↓】keys and the knob 

to set the center frequency value.  

·[Span]: Press【Freq】→[Sweep] and open the span setting submenu. 

For details, please refer to the description of the [Span] menu.  

·[Start frequency]: Press 【Freq】→ [Start Frequency] to select [GHz], 

[MHz], [kHz] and [Hz] in the frequency unit menu with the numeric keys 

on the front panel, or use the 【↑】【↓】 keys and the knob to set the start 

frequency value.  

·[Stop Frequency]: Press 【Freq】→ [Stop Frequency] to select [GHz], 

[MHz], [kHz] and [Hz] in the frequency unit menu with the numeric keys 

on the front panel, or use the 【↑】【↓】 keys and the knob to set the stop 

frequency value.  

·[Step Frequency]: Press 【Freq】→ [Step Frequency] to select [GHz], 

[MHz], [kHz] and [Hz] in the frequency unit menu with the numeric keys 

on the front panel, or use the 【↑】【↓】 keys and the knob to set the step 

frequency value.  

·[Signal Standard]: Click this menu to pop up the signal standard 

menu, including[Header],[Footer],[Page Up],[Page Down],[Recall 

Immediately]and other soft menus, press [Recall Immediately]to select 

the required signal standard file.  

·[Channel No.]: Click the menu to display the content and number of 

the selected signal standard.  

·[Special Notes]: The setting of the channel number shall be carried 

out under the premise of loading the signal standard, otherwise a 

prompt that it cannot be set will pop up.  
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5.3.2 Frequency menu 2/2 

信号跟踪

关         开

频率

信号搜索

翻页2/2

 

·[Signal Tracking Off On]: Click this menu, and select whether to 

track the signal.  After each sweep, the signal tracking function will 

place the activated marker on the peak point of the signal and set the 

peak frequency as the center frequency. Enable [Signal Tracking On 

Off] to automatically keep the slowly drifting signal in the center of the 

display screen. 

·[Signal Search]: Click this menu, the menu will search for the signal 

within the current span, and place the activated marker on the peak 

point of the signal. In case of no signal within the current span, the 

prompt of search failure will be given.  

·[Channel No.]: Click the menu to display the content and number of 

the selected signal standard.  

·[Special Notes]: The setting of the channel number shall be carried 

out under the premise of loading the signal standard, otherwise a 

prompt that it cannot be set will pop up.  

5.3.3 Sweep menu 

扫宽

扫宽

全扫宽

零扫宽

上次扫宽

<   返回

>

 

·[Span]: Press 【Freq】 → [Span] to set the span value in the current 

state. Then select [GHz], [MHz], [kHz] and [Hz] in the frequency unit 

menu with the numeric keys on the front panel, or press the [↑], [↓] 

keys and the knob to set the span. The span is stepped by1,2and5.  

·[Full Span]: Press 【Freq】 →  [Span] →[Full Span] to set the span 

in the current measurement state as the maximum span value.  

·[Zero Span]: Press 【Freq】 → [Span] →[Zero Span] to set the span 

in the current measurement state as the minimum span value and set 

the full span value as 0Hz.  

·[Last Span]: Press【Freq】 →  [Span] → [Last Span], and set the 

span in the current measurement state as the span value set last time.  

·[Special Notes]: Full and zero span functions are invalid when 

some measurement functions are enabled.  
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5.3.4 Amplitude menu 

参考电平
0.0dBm

幅度

参考位置

衰减器

自动   手动

刻度/格
10.0dB

刻度类型

对数  线性

幅度单位
dBm

前置放大器

关           开

>

 

·[Ref Level]: Press [Amplitude] → [Ref Level], and then select [dBuV], 

[-dBuV], [mV] and [uV] in the frequency unit menu with the numeric 

keys on the front panel, or use the 【↑】【↓】keys and the knob to set it.  

·[Ref Pos]: Press【Amplitude】→ [Ref Pos], and select the position of 

the reference line in the rectangular coordinate graph by clicking the 

corresponding numeric key.  

·[Atten Auto/Man]: Press 【Amplitude】→[Atten Auto Man] to adjust 

the input attenuation of the spectrum analyzer. In the automatic mode, 

the input attenuator is associated with the reference level. In the 

manual mode, the attenuation of the attenuator can be adjusted by 

numeric keys, step key or knob. The attenuation range is 0dB ~ 50dB.  

·[Scale/Div]: Press 【Amplitude】→[Scale/Div] to adjust the size of the 

screen grid line. Then select the frequency unit with the numeric keys 

on the front panel, or use the 【↑】【↓】 keys and the rotating knob to set 

it. Select between 0.1dB/div and 20dB/div. The default value is 

10dB/div. 

·[Scale Log Line]: Press【Amplitude】→[Scale  Log Line] to select the 

vertical axis scale type of log or linear. Log scale is generally in dBm, 

and linear scale is generally in mV by default.  

·[Amp Unit] Press【Amplitude】→[Amp Unit], and select the units of the 

vertical axis, including [dBm], [dBmV], [dBuV], [Volt], and [Watt].  

·[Pre Amp Off On]: This function is used to control the On/Off state of 

the preamplifier. Such function will be activated only when the 

reference level is less than-40dBm.  

·[Special Notes]: When the preamplifier is opened, don‘t input the 

signal of>+13dbm, otherwise the instrument will be damaged.  
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5.3.5 Bandwidth menu 

分辨率带宽

自动     手动

带宽

视频带宽

自动     手动

平均

关         开

SPAN/RBW
100

RBW/VBW
1

检波

自动
>

 

·[RBW Auto Man]: Press 【BW】, [RBW Auto Man], and set the 

resolution bandwidth from 1Hz to 10MHz. In manual mode, the 

resolution bandwidth can be changed in steps of 1, 3 and 10with 

numeric keys, step key or knob. In automatic mode, it changes with the 

span at the SPAN/RBW ratio. The 10 MHz resolution bandwidth is not 

automatically associated with the span and needs to be set manually. 

·[VBW Auto Man]: Press 【BW】  → [VBW Auto Man]to adjust the 

video bandwidth displayed in the active function zone. Adjust the video 

bandwidth with the range from 1Hz to 10MHz. In manual mode, use 

the numeric keys, step keys or knob to change the video bandwidth in 

steps of 1, 3, and 10. In the automatic mode, the RBW/VBW ratio 

changes with resolution bandwidth.  

·[Ave Off On]: Press 【BW】 → [Ava Off/On] to select the averaging 

function. This function continuously averages the traces to achieve a 

smooth trace. 

·[SPAN/RBW]: press 【BW】→ [SPAN/RBW] to set the ratio of current 

frequency bandwidth to resolution bandwidth and display it in the input 

area. The default value is 100. This ratio is used in the correlation 

mode of resolution bandwidth.  

·[RBW/VBW]: press 【BW】→[RBW/VBW] to set the ratio of current 

video bandwidth to resolution bandwidth.  The default value is 1. If the 

resolution bandwidth changes, the video bandwidth will automatically 

change to meet the ratio when it is automatic. The ratio is displayed in 

the input zone and used in the association mode of two bandwidths. If 

a new ratio is selected, the video bandwidth is changed to meet the 

new ratio, while the resolution bandwidth remains unchanged. 

·[Detection]:  press 【BW】 → [Detection] to pop up the soft menu of 

setting detection mode. For details, please refer to the description 

of[Detection]menu. 
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5.3.6 Detection menu 

自动

检波

标准

正峰值

负峰值

取样

均值

均方根

< 返回

 

·[Auto]: Enter the detection menu, and it will automatically default to 

the normal mode.  

·[Normal] In this mode, when noise is detected, the measurement 

results of positive and negative peaks are displayed simultaneously to 

achieve a similar display effect to the analog instrument. However, only 

positive peak is displayed when the signal is detected. This is the most 

common method of detector. The signal and noise base can be seen 

simultaneously without losing any signal. 

·[PosPeak]: Select the positive peak detection mode. Make sure that 

no peak signals are missed, which is suitable for measuring signals 

that are very close to the noise base. Select the positive peak detector 

when [Max Hold]. 

·[NegPeak]: Select the negative peak detection mode. This mode 

enables the trace to display a negative peak level. In most cases, it is 

used in self-tests of the broadband millimeter wave spectrum analyzer 

and is rarely used in measurements. It can fully reproduce the 

modulation envelope of the AM signal. Select the negative peak 

detector when  [Min Hold]. 

·[Sample]: Set the detector to sample detection mode. It is suitable for 

measuring noise signals and can measure noise better than normal 

detection methods. It is usually used for video averaging and noise 

frequency marker functions. 

·[Ave]: Set the detector to average detection mode. The average of 

the sampled data of the trace in each sampling interval is displayed in 

the average detection mode. 

·[Rms]: Set the detector to Rms detection mode. The average of the 

sampled data of the trace in each sampling interval is displayed in the 

Rms detection mode. 

·[Back]: return to the previous menu.  
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5.3.7 Marker menu 

光标
1 2 3 4 5 6

光标

普通模式

差值模式

噪声光标

关         开

计数器

关 开

光标-> >

光标关闭

全部关闭

 

·[Marker 1 2 3 4 5 6]: Press【Mkr】→ [Marker 1 2 3 4 5 6] to select 

different frequency markers, activate a single frequency marker, place 

the frequency marker in the center of the trace, and display these 

values in the frequency marker display area in the upper right corner of 

the screen.  

·[Normal Mode]: Press【Mkr】→[Normal Mode] to display the 

frequency and amplitude of the frequency marker. Use the knob, step 

key or numeric key to move the active frequency marker. The 

displayed amplitude difference is in dBby default.  

·[Difference Mode]: Press 【Mkr】→[Difference Mode] to display the 

amplitude difference and frequency difference between the two 

frequency markers (time difference in case of zero bandwidth). Use the 

knob, step key or numeric key to move the active frequency marker. 

The displayed amplitude difference is in dB by default.  

·[Noise Mkr Off On]: Press【Mkr】→[Noise Mkr Off On] and select 

noise marker ON/OFF. When the menu is on, activate the noise 

marker. The noise marker will read noise power near the activated 

marker that is normalized to the 1 Hz bandwidth. At this time, the 

detector is in the Rms detection mode.  

·[Counter Off On]: Press【Mkr】→[Counter Off On] to open or close the 

frequency marker count function. If the frequency marker is not 

currently activated, an active frequency marker will be activated in the 

middle of the screen when the frequency marker count function is 

enabled.  

·[Mkr]: By pressing【Mkr】→[Mkr→], soft menus related to the marker 

function pop up, which are related to whether the frequency, bandwidth 

and frequency marker of the spectrum analyzer are in normal or 

difference frequency marker mode. These marker functions allow the 

user to change the settings of the spectrum analyzer with the marker 

as a reference.  

·[Marker Off]: Press 【Mkr】 → [Mkr Off] to close the currently 

selected marker and its related functions, such as: [Noise marker]. 

·[All Off]: Press 【Mkr】 → [All Off] to close all markers and their 

related functions, such as: [Noise marker]. 
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光标->

中心频率

光标->

光标->

步进频率

光标->

起始频率

光标->

终止频率

光标->

终止频率

< 返回

 

·[Mkr→Center Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Center Freq], 

the marker will move to the center frequency, and the reading at the 

center frequency is displayed on the screen.  

·[Mkr →Step Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Step Freq] to set 

the stepping amount of the center frequency, that is, the value of the 

frequency step is equal to the marker frequency. If the difference 

marker function is activated, the frequency step value is equal to the 

frequency of the difference marker.  

·[Mkr →Start Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Start Freq] to set 

the start frequency equal to the marker frequency.  

·[Mkr →Stop Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Stop Freq] to set 

the stop frequency equal to the marker frequency.  

·[Back]: Return to the previous menu 
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5.3.8 Measurement menu 

场强测量

测量

通道功率

占用带宽

邻道功率

杂散模板

载噪比

>

关闭测量

翻页1/2 >

>

>

>

>

>

 

·[Field Strength Meter]: Press 【Measure】→[Field Strength 

Measurement], select the field strength measurement function, and 

call out the relevant function menu.  For details, please refer to the 

menu description of [Field Strength Measurement].  

·[Ch Power]: Press 【Measure】→[CHPower], select the channel 

power function, and call out the relevant function menu. For details, 

please refer to the menu description of [CHPower].  

·[OBW]: Press 【Measure】→[OBW], select the occupied bandwidth 

function, and call out the relevant function menu.  For details, please 

refer to the menu description of [OBW].   

·[Adj CH Power]: Press 【Measure】→[Adj CH Power], select the 

adjacent channel power function, and call out the relevant function 

menu.  For details, please refer to the menu description of [Adj CH 

Power].  

·[Stray Template]: Press 【Measure】→[Stray Template], select the 

stray template function, and call out the relevant function menu. For 

details, please refer to the menu description of [Stray Template].  

·[Carrier-to-Noise Ratio]: Press 【Measure】→[Carrier-to-Noise 

Ratio], select the carrier-to-noise Ratio measurement function, and call 

out the relevant function menu.  For details, please refer to the menu 

description of [Carrier-to-Noise Ratio].  

·[Close Measurement]: Press 【Measure】→[Close Measurement] 

and close measurement.  

音频解调

IQ捕获

测量

关闭测量

翻页2/2 >

>

>

 

·[Audio Demodulation]: Press【Measure】→[Page Down 1/2]→[Audio 

Demodulation] to start the audio demodulation function.  For details, 

please refer to the menu description of [Audio Demodulation].  

·[IQ Capture]: Press【Measure】→[Page Down 1/2]→[IQ Capture] to 

start the IQ capture function.  For details, please refer to the menu 

description of [IQ Capture].  

The spectrum analyzer provides the function of field strength measurement, including} [Field 

Strength Off On], [Recall Antenna], [Edit Antenna], [Save Antenna] and other related soft menus. 

With the corresponding test antenna, the field strength test can be carried out quickly. 
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场强

关 开

场强

调用天线

编辑天线

>

<   返回

>

保存天线

>

 

·[Field Strength Off On]: Press【Measure】→[Field Strength 

Measurement]→[Field Measurement Off On] to start or stop the field 

strength measurement function.  

·[Recall Antenna]: Press【Measure】→[Field Strength 

Measurement]→[Recall Antenna], soft menus such as [Header], 

[Footer], [Last Page], [Next Page], [Recall Immediately] and [Delete] 

pop up, and you can select and call the saved antenna factor file in the 

spectrum analyzer  

·[Edit Antenna]: Press【Measure】→[Field Strength 

Measurement]→[Edit Antenna] to pop up[Add Edit Point],[Delete Edit 

Point],[Clear Edit Point],[Complete Editing],[Cancel Editing]and other 

soft menus for editing antenna factors.  

·[Save Antenna]: Press【Measure】→[Field Strength 

Measurement]→[Save Antenna] to save the antenna factor.  

·[Back]: Press【Measure】→[Field Strength Measurement]→[Back] to 

exit the field strength menu and return to the measurement menu.  

The spectrum analyzer provides the channel power measurement function. The channel power of 

the signal can be measured by setting the relevant parameters in the function menu and selecting 

the appropriate resolution bandwidth and sweep width. Please refer to Section 1 Channel Power 

Measurement of this chapter for specific operations. 

通道功率

关         开

通道功率

中心频率

通道带宽

通道扫宽

<   返回

>

 

·[Ch Power Off On]: Press 【Measure】→[Ch Power] →[Ch Power Off 

On] to start or stop the channel power measurement. 

·[Center frequency]: Press 【Measure】→[Ch Power] →[Center Freq] 

and set the center frequency with numeric keys. 

·[Ch BW]: Press 【Measure】→[Channel Power] → [Channel 

Bandwidth] and set the channel bandwidth with the numeric keys. 

·[Channel Span]: Press 【Measure】→[Channel Power] → [Channel 

Span] and set the channel span with the numeric keys. 

·[Special Notes]: The channel power bandwidth is a frequency width 

of the power displayed by the spectrum analyzer within this bandwidth, 

while the channel power span is the frequency range over which the 

spectrum analyzer sweeps. The channel power span should be set to 

be greater than or equal to the channel power bandwidth. Otherwise, 

the spectrum analyzer will automatically set the channel bandwidth 

equal to the channel power span. The ratio of channel power span to 

channel power bandwidth remains constant. This ratio remains 

constant as the channel power span changes. Changing the channel 

power bandwidth can change this ratio. For example, when the 

channel power span is doubled, the spectrum analyzer will also 

increase the channel power bandwidth by the same factor. 

The occupied bandwidth measurement of the spectrum analyzer can present the measurement 

results in a quick, clear and accurate manner. There are two methods for calculating the occupied 
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bandwidth depending on the modulation method: power percentage method and power drop XdB 

method. Users can choose the appropriate bandwidth measurement method according to their 

own needs. Please refer to Section 1 Occupied Bandwidth Measurement of this Chapter for 

specific operations. 

占用带宽

关         开

占用带宽

测量方法

百分比   XdB

百分比
99.00%

XdB
-3.00dB

通道扫宽

<   返回

>

 

·[OBW Off On]: Press【Measure】→[OBW]→[OBW Off On] to start or 

stop the OBW measurement function.   

·[Measurement method]: Press 【Measure】→[OWB] 

→[Measurement Method % XdB] to select the measurement methods, 

including percentage method and drop XdB method.  The occupied 

bandwidth of the signal is obtained by calculating the bandwidth of the 

portion of the frequency containing a certain percentage of the total 

transmitted signal power, and the percentage of power can be set by 

the user. The descending XdB method defines the occupied bandwidth 

as: the distance between the two frequency points when the signal 

power drops by XdB on both sides of the frequency point where the 

peak power of the signal is located. The X dB of the signal power drop 

is set by the user. 

·[Percent]: Press 【Measure】 →[OWB]→ [Percentage]. If the 

percentage measurement method is selected, it is used to set the 

percentage of power.  

·[XdB]: Press 【Measure】 →[OWB]→[XdB]. If the drop XdB method 

is selected, you can set the XdB value of signal power drop.  

·[Channel Span]: Press 【Measure】 →[OWB]→[Channel Sweep] to 

set the sweep width of occupied bandwidth measurement.  

The spectrum analyzer has the measurement function of adjacent channel power ratio. Users can 

obtain the measurement results of adjacent channel power ratio by setting channel related 

parameters. The threshold test function will facilitate the user to define the adjacent channel 

threshold and observe whether the adjacent channel power exceeds the set range. Please refer to 

Section 1 Adjacent Channel Power Ratio Measurement of this chapter for specific operations. 
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<  返回
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·[ACPR Off On]: Press 【Measure】→[ACPR] →[ACPR Off On] to start 

or stop the ACPR measurement. 

·[Center frequency]: Press 【Measure】→[ACPR] →[Center Freq] and 

set the center frequency with numeric keys.  

·[Main Ch BW]: Press 【Measure】→[ACPR] → [Main CHBW] and set 

the main channel bandwidth with the numeric keys.  

·[Adj  Ch BW]: Press 【Measure】→[ACPR] → [AdjCHBW] and set 

the adjacent channel bandwidth with the numeric keys.  

·[Ch Offset]: Press 【Measure】→[ACPR] → [Ch Offset] and set the 

channel offset with the numeric keys.  

 

门限测试

关         开

上邻道门限
0.0dB

邻道功率

<  返回

下邻道门限
0.0dB

翻页2/2

 

·[Threshold Test Off On]: Press 【Measure】→[ACPR] → [Threshold 

Test Off On] to start or stop the tests for the upper and lower adjacent 

channel power thresholds.  

·[Upper Adj Ch Threshold]: Press 【Measure】→[ACPR] → [Upper 

Adj Ch Threshold] to set the power threshold of upper adjacent 

channel test.   

·[Lower Adj Ch Threshold]: Press 【Measure】→[ACPR] → [Lower 

Adj Ch Threshold] to set the power threshold of lower adjacent channel 

test.   

·[Special Notes]: When the threshold test function is started, if the 

adjacent channel power ratio exceeds the set threshold, it will be 

marked with a red background. 

 

The spectrum analyzer has the function of carrier-to-noise ratio measurement which is used to 

measure the ratio of carrier power to noise power. 



4957B RF Analyzer User Manuals 

 Spectrum analysis mode 

 111 / 248 

 

载噪比

关        开

中心频率

载噪比

<  返回

载波带宽
3.000MHz

噪声带宽
3.000MHz

频率偏移
3.000MHz

 

·[CNR Off On]: Press 【Measure】→[CNR]→[CNR  Off On] and start 

or stop the carrier-to-noise ratio function. 

·[Center frequency]: Press 【Measure】→[CNR] →[Center Freq] and 

set the center frequency with numeric keys.   

·[Carrier Bandwidth]: Press 【Measure】→[CNR] →[Carrier 

Bandwidth]  and set the carrier bandwidth with numeric keys, with the 

default value of3MHz.  

·[Noise BW]: Press 【Measure】→[CNR] →[Noise BW]  and set the 

noise bandwidth with numeric keys, with the default value of3MHz.  

·[Freq Offset]: Press 【Measure】→[CNR] →[Freq Offset] and set the 

frequency offset with numeric keys, with the default value of3MHz.  

 

The function of stray template is to recall the limit line as a template to measure whether the signal 

power is limited by the template. The template can move up and down left and right according to 

the center frequency and reference power. The template always moves the center point of the limit 

line left and right to the center frequency, and moves the center point up and down to the 

reference power point according to the calculated reference power. 

杂散模板

关        开

杂散模板

参考通道带宽
1.000MHz

调用极限

文件到模板

参考功率

峰值    通道

峰值光标

关          开

终止频率

步进频率

自动 手动

信号跟踪

关         开

上页信息

下页信息

<    返回

>

 

·[Stray Template Off On]: Press 【Measure】→[Stray 

Template]→[Stray Template Off On]  to start or stop the stray template 

function.  

·[Ref Ch BW]: Press 【Measure】→[Stray Template] → [Ref Ch BW] 

and set the reference channel bandwidth with the numeric keys.  

·[Recall Limit Line]: Press 【Measure】→[Stray Template] →[Recall 

Limit Line] and show related soft menus, 

including[Header],[Footer],[Page Up],[Page Down],[Recall 

Immediately]and[Delete], the user can select the limit file to be 

recalled.  

·[Ref Power]: Press 【Measure】→[Stray Template] →[Ref Power] to 

set the mode of reference power setting, including taking peak power 

as reference power or channel power as reference power.  

·[Peak Mkr Off On]: Press 【Measure】→[Stray Template]  →[Peak 

Mkr Off on] to open or close the peak marker.  

·[Information on Last Page]: Press 【Measure】→[Stray Template] 

→[Information on Last Page] to view the information on the last page.  

·[Information on Next Page]: Press 【Measure】→[Stray Template] 

→[Information on Next Page] to view the information on the next page. 
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The IQ capture function is to capture the original IQ data with the capture time, sampling rate, 

capture mode and other parameters set by the user, and save them as a data file for data analysis. 

IQ捕获

关         开

开始捕获

IQ捕获

捕获时间
1.000ms

捕获模式

单次    连续

采样率
5.000MHz

触发

[自由触发]

存储名称
[IQCapt...]

<    返回

>

 

·[IQ Capture Off On]: Press【Measure】→[Page Down 1/2]→[IQ Capture]→[IQ 

Capture Off On] to start or stop the IQ capture function.  

·[Start Capture]: Press【Measure】→[Page Down 1/2]→[IQ Capture]→[Start 

Capture] and select to start IQ capture  

·[Capture Time]: Press【Measure】→[Page Down 1/2]→[IQ Capture]→[Capture 

Time] to set the IQ capture time. 

·[Capture Mode]: Press【Measure】→[Page Down 1/2]→[IQ 

Capture]→[Capture mode] to set the mode of IQ capture as single or 

continuous. If the capture mode is set as single, the capture will end only once. 

If the capture mode is multiple times, the sweep thread will capture once after 

each sweep. The capture will stop only when the user sets to Stop Capture.  

·[Sampling Rate]: Press【Measure】→[Page Down 1/2]→[IQ 

Capture]→[Sampling Rate] to set the sampling rate of IQ capture. 

·[Trig]: Press【Measure】→[Page Down 1/2]→[IQ Capture]→[Trigger]. The 

trigger methods include [Freerun] and [External Trigger]. Select external trigger 

to set [Trigger Polarity] and [Trigger Delay]. 

·[Save Name]: Press【Measure】→[Page Down 1/2]→[IQ Capture]→[Save 

Name] to save the captured data.  

 

音频解调

关        开

音频解调

解调类型

调频

解调时间
100.00ms

解调模式

间歇    连续

音量
95

信号跟踪

关         开
<    返回

>

>

 

·[Audio Demodulation Off On]: Press【Measure】→[Page Down 

1/2]→[Audio Demodulation]→[Audio Demodulation Off On] to start or stop 

the audio demodulation function. 

·[Demodulation type]: Press 【Measure】→[Page Down 1/2]→[Audio 

Demodulation]→[Demodulation Type] to set the demodulation type. You 

can select the demodulation type of [FM], [AM], [Upper Sideband] or 

[Lower Sideband]. 

·[Demodulation Time]: [Page Down 1/2]→[Audio 

Demodulation]→[Demodulation Time] to set the demodulation time.  

·[Demodulation Mode]: Press 【Measure】→[Page Down 1/2]→[Audio 

Demodulation]→[Demodulation Time] to set the demodulation time.  Set 

the demodulation mode. In intermittent mode, the data is swept for one 

screen and then demodulated for a period of time according to the 

demodulation time, and then the data is swept for one screen and then 

demodulated for a period of time according to the demodulation time, and 

that cycle repeats.  In continuous mode, the data is continuously 

demodulated after being swept for one screen, and then the data is no 

longer swept. 

·[Volume]: Press 【Measure】→[Audio Demodulation]→[Volume] to set 



4957B RF Analyzer User Manuals 

 Spectrum analysis mode 

 113 / 248 

 

the speaker volume in the demodulation mode.   

5.3.9 Signal generation menu 

信号发生

信号发生

关   开

手动功率
-18.0 dBm

高功率

返回<

频率
3.25GHz

低功率

>

 

·[Signal Generation Off On]：Press 【Measure】→[Page Down 

1/2]→[Signal Generation]→[Signal Generation Off On] to set the signal 

source of the signal generation function ON or OFF. 

·[Freq 3.25GHz]： Press 【Measure】→[Page Down 1/2]→[Signal 

Generation]→[Freq 3.25GHz], press numeric keys and then soft unit keys to 

confirm your entry, or change the output frequency with【↑】【↓】keys and 

knob. 

·[High Power]: Press【Measure】→[Page Down 1/2]→[Signal 

Generation]→[High Power] and directly set the output power of the signal 

source to high power.  

·[Low Power]: Press【Measure】→[Page Down 1/2]→[Signal 

Generation]→[High Power] and directly set the output power of the signal 

source to low power.  

·[Manual Power -18dBm]: Press 【Measure】→[Page Down 1/2]→[Signal 

Generation]→[Manual Power -18dBm], press numeric keys and then soft 

unit keys to confirm your entry, or change the power with【↑】【↓】keys and 

knob.  

·[Special Notes]: The manual power is set to - 35 ~ - 10dBm, and the 

default value is - 18dBm. 
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干扰地图

干扰地图
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      存储调用 >

       测量  >

       距离时间 >

开始采集

放大

缩小

<          返回

 

·[Interference Map Off On]: Press【Measure】→[Page Down 

1/2]→[Interference Map]→[Interference Map Off On] to set interference 

map ON or OFF.  

·[Save/Recall]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Save/Recall] to open the save/recall submenu 

·【Measure】: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure] to open the measurement submenu 

·[Distance/Time]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Distance/Time] to open the distance/time measurement 

submenu.   

·[Start Acquisition]: Press【Measure】→[Page Down 

1/2]→[Interference Map]→[Start Acquisition]. and start data 

measurement and mark the location and measurement results on the 

map. The interval between two marks can be set through the 

[Distance/Time] menu.  

·[Zoom In]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Zoom In] and set map Zoom IN.  

·[Zoom Out]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Zoom Out]. and set map Zoom Out.  

 

存储调用

保存采集数据

保存CSV文件

保存BMP文件

调用采集数据

<          返回

 

·[Save Collected Data]: Press【Measure】→[Page Down 

1/2]→[Interference Map]→[Save/Recall]→[Save Collected Data] to 

store the collected data to the instrument.  

·[Save CSV File]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Save/Recall]→[Save CSV File] to store the collected data as a 

file in CSV format.   

·[Save BMP file]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Save/Recall]→[Save BMP File] to store the collected data as 

images. 

·[Recall Collected Data]: Press【Measure】→[Page Down 

1/2]→[Interference Map]→[Save/Recall]→[Recall Collected Data] to 

call out the stored historical data for viewing. 
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测量

           RSSI            >

    邻道功率比    >

中心频率

分辨率带宽

检波

自动

<          返回

>

 

·[RSSI]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[RSSI] to open the RSSI measurement 

submenu.  

·[ACPR]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[ACPR] to open the ACPR measurement 

submenu.   

·[Center Freq]: Press【Measure】→[Page Down 

1/2]→[Interference Map]→[Measure]→[Center Freq] and set the 

center frequency.   

·[RBW]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[RBW] and set the resolution bandwidth. 

·[Detection]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[Detection] to open the detection submenu.   

 

距离时间

重复类型

时间 距离

重复时间
10.000s

重复距离
100m

全部删除

 

·[Repetition Type]: Press【Measure】→[Page Down 

1/2]→[Interference Map]→[Distance/Time]→[Repetition Type] and 

set the repetition type.  

·[Repetition Time]: Press【Measure】→[Page Down 

1/2]→[Interference Map]→[Distance/Time]→[Repetition Time] and 

set the interval between two acquisitions. The time interval is valid 

if and only if the repetition type is set to time.  

·[Repetition Distance]: Press【Measure】→[Page Down 

1/2]→[Interference Map]→[Distance/Time]→[Repetition Distance] 

and set the distance between two acquisitions. The distance is 

valid if and only if the repetition type is set to distance.  

·[Del All]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Distance/Time]→[Del All] and delete all collected data on 

the map.  
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·[Excellent]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[RSSI]→[Excellent] and set the color when the 

measured signal is greater than this value.  

·[Very Good]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[RSSI]→[Very Good] and set the color when the 

measured signal is greater than this value. 

·[Good]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[RSSI]→[Good] and set the color when the 

measured signal is greater than this value.   

·[General]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[RSSI]→[General] and set the color when the 

measured signal is greater than this value. 

·[Poor]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[RSSI]→[Poor] and set the color when the 

measured signal is less than this value.   

 

 

<          返回

邻道功率比

主信道带宽
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·[Main Ch BW]: Press【Measure】→[Page Down 1/2] →[Interference 

Map]→ [Measure]→[ACPR] →[Main CHBW] and set the main 

channel bandwidth. 

·[Adj Ch BW]: Press【Measure】→[Page Down 1/2] →[Interference 

Map]→ [Measure]→[ACPR] →[Adj Ch BW] and set the adjacent 

channel bandwidth.   

·[CHSpace]: Press【Measure】→[Page Down 1/2] →[Interference 

Map]→ [Measure]→[ACPR] →[CHSpace] and set the channel space.  

·[Adj Ch Threshold]: Press【Measure】→[Page Down 1/2] 

→[Interference Map]→ [Measure]→[ACPR] →[Adj Ch Threshold] and 

set the adjacent channel threshold.  

·[Good]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[ACPR]→[Good] and set the color when the 

measured signal is greater than this value.   

·[Poor]: Press【Measure】→[Page Down 1/2]→[Interference 

Map]→[Measure]→[ACPR]→[Poor] and set the color when the 

measured signal is less than this value.  

 

 

5.3.11 Sweep menu 

The sweep time is the time required for the local oscillator of the spectrum analyzer to tune the 

selected frequency interval. It directly affects the time it takes to complete a test, and may vary 

from span, resolution bandwidth and video bandwidth. In automatic mode, the spectrum analyzer 
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will use the quickest sweep time after the measurement setup is completed. In the manual mode, 

the sweep time can be increased to meet specific measurement needs. 

In sweep mode, the default mode is linear sweep, and the list sweep function, as an option, can 

realize continuous sweep and measurement of multiple frequency bands, including editing list, 

save list and recalling list functions to facilitate the users. 

扫描点数
[1001]

触发

[自由触发]

扫描时间

自动   手动

扫描

扫描类型

连续   单次

重新扫描

扫描模式

线性   列表

编辑列表

存储列表

调用列表

>

>

扫描方式

[默认]
>

 

·[Swp Time Auto Man]: Press 【Swp】→ [Swp Time] to adjust the sweep 

time of the spectrum analyzer. Adjust the sweep time with numeric keys, 

step keys or the knob. The underlined Manual indicates that the sweep 

time can be set manually. When the automatic mode is selected, the 

sweep time will be automatically correlated based on the resolution 

bandwidth, frequency bandwidth and video bandwidth settings.  

·[Swp Type Cont Single]: Press 【Swp】→ [Swp Type] to set continuous 

sweep mode or single sweep mode.  

·[Swp Again]: Press 【Swp】→[Swp Again] and sweep again.  

·[Swp Mode]: Press 【Swp】→[Swp Mode] and set fast sweep or default 

sweep. 

·[Trigger]: Press 【Swp】→[Trigger] and select the trigger modes of 

sweeping, including [Freerun], [Video Trigger], [External Trigger], etc. 

Refer to the trigger menu for details.  

·[Swp Points]: Press 【Swp】→[Swp Points] and set the sweep points. 

Sweep points can be set as201,501,1001,2001and4001.  

·[Swp Mode Lin List]:  Press 【Swp】→ [Swp Mode] and select linear or 

list mode. Linear sweep refers to sweep at linear frequency spacings with 

equal frequency spacing between adjacent measurement points. The list 

mode is optional. In the list sweep mode, the spectrum analyzer sweeps 

based on the frequency range and other parameters set by the edited list.  

·[Edit List]:  This function is a list sweep option. Press 【Swp】 → [Page 

Down 1/2] →[Edit List], and open the list editing soft menu. The user can 

use [Add Edit Segment], [Delete Edit Segment] and [Clear All Segments] 

and other soft keys to manage and edit the sweep list. The selected 

sweep segment is represented by green font; After editing the sweep 

segment, press the [Complete Editing] soft key to confirm to return to the 

sweep submenu.  

·[Save List]: This function is a list sweep option. Press 【Swp】 → [Page 

Down 1/2]  →[Save List], and store the current edited list in the spectrum 

analyzer for subsequent recalls..  

·[Recall List]:  This function is a list sweep option. Press 【Swp】 → 

[Page Down 1/2]  →[Recall List], and the sweep list dialog box pops up 

to recall or delete the required sweep list.  
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5.3.12 Trigger menu 

Select the trigger mode of sweeping or measurement, including [Freerun], [Video Trigger], 

[External Trigger], [Trigger Polarity] and [trigger Delay]. The user can select the trigger mode 

based on the actual demand. 

自由触发

触发

视频触发

外部触发
1.50V

触发极性

正         负

触发延时
1.000us

>

<   返回

 

·[Freerun]: If the freerun is set after the一last continuous sweeping or 

single sweeping, a new sweep or measurement will be started. 

·[Video Trigger]: Set the trigger mode to video trigger. As long as the 

input signal exceeds the set video trigger level, sweeping will be 

triggered. The trigger level value can be set by numeric keys, step 

keys or knob, and the green line on the screen indicates the selected 

trigger level.  

·[External Trigger]: Set the spectrum analyzer to the external trigger 

mode. Select sweeping and measurement to synchronize with the next 

voltage cycle.  

·[Trigger Polarity]: The control level triggers the positive and negative 

polarity. .The positive polarity is triggered by the rising edge, and the 

negative polarity is triggered by the falling edge.  

·[Trigger delay]: It is allowed to set the time delay of level trigger. The 

spectrum analyzer will wait within this time period after receiving the 

external trigger signal and then start sweeping.  
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5.3.13 Trace menu 

The trace menu is used to set the display of trace, and the user can select refresh trace, maximum 

hold, minimum hold and other related settings according to different needs of user test. 

迹线
1   2   3

迹线

刷新迹线

最大保持

最小保持

保持迹线

隐藏迹线

 

·[Trace 1 2 3]: Press 【Trace】→【Trace 1 2 3】for trace selection. The 

spectrum analyzer provides traces 1, 2, 3, the selected trace number 

and the status menu item where the trace is located are underlined.  

·[Refresh trace]: Press 【Trace】→【Refresh Trace】to refresh all data 

of the previously displayed trace and continuously display the signal 

received by the spectrum analyzer in the sweep state.  

·[Max Hold]: Press 【Trace】→【Max Hold】to keep the maximum value 

of the points on the selected trace, and update the value with the new 

maximum value detected in each sweep. If the detection mode is 

automatic, it will switch to the positive peak detection mode.  

·[Min Hold]: Press 【Trace】→【Min Hold】to keep the minimum value 

of the points on the selected trace, and update the value with the new 

minimum value detected in each sweep. If the detection mode is 

automatic, it will switch to the negative peak detection mode.  

·[Hold Trace]: Press 【Trace】→【Hold Trace】to keep and display the 

amplitude data of the selected trace. However, such data won‘t be 

updated when the spectrum analyzer sweeps.  

·[Hide Trace]: Press 【Trace】→【Hide Trace】to process the signal 

on the background. However, such signal is not displayed on the 

screen.  
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5.3.14 Limit menu 

极限
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·[Limit Up Low]: Press 【Limit】→[Limit Up Low], and select the 

current limit line as the upper limit line or the lower limit line  

·[Limit Off On]: Press 【Limit】→[Limit Off On], and select limit function 

ON/OFF.  

·[Test Off On]: Press【Limit】→[Test Off On] to start/stop the limit line 

test.  

·[Edit Limit Line]: Press【Limit】→[Edit Limit Line]，

including[Frequency],[Amplitude],[Add Point],[Delete Point],[Last 

Point],[Next Point],[Set Default]]and other soft menus to view the 

frequency and amplitude of limit points and add or delete limit points.  

·[Offset]: Press【Limit】→ [Offset] to set the offset allowance.   

·[Audio Alarm Off On]: Press【Limit】→[Audio Alarm Off On] to set 

audio alarm On/Off. If the audio alarm is on and the upper and lower 

limit line test is on, the function is effective. If the limit is out of range 

when the upper and lower limit lines are swept on the current screen, 

the buzzer will give a short sound.  

·[Save Limit]: Press【Limit】→[Save Limit] to store the limit.  

·[Recall Limit]: Press【Limit】→[Recall Limit], 

including[Header],[Footer],[Last Page],[Next Page],[Recall 

Immediately],[Delete][Cancel]and other soft menus to call or delete 

saved limits.  
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5.3.15 Peak menu 

最大峰值

峰值
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峰值跟踪

关         开

光标->

中心频率
 

·[Max Peak]: Press【Peak】→[Max Peak] to place a frequency marker 

at the highest point of the trace and display the frequency and 

amplitude of the frequency marker in the upper right corner of the 

screen.  

·[Sub Peak]: Press 【Peak】→[Sub Peak] to move the active 

frequency marker to the next highest peak point on the trace that is 

associated with the current frequency marker position. Press the key 

again, and the user can find the lower peak point quickly.  

·[Left Peak]: Press 【Peak】→[Left Peak] to find the next peak to the 

left of the current frequency marker position. 

·[Right Peak]: Press 【Peak】→[Right Peak] to find the next peak to 

the right of the current frequency marker position.  

·[Max]: Press【Peak】→[Max] to place a marker at the highest point of 

the trace and display the frequency and amplitude of the marker in the 

upper right corner of the screen.  

·Min Peak] Press【Peak】→[Min] to place a marker at the lowest point 

of the trace and display the frequency and amplitude of the marker in 

the upper right corner of the screen.  

·[Peak Tracking Off On]: Press【Peak】→[Peak Tracking Off On]. If 

peak tracking is on, the current marker will perform a peak search 

operation after each sweep. If peak tracking is off, no operation will be 

performed.  

·[Mkr→]: Press【Peak】 → [Mkr →] to set the marker frequency equal 

to the center frequency. This function quickly moves the signal to the 

center of the screen. 
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5.3.16 File menu 
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·[StoreStateFile]: Press 【File】→[Save State] to save the current 

sweep status parameters.   

·[Recall Status]: Press【File】→[Recall State] to pop up the state file 

list. The soft menus, including[Header],[Footer],[Last Page],[Next 

Page],[Recall Immediately]and [Delete], are used to read the existing 

state file and recall the corresponding state parameters to the current 

sweep.  

·[Save Data]: Press【File】→[Save Data] to store trace data.  

·[Recall Data]: Press【File】→[Recall Data] to pop up the data file list. 

The soft menus, including[Header],[Footer],[Last Page],[Next 

Page],[Recall Immediately]and [Delete], are used to read the existing 

data files and recall the corresponding data to the current sweep.  

·[Save Image]: Press【File】→[Save Image] to capture the current 

screen image.  

·[Default State]: Press【File】→[Default State] to restore to factory 

settings.  

·[File Mgmnt]: Press 【File】→[File Mgmnt] to pop up the file 

management menu, including [Source File], [Target File],  [Start 

Copy], [Delete Files] and other relevant soft menus to copy and delete 

files.  

·[Storage location]: Press 【File】→[Storage Location] to select the 

storage location, the interior is the internal memory of the instrument, 

and the other optional locations are the memory and SD card of the 

USB interface. After the security feature option is selected, the internal 

memory cannot be selected.  

5.3.17 Security data menu 

In case of the security data option, the spectrum analyzer will not be able to select the internal 

memory, but only the memory and SD card with USB interface will be selected. 

 

内部

存储位置

SD卡

USB

<    返回

 

·[Internal]: Press 【File】→[Storage Location]→[Internal], the [Internal] 

is in a gray state and cannot be saved internally.  

·[SDCard]: Press 【File】→[Storage Location]→[SD card], and select 

Store Data to the SD card.  

·[USB]: Press【File】→[Storage Location] →[USB]and select Store Data 

to USB.  
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6 Cable and antenna feeder test mode (optional) 

6.1 Introduction to typical measurements 

The cable and antenna feeder test mode (CAT) is used for the contact performance tests of radar, 
antenna and feeder, Including VSWR, return loss, impedance and Distance-To-Fault (DTF). 

Start the instrument, press【Mode】to pop up the mode selection dialog box, then select [CAT] in 

the dialog box, and press [OK] to enter the CAT mode after the progress bar is completed. 

 

                               Figure 6-1 Main Interface of CAT 

 

 
 

All operations in this section are based on the premise of the selected 

CAT, which will not be described separately later. 

6.1.1 Selection of measurement parameters 

In the CAT mode,  the RF analyzer can measure the return loss, VSWR, impedance, cable loss 
and other parameters of the device under test, and also provides the fault point Distance-To-Fault 

(DTF) function to accurately locate the impedance mismatch point. Press the 【Measure】 key to 

select different measurement parameters. 

a) [Return Loss] , select the return loss parameter and display it in logarithmic format; 

b) [Cable Loss] , select the test parameter for cable loss; 

c) [VSWR] , select the test parameter as standing wave ratio; 

d) [DTF Return Loss] , select the test parameter fault location point for return loss test; 

e) [DTF VSWR] , select the test parameter fault location point for standing wave ratio test; 

f) [Impedance] , select the test parameter as impedance, and the coordinate system is Smith 
chart; 

g) [Smith] , select the test parameter as the Smith chart; 

h) [Phase] , select the test parameter as the reflection phase; 

6.1.2 Calibration 

The calibration in CAT mode is basically the same as that in vector network analysis mode. The 
calibration steps in antenna feeder test mode are as follows: 

Notice 
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a) Press the [Cal] key and the [Cal Kit]  key, select the calibration part model, and Press [OK] ; 

b) Press [M Cal], a message will pop up on the display: ―Please connect the open-circuit device 
to port 1, and press the corresponding menu button to start measuring!‖ Connect the 
open-circuit device to test port 1. Press [Opener], the RF analyzer will display ―cal std 
measuring...‖ during the measurement of standard piece. After the measurement and 
calculation of the error factor, the prompt message will pop up on the display: "please connect 
the short-circuit device on port 1, and then press the corresponding menu button to start 
measuring!‖ ‖; 

c) Remove the open-circuit device from test port 1, connect the short-circuit device, press 
[Short-circuit Device] , and a message pops up on the display: "Please connect the load on 
port 1, then press the corresponding menu button to start measurement!‖ ‖; 

d) Remove the short-circuit device from test port 1, connect the load, press [LOAD] , and a 
message will pop up on the display: "Press [Done] to complete the measurement!‖ ‖; 

e) Press [Done] to complete the calibration process of the cable and antenna analysis mode; 

After the calibration is complete, the calibration off On is displayed in the menu bar under 

calibration. Connect with the DUT for measurement. 

6.1.3 Marker function 

The marker function in CAT mode is the same as that in vector network analysis mode. 

6.1.4 Saving and recalling function 

The saving and recalling function in CAT mode is the same as that in vector network analysis 
mode. 

6.1.5 DTF measurement 

CAT provides DTF measurement function. The DTF (Distance-To-Fault) measurement, also 
known as the fault point location function, shows the magnitude of the response signal at different 
positions of the signal path of the kit under test, thus providing a basis for judging the impedance 
change on the transmission path. DTF measurements are also referred to as time domain 
measurements in some vector network analyzers, and the time domain measures the display time 
of x-axis and DTF measures the distance of  x-axis, and the relationship between the two is: 

Distance = time × speed of light × rate factor 
For the kit under test, the rate factor is a constant greater than zero and less than 1, and the speed 
of light is the rate at which light travels in a vacuum, so the distance and time are proportional. 

6.1.5.1 Principle of measurement 

In the usual measurement, the vector network analyzer displays the response of the kit under test 
as the change of frequency, which is called frequency domain measurement. The modern vector 
network analyzer obtains time domain data by inverse Fourier transform of the frequency domain 
data, and the measurement result is displayed as time on the X axis, and the response value 
appears at discrete time points, and the impedance change point of the kit under test can be 
analyzed. The following figure shows the frequency and time domain reflection measurements for 
the same cable, and this cable has two bends, each of which causes a mismatch in the 
transmission line or a change in impedance. 
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Limit

frequency Time  

Figure 6-2 Measurement of Frequency and Time Domain 

The frequency domain response of the S11 measured at the input port shows a combined 
reflection response due to multiple cable mismatch point interactions, but it is difficult to determine 
the exact physical location at which the cable mismatch occurs. 

The time domain response shows the location and magnitude of each impedance mismatch point. 
From the response we can see that there is a significant mismatch in the second bend of the 
cable. 

the RF analyzer's time domain measurement function simulates a traditional time domain 
reflection (TDR). The time domain reflexometer emits an impulse or step signal to the kit under 
test, and then observe the energy of the reflected signal. By analyzing the amplitude, duration and 
waveform of the reflected signal, the impedance change of the kit under test can be determined. If 
time domain measurement is performed in the cable and antenna mode but the incident impulse 
or step signal does not create, and the frequency sweep measurement is performed, then it will 
calculate the time domain information from the frequency domain measurement result by the 
Fourier algorithm, so it is also called the frequency domain reflexometer . 

The CAT mode of 4957Bis to measureS11 and then perform time domain conversion 
measurement. The S11 reflection measurement is not a simple display of the size of the reflected 
signal received by the A or B receiver, but shows the ratio measurement between the 
measurement receiver and reference receiver. The S11 ratio measurement can be used to 
remove system errors in the calibration. This is especially important for DTF measurements 
because the measurement reference plane is established by calibration, and the calibration point 
becomes the zero point of the X time axis, and all time and distance data will use this point as the 
reference point. In that case, time and amplitude data are very accurate due to calibration. The 
time domain measurement of the RF analyzer usually involves the following steps: 

a) Collect raw data of receiver (A and R) and perform a ratio operation; 

b) Perform error correction; 

c) Transform the frequency domain data into the time domain; 

d) Display measurement result 

6.1.5.2 DTF measurement resolution and range 

This Section discusses how to observe the effective DTF data of the device under test and how to 
make settings for the highest resolution and greater measurement range. 

1) Response Resolution 

The RF analyzer's DTF response resolution refers to the RF analyzer's ability to distinguish 
between two adjacent responses. For equal amplitude response, it is equal to the pulse width of 
the impulse response defined by the 50% (6dB) amplitude point, or the rise time of step response 

defined by 10%～90％ amplitude point as shown in the following figure: 
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Figure 6-3 Time Domain Response Resolution 

The time domain response resolution is subject to the several factors: 

A) Frequency span 

The figure below shows the effect of the frequency span on the response resolution: 
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Time

Time Domain

Time

Narrow Span

 

Figure 6-4 Effect of Frequency Span on the Response Resolution 

The time domain measurement response under a narrow frequency span shows that the impulse 

response pulses that should be separated independently overlap each other. The RF analyzer can 

distinguish between different response pulses when performing time domain measurements over 

a wide frequency span. 

The frequency span is inversely proportional to the pulse width. The wider the frequency span, the 

narrower the impulse response pulse, and the shorter the step response rise time, the higher the 

resolution of the response measurement. 

b) Window function 

If the cable and antenna mode is used for frequency time domain transformation, the length of 
data processed is limited. To reduce the effects of ringing caused by data truncation, the RF 
analyzer usually provides the option of windowing. Windowing can reduce the ringing effect and 
reduce the side lobes, but it will increase the width of the main lobe and reduce the resolution. 
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Figure 6-5 Using Window Filtering to Suppress Side Lobes 

4957B provides three kinds of window functions, which are maximum value, normal value, 
minimum value. The main lobe width and side lobe height of three kinds of window functions can 
select different window according to specific test needs. 

Small window

Large window

 

Figure 6-6 Effects of Different Windows 

6) Measurement Range 

In time domain measurements, the measurement range is defined as the maximum length of time 
that can be set, and no repeated response occurs when measurements are taken over this length 
of time. 

The measurement range is inversely proportional to the response resolution. If one is increased, 
the other is decreased. 

The time domain waveform is a periodic signal that repeats over time, so a repetitive response 
occurs. The repeated response (false response) is not the true response of the kit under test, 
which only occurs at specific time intervals (1/sweep point frequency interval), so the 
measurement range is determined by the frequency interval ΔF of the sweeping point: 
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For time domain measurements, the maximum measurable stop time is: 1/△F. In the reflection 

measurement, since the signal will circle within the kit to be tested, the maximum measurement 
distance is: 

 

∆F
∆F = 

Frequency span

Sweep points-1

Example:

Span=1GHz

Sweep points=201

△F=5 MHz

 

Figure 6-7 Definition of the Sweeping Point Frequency Space 

The measurement range is proportional to the number of sweep points -1, which is inversely 
proportional to the span. To improve the measurement range, the following two settings can be 
modified: 

·Increase the number of sweep points 

·Decrease the frequency span. 

6.1.5.3 Setting of time domain conversion measurement 

Before entering the DTF measurement mode, measurement parameters such as Meas Freq 
Range, Points, IF BW, etc. should be set up to complete single port calibration, and then the DTF 
test should be carried out according to the following steps. First, connect the tested cable to 
network port 1: 

a) Press 【Measure】 , press [DTF VSWR]  or [DTF Return Loss] to activate the time domain  

conversion function and enter the DTF measurement mode. 

b) Press 【Frep】, [Start Dist] , input the starting distance to be observed, and complete the input  

based on the corresponding distance unit; 

c) Press 【Frep】 , [Stop Dist] , enter the end distance to be observed, and complete the input  

based on corresponding distance unit; 

d) If you want to set the window function, press 【Frep】 , [Window >] , display the submenu of  

Distance=0.5*(sweep points -1/span)*C*Speed factor 
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[Window >] , and select different window functions; 

e) Press [Return] , [Unit m/ft] , set the required distance unit system; 

f) Press [Cable Specification>] , [Load Cable] , select the model of the cable to be tested in the  

cable model selection list, press [OK]  to complete the selection and close the dialog box; 

g) If there is no corresponding cable type, press [Cable Specification >] , [Cable Loss] , input the  

cable loss of cable to be tested, press [OK]  to complete the setting and close the dialog box; 

h) Press [Velocity]  and input the transmission rate factor of the device under test, press [OK]   

to complete the setting and close the dialog box. 

i) Observe and record the test results. 

6.2 Menu Structure 

This Section describes the menu structure of the 4957B RF analyzer in the antenna feeder test 
mode. 

The CAT mode includes 10 groups of primary menus such as ―Frequency‖, ―Amplitude‖, 
―Bandwidth‖, ―Marker‖, ―Measure‖, ―Sweep/set‖, ―Calibrate‖, ―Trace‖, ―Peak‖ and ―File‖. The 
―Measure‖, ―Frequency‖ and ―Calibrate‖ menus are illustrated in this section. For other menus, 
refer to the menu description in vector network analysis mode. 
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Figure 2-8 Menu Structure of ―Measure‖, ―Frequency/Distance‖ and ―Calibrate‖ 
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Only when the measurement format is "DTF return loss" and "DTF 

standing wave ratio", select 【 Freq 】  to display the 

【Frequency/Distance】 menu. 

 

6.3 Menu Description 

6.3.1 Frequency menu 

In the antenna feeder measurement mode and the DTF return loss and DTF standing wave ratio 

measurement format, press the 【Freq】 button, and the frequency and distance setting menus, 

including [Start Freq], [Stop Freq], [Start Dist], [Stop Dist] and [Cable Specification] pop up. 
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·[Start Freq]: Press 【Freq】→[Start Freq], use the numeric keys on 

the front panel, select the frequency unit, or use the 【↑】【↓】 keys and 

the knob for setting. 

·[Stop Freq]: Press 【Freq】→[Stop Freq], use the numeric keys on the 

front panel, select the frequency unit, or use the 【↑】【↓】 keys and the 

knob for setting. 

·[Start Dist]: Press 【Freq】 → [Start Dist], the default is 0.00m, and 

then select [m] in the right menu of the screen with a numeric key on 

the front panel, or set it with the 【↑】【↓】 keys and the knob. 

·[Special Notes]: With the 【↑】【↓】 keys and the knob, the increase 

or decrease step of the starting distance is 0.1m. 

·[Stop Dist]: Press 【Freq】 → [Stop Dist], and then select [m] in the 

right menu of the screen with a numeric key, or set it with the 【↑】【↓】 

keys and the knob. 

·[Cable Specification]: Press 【Freq】 → [Cable Specification] and 

switch to the setting menu of cable specification, including [Corr Mode 

Man Auto] , [Velocity], [Cable Loss], [Load Cable], [Edit Cable], [Save 

Cable], etc. 

·[Unit m ft]: Press 【Freq】 → [Unit m ft], and set the type of distance 

unit used for DTF measurements. 

·[Special Notes]: Metric units are m and English units are ft. 

·[WinFunc]: Switch to the window function menu and set the window 

function according to the corresponding menu item: rectangular 

window, nominal edge smoothing, low edge smoothing and minimum 

edge smoothing. 

 

Notice 
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6.3.2 Cable specification menu 
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·[Corr Mode Man Auto]: Press [Cable Specification] → [Corr Mode 

Man Auto] to set the cable parameter mode. When manually setting, 

use the menu item to set and display the rate factor and cable loss. 

When automatically setting, use the parameters of the loaded cable 

model. 

·[Velocity]: Press [Cable Specification] → [Velocity], enter the velocity 

with a numeric key on the front panel, and press [ ↲ ] key for 

confirmation; or set it with【↑】【↓】keys and the knob. 

·[Special Notes]: The velocity should not be greater than 1.000. If it is 

greater than 1.000, the software will automatically set it to 1.000. 

·[Cable Loss 0.00dB/ft]: Press [Cable Specification] → [Cable Loss], 

set the cable loss with a numeric key on the front panel with reference 

to actual parameters, and press[↲] key for confirmation. 

·[Load Cable]: Press [Cable Specification] → [Load Cable], and load 

the edited cable model. In the pop-up cable model list, select the cable 

model to be called, press [Recall] or [OK] to load the cable model. The 

cable parameters of the cable model are valid when the correction 

mode is automatic. 

·[Edit Cable]: Press [Cable Specification]→[Edit Cable], the Edit 

Cable dialog box pops up. In the dialog box, set the velocity and the 

cable loss at each frequency point to define a new cable model. After 

editing is complete, press [Done]  to complete the cable parameter 

setting. 

·[Save Cable]: Press [Cable Specification]→[Save Cable], the file 

naming box pops up. Edit the name of the cable model in the box and 

press[↲] to save the current cable model. 

6.3.3 Measurement menu 

Measurement menu in antenna feeder mode 
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测量

回波损耗

电缆损耗

驻波比

DTF回波损耗

DTF驻波比

史密斯>

高级>

相位

 

·[Return Loss]: Press【Measure】→[Return Loss], and set the 

measurement format to return loss. 

·[Cable Loss]: Press【Measure】→[Cable Loss], and set the cable loss 

for DTF measurement, and this parameter is valid when the correction 

mode is manual. After the setting tab is popped up, enter the value to 

be set with numeric keys, press the [OK]  key to complete the 

parameter setting, or adjust it by the step key or rotary knob. 

·[VSWR]: Press【Measure】→[VSWR], and set the measurement 

format to VSWR. 

·[DTF Return Loss]: Press【Measure】→[DTF Return Loss], and set 

the measurement format to DTF return loss. 

·[DTF VSWR]: Press 【 Measure 】 →[DTF VSWR], and set the 

measurement format to DTF VSWR. 

·[Smith]: Press 【Measure】→ [Smith], and set the measurement 

format as impedance chart, with the marker information of impedance 

chart displayed as linear, logarithmic, Re/Im, impedance ([R + JX]) and 

admittance ([G + JB]). 

·[Phase]: Press 【Measure】→[Phase]: Set the measurement format to 

phase. 

·[Advance]: Press 【 Measure 】 →[Advance>] to select the 

measurement parameters from A1, B1, R1 and S11. 

6.3.4 Smith menu 

史密斯

线性

对数

复数对

R+JX

G+JB

返回

 

·[Linear]: Press [Smith] → [Linear], and set the display format of 

marker information as linear in Smith format. 

·[Log]: Press [Smith] → [Log], and set the display format of marker 

information as log in Smith format. 

·[Re/Im]: Press [Smith] → [Re/Im], and set the display format of marker 

information as Re/Im in Smith format. 

·[R+JX]: Press [Smith] → [R+JX], and set the display format of marker 

information as impedance in Smith format. 

·[G+JB]: Press [Smith] → [G+JB], and set the display format of marker 

information as admittance in Smith format. 
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6.3.5 Calibration menu 

The calibration menu is the same as that in vector network analysis mode. 

校准

关 开

校准

校准件

机械校准

电子校准

>

继续校准 >

 

·[Cal Off On]: Press [Cal]→[Cal Off On] to turn the error correction on or off, 

and the calibration can only be turned on when the corresponding 

calibration is completed. 

·[Cal Kit]: Press [Cal]→[Cal Kit] to enter the calibration kit selection dialog 

box, and select the calibration kit type. 

·[Special Notes]: The mechanical calibration kit types include 31101A 

31101B 31121 31123 

·[M Cal]: Press [Cal] → [M Cal] and complete the relevant calibrations in the 

calibration steps, including open circuit, short circuit and load. 

·[E Cal]: Press [Cal]→[E Cal] to enter the electronic calibration dialog box, 

and click the down arrow on the touchscreen to select the 【Cal Port】: One 

port P1, one port P2, full 2 ports; click [Start], [Interrupt] and [Exit] for 

relevant operations of electronic calibration. 

·[Cal Cont]: Press [Cal] → [Cal Cont]. If the submenu type is consistent with 

the mechanical calibration, continue to complete the calibration. 

 

 

6.3.6 Mechanical calibration menu 

开路

机械校准

短路

负载

 

·[OPEN]: Press 【M Cal】→[Open] and select the calibration standard 

of OPEN. 

·[SHORT]: Press 【M Cal】→[Short] and select the calibration standard 

of SHORT. 

·[LOAD]: Press 【M Cal】→[Load] and select the calibration standard 

of Load. 

6.3.7 File menu 

Refer to the file menu in the vector network analysis mode 
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7 Vector voltmeter mode (optional) 

The 4957B Vector Voltage Measurement Mode (VVM)  is a convenient tool for phase matching of 
radio frequency cables, which is mainly used to measure the electrical length of cables or other 
kits to be measured. This mode can directly replace a vector voltmeter and has the same flexible 
and convenient operation interface as the vector voltmeter. The results of single port electrical 
length measurement are displayed in amplitude and phase formats, while the results of all port are 
only displayed in the amplitude format. 

As shown in the figure (a), measuring the electrical length of the kit under test with a vector 
voltmeter requires a directional coupler and a signal source to transmit the fixed carrier frequency. 

In the figure (b) below, the signal source and directional coupler are integrated into one instrument. 
Therefore, the kit under test can be directly connected through the RF output port of 4957B and 
are tested directly without any external devices. 

 

 

Figure 7-1 Measurement Structure Comparison of Vector Voltmeter and 4957B Vector Voltage 
Measurement Mode 

 

7.1 Introduction to typical measurements 

The vector voltmeter mode can directly replace a vector voltmeter to measure the electrical length 
of cables or other kits to be measured. 

After startup, press 【Mode】 to pop up a mode selection dialog box, select the [Vector Voltmeter], 

and press [OK] to enter the vector voltmeter mode after completing the progress bar. 
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Figure 6-2 Main Interface of Vector Voltmeter Mode 

 

 
 

All operations in this section are based on the premise of the selected 

vector voltmeter mode, which will not be described separately later. 

7.1.1 Frequency range setting 

Before performing the vector voltage measurement, set the frequency value of the point frequency 
signal to be tested. The frequency range of the 4957B instrument in vector voltage measurement 
mode is 30kHz~6.5GHz (4957B). The frequency range should be met during the setting, the 
corresponding button operations are as follows: 

a)  Press 【Frep】 and input the frequency value, and  complete the center frequency setting by 

pressing corresponding frequency unit on the touch screen. 

7.1.2 Setting of measurement port 

If reflection measurement is required at port 1, keep the default setting of the setting of the 

instrument analyzer. 

If reflection measurement is required at port 2, 

a)  Press 【Measure】  → [Meas Port 1 2] , switch [Meas Port 1 2]  and change the default 

measurement type from 1 port to 2 port. 

If transmission measurement is required, when the excitation source port is port 1 or port 2, switch 

with the same operation method. 

7.1.3 Calibration 

Before performing the vector voltage test, after completing the frequency setting and other 
measurement settings, calibration must be performed to eliminate the systematic error of the RF 
analyzer to ensure the validity and correctness of the measurement results. 

7.1.3.1 One port reflection error correction 

Single port correction can be conducted on  S11  or  S22  measurement of the instrument. 
The two processes are basically the same, the difference is that the selected parameters and 
ports. 

Notice 
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a) In vector voltage measurement mode, select the type of measurement you want to make: 

To measure reflection at port 1 (forward, S11), keep the default instrument settings. 

If reflection measurement (reverse, S22) is required at port 2, press  【Measure】 

→[Measurement Port 1 2],switch to [Measurement Port 1 2] , switch port 1 to port 2, and 

measure parameters automatically switch from S11 to S22. 

b) Set other parameters for measurement: Center frequency, measurement type is the default 
reflection measurement etc. 

c) Open the calibration menu, and press 【Calibrate】. 

d) Press 【Calibrate】  → [Cal Kit] to see if the calibration kit is consistent with the kit specified 

under the current softkey. If not, press the corresponding softkey to select the correct 

calibration kit model. Press [Back]  to return to 【Calibrate】  menu bar, press [M Cal >]  

and select the type to be corrected. 

a) If user wants to make a reflection measurement on port 1, press [S11 One Port] . 

b) To measure reflection at port 2, press [S22 One Port]. 

e) If it is on the port 1, the system will automatically prompt user to connect the open device to 
the port 1, and then press the corresponding menu button to start the measurement! At this 
time, connect the standard connector of the open-circuit device to the port to be used as the 
test port (P1 for S11, and P2 for S22). 

 
 

All adapters and cables to be used for device measurement shall be 

prepared, that is, to connect the standard device to the position for 

measurement. 

 

f) After the display trace is stable, to measure the normal part, press [OPEN] and analyzer will 
display ―Cal std measuring……‖ during the measurement of the normal kit. After the 
measurement is completed and the error coefficient is calculated , it will display the prompt 
of ‖Connect Short in P1, then press corresp. menu button to start!‖ And the software menu will 
be underlined to indicate that the project has been tested, such as [OPEN]. 

g) Disconnect the open device and connect the short device to the test port. 

h) When the trace to be displayed is stable, to measure the normal kit, press [Short-circuit 
Device], the analyzer will display ―Measuring……‖ during the measurement of the normal part. 
After the measurement is completed, it will display the prompt of ―Port 1 short measurement 
has completed. Connect load at P1, and press ‗Load‘‖ after measurement. Connect LOAD in 
P1, press ‗LOAD‘‖, and the software menu will be underlined to indicate that the project has 
been tested, such as [Short-circuit Device]. 

i) Disconnect the circuit breaker and connect the load to the test port. 

j) When the trace to be displayed is stable, to measure the normal kit, press [SHORT] and 
analyzer will display ―Cal std measuring……‖ during the measurement of the normal kit. After 
the measurement is completed and the error coefficient is calculated, it will display the prompt 
of ‖Connect load in P1, then press corresp. menu button to start!‖ And the software menu will 
be underlined to indicate that the project has been tested, such as [SHORT]. 

k) Press [Done] , the RF analyzer displays the corrected data trace indicating that the correction 
is enabled. 

 

That is to complete the single port calibration for reflected measurement. The DUT can be 

connected and measured at this time. 

 

Notice 
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The open-circuit device, short-circuit device and load can be measured 

in any sequence regardless that mentioned here. 

 

 

Figure 6-3 Standard Piece Connection of Single Port Reflection Error Correction 

7.1.3.2 Error correction of full 2 ports 

·Eliminate directional error during test component assembling in the forward and reverse 

directions 

·Eliminate source matching error during test component assembling in the forward and reverse 

directions 

·Eliminate load matching error during test component assembling in the forward and reverse 

directions 

· Eliminate isolation error during test component assembling in the forward and reverse directions 

· Remove the frequency response of the test component assembly in the forward and reverse 

directions 

 
 

This is a relatively accurate error correction process. The RF analyzer 

updates the measurement trace once via forward and reverse sweep, 

which takes more time compared with other correction process. 

 

a) Set parameters for device measurement: Frequency, measurement mode, measurement port,  

measurement format, relative measurement switch etc. Start frequency, stop frequency, 
output power, number of sweeping points or IF bandwidth. 

b) Open the calibration menu and press 【Calibrate】 . 

c) Press 【Calibrate】 and see if the calibration kit is consistent with the kit specified under the  

current softkey. If not, press the appropriate softkey to select the correct calibration kit model. 

d) Press [Back]  and return to the 【Calibrate】  menu bar, press [M Cal] , select the type to be  

corrected, press [Full 2 Ports] , the system will prompt to ―press [Reflect] to start the 
corresponding measurement! ‖  

Open-circuit device 

RF Analyzer 

Short-circuit device 
Short-circuit device 

Open-circuit device 

For S22 response For S11 response 

Load 
Load 

Notice 
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e) To start reflection measurement, press [Reflect>] to prompt ―Connect OPEN in P1,then press  

corresp. menu button to start!‖. connect the open circuit device to test port 1 according to the 
diagram, and after the display trace is stable, press [P1 OPEN], the analyzer will display "Cal 
std measuring..." during the measurement of the standard piece, and after completing the 
measurement, it will display the prompt "Connect SHORT in P1, then press corresp. menu 
button to start!" And the software menu will be underlined to indicate that the project has been 
tested, such as [P1 OPEN]. 

f) Disconnect the opener, and connect the short circuit device to the test port 1. After the display  

trace is stable, to measure the standard piece, press [P1 SHORT], the analyzer will display 
"calibration standard measurement …" during the measurement of the standard piece, and 
after completing the measurement, it will display the prompt "Port 1 Short Measure Done. 
Connect LOAD in P1, press ‗P1 LOAD‘‖, and the software menu will be underlined to indicate 
that the project has been tested, such as [P1 SHORT]. 

g) Disconnect the short-circuit device, connect the load to test port 1, and press [P1 LOAD] after  

the trace is stable to prompt ―Calibrating standard piece measurement...‖ during standard 
piece measurement, and prompt ―Connect the load to Port 1, then press corresp. menu button 
to start!‖ after measurement. At this time, underline of the menu indicates the item is tested 
completely, for example, [P1 LOAD]. 

h) Disconnect the load from P1, connect the open-circuit device, short-circuit device and load to  

P2 as per the same standard method with P1 in sequence, and complete the measurement 
on such standard pieces as S22 OPEN, SHORT and LOAD. 

i) After reflection calibration on P1 and P2, the prompt ―Press [Done] to complete the  

measurement.‖ Press [Done], and the system will calculate the reflection factor automatically. 

j) Return to previous menu for transmission calibration. Press [Tr>] to prompt ―Connect Thru  

cable between P1 and P2, then press corresp. menu button to start!‖ connect test port 1 and 
test port 2 with cables. You can press [Auto Meas], and the system can automatically 
complete four transmission calibration tasks in turn, or press [Pos Match], [Pos Trans], [Rev 
Match] and [Rev Trans] in turn to complete each calibration task individually. When all four 
tasks are completed, the  full 2 ports transmission calibration is completed. 

k) Press [Back] to return to previous menu, and press [ISO] for isolation calibration. 

l) For isolation measurement, press [ISO] to prompt ―Connect LOADs in P1 and P2, then press  

corresp. menu button to start!‖. Connect the load to test port 1 and test port 2 respectively, 
press [Auto Meas] to complete isolation calibration on the two items automatically in turn, or 
press [Pos Iso] and [Rev Iso] to complete each isolation calibration independently. or directly 
press [Ignore Iso]  to ignore isolation calibration. 

m) Press [Done] to finish the full 2 ports calibration. After that, the prompt ―Calibration Off/On‖  

shows in the prompt zone. Connect with the DUT for measurement. 
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Figure 6-4 Standard Piece Connection of Full 2 Ports Error Correction 

7.1.4 Selection of measurement format 

The vector voltage measurement mode of the instrument measures the amplitude, phase, 
standing wave ratio and impedance of the device under test. 

a) Press 【Measure】  -> [Format] ; 

b) Select different measurement parameters via the menu soft key, and the default is dB format. 

[dB], select the measurement parameter as amplitude, with the amplitude value and phase 
value displayed; [VSWR], select the measurement parameter as VSWR; [Re/Im], select the 
test parameter as impedance, with the information displayed in the real value and the 
imaginary value. 

7.1.5 Setting of measurement type 

If single port measurement is required, keep the default setting of the instrument. 

For dual port measurements, please perform the following operations: 

a)  Press 【Measure】  → [Meas Type  Rf/ Tr], switch to [Meas Type  Rf/ Tr], and change the 

default measurement from reflection to transmission. 

7.1.6 Setting of output power 

It is used to set the output power of the RF analyzer source, including the high power, low power 
and manually-entered power. The actual output power varies with the RF analyzer model. The 
operation for setting the output function is as follows: 

a) Press the 【Amplitude】 and select [High]  or [Low]  on the touch screen to select the 

required power. 

b) To improve the output power accuracy, follow the steps below to set it manually: 

c) Press [Man -18dBm]  to select the manual input power; 

d) Use the numeric keys to enter the number and select the unit on the touch screen to complete 
the input or adjust the manual power by turning the wheel or pressing [↑]  [↓] . 

7.2 Menu Structure 

The vector voltage measurement mode mainly has four groups of menus: ―Measurement‖, 

―Calibration‖, ―File‖ and ―Amplitude‖. The ―frequency‖ can be directly input by the 【Freq】 key, and 

―calibration‖ and ―File‖ can refer to the vector grid analysis mode. The menus of "Measure" and 
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"Amplitude" are mainly introduced, with the structures being as follows: 

测量

测量类型

反射  传输

测量端口
1    2

相对测量

关    开

阻抗

格式

dB

驻波比

返回

手动功率
-5~-20dBm

输出功率

高功率

低功率

返回

测量格式

 

Figure 6-5 Structure of Measurement and Amplitude Menus 

7.3 Menu Description 

7.3.1 Measurement menu 

Measurement menu in the vector voltmeter mode 

测量

测量类型

反射    传输

测量端口
1        2

测量格式

驻波比

相对测量

关    开

 

·[Measurement Type Reflection Transmission] Press 【Measure】 

→\ [Measurement Type Reflection Transmission] to set the 

measurement type. 

·[Measurement Port 1 2] Press 【Measure】 →\ [Measurement Port 

1 2] to set the measurement port. 

·[Measurement Format    Standing-wave Ratio (SWR)]: Press 

【Measure】 →\ [Measurement Format], and set the measurement 

format to be such that the standing-wave ratio, the impedance and dB 

can be selected. 

·[Relative Measurement Off On]: Press 【Measure】 →\ [Relative 

Measurement Off On] to select the relative measurement switch 

status. 
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7.3.2 Amplitude menu 

Click the amplitude menu, corresponding to the [Output Power] menu to set output power. 

高功率

输出功率

低功率

手动
-35~-10dBm

射频输出

关/开

< 返回

 

·[High Power]: Press 【Amplitude】 → \[High Power] key, and select 

\[High Power] on the touch screen to set the output power as the high 

power status. 

·[Low Power]: Press 【Amplitude】 → [Low Power] key, and select 

[Low Power] on the touch screen to set the output power as the low 

power status. 

·[Manual]: Press 【Amplitude】 → [Manual] key, and the range is 

-35dB～-10dBm. Enter the numbers with the numeric keys or use the 

knob or press 【↑】【↓】 to adjust the manual power. 

·[Radio Frequency Output]: If it is currently off, press 【 Radio 

Frequency Output】 to turn on; and if it is currently on, press it to turn 

off. 

·[Back]: Return to the 【Measure】 menu. 

·[Special Notes]: The manual power menu display range 

is-35~-10dBm, in order to ensure the setting range of power flatness 

index, the actual range can be set to -45 - 5dBm. If it is set to a value 

outside the range displayed by the menu item, there is a certain 

deviation in the power output at some frequency points. 

 

7.3.3 File menu 

Refer to the file menu in the vector network analysis mode 

 

  



4957B RF Analyzer User Manuals 

 USB power measurement mode(optional) 

 143 / 248 

 

8 USB power measurement mode (optional) 

8.1 Introduction to typical measurement 

The 4957B USB power measurement mode of the 4957B instrument uses the USB interface to 
externally connect the USB power sensor via a USB cable for the power test. With the 8723XUSB 
power sensor provided by China Electronics Instrument and Meter Co., Ltd., it can test up to 6.5 
GHz radio frequency/ signal and perform true average power measurements over a high dynamic 
range of -60 dBm to +20 dBm. The measurement reading is displayed on the display interface of 
the USB Power Meter mode of 4957B. The test block diagram is shown in Figure 4-1, and 
attenuators can be added as required. 

After startup, press 【Mode】 to pop up a mode selection dialog box, select [USB Power 

Measurement], and press [OK] to enter the USB power measurement mode after completing the 
progress bar. 

 
 

All operations in this section are based on the premise of the selected 

power measurement mode, which will not be described separately later. 

8723X DUT

Attenuator(Optional)

 

       Figure 8-1 Power Measurement Structure Chart 

 

Figure 8-2 USB  Power Measurement Interface 

 

Notice 
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The USB power sensor of 4957B recommends that you purchase the high-performance 
microwave power sensor based on the USB interface developed by China Electronics Instrument 
and Meter Co., Ltd., which provides following types and can be purchased based on your testing 
requirements: 

 
 

First, observe the maximum input power range of the USB power sensor 

identification to ensure that the input is within the specified range to 

avoid damage to the probe caused by excessive power! 

Table 8-1 8723XUSB Power Sensor 

Model Frequency range Input Power 

Range 

Input Connector 

Mode 

87230 9kHz~6GHz -50dBm～+20dBm N(m) 

87231 10MHz～18GHz -60dBm～+20dBm N(m) 

87232 50MHz～26.5GHz -60dBm～+20dBm 3.5mm(m) 

87233 50MHz～40GHz -60dBm～+20dBm 2.4mm(m) 

Connect the power sensor 

a) Connect the small port of the USB cable to the 8723XUSB power sensor. 

b) Then connect the large end of the USB cable to the USB interface of the spectrum analyzer,     

and the green indicator light of the power sensor will be on later. 

c) If user wants to power off, please unplug the USB cable to turn off the USB power sensor, and  

then the green LED will go out. 

 

 

The 8723XUSB power sensor is enclosed with the USB cable. The user 

can use his own USB cable, but make sure that the cable meets 

international safety standards! 

 

Notice 

Notice 
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8.2 Menu Structure 

频率

频率

最大刻度
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最小刻度

自动比例
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关 开
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关 开

偏移
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校零

校零

全刻度

平均因子
16

 

Figure 8-3 Overall Block Diagram of Power Measurement Menu 
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8.3 Menu Description 

8.3.1 Frequency menu 

频率

频率

 

·[Frequency]:   Press 【Freq】 → [Frequency], you can use the number 

keys, and then select the corresponding frequency menu, or use 【↑】【↓】 

or the knob to change, and the frequency modification step is 10 MHz. 

·[Special Notes]:  The setting range of the frequency is related to the 

selected USB power sensor. For the specific range, refer to Table 6-1.  

8.3.2 Amplitude menu 

最大刻度

幅度

最小刻度

自动比例

相对测量

关 开

偏移

关 开

偏移
0.00

全刻度

 

·[Maximum Scale]: Press 【Amplitude】 → [Max Scale], the maximum 

value of the currently displayed signal can be changed by using the number 

keys, or using 【↑】【↓】 or the knob, and the default modification step is 1 

dB. 

·[Minimum Scale]: Press 【Amplitude】 → [Minimum Scale], the minimum 

value of the currently displayed signal can be changed by using the number 

keys, or using 【↑】【↓】 or the knob, and the default modification step is 1 

dB. 

·[Auto Scale]: Press 【Amplitude】 → [Auto Scale] to display the 

measurement signal within the scope of 10 dB. 

·[full Scale]: Press 【Amplitude】 → [Full Scale] to display the 

measurement signal within the scope of 10 dB. 

·[Offset Off On]: Press 【Amplitude】 → [Offset Off On], when the power 

of the kits to be measured is greater than the maximum power value that 

the instrument can measure, the measured power can be reduced within 

the normal measurement range by connecting an attenuator. The power 

offset function allows for setting offset values to offset attenuation values or 

cable losses for added attenuators or connecting cables. It also allows for 

setting power offsets for gains of added amplifiers. Positive values can 

compensate losses and negative values can compensate gains. 

·[Offset]: Press 【Amplitude】 → [Offset]  

·[Relative Measurement Off On]: Press 【Amplitude】 → [Relative 

Measurement Off On], the relative measurement function reflects the 

change in power that has been set to the reference signal. In the event of 

using the unit of  dBm , it is the difference between the measured value 

and the saved value, and the reading is expressed in dB; and in the event 

of using the unit of  W , it is the ratio of the measured value to the saved 

value, and it is expressed in percentage %. If the relative measurement 

switch is turned on, the instrument will measure and save the current power 

level. At the same time, the power measurement will show a power level 

relative to the saved value. 
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8.3.3 Bandwidth menu 

Average
OFF ON

BW/Average

 

·[Ave Off On]:  Press 【Amplitude】 → [Average Off On],  you can use 

the number keys, or use 【↑】【↓】 or the knob to change, and the 

average modification step is 1.  

·[Special Notes]: The averaging function is generally used to measure 

low-power signals or signals close to noise power. It can smooth traces 

to reduce the influence of random noise on the measurement and 

improve measurement accuracy, but at the same time it will reduce 

measuring speed. The times of averaging determine the times for 

reading averaging. The more averaging times, the more the noise will be 

reduced. 

8.3.4 Zero menu 

校零

校零

 

·[Zero]:   Press [Zero] → [Zero].  

•[Special Notes]: In order to improve the measuring accuracy of the 

instrument, zeroing is necessary before using 8723X series USB 

power probes to measure small signal power. Zeroing refers to 

measuring and storing the noise of the whole measuring channel. 

During the measurement, it is required to deduct the zeroing value 

from the actual measurement value, namely, deducting the noise of the 

channel, and after that the reading should be the input signal level of 

the channel. The zeroing of USB power probes is consistent with that 

of ordinary power probes. The zero refers to the internal zero of the 

USB power sensor, and the internal zero adds a switch at the front end 

of the measurement channel, and user does not need to disconnect 

the sensor from the device under test, and test and measure and save 

the noise of the channel. During the internal zero process, the RF 

signal is constantly applied to the power sensor, which reduces the 

wear on the sensor connector and shortens the test time. 

8.3.5 File menu 

Refer to the file menu in the vector network analysis mode 
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9 Interference analysis measurement mode (optional) 

9.1 Introduction to typical measurement 

The interference analysis measurement is an extension for the spectrum measurement mode. 

After startup, press 【Mode】 to pop up a mode selection dialog box, select [Spectrum Analysis], 

and press [OK] to enter the spectrum analysis mode after completing the progress bar. Then press 
[System]→[Measurement Mode]→[Interference Analysis] on the touch screen to enter the 
interference analysis mode. 

 

Figure 9-1 Main Interface of Interference Analysis 

The interference analysis mode of the 4957B instrument is divided into the following three 
common measurement modes: 

Spectrum measurement (for specific operations, please refer to the chapter on spectrum analysis, 
which will not be described repeatedly in this section); 

Waterfall chart measurement; 

Received signal strength indication (RSSI) measurement. 

 
 

All operations in this section are based on the premise of the selected 

interference analysis mode, which will not be described separately later. 

9.1.1 Waterfall Chart Measurement 

The waterfall chart uses the frequency-amplitude-time three-dimensional display method, so as to 
easily observe periodic or intermittent signals. The intensity of the timing signal amplitude is 
reflected by the difference in the color display of the waterfall chart. 

In order to facilitate the observation of the measurement signal, the following steps can be taken: 

a) Press 【Freq】  →  [Sweep Width]  → [Full Sweep Width], then press 【Peak】 to get the 

maximum value point of the current measurement signal, Then press [Marker → Center 

Frequency] to set the current peak point as the center frequency, and at this moment the 

maximum value will be displayed at the center of the trace area. 

b) Press 【BW】  → [Resolution Bandwidth Auto Man], use the number keys or 【↑】【↓】 keys 

or the knob to set the appropriate resolution bandwidth, and similarly set the appropriate video 

bandwidth value. 

Notice 



4957B RF Analyzer User Manuals 

Demodulation analysis measurement mode(optional) 

 149 / 248 

 

c) Press 【Amplitude】 → [Ref Level] to bring the current maximum value point close to the 

topmost position of the display area, and press [Scale/Graduation] to set the appropriate 

scale/graduation value for easy viewing. 

d) Press [Auto Save] → [Scan Interval] to set the scan interval value. 

 

 

When the scan interval is greater than 0, the trace will be set to the 

maximum hold state, ensuring that the maximum value of the signal 

obtained by each scan will be displayed on the interface. 

e) Press [Sweep Width Time] to set the time to be recorded, then through [Auto Save Off On], 

you can set the automatic storage, which will be automatically carried out after each screen is 

completed. 

f) Press [Auto Save] → [Time Marker], and move the horizontal straight line in the vertical 

direction of the waterfall chart by using the number keys or 【↑】【↓】 or the knob, and the 

spectrogram below will display the trace information in the straight line position. 

 

 
When the time marker value is greater than 0, the trace is no longer 

refreshed, and the waterfall chart area is no longer updated. 

g)  The interference analysis for the 4957 provides six independent markers for reading out the 

amplitude and frequency values of the marker position. The specific usage methods are as 

follows: 【Mkr】 → \[Marker 1 2 3 4 5 6]. 

h)  If you want to save the current waterfall chart measurement information as a picture, you can 

use 【File】 → [Save Picture]. 

i) The waterfall chart test structure is as shown in Figure 5-1 (the display is different under 

different parameter settings, and Figure 5-1 is just an example): 

 

Figure 9-2 Interference Analysis Waterfall Chart 

9.1.2 RSSI measurement 

RSSI measurement is mainly used to measure the intensity change of a point frequency signal 

over a period of time. 

Notice 

Notice 
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In order to facilitate the observation of the measurement signal, the following steps can be taken: 

a) To set the scan interval time, [Auto Save]  →  [Scan Interval], and the scan interval time 
represents the sweep time of two adjacent points in each scan; 

b) To set the sweep width recording time, [Auto Save]  →  [Sweep Width Time], set the time to 
be recorded and displayed. After reaching the set sweep width time, the display interface will 
no longer refresh the display. 

c) To turn on the Auto Save switch, [Auto Save]  →  [Auto Save Off On], the data will be 
automatically saved to the file after each screen is completed. 

 
 

After setting the sweep width time, the data points displayed on the 

screen only record the data points in the most recent time, not the data 

points in the whole sweep width time. 

 

The RSSI test structure is as shown in Figure 5-2 (the display is different under different parameter 

settings, and Figure 5-2 is just an example): 

 

Figure 9-3 Interference Analysis RSSI Test Chart 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notice 
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9.2 Interference Analysis Menu Structure 

信号标准
--

中心频率

频率

扫宽  >

起始频率

终止频率

步进频率

自动 手动

信道号
--

扫宽

扫宽

全扫宽

零扫宽

上次扫宽

< 返回

参考电平
0.0dBm

幅度/标尺

参考位置

衰减器

自动 手动

刻度/格
20.0dB

幅度单位
dBm

前置放大器

关 开

分辨率带宽

自动 手动

带宽/平均

视频带宽

自动 手动

平均

关 开

SPAN/RBW
100

RBW/VBW
1

检波    

自动

自动

检波

标准

正峰值

负峰值

取样

均值

均方根

< 返回

光标
1 2 3 4 5 6

光标

普通模式

差值模式

噪声光标

关 开

光标 >

光标关闭

全部关闭

光标->

中心频率

光标->

光标->

步进频率

光标->

起始频率

光标->

终止频率

光标->

终止频率

< 返回

最大峰值

峰值

次峰值

左邻峰值

右邻峰值

最大值

最小值

光标->

中心频率

扫描时间

自动 手动

扫描

扫描类型

连续 单次

重新扫描

>>

表头

信号标准

表尾

上一页

下一页

立即调用

取消

>

 

Figure 9-4 Overall Menu Block Diagram of Interference Analysis 
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刷新迹线

迹线

最大保持

最小保持

频谱测量

测量

瀑布图

RSSI

扫描间隔
Auto

自动存储

扫宽时间
Auto

自动存储

关 开

时间光标
0 ns

重启测量

>

 

Figure 9-5 Overall Menu Block Diagram of Interference Analysis (Continued) 
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9.3 Description of Interference Analysis Menu 

9.3.1 Frequency menu 

中心频率

频率

扫宽 

起始频率

终止频率

步进频率

自动 手动

信号标准
--

信道号
--

>

>

 

·[Center frequency]: Press 【Freq】→[Center Freq], use the numeric 

keys on the front panel, select [GHz], [MHz], [kHz] and [Hz] in the 

frequency unit menu, or use the 【↑】【↓】 keys and the knob for setting.  

·[Special Notes]: When using the 【↑】【↓】 keys and the knob, the size 

of the frequency step is the same as the set value of the [Step Freq]. 

After pressing [Step Freq Auto/Man] to switch to [Step Freq Auto/Man], 

you can use the numeric keys or the 【↑】【↓】 keys and the knob to set 

the step frequency value.  

·[Span]: Press 【Freq】→[Span] to activate the span submenu. You 

can use the numeric keys, and then select the frequency unit to 

change. You can also use the 【↑】【↓】 keys and the knob to change 

the span. For the detailed information, please refer to the description of 

the [Span] menu.  

·[Special Notes]:   Use the 【↑】【↓】 keys and the knob to change the 

sweep width, and change based on the step of 1-2-5 (in the RSSI 

mode, it can only be the zero sweep width mode ) .  

·[Start Freq]: Press 【Freq】→[Start Freq], use the numeric keys on 

the front panel, select the frequency unit, or use the 【↑】【↓】 keys and 

the knob for setting.  

·[Stop Freq]: Press 【Freq】→[Stop Freq], use the numeric keys on the 

front panel, select the frequency unit, or use the 【↑】【↓】 keys and the 

knob for setting.  

·[Signal Standard]: Press 【Freq】→[Signal Standard], use the 【↑】

【↓】 keys and the knob to select the signal standard, and use the 

dialog box menu [Immediate Recall] or [OK] key  for recalling. Refer 

to the dialog box menu for details of the dialog box menu.  

·[Special Notes]: After the signal standard is loaded, the center 

frequency and the span are set to the center frequency and the span 

value defined in the signal standard.  

·[Channel No.]: Press 【Freq】→[Channel No.] to pop up the channel 

number setting dialog box, and use the numeric keys or the 【↑】【↓】 

keys and the knob to set the channel number.  

·[Special Notes]: The setting of the channel number shall be carried 

out under the premise of loading the signal standard, otherwise a 

prompt that it cannot be set will pop up.  
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9.3.2 Sweep width menu 

扫宽

扫宽

全扫宽

零扫宽

上次扫宽

< 返回

 

·[Span]: Press 【Freq】→[Span] to activate the span submenu. You 

can use the numeric keys, and then select the frequency unit to 

change. You can also use the 【↑】【↓】 keys and the knob to change 

the span. For the detailed information, please refer to the description of 

the [Span] menu.  

·[Special Notes]: Use the 【↑】【↓】 keys and the knob to change the 

span with a step of 1-2-5.  

·[Full Span]: Press [Span]→[Full Span] to set the current span to 

44.1GHz.  

·[Span]: Press 【Freq】→[Span]→[Zero Span] to set the current span 

to 0Hz.  

·[Last Span]: Press 【Freq】→[Span]→[Last Span] to restore the span 

to the value set last time. 

·[Back]: Press 【Freq】→[Span]→[Back] to return to the 【Freq】 

menu.   

·[Special Notes]:   The RSSI mode can only be a zero sweep width 

mode.  

9.2.3 Amplitude menu 

参考电平
0.0dBm

幅度

参考位置

衰减器

自动 手动

刻度/格
20.0dB

幅度单位
dBm

前置放大器

关 开
 

·[Ref Level]: Press 【Amplitude】→[Ref Level], use the numeric keys 

on the front panel, and then select [dBuV], [-dBuV], [mV] and [uV], or 

use the 【↑】【↓】 keys and the knob to set it. 

·[Special Notes]: When the 【↑】【↓】 keys and the knob are used, the 

step is 10dB.  

·[Ref Pos]: Press 【Amplitude】→[Ref Pos], and use the numeric keys 

or the 【↑】【↓】 keys and the knob to change it.  

·[Atten Auto Man]: Press 【Amplitude】→[Atten Auto Man] to switch 

the automatic and manual switch of the attenuator through the menu. 

You can use the numeric keys or the 【↑】【↓】 keys and the knob to 

change it.  

·[Special Notes]: The setting range of the attenuation value is 0 dB - 

60 dB, with the step value of 10 dB.  

·[Scale]: Press 【Amplitude】→[Scale], and use the numeric keys or 

the 【↑】【↓】 keys and the knob to set the scale within the setting range 

of 0.1dB - 20dB.  

·[Amp Unit]:  In the interference analysis mode, the amplitude unit is 

uniformly displayed in dBm.  

·[Pre Amp Off On]: Press 【Amplitude】→[Pre Amp Off On]  to turn 

the preamplifier on or off.  
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9.3.4 Bandwidth menu 

分辨率带宽

自动 手动

带宽

视频带宽

自动 手动

平均

关 开

SPAN/RBW
100

RBW/VBW
1

检波    

自动
>

 

·[RBW Auto Man]: Press 【BW】→[RBW Auto Man], and use the 

numeric keys on the front panel or the 【↑】【↓】 keys and the knob to 

set it.  

·[Special Notes]: Since the resolution bandwidth is subject to the 

bandwidth of the IF filter, the shape of trace depends on the IF filter. 

This instrument supports variable resolution bandwidth settings, 

ranging from 1 Hz. ~10MHz, which can be changed with a step of 

1-3-10.  

·[VBW Auto Man]: Press 【Amplitude】→[VBW Auto Man], and use the 

numeric keys or the 【↑】【↓】 keys and the knob to change it.  

·[Special Notes]: The video bandwidth filter is used to smooth the 

traces, aiming to improve the ability of detecting weak signals in noise 

signals. This instrument supports variable resolution bandwidth 

settings, ranging from 1Hz~10MHz, which can be changed with a step 

of 1-3-10.  

·[Ave Off On]: Press 【BW】→[Ave Off On], the average function can 

smooth the display trace without changing the video bandwidth filter, 

and use the numeric keys or the 【↑】【↓】 keys and the knob to change 

it.  

·[SPAN/RBW]: Press 【BW】→[SPAN/RBW] to set the ratio of span to 

resolution bandwidth. In automatic mode, the resolution bandwidth will 

automatically change with the change of span. You can use numeric 

keys or the 【↑】【↓】 keys and the knob to change it.  

·[RBW/VBW]: Press 【BW】→[RBW/VBW]. In automatic mode, the 

video bandwidth will change with the change of resolution bandwidth. 

You can use numeric keys or the 【↑】【↓】 keys and the knob to change 

it.  

·[Detection]: Press 【BW】→[Detection] to open the detection function 

submenu. Please refer to the [Detection] menu for details.  
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自动

检波

标准

正峰值

负峰值

取样

均值

均方根

< 返回

 

·[Auto]: Press 【BW】→[Detection]→[Auto], the detection is the same as 

that in the spectrum analysis mode.  

·[Standard]: Press 【BW】→[Detection]→[Standard], the most 

commonly used detection method can see the signal and noise base at 

the same time without losing any signal.  

·[PosPeak]: Press 【BW】→[Detection]→[PosPeak] to ensure that no 

peak signal is missed and to measure the signals that are very close to 

the noise base.  

·[NegPeak]: Press 【BW】→[Detection]→[NegPeak], it is used in the 

self-inspection of the bandwidth millimeter wave RFanalyzer in most 

cases, but it is rarely used in the test, and it can reproduce the 

modulation envelope of the AM signal very well.  

·[Sampling]: Press 【BW】→[Detection]→[Sampling], it is beneficial to 

measuring the noise signal, and can measure the noise better than the 

standard detection.  

·[Ave]: Press 【BW】→[Detection]→[Ave] to average the data in the 

sampling interval.  

·[Rms]: Press 【BW】→[Detection]→[Rms] to calculate the root mean 

square of the data in the sampling interval.  
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9.3.5 Marker menu 

光标
1 2 3 4 5 6

光标

普通模式

差值模式

噪声光标

关 开

光标- >

光标关闭

全部关闭

>

 

·【Mkr】→[Mkr 1 2 3 4 5 6]: Press 【Mkr】→[Mkr 1 2 3 4 5 6] to switch 

between different marker displays, and the selected marker will be 

marked with an underline.  

·[Normal Mode]: Press 【Mkr】→[Normal Mode] to set the currently 

selected marker display mode to normal mode.  

·[Difference Mode]: Press 【Mkr】→[Difference Mode] to display the 

amplitude difference and frequency difference between the two frequency 

markers (time difference in case of zero bandwidth). Use the knob, step 

key or numeric key to move the active frequency marker. The displayed 

amplitude difference is in dB by default.  

·[Noise Mkr Off On]:  Press 【Marker】 → [Noise Marker Off On], the 

noise marker shows the noise power that normalizes the noise to the 1Hz 

bandwidth near the active marker. At this time, the detector is set to the 

root-mean-square detection mode. In the default state, when the noise 

marker is turned on, the unit of the marker reading is automatically 

switched to dBm/Hz.  

·[Mkr→]: Press 【Mkr】→[Mkr→] to open the marker function submenu, 

which allows users to use the marker as a reference to change the 

instrument display. Please refer to the [Mkr→] function menu for details.  

·[Mkr Off]: Press 【Mkr】→[Mkr Off] to turn off the currently activated 

marker.  

·[All Off]: Press 【Mkr】→[All Off] to turn off all markers that have been 

turned on.  

·[Special Notes]: There is no marker function in RSSI measurement 

mode.  

 

光标->

中心频率

光标->

光标->

步进频率

光标->

起始频率

光标->

终止频率

光标->

终止频率

< 返回

 

·[Mkr→Center Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Center Freq], the 

marker will move to the center frequency, and the reading at the center 
frequency is displayed on the screen.  

·[Mkr→Step Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Step Freq] to set the 

stepping amount of the center frequency, that is, the value of the 
frequency step is equal to the marker frequency. If the difference marker 
function is activated, the frequency step value is equal to the frequency of 
the difference marker.  

·[Mkr→Start Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Start Freq] to set the 

start frequency equal to the marker frequency.  

·[Mkr→Stop Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Stop Freq] to set the 

stop frequency equal to the marker frequency.  

·[Back]: Return to the previous menu  

(not available in RSSI measurement mode) 
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9.3.6 Peak menu 

最大峰值

峰值

次峰值

左邻峰值

右邻峰值

最大值

最小值

光标->

中心频率
 

·[Max Peak]: Press 【Peak】→[Max Peak] to set the current active 

marker to the maximum peak point of the measurement trace and 

display the frequency and amplitude of the marker in the upper center 

of the screen.  

·[Sub Peak]: Press [Peak]→[Sub Peak] to move the active marker to 

the next highest point on the trace that is associated with the current 

marker position. 

·Left Peak]: Press 【Peak】→[Left Peak] to find the next peak to the left 

of the current frequency marker position.  

·[Right Peak]: Press 【Peak】→[Right Peak] to find the next peak to the 

right of the current frequency marker position.  

·[Max]: Place a marker at the highest point of the trace and display the 

frequency and amplitude of the marker in the upper right corner of the 

screen. Pressing this button will not change the activated functions. 

·[Min]: Press [Peak]→[Min] to place a marker at the lowest point of the 

trace and display the frequency and amplitude of the marker in the 

upper right corner of the screen. Pressing this button will not change 

the activated functions. 

·[Mkr→Center Freq]:  Press [Peak]→[Mkr → Center Freq] and set 

the center frequency equal to the marker frequency. This function 

quickly moves the signal to the center of the screen. 

(not available in RSSI measurement mode) 

9.3.7 Scan menu 

扫描时间

自动 手动

扫描

扫描类型

连续 单次

重新扫描

 

·[Swp Time Auto Man]: Press 【Swp】→[Swp Time Auto Man] to switch 

the sweep time between Auto and Manual. The underline marks the 

current state. If the sweep time is automatic, the RF analyzer 

automatically sets the sweep time to the fastest according to the current 

instrument status, and the screen displays the fastest sweep time under 

the current setting. If the sweep time is manually set, the sweep time 

value can be input at this time. Use the numeric keys to enter the sweep 

time value and select the time unit by pressing corresponding soft key to 

complete the setting. If the sweep time is automatic,  the sweep speed 

may change depending on the change of RBW and VBW. The larger the 

values of RBW and VBW, the faster the sweeping speed and vice versa. 

If the sweep time of the instrument meet the minimum scanning time limit, 

the maximum non-zero sweep width can be set to 800 s, and the 

maximum zero sweep width can be set to be 600 s. 

·[Swp Type Cont Single]: Press 【Swp】→[Swp Type Cont Single]. The 

sweep type setting determines how the RF analyzer sweeps and when it 

stops to enter into the hold state. In the interference analysis mode, it 

provides two sweep modes: Continuous sweep and single sweep.  

·[Re-sweep]: Press 【Swp】→[Re-sweep] to restart the sweep. 



4957B RF Analyzer User Manuals 

Demodulation analysis measurement mode(optional) 

 159 / 248 

 

9.3.8 Auto Save menu 

扫描间隔
Auto

自动存储

扫宽时间
Auto

自动存储

关 开

时间光标
0 ns

重启测量

>

 

·[Swp Interval]: Press [Auto Save]→[Swp Interval Auto] to set the 

sweep interval. After setting the sweep time, the trace will be switched to 

the maximum hold state by default to ensure that all signals measured 

during the sweep interval can be recorded.  

·[Span Time]: Press [Auto Save]→[Span Time Auto], and the span time 

is the entire sweep time. After the sweep reaches the span time, it will 

stop recording.  

·[Auto Save Off On]: Press [Auto Save]→[Auto Save Off On], and press 

the menu to switch the automatic save switch.  

·[Special Notes]: The automatic save function cannot be turned on until 

the span time is set.  

·[Time Mkr]: Press [Auto Save]→[Time Mkr] to view the historical data.  

·[Special Notes]: It can only be used in the waterfall chart measurement 

mode.  

·[Re-measure]: Press [Auto Save]→[Re-measure] to restart the sweep.  

·[Special Notes]: This menu shall not be used in spectrum 

measurement;  

The time marker menu function shall not be used in RSSI.   

 

9.3.9 Measurement menu 

频谱测量

测量

瀑布图

RSSI

 

 · [Spectrum Measurement]:   Press 【Measure】 → [Spectrum 

Measurement] to switch the measurement mode to spectrum 

measurement.  

  · [waterfall Chart]:   Press 【Measure】 → [Waterfall] to switch the 

measurement mode to waterfall chart.  

 · [RSSI]:   Press 【Measure】 → [RSSI] to switch the measurement 

mode to RSSI.  
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10 Demodulation Analysis measurement mode (optional) 

10.1 Introduction to typical measurement 

The demodulation analysis measurement mode is an extension of the spectrum measurement 

mode. After startup, press  【Mode】 to pop up a mode selection dialog box, select [Spectrum 

Analysis Mode], and press [OK] to enter the spectrum analysis mode after completing the 

progress bar. Then press 【System】 → [Measurement Mode] → [Demodulation Analysis] on the 

touch screen to enter the demodulation analysis mode. 

 

Figure 10-1 Main Interface of Demodulation Analysis Mode 

The demodulation analysis measurement mode provides the display of AM, FM and PM 
modulation signal spectrums and the analysis of related parameters. The main maps and the 
measurements of related parameters are as shown below: 

Radio frequency spectrum: Similar to the spectrum analysis mode, it displays the spectrogram of 
the modulated signal, and it can be used to measure the occupied bandwidth. 

Audio map: It displays a spectrogram of the demodulated audio signal. 

Audio waveform: It displays the waveform of the demodulated audio signal in the time domain. 

Parameter analysis: It can measure and analyze the parameters such as carrier power, 
modulation rate, carrier frequency offset, modulation depth (AM), modulation frequency offset 
(FM), modulation phase offset (PM), signal-to-noise-and-distortion ratio, modulation distortion, 
total harmonic distortion, etc. of modulated signals. 

 
 

All operations in this section are based on the premise of the selected 

demodulation analysis mode, which will not be described separately 

later. 

The demodulation analysis can display three kinds of maps at the same time, or each map can be 

displayed separately. You can press the 【Measure】 menu, and select [Radio Frequency Map], 

[Audio Map], [Audio Waveform], and [Show all] to choose to display a certain map or to display all 
maps at the same time. 

In order to facilitate the observation of the measurement signal, the following steps can be taken: 

a) Press 【Measure】  →  [Demodulation Type AM FM PM] to select the type of analog signal 

to be demodulated. 

b) Press 【Freq】  → [Center Frequency ] to set the center frequency of the measurement 

signal.  

c) Press 【BW】  →  [Intermediate Frequency Bandwidth], and use the number keys or the 【↑】

Notice 
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【↓】 keys or the knob to set an appropriate intermediate frequency bandwidth. 

d) Press 【Amplitude】  →  [Ref Level] to set the reference level of the radio frequency 

spectrum, and press [Scale/Graduation] to set the appropriate scale/graduation value to 
facilitate viewing the radio frequency spectrum. 

e) e)   Press [Audio Map]   →  [Sweep Width] to set the appropriate sweep width, and press 
[Scale/Graduation] to set the appropriate scale/graduation value to facilitate viewing the 
spectrogram of audio signals. 

f) Press [Audio Waveform]  →  [Sweep time] to set the display time of the audio signal 
waveform, press [Scale/Graduation] to set the appropriate scale/graduation value to facilitate 
viewing the spectrogram of audio signals. 

 
 

When setting the intermediate frequency bandwidth, you need to select 

an appropriate value. The intermediate frequency bandwidth shall be 

greater than the width of the modulation signal in order to accurately 

demodulate the signal. You can observe the bandwidth of the modulation 

signal in the radio frequency spectrum. At the same time, if the 

intermediate frequency bandwidth is too large, noise would be 

introduced, which would affect the accuracy of parameter measurement. 

The following takes the measurement of  FM signal as an example to introduce the measurement 
method of demodulation analysis. First, input an FM modulation signal generated by a signal 
source at the radio frequency input end of the instrument. The frequency of the signal is 6 GHz, 
the amplitude is -10 dBm, the modulation rate is 3 kHz, and the modulation frequency offset is 30 
kHz. The measuring steps are shown as follows: 

a) Press 【Measure】  →  [Demodulation Type AM FM PM] to select FM. 

b) Press 【Freq】  → [Center Frequency] to set the center frequency of the measurement signal 

to be 6 GHz.  

c) Press 【BW】  →  [Intermediate Frequency Bandwidth] to set the intermediate frequency 

bandwidth to be 100 kHz.  

d) Press 【Audio Map】  → [Sweep Width] to set the sweep width to be 50 kHz.  

e) Press [Audio Waveform]  →  [Sweep time] to set to be 2 ms. 

The measurement result is shown in Figure 7-1: 

 

Figure 10-2 FM Demodulation Analysis Result 

 

Notice 
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10.2 Demodulation analysis menu structure 
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Figure 10-3 Demodulation Analysis Menu 
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Figure 10-4 Demodulation Analysis Menu (Continued) 
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10.3 Description of demodulation analysis menu 

10.3.1 Frequency menu 

中心频率

频率

扫宽 

起始频率

终止频率

步进频率

自动 手动

信号标准
--
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>

>

 

·[Center frequency]: Press 【Freq】 → [Center Frequency], through 

the number keys on the front panel, select [GHz], [MHz], [kHz] and [Hz] 

in the frequency unit menu, or use the 【↑】【↓】 keys and the knob to 

set the center frequency. 

·[Special Notes]: When using the 【↑】【↓】 keys and the knob, the size 

of the frequency step is the same as the set value of the [ Step 

Frequency]. After pressing the [Step Frequency  Auto  Man]to switch 

to [Step Frequency  Auto   Man ], you can use the number keys or 

the 【↑】【↓】 keys and the knob to set the step frequency value. 

·[Sweep Width]: Press 【Freq】 → [ Sweep Width ] to activate the 

sweep width submenu. You can use the number keys, and then select 

the frequency unit to change. You can also use the 【↑】【↓】 keys and 

the knob to change the sweep width. For the detailed information, 

please refer to the description of the [ Sweep Width ] menu. 

·[Special Notes]: Use the 【↑】【↓】 keys and the knob to change the 

span with a step of 1-2-5.  

·  [Start Frequency]: Press 【Freq】 → [ Start Frequency ], and then 

select the corresponding frequency unit through the number keys on 

the front panel, or use the 【↑】【↓】 keys and the knob to set.  

·[Stop Frequency]: Press 【Freq】 → [Stop Frequency ], and then 

select the corresponding frequency unit through the number keys on 

the front panel, or use the 【↑】【↓】 keys and the knob to set. 

·[Signal Standard]: Press 【Freq】 → [ Signal Standard ] to pop up 

the related soft menu, including [ Header ], [ Footer ], [Page Up ], 

[Page Down], and [ Recall Immediately ], select the relevant signal 

standard, and use the [Recall Immediately ] key or the [OK] key to call. 

·[Special Notes]: After the signal standard is loaded, the center 

frequency and the sweep width are set to the center frequency and the 

sweep width value defined in the signal standard. 

·[Channel No.]: Press 【Freq】 → [ Channel number ] to pop up the 

channel number setting dialog box, and use the number keys or the 

【↑】【↓】 keys and the knob to set the channel number. 

·[Special Notes]: The setting of the channel number shall be carried 

out under the premise of loading the signal standard, otherwise a 

prompt that it cannot be set will pop up. 
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10.3.2 Sweep width menu 

扫宽

扫宽

上次扫宽

< 返回

 

·[Sweep Width]:   Press 【Freq】 → [ Sweep Width ] to activate the 

sweep width submenu. You can use the number keys, and then select 

the frequency unit to change the sweep width. You can also use the 【↑】

【↓】 keys and the knob to change.  

·[Special Notes]: Use the 【↑】【↓】 keys and the knob to change the 

span with a step of 1-2-5.  

·[Last Sweep Width]:   Press 【Freq】 → [ Sweep Width ]→[ Last 

Sweep Width ], and restore the sweep width to the last set sweep width 

value.  

·[Back]:  Press 【Freq】 → [ Sweep Width ]→[Back ], and return the 

【Freq】menu.  

 

 

10.3.3 Amplitude menu 

参考电平
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自动 手动
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关             开
 

·[Ref Level]: Press 【Amplitude】 → [ Ref Level], use the number keys on 

the front panel, and then select [dBm], [-dBm], [mV] and [uV], or use the 

【↑】【↓】 keys and the knob to set.  

·[Special Notes]: When using the 【↑】【↓】 keys and the knob, the step 

is 10 dB.  

·[Reference Position]: Press 【Amplitude】 → [Reference Position ], 

you can use the number keys, and you can also use the 【↑】【↓】 keys 

and the knob to change.  

·[Attenuator Auto Man]: Press 【Amplitude】 → [ Attenuator  Auto 

Man] to switch the automatic and manual switch of the attenuator 

through the menu. You can use the number keys, and you can also use 

the 【↑】【↓】 keys and the knob to change.  

·[Special Notes]: The setting range of the attenuation value is 0 dB ~ 60 

dB, with the step value of 10 dB.  

·[Scale/Graduation]: Press 【Amplitude】 → [ Scale / Graduation ] to 

set via the number keys or the 【↑】【↓】 keys and the knob, and the 

setting range of scale / graduation is 0.1 dB ～ 20 dB.  

·[Pre Amp Off On]: Press 【Amplitude】 to control the on/off state of the 

preamplifier. Only when the reference level is less than -40 dBm, this 

function will be activated.  
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10.3.4 Bandwidth menu 

中频带宽

带宽

平均

关 开

 

·[Immediate Frequency Bandwidth]:   Press 【BW】 → [Immediate 

Frequency Bandwidth], through the number keys on the front panel, 

select the corresponding frequency units of [GHz], [MHz], [kHz] and 

[Hz], or use the 【↑】【↓】 keys and the knob to set.  

·[Special Notes]:  The intermediate frequency bandwidth shall be 

greater than the width of the modulation signal in order to accurately 

demodulate the signal. You can observe the bandwidth of the 

modulation signal in the radio frequency spectrum. At the same time, if 

the intermediate frequency bandwidth is too large, noise would be 

introduced, which would affect the accuracy of parameter 

measurement. The immediate frequency bandwidth ranges from 10 kHz 

to 300 kHz, changing in the steps of  1-3-10.  

·[Average Off On]:   Press 【BW】 → [ Avg Off  On], the average 

function can smooth the displayed trace. When the average function is 

turned on, you can use the number keys to select the average times, 

and you can also use the 【↑】【↓】 keys and the rotary round to change.  
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10.3.5 Marker menu 

光标
1 2 3 4 5 6

光标

普通模式

差值模式

  选择迹线 

光标关闭

全部关闭

>

 

·[Marker 1 2 3 4 5 6]: Press 【Mkr】 → [Marker 1 2 3 4 5 6] to switch 

between different marker displays, and the selected marker will be 

marked with an underline.  

·[Normal Mode]: Press 【Mkr】 → [ Normal Mode ], and set the 

currently selected marker display mode to be the normal mode.  

·[Delta Mode]: Press 【Mkr】 → [ Delta Mode ], and set the currently 

selected marker display mode to be the delta mode.  The delta mode 

displays the frequency difference and the amplitude difference between 

the difference marker and the reference marker ( it is the time difference 

at the zero sweep width ).  When the amplitude unit is selected to be 

dBm, dBmV, dBuV, dBW, dBV, dBA, dBmA and dBuA, the displayed 

amplitude value unit is dB, and when the amplitude unit is displayed to 

be A, W and V, the displayed amplitude unit is % .  

·[Selection Trace]: Press 【Mkr】 → [ Selection Trace ]to pop up the 

related soft menu of the trace, including [ Radio Frequency Spectrum ], 

[ Audio Map ] and [ Audio waveform ]. For details, please refer to the 

menu of [ Selection Trace ].  

·[Marker Off]: Press 【Mkr】 →[Marker Off ] to turn off the currently 

activated marker.  

·[All Off]: Press 【Mkr】 →[All Off]  to turn off all the activated markers.  

 

射频图谱

选择迹线

音频图谱

音频波形

< 返回

 

·[Selection Trace]:  Press 【Mkr】 → [ Selection Trace ] 

·[Radio Frequency Spectrum]:  Press 【Mkr】 → [ Selection 

Trace ]→[ Radio Frequency Spectrum ], select the current trace to be the 

trace in the radio frequency spectrum, and the marker operates only on 

this trace.  

·[Audio Map ]:  Press 【Mkr】 → [ Selection Trace ]→[ Audio Map ], 

select the current trace to be the trace in the audio map, and the marker 

operates only on this trace.  

·[Audio Waveform]:  Press 【Mkr】 → [ Selection Trace ]→[ Audio 

Waveform ], select the current trace to be the trace in the audio 

waveform, and the marker operates only on this trace.  
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10.3.6 Peak menu 
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·[Max Peak]:  Press 【Peak】→[Max Peak] to set the current active 

marker to the maximum peak point of the measurement trace and 

display the frequency and amplitude of the marker in the upper center of 

the screen.  

·[Sub Peak]:  Press [Peak]→[Sub Peak] to move the active marker to 

the next highest point on the trace that is associated with the current 

marker position. 

·[Left Peak]:   Press [Peak] →[ Left Peak ] to find the next peak to the 

left of the current marker position.  

·[Right Peak]:   Press [Peak] →[ Right Peak ] to find the next peak to 

the right of the current marker position.  

·[Max]: Place a marker at the highest point of the trace and display the 

frequency and amplitude of the marker in the upper right corner of the 

screen. Pressing this button will not change the activated functions. 

·[Min]:  Press [Peak]→[Min] to place a marker at the lowest point of the 

trace and display the frequency and amplitude of the marker in the upper 

right corner of the screen. Pressing this button will not change the 

activated functions. 

·[Marker -> Center Frequency]:   Press 【Peak】 →[ Marker → Center 

Frequency ], and set the center frequency equal to the marker frequency. 

This function quickly moves the signal to the center of the screen, and 

this operation is only effective to the radio frequency spectrum.  

·[Special Notes]: The operations of searching each peak value, the 

maximum value and the minimum value are all carried out on the 

selected trace. For details, see the menu of [Selection Trace].  

10.3.7 Radio frequency spectrum menu 

占用带宽

关 开

射频图谱

测量方法

百分比 XdB

百分比
99.00%

XdB
-3.00dB

 

·[Special Notes]:  The occupied bandwidth measurement in the radio 

frequency spectrum is similar to that in the spectrum analysis mode, 

except that it is only applied to the radio frequency spectrum in the 

demodulation analysis measurement mode.  

·[Occupied Bandwidth Off On]:  Press [Radio Frequency 

Spectrum ]→[ Occupied Bandwidth  Off On], and set the occupied 

bandwidth measurement switch.  

·[Measuring Method Percentage XdB]:  Press [Radio Frequency 

Spectrum ]→[ Measuring Method  Percentage XdB], and select different 

measuring methods, including the percentage method or the XdB drop 

method.  The occupied bandwidth of the signal is obtained by 

calculating the bandwidth of the portion of the frequency containing a 

certain percentage of the total transmitted signal power, and the 

percentage of power can be set by the user. The descending XdB method 

defines the occupied bandwidth as: the distance between the two 

frequency points when the signal power drops by XdB on both sides of 



4957B RF Analyzer User Manuals 

Demodulation analysis measurement mode(optional) 

 169 / 248 

 

the frequency point where the peak power of the signal is located. The X 

dB of the signal power drop is set by the user. 

·[Percentage]:  Press [Radio Frequency Spectrum]→[ Percentage ] to 

set the percentage.  

·[XdB]:  Press [Radio Frequency Spectrum→[XdB] to set the XdB 

value.  

10.3.8 Audio map menu 

扫宽

音频图谱

刻度/格
10.0dB

参考位置

 

·[Sweep Width]:  Press [Audio Map]→[ Sweep Width ]to set the sweep 

width of the audio map. The sweep width here shall be set large enough 

to display the audio signal and associated harmonics. You can use the 

number keys and then select the frequency unit to change the sweep 

width, or you can use the 【↑】【↓】 keys and the knob to change.  

·[Scale]: Press [Audio Map ]→[ Scale / Graduation ], and set the scale of 

the audio map to facilitate the observation of the audio map trace. You 

can change the scale unit by using the number keys and then selecting 

the power units of [dB] , [-dB] , and you can also use the 【↑】【↓】 keys 

and the knob to change.  

·[Reference Position]:  Press [Audio Map ]→[ Reference Position ], 

and set the reference position of the audio map to facilitate the 

observation of the audio map trace. You can use the number keys and 

then click to confirm, and you can also use the 【↑】【↓】 keys and the 

knob to change the reference position.  

10.3.9 Audio waveform menu 

扫描时间

音频波形

刻度/格
20.0%

 

·[Sweep Time]:  Press [ Audio Waveform ]→[Sweep Time ] to set the 

sweep time of the audio waveform. The larger the sweep time is set 

here, the more sampling points, and the more stable the measurement 

results are.  

·[Scale]: Press [ Audio Waveform ]→[ Scale / Graduation ], and set the 

scale of the audio waveform to facilitate the observation of the audio 

map trace. You can change the scale unit by using the number keys and 

then selecting [%] or click the OK key, and you can also use the 【↑】【↓】 

keys and the knob to change.  

·[Special Notes]:  The scale unit changes based on the type of the 

demodulated signal. When measuring the AM signal, the scale unit is 

percentage (%), when measuring the FM signal, the scale unit is the 

frequency unit (Hz, kHz and GHz), and when measuring the PM signal, 

the scale unit is the radian (Rad).  
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10.3.10 Measurement menu 
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·[Demodulation Type AM FM PM]:   Press 【Measure】 

[Demodulation Type AM FM PM] to select the type of the signal to be 

demodulated.  

·[ Radio Frequency Spectrum ]:  Press 【Measure】→[Radio 

Frequency Spectrum], and choose to only display the radio frequency 

spectrum.  

·[Audio Map]:  Press 【Measure】→[Audio Map], and choose to only 

display the audio map.  

·[Audio Waveform]: Press 【Measure】→[Audio Waveform], and choose 

to only display the audio waveform.  

·[Display All]:  Press 【Measure】→[Display All], and choose to display 

the radio frequency spectrum, the audio map, and the audio waveform 

simultaneously.  

·[Swp Type Cont Single]: Press 【Measure】 →[Sweep Type 

Continuous Single ], and select continuous sweep or single sweep.  

·[Sweep again]: Press 【Measure】 →[ Sweep Again ], and select to 

trigger the single sweep. Only when the sweep type is set to be the 

single sweep, it makes sense sweep again.  
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11 Channel sweep measurement mode (optional) 

11.1 Introduction to typical measurements 

The channel sweep measurement mode is an extension of the spectrum measurement mode. 

After startup, press 【Mode】 to pop up a mode selection dialog box, select [Spectrum Analysis 

Mode], and press [OK] to enter the spectrum analysis mode first after completing the progress bar. 
Then press [System]→[Measurement Mode]→[Channel Sweep] on the touch screen to enter the 
channel sweep measurement mode. 

 

Figure 11-1 Main Interface of Channel Sweep Measurement Mode 

The channel sweep measurement mode provides the measurement of signal power for multiple 
channels. The signal power is displayed in the form of a bar graph or a list, and the signal power of 
up to 20 channels can be measured. Channel sweep is divided into three measurement methods 
according to the way of setting the channel: Channel sweep, frequency sweep, and list sweep. 

Channel sweep: Set the channel to be measured by setting the signal standard, the start channel, 
and the channel step. 
Frequency sweep: Set the channel to be measured by setting the start frequency and the 
frequency step. 
List sweep: Set the channel to be measured by setting the list. 
All the three measurement methods can be used to set the bandwidth of the channel and the 
number of channels to be measured.  

 
 

All operations in this section are based on the premise of channel sweep 

measurement, which will not be described separately later. 

11.1.1 Channel sweep 

The following is a measurement example of channel sweep. The main operation steps are as 
follows: 

a) Press 【Sweep】 →[Channel Sweep] →[Signal Standard] to set the standard of the channel 

to be measured. 

b) Press 【Sweep】 →[Channel Sweep]→[Start Channel] to set the start channel number to be 

measured .  This start channel shall meet the requirements of the selected signal standard.  

c) Press 【Sweep】 →[Channel Sweep]  →[Number of Channels], set the number of channels 

to be measured, and up to 20 channels can be measured simultaneously.  

Notice 
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d) Press 【Sweep】 →[Channel Sweep]  →[Channel Step] to set the step of the channel to be 

measured. The instrument will take the start channel number as the initial measurement 
channel, and measure a certain number of channels successively in the set channel step. 

e) Press 【Sweep】→[Display Diagram Table], and set to be the diagram display mode. 

f) Press 【Sweep】 →[Power Display Real-time Maximum], select the Maximum option, and set 

to display the maximum power of each channel. 

 
 

Only when the maximum hold switch is on can set the power display to 

be maximum. 

 

Figure 11-2 Schematic Diagram of Channel Sweep 

11.1.2 Frequency sweep  

The following is a measurement example of frequency sweep. The main operation steps are as 

follows: 

a) Press 【Sweep】 →[Frequency Sweep]  →[Start Frequency], and set the center frequency of 

the start channel to be measured. 

b) Press 【Sweep】 →[Frequency Sweep]  →[Frequency Step], and set the frequency step of 

the channel to be measured.  

c) Press 【Sweep】 →[Frequency Sweep]  →[Channel Bandwidth], and set the bandwidth of 

the channel to be measured.  

d) Press 【Sweep】 →[Channel Sweep]  →[Number of Channels], set the number of channels 

to be measured, and up to 20 channels can be measured simultaneously. 

e) Press 【Measure】 →[Display Diagram Table], and set to be the diagram display mode. 

f) Press 【Measure】 →[Power Display Real-time Maximum], select the Real-time option, and 

set to display the real-time power of each channel. 

g) Press 【Measure】 →[Color Single Double] to select the double color option. 

h) Press 【Measure】 →[Chart Direction Vertical Parallel] to select the parallel chart display 

mode. 

Notice 
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Figure 11-3  Schematic Diagram of Frequency Sweep 

11.1.3 List Sweep 

The following is a measurement example of frequency sweep. The main operation steps are as 
follows: 

a) Press 【Sweep】 →[List Sweep]  →[Edit List], edit the channel list to be swept. In the list, the 

information of each channel can be set by setting the signal standard and the channel number, 
and the channel information can also be set by setting the frequency and the bandwidth. 

b) Press 【Sweep】 →[List Sweep]  →[Number of Channels], set the number of channels to be 

measured, and up to 20 channels can be measured simultaneously. 

c) Press 【Sweep】 →[Display Diagram Table], and set to be the diagram display mode. 

d) Press 【Sweep】 →[Power Display Real-time Maximum], select the Real-time option, and set 

to display the real-time power of each channel. 

 

Figure 11-4 Schematic Diagram of List Sweep 
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11.2 Menu structure of channel sweep 
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 Figure 11-5 Channel Sweep Menu 
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11.3 Description of channel sweep menu 

11.3.1 Sweep menu 

  信道扫描 >

扫描

  频率扫描 >

  列表扫描 >

 

·[Channel Sweep]:  Press 【Sweep】→[Channel Sweep], and set the 

channel sweep measurement mode and activate the submenu 

of[Channel Sweep]. You can set the sweep channel parameters in the 

submenu of [Channel Sweep]. For details, see the submenu 

of[Channel Sweep].  

·[Freq Sweep]: Press 【Sweep】→[Frequency Sweep], and set the 

frequency sweep measurement mode and activate the submenu 

of[Frequency Sweep]. You can set the sweep channel parameters in 

the submenu of [Frequency Sweep]. For details, see the submenu 

of[Frequency Sweep].  

·[List Sweep]: Press 【Sweep】→[List Sweep], and set the list sweep 

measurement mode and activate the submenu of[List Sweep]. You can 

set the sweep channel parameters in the submenu of [List Sweep]. For 

details, see the submenu of[List Sweep].  

11.3.2 Channel sweep menu 

信号标准
--

信道扫描

起始信道
--

信道数量

信道步进
1

信道带宽
200.000kHz

>

 

·[Signal Standard]: }Press 【Sweep】→[Channel Sweep ]→[Signal 

Standard ] to pop up the list of existing signal standards. Through the 

related menus of [ Header ], [Footer], [Page Pp], [ Page Down ], etc., 

click  [Recall Immediately] to select the corresponding signal 

standard.  

·[Start Channel]:  Press 【Sweep】 →[Channel Sweep ]→[ Start 

Channel ] to set the start channel number. This channel is the initial 

channel for measurement, and this channel number can only be set 

under the premise of selecting the signal standard.  

·[Channel Num]: Press 【Sweep】→[ Channel Sweep ]→[ Number of 

Channels ] to set the number of channels to be measured, and up to 

20 channels can be measured.  

·[Cannel Step]:  Press 【Sweep】→[ Channel Sweep ]→[Channel 

Step ] to set the step between the channels to be measured.  

·[Channel BW]: Press 【Sweep】→[ Channel Sweep ]→[Channel 

Bandwidth ] to set the bandwidth of the channel to be measured.  
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11.3.3 Frequency sweep menu 

起始频率
890.000MHz

频率扫描

频率步进
200.000kHz

信道带宽
200.000kHz

信道数量

 

·[Start Frequency]:  Press 【Sweep】 →[ Frequency Sweep ]→[Start 

Frequency ] to set the center frequency of the start channel.  

·[Freq Step]: Press 【Sweep】→[ Frequency Sweep ]→[Frequency 

Step] to set the frequency step between the channels.  

·[Channel BW]: Press 【Sweep】→[ Frequency Sweep ]→[Channel 

Bandwidth ]to set the bandwidth of the channel to be measured.  

·[Channel Num]: Press 【Sweep】→[Frequency Sweep ]→[Number of 

Channels ]to set the number of channels to be measured, and up to 20 

channels can be measured.  

11.3.4 List sweep menu 

编辑列表 

列表扫描

信道数量

>

 

·[Edit List]: Press 【Sweep】 → [ List Sweep ]→[Edit List ] to pop up the 

corresponding edit list menu. For details, please refer to the menu of 

[ Edit List ].  

·[Channel Num]: Press 【Sweep】→[List Sweep ]→[Number of 

Channels ]to set the number of channels to be measured, and up to 20 

channels can be measured.  

 

信号标准 

编辑列表

信道号

中心频率

信道带宽

完成编辑

取消编辑

>

 

·[Signal Standard]: Press [Edit List ] →[Signal Standard ] to pop up the 

list of signal standards. Through [ Header ], [ Footer ], [ Page Up], and 

[Page Down], select the required signal standard, and click [ Recall 

Immediately].  

·[Channel Number]:  Press [ Edit List ]→[ Channel Number ] to display 

the information such as the selected signal standard, the channel range, 

etc. The user can also edit the channel number, and click [ Complete 

Editing ] to save the settings.  

·[Center Frequency]:  Press [Edit List ]→[ Center Frequency ] to edit 

the center frequency of the selected channel, and click [ Complete 

Editing ] to save the settings.  

·[Channel BW]: Press [ Edit List ]→[ Channel Bandwidth ] to edit the 

bandwidth of the selected channel, and click [ Complete Editing ] to save 

the settings.  

·[Complete Editing]: Press [ Edit List ]→[ Complete Editing ] to save the 

changed settings, and return to the list sweep menu.  

·[Cancel Editing]: Press [ Edit List ]→[ Cancel Editing] to cancel the 

changed settings, and return to the list sweep menu.  
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11.3.5 Measurement menu 

显示

图 表

测量

最大保持

关 开

单元

信道 频率

功率显示

实时 最大

颜色

单 双

图标方向

垂直 平行
 

·[Display Diagram Table]:   Press 【Measure】 →[Display  Diagram 

Table] to select the icon display mode. For two kinds of diagrams, see 

Figure 8-7and Figure 8-8.  

·[Max Hold Off On]:   Press 【Measure】 →[Max Hold  Off  On ] to 

set the maximum hold switch.  

·[Unit Channel Frequency]:   Press 【Measure】→[Unit  Channel 

Frequency ], and set to display the channel as the channel number or the 

frequency.  

·[Power Display Real-time Maximum]:   Press 【Measure】 →[Power 

Display  Real-time  Maximum], and set to display power as real-time or 

maximum. Only when the maximum hold is on can set the maximum 

display of power.  

·[Color Single Double]:   Press 【Measure】 →[Color  Single  

Double ], and set to display the channel in a single color or double 

colors.  

·[Icon Direction Vertical Parallel]:   Press 【Measure】 →[Icon 

Direction  Vertical   Parallel ], and set to display the channel diagram 

in the vertical or parallel manner.  
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12 Field strength measurement mode (Optional) 

12.1 Introduction to typical measurements 

The field strength measurement mode is an extension of the spectrum measurement mode. After 

startup, press 【Mode】 to pop up a mode selection dialog box, select [Spectrum Analysis Mode], 

and press [OK] to enter the spectrum analysis mode after completing the progress bar. Then press 

【System】 →[Measurement Mode]→[Field Strength Measurement] on the touch screen to enter 

the field strength measurement mode. 

 

Figure 12-1 Main Interface of Field Strength Measurement Mode 

Field strength measurement is indispensable in the radiant intensity measurement of measured 
equipment. According to different measurement modes, the field strength measurement can be 
divided into: Three modes of point frequency measurement, frequency sweep measurement and 
list sweep measurement. 
Point frequency measurement: Observe the frequency offset, the amplitude value and the field 
strength value of the current point by setting the point frequency. 
Frequency sweep measurement: By setting the start frequency, the step frequency and the 
number of sweep points to observe the changes of the amplitude value and the field strength value 
within a frequency range. 
List sweep measurement: Observe the amplitude value and the field strength value of the list 
frequency point by calling a pre-edited or saved list. 

 
 

All operations in this section are based on the premise of field strength 

measurement, which will not be described separately later. 

12.1.1 Point frequency measurement 

The main operation steps of point frequency measurement are as follows: 

a) Press 【Measure】  →[Point Frequency Measurement] to select the point frequency 

measurement mode; 

b) Press 【Freq】 →[Point Frequency] to set the point frequency value. The setting range of the 

point frequency value is [1 MHz, 44.1 GHz]; 

c) Press 【BW】→[BW] to set the bandwidth value, which will be set to 150Hz, 300Hz, 600Hz, 

1.5kHz, 2.4kHz, 6kHz, 9kHz, 15kHz, 30kHz, 50kHz, 120kHz, 150kHz; 

d) Press 【Sweep/Antenna】→[Recall Antenna] to select the antenna factor file; 

e) Press 【Demodulation】 to set the demodulation type and demodulation volume. 

f) The schematic diagram of point frequency measurement is shown in the following figure (for 
example only 

Notice 
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Figure 12-2 Schematic Diagram of Point Frequency Measurement Mode 

12.1.2 Frequency sweep measurement 

The main operation steps of frequency sweep measurement are as follows: 

a) Press 【Measure】 →[Frequency Sweep] to select the frequency sweep mode; 

b) Press 【Freq】 →[Start Frequency] to set the start frequency value of frequency sweep; 

c) Press 【Freq】 →[Step Frequency] to set the step frequency value of frequency sweep; 

d) Press 【Freq】 →[Sweep Points] to set the number of sweep points for frequency sweep; 

e) Press 【BW】 →[Bandwidth] to set the bandwidth value, which will be set to be 150 Hz, 300 

Hz, 600 Hz, 1.5 kHz, 2.4 kHz, 6 kHz, 9 kHz, 15 kHz, 30 kHz, 50 kHz, 120 kHz, and 150kHz; 
f) Press [Sweep/Antenna] →[Recall Antenna] to select the antenna factor file; 
g) Press [Sweep/Antenna] →[Residence time +∞ Manual] to set the residence time; 
h) Press [Sweep/Antenna] →[Dwell time Off On] to set the residence time switch. 

i) Press 【Marker 】 →[Marker Off On] to turn on or off the marker; 

j) Press【Peak】to directly position the marker at the maximum point. 

 
 

The residence time refers to the time staying at the frequency point after 

the measured value of the current frequency point exceeds the set limit 

value after the limit switch is turned on. 

The schematic diagram of frequency sweep measurement is shown in the following figure (for 

example only) 

Notice 
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Figure 12-3 Schematic Diagram of Frequency Sweep Measurement Mode 

12.1.3 List sweep measurement 

The main operation steps of list sweep measurement are as follows: 

a) Press 【List Edit】 →[Edit List] to edit the current list; 

b) Press 【List Edit】 →[Edit List]→[Frequency] to set the frequency value of each segment; 

c) Press 【List Edit】 →[Edit List] →[Bandwidth] to set the bandwidth value, which will be set to 

be 150 Hz, 300 Hz, 600 Hz, 1.5 kHz, 2.4 kHz, 6 kHz, 9 kHz, 15 kHz, 30 kHz, 50 kHz, 120 kHz, 

and 150kHz; 

d) Press 【Measure】→[List Sweep] to switch the current measurement mode to the list sweep 

mode; 

e) Press [Sweep/Antenna] →[Recall Antenna] to select the antenna factor file; 

f) Press [Sweep/Antenna] →[Residence time +∞ Manual] to set the residence time; 

g) Press [Sweep/Antenna] →[Dwell time Off On] to set the residence time switch. 

h) Press 【Mkr】 →[Marker Off On] to turn on or off the marker; 

i) Press【Peak】to directly position the marker at the maximum point. 

 
 The list sweep mode can only be switched when the list exists! 

The schematic diagram of list sweep measurement is shown in the following figure (for example 

only) 

Notice 
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Figure 12-4 Schematic Diagram of List Sweep Measurement Mode 
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12.2 Menu structure of field strength measurement 

点频频率
500MHz

频率

频率步进

自动 手动

频率跟踪

关 开

起始频率
500MHz

频率

步进频率
10MHz

扫描点数
58

参考值
107dBuV

幅度

衰减器

自动 手动

刻度/格
20.0dB

极限

关 开

声音报警

关 开

单位
dBuV

>

dBm

单位

dBmV

dBuV

Volt

Watt带宽
30kHz

带宽

检波 >

峰值

检波

均值

实时

返回

>

>

最大值

光标

光标

关 开

关

解调

调频

调幅

上边带

下边带

音频啸叫

关 开

音量
95

点频测量

测量

频率扫描

列表扫描

 

Figure 12-5 Overall Menu Block Diagram of Field Strength Measurement 
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扫描类型

连续 单次

扫描/天线

重新扫描

驻留时间

+∞ 手动

驻留时间

关 开

调用天线 >

编辑天线 >

保存天线

表头

表尾

上一页

下一页

立即调用

删除

全部删除

取消

增加编辑点

编辑天线

删除编辑点

清空所有点

完成编辑

取消编辑

>

编辑列表

列表编辑

保存列表

调用列表

>

>

增加编辑点

编辑列表

删除编辑点

清空所有点

完成编辑

取消编辑

>

表头

表尾

上一页

下一页

立即调用

删除

全部删除
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Figure 12-6 Overall Menu Block Diagram of Field Strength Measurement (Continued) 
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12.3 Description of field strength measurement menu 

12.3.1 Frequency menu (point frequency measurement mode) 

点频频率
500MHz

频率

频率步进

自动 手动

频率跟踪

关 开
 

·[Point Frequency]:  Press 【Freq】 → [Point Frequency],  through 

the number keys on the front panel, select [GHz], [MHz], [kHz] and [Hz] 

in the frequency unit menu, or use the 【↑】【↓】 keys and the knob to 

set the point frequency.  

·[Special Notes]: The point frequency setting range is 1 MHz ~ 44 

GHz.  

·[Freq Step]: Press 【Freq】 →[ Frequency Step  Auto  Man ], and 

set the  【↑】【↓】 keys and the knob to change the step value of the 

point frequency . In the automatic state, the frequency step is set to be 

1 MHz.  

·[Frequency Tracking Off On]:  Press 【Freq】→[ Frequency 

Tracking  Off  On ] to set the frequency tracking switch. In the state 

of frequency tracking on, the instrument can automatically track the 

frequency value of the peak point, and display the frequency of the 

tracked peak point in the frequency display area of the current screen.  

·[Special Notes]: The peak point tracked by the frequency is the peak 

point of the search amplitude signal in the current bandwidth range.  

12.3.2 Frequency menu (frequency sweep measurement mode) 

起始频率
500MHz

频率

步进频率
10MHz

扫描点数
58

 

·[Start Frequency 500 MHz]:  Press 【Freq】 → [Start Frequency  

500MHz] , through the number keys on the front panel, select [GHz], 

[MHz], [kHz] and [Hz] in the frequency unit menu, or use the 【↑】【↓】 

keys and the knob to set the start frequency.  

·[Special Notes]: The start frequency setting range is 1 MHz ~ 44 

GHz.  

·[Step Frequency 10 MHz]:  Press 【Freq】 →[ Step Frequency  

10MHz] , and set the  【↑】【↓】 keys and the knob to change the step 

value of the sweep frequency .  

·[Number of Sweep Points 58]:  Press【Freq】→[Number of Sweep 

Points  58], set the number of sweep points for frequency sweep, and 

the setting range for the number of sweep points is 2~58.  
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12.3.3 Amplitude menu 

参考值
107dBuV

幅度

衰减器

自动 手动

刻度/格
20.0dB

极限

关 开

声音报警

关 开

单位
dBuV

>

 

·[Reference Value 107 dBuV]:  Press 【Amplitude】 → [ Reference 

Value 107dBuV ], use the number keys on the front panel, and then 

select [dBuV], [-dBuV], [mV] and [uV], or use the 【↑】【↓】 keys and the 

knob to set the reference value.  

·[Special Notes]: The reference value setting range is -43 dBuV ~ 147 

dBuV.  

·[Attenuator Auto Man]:  Press 【Amplitude】 →[ Attenuator Auto  

Man ], in the automatic state of the attenuator, the attenuator will 

automatically adjust the attenuation value according to the reference 

value, and in the attenuator manual state, the attenuator will always use 

the set attenuation value.  

·[Scale/Graduation 20.0 dB]:  Press 【Amplitude】 → [ Scale/ 

Graduation  20.0dB ], use the number keys on the front panel, and 

then select [dB] and [-dBm] in the frequency unit menu, or use the 【↑】

【↓】 keys and the knob to set the reference value.  

·[Limit Value Off On]:  Press 【Amplitude】 →[ Limit Value  Off  

On ].  By pressing this menu, you can choose to turn on or off the limit 

value switch .  

·[Audible Alarm Off On]:  Press 【Amplitude】 →[Audible Alarm Off  

On ].  By pressing this menu, you can choose to turn on or off the 

audible alarm switch .  

·[Unit dBuV]:  Press 【Amplitude →[ Unit],  open the unit function 

menu, and you can select the menu types, including [dBm], [dBmV], 

[dBuV], [Volt], and [Watt].  

12.3.4 Bandwidth menu 

带宽
30kHz

带宽

检波 >

 

·[Bandwidth 30 kHz]:  Press 【Amplitude → [ Bandwidth 30kHz ], use 

the number keys on the front panel, and then select [GHz], [MHz], [kHz] 

and [Hz], or use the 【↑】【↓】 keys and the knob to set the reference 

value.  

·[Special Notes]: The bandwidth value can only be set as 150 Hz, 300 

Hz, 600 Hz, 1.5 kHz, 2.4 kHz, 6 kHz, 9 kHz, 15 kHz, 30 kHz, 50 kHz, 

120 kHz, and 150kHz.  

·[Detection]:  Press 【BW】→[ Detection] to open the detection menu. 

The available detection types include: Peak, average, and real-time.  
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12.3.5 Marker menu 

最大值

光标

光标

关 开
 

·[Max]: Press 【Mkr】 →[ Maximum]. By pressing this menu, you can 

display the marker at the maximum point position.  

·[Mkr Off On]: Press 【Mkr】→[Marker  Off  On ].  By pressing this 

menu, you can choose to turn off or on the marker display.  

·[Special Notes]: The marker menu is only effective in the frequency 

sweep mode and the list sweep mode.  

12.3.6 Peak menu 

最大值

峰值

光标

关 开
 

·[Max]: Press 【Peak】 →[ Max]. By pressing this menu, you can 

display the marker at the maximum point position.  

·[Mkr Off On]: Press 【Peak】→[ Marker Off  On ].  By pressing this 

menu, you can choose to turn off or on the marker display.  

·[Special Notes]: The peak menu is only effective in the frequency 

sweep mode and the list sweep mode.  

12.3.7 Sweep/antenna menu 

扫描类型

连续 单次

扫描/天线

重新扫描

驻留时间

+∞ 手动

停留时间

关 开

调用天线 >

编辑天线 >

保存天线

 

·[Swp Type Cont Single]: Press 【Sweep /Antenna】→ [Sweep Type 

Continuous  Single ], and it is used to set the continuous sweep mode 

or the single sweep mode .  

·[Re-sweep]: Press 【Sweep /Antenna】→[Sweep Again], and it is 

used to sweep again.  

·[Residence time +∞ Manual]:  Press 【Sweep /Antenna】

→[Residence time + ∞ Manual ],  and it is used to set the residence 

time. The residence time refers to the time staying at this point when 

the amplitude of the sweep point exceeds the limit value. The default is 

infinity, and the manual setting range is 1 ms ~ 40 s.  

·[Special Notes]: The residence time is only effective when the limit 

switch is turned on.  

·[Dwell Time Off On]:  Press 【Sweep /Antenna】→[Dwell Time  Off  

On],  and it is used to set the dwell time. The dwell time refers to the 

waiting time of sweep at each time. The default is Off, and the manual 

setting range is 1 ms ~ 40 s.  

·[Special Notes]: Dwell time and residence time are only effective in 

the frequency sweep mode and the list sweep mode.  

·[Recall Antenna]:  Press 【Sweep /Antenna】→[ Recall Antenna] 

to pop up the soft menus such as [Header], [Footer], [Page Up], [Page 

Down], [Recall Immediately], [Delete], etc. You can select the saved 

antenna factor file and call .  

·[Edit Antenna]:  Press 【Sweep /Antenna】→[Recall Antenna] to  

pop up the soft menus such as [ Add Edit Point], [ Delete Edit Point], 
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[ Clear All Points], [ Complete Editing], [ Cancel Editing], etc. It is used 

to edit the antenna factors.  

·[Save Antenna]:  Press 【Sweep /Antenna】→[Save Antenna] to  

open the antenna saving dialog box. It is used to save the antenna 

factor file.  

12.3.8 Demodulation menu 

关

解调

调频

调幅

上边带

下边带

音频啸叫

关 开

音量
95

 

·[Off]:  Press 【Demodulation】 →[Off] to turn off the demodulation 

mode  .  

·[Frequency Modulation]:  Press 【Demodulation】 →[ Frequency 

Modulation],  and it is used to switch demodulation to the frequency 

modulation mode.  

·[Amplitude Modulation]:  Press 【Demodulation】 →[Amplitude 

Modulation],  and it is used to switch demodulation to the amplitude 

modulation mode.  

·[Upper Sideband]:  Press 【Demodulation】 →[ Upper Sideband],  

and it is used to switch demodulation to the upper sideband mode.  

·[Lower Sideband]:  Press 【Demodulation】 →[Lower Sideband],  

and it is used to switch demodulation to the lower sideband mode.  

·[Audio Howling Off On]:  Press 【Demodulation】 → [Audio 

Howling Off   On],  and it is used to enable or disable the audio 

howling function.  

·[Special Notes]: After the audio howling switch is turned on, the 

demodulation modes of [Frequency Modulation ], [Amplitude 

Modulation ], [Upper Sideband ], [Lower Sideband ], etc. will no longer 

work.  

·[Volume 95]:  Press 【Demodulation】 → [Volume  95 ] to  set the 

demodulation volume. You can use the number keys or the 【↑】【↓】 

keys or the knob to set the desired volume value.  

12.3.9 List edit menu 

编辑列表

列表编辑

保存列表

调用列表

>

>

 

·[Edit List]: Press 【List Edit】 →[ Edit List] to  pop up the soft menus 

of [Add Edit Point ], [Delete Edit Point ], [Clear All Points ], [Complete 

Editing ], [Cancel Editing ], etc. It is used to edit the list items.  

·[Save List]:  Press 【List Edit】 →[ Save List ] to  open the list file 

save dialog box for list file saving.  

·[Recall List]:  Press 【List Edit】 →[ Recall List] to pop up the soft 

menus such as [Header], [Footer], [Page Up], [Page Down], [Recall 

Immediately], [Delete], etc. You can select the saved list file and recall 

it. 
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12.3.10 Measurement menu 

点频测量

测量

频率扫描

列表扫描

 

·[Point Frequency Measurement]:  Press 【Measure】 → [Point 

Frequency Measurement], and  switch the field strength 

measurement mode to the point frequency measurement mode.  

·[Freq Sweep]: Press 【Measure】 → [Frequency Sweep], and  

switch the field strength measurement mode to the frequency sweep 

measurement mode.  

·[List Sweep]: Press 【Measure】 → [List Sweep], and  switch the 

field strength measurement mode to the list sweep measurement 

mode.  

·[Special Notes]: Before switching the list sweep mode, make sure 

that a list file exists currently. It can be viewed through the 【List Edit】 

-[Edit List] menu.  
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13 Location analyzer mode (optional) 

13.1 Introduction to typical measurements 

The Location analyzer measurement mode is an extension of the spectrum measurement mode. 

After startup, press 【Mode】 to pop up a mode selection dialog box, select [Spectrum Analysis 

Mode], and press [OK] to enter the spectrum analysis mode after completing the progress bar. 

Then press 【System】 → [Measurement Mode] → [Location analyzer] on the touch screen to 

enter the Location analyzer mode. 

 

Figure 13-1 Main Interface of Location analyzer Mode 

It is mainly used for positioning interference sources or unknown signal sources, and the direction 
of interference signals can be quickly positioned by using external receiving antenna and 
electronic compass; 

 
 

The Location analyzer measurement mode shall be configured with the 

options of the receiving antenna and the electronic compass. Since the 

azimuth measurement of the electronic compass used in the Location 

analyzer adopts the principle of geomagnetism, please try to keep a 

distance from the magnetic object during the test. 

The Location analyzer measurement is mainly divided into three measurement modes: 

13.1.1 Direct lookup 

The main steps for the direct lookup measurement are as follows: 

a) Press 【Measure】 →[Direct Lookup] to select the direct lookup measurement mode; 

b) Press [Freq]→[Center Freq] to set the center frequency value; 

c) Press 【BW】→[BW] to set the bandwidth value, which will be set to 150Hz, 300Hz, 600Hz, 

1.5kHz, 2.4kHz, 6kHz, 9kHz, 15kHz, 30kHz, 50kHz, 120kHz, 150kHz; 

d) Press 【Sweep/Antenna】→[Recall Antenna] to select the antenna factor file; 

e) Press 【Demodulation】 to set the demodulation type and demodulation volume. 

f) The schematic diagram of direct lookup measurement is as shown in the figure below (for 

example only) 

Notice 
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Figure 13-2 Schematic Diagram of Direct Lookup Measurement Mode 

13.1.2 Horizontal sweep 

Horizontal sweep is to display the measured value information after rotating one cycle of the 
current measurement point on a horizontal disc. The main operation steps of horizontal sweep 
measurement are as follows: 

a) Press 【Measure】 →[Horizontal Sweep] to select the horizontal sweep measurement mode; 

b) Press [Freq]→[Center Freq] to set the center frequency value; 

c) Press 【BW】→[BW] to set the bandwidth value, which will be set to 150Hz, 300Hz, 600Hz, 

1.5kHz, 2.4kHz, 6kHz, 9kHz, 15kHz, 30kHz, 50kHz, 120kHz, 150kHz; 

d) Press 【Sweep/Antenna】→[Recall Antenna] to select the antenna factor file; 

e) Press 【Demodulation】 to set the demodulation type and demodulation volume. 

The schematic diagram of horizontal sweep measurement is as shown in the following figure (for 

example only) 



4957B RF Analyzer User Manuals 

Location analyzer mode(optional) 

 191 / 248 

 

 

Figure 13-3 Schematic Diagram of Horizontal Sweep Measurement Mode 
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13.2 Menu structure of Location analyzer 

翻页1/2
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Figure 12-5 Overall Menu Block Diagram of Location analyzer 
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13.3 Description of Location analyzer menu 

13.3.1 Frequency menu 

中心频率
500MHz

频率

频率步进

自动 手动

定位选择
1  2  3  4  5  6

定位保存

定位编辑

 

·[Center Frequency]:  Press 【Freq】 → [Center Frequency], through 

the number keys on the front panel, select [GHz], [MHz], [kHz] and [Hz] 

in the frequency unit menu, or use the 【↑】【↓】 keys and the knob to 

set.  

·[Special Notes]: When using the 【↑】【↓】 keys and the knob, the size 

of the frequency step is the same as the set value of the [Step 

Frequency]. After pressing the [Step Frequency Auto Man] to switch to 

[Step Frequency Auto Man], you can use the number keys or the 【↑】

【↓】 keys and the knob to set the step frequency value.  

·[Frequency Step Auto Man]:  Press 【Freq】 → [Frequency Step], 

through the number keys on the front panel, select [GHz], [MHz], [kHz] 

and [Hz] in the frequency unit menu, or use the 【↑】【↓】 keys and the 

knob to set.  

·[Positioning Selection 1 2 3 4 5 6]:   Press 【Freq】 →[Positioning 

Selection], and the data saving function of 6 different location 

information can be realized by switching the menu mark.  

·[Positioning Save]:   Press 【Freq】 →[Positioning Save], and the 

data saving function of current positioning information can be realized 

by this menu.  

·[Positioning Edit]:   Press 【Freq】→[Positioning Edit] to open the 

positioning data editing submenu, and you can [Edit Positioning Point], 

[Delete Positioning Point] and [Complete Editing].  

13.3.2 Amplitude menu 

参考值
107.0dBuV

幅度

衰减器

自动 手动

前置放大器

关 开

单位
dBuV

>

 

·[Reference Value 107.0 dBuV]:  Press 【Amplitude】 → [Ref Level], 

use the number keys on the front panel, and then select [dBuV], 

[-dBuV], [mV] and [uV], or use the 【↑】【↓】 keys and the knob to set.  

·[Special Notes]: When using the [↑][↓] keys and the knob, the step is 

10 dB.  

·[Attenuator Auto Man]:  Press 【Amplitude】 → [Attenuator Auto 

Man] to switch the automatic and manual switch of the attenuator 

through the menu. You can use the number keys, and you can also use 

the 【↑】【↓】 keys and the knob to change.  

·[Special Notes]:  The setting range of the attenuation value is 0 dB - 

50 dB, with the step value of 10 dB.  

·[Unit dBuV]:  Select the unit of the vertical axis, including [dBm], 

[dBmV], [dBuV], [Volt], [Watt], [A], [dBW], [dBV], [dBA], [dBmA] and 

[dBuA].  

·[Preamplifier Off On]:  Press 【Amplitude】 →[Preamplifier Off On], 

you can choose whether to turn on the pre-amplifier through the menu  
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13.3.3  Bandwidth menu 

Bandwidth
30kHz

Bandwidth

Detector >>

 

·[Bandwidth 30 kHz]:   Press 【BW】→[Bandwidth 30 kHz], and set 

through the number keys on the front panel or the 【↑】【↓】 keys and 

the knob.  

·[Special Notes]:   Since the resolution bandwidth is subject to the 

bandwidth of the intermediate frequency filter, the shape of the trace 

depends on the intermediate frequency filter. This instrument supports 

variable resolution bandwidth settings, with the range of 150Hz, 

300Hz, 600Hz, 1.5kHz, 2.4kHz , 6kHz, 9kHz, 15kHz, 30kHz, 50kHz, 

120kHz and 150KHz.  

·[Detection]:   Press 【BW】 →[Detection], you can select the three 

detection modes of: [Peak], [Average], and [Real-time].  

13.3.4 Marker menu 

最大场强角度

自动 手动

光标

角度范围

 

·[Maximum Field Strength Angle  Auto Man]:   Press 【Mkr】

→[Max Field Strength Angle Auto  Man] to select the currently 

judged maximum field strength angle mode.  

·[Angle Range]:   Press 【Mkr】→[Angle Range] to select the display 

range of the current local directional diagram.  

·[Special Notes]: The marker menu is only available in the horizontal 

sweep mode; and the local directional diagram pops up when you 

choose to manually judge the maximum field strength angle.  
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13.3.5 Peak menu 

最大峰值

峰值

次峰值

右邻峰值

左邻峰值

 

·[Max Peak]:  Press 【Peak】→[Max Peak] to set the currently active 

marker to the maximum peak point of the field strength in the 

measurement directional diagram.  

·[Sub Peak]:  Press 【Peak】→[Sub Peak] to move the active marker 

to the next highest point that is associated with the current marker 

position on the directional diagram.  

·Left Peak]: Press 【Peak】→[Left Peak] to find the next peak to the 

left of the current frequency marker position.  

·[Right Peak]: Press 【Peak】→[Right Peak] to find the next peak to 

the right of the current frequency marker position.  

·[Special Notes]: The marker menu is only available in the horizontal 

sweep mode.  

13.3.6 Sweep/antenna menu 

扫描类型

连续 单次

扫描/天线

重新扫描

调用天线

编辑天线

保存天线

>

>

 

·\[Sweep Type Continuous Single]: Press 【Sweep/Antenna】

→[Sweep Type Continuous Single]. The sweep method setting 

determines how the instrument sweeps and when it stops to enter into 

the hold state. In the interference analysis mode, it provides two sweep 

modes: Continuous sweep and single sweep.  

·[Sweep Again]: Press 【Sweep】 →[Sweep Again] to restart the 

sweep.  

·[Recall Antenna]:  Press 【Sweep/Antenna】→[Recall Antenna] to 

pop up the soft menus such as [Header], [Footer], [Page Up], [Page 

Down], [Recall Immediately], [Delete], etc. You can select the saved 

antenna factor file and recall it .  

·[Edit Antenna ]:  Press 【Sweep/Antenna】→[Recall Antenna] to  

pop up [Add Edit Point], [Delete Edit Point], [Clear All Points], 

[Complete Editing], [Cancel Editing], etc. It is used to edit the antenna 

factors.  

·[Save Antenna]： Press 【Sweep/Antenna】 →[Save Antenna] to  

open the antenna saving dialog box. It is used to save the antenna 

factor file.  
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13.3.7 Demodulation menu 

关

解调

调频

调幅

上边带

下边带

音频啸叫

关 开

音量
95

 

·[Off]:  Press 【Demodulation】→[Off] to turn off the demodulation 

mode .  

·[Frequency Modulation]:  Press 【Demodulation】→[Frequency 

Modulation],  and it is used to switch demodulation to the frequency 

modulation mode.  

·[Amplitude Modulation]:  Press 【Demodulation】→[Amplitude 

Modulation],  and it is used to switch demodulation to the amplitude 

modulation mode.  

·[Upper Side band]:  Press 【Demodulation】→[Upper Sideband,  

and it is used to switch demodulation to the upper sideband mode.  

·[Lower Sideband]:  Press 【Demodulation】→[Lower Sideband],  

and it is used to switch demodulation to the lower sideband mode.  

·[Audio Howling Off On]:  Press 【Demodulation】→[Audio Howling 

Off On] to  turn on or off the audio howling function.  

·[Special Notes]: After the audio howling switch is turned on, the 

demodulation methods of [Frequency Modulation], [Amplitude 

Modulation], [Upper Sideband], [Lower Sideband], etc. will no longer 

work.  

·[Volume 95]:  Press 【Demodulation】→[Volume 95],  and it is used 

to set the demodulation volume. You can set the desired volume value 

through the number keys or the 【↑】【↓】 keys or the knob.  

13.3.8 Measurement menu 

直接查找

测量

水平扫描

地图定位

 

·[Direct Lookup]:   Press 【Measure】→[Direct Lookup] to select the 

current measurement mode as the direct lookup mode.  

·[Horizontal Sweep]:   Press 【Measure】→[Horizontal Sweep] to 

select the current measurement method as the horizontal sweep 

mode.  

·[Map Positioning]:   Press 【Measure】→[Map Positioning] to select 

the current measurement method as the map positioning mode.  
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13.3.9 Map menu 

定位

实时 调用

地图

放大

缩小

标记

定位数据

>

 

·[Positioning Real-time Recall]:  Press 【Map】→[Positioning 

Real-time Recall]. The real-time positioning mode means that the 

current measurement is refreshed in real time with the GPS and the 

compass, and the calling of the positioning mode is to display the 

positioning data measured at different positioning points on the 

current map.  

·[Zoom in]:   Press 【Map】→[Zoom in] to display the currently 

called map in an enlarged scale.  

·[Zoom out]:   Press 【Map】→[Zoom out] to display the currently 

called map in a reduced scale.  

·[Marker]: Press 【Map】→[Marker] to open the marker submenu, 

[Marker Current Position], [Marker Delete Marker], and [Marker 

Delete All]. Measurement information  at different locations and in 

different directions can be displayed on the map via the marker 

submenu . 

·[Positioning Data]:   Press 【Map】→[Positioning Data] to open 

the positioning data sheet on the selected positioning point, and you 

can select [Delete], [Recall], and [Cancel].  

·[Special Notes]: The [Positioning Data] menu can only be used 

after calling the positioning mode.  
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14 Signal analysis mode (optional) 

14.1 Introduction to typical measurements 

The signal analysis measurement mode is an extension of the spectrum measurement mode. 

After startup, press 【Mode】 to pop up a mode selection dialog box, select [Spectrum Analysis 

Mode], and press [OK] to enter the spectrum analysis mode after completing the progress bar. 

Then press 【System】 → [Measurement Mode] → [Signal Analysis] on the touch screen to enter 

the signal analysis mode. 

The signal analysis measurement mode provides a rapid analysis for interference signals. With 
the help of waterfall charts, the display and playback of historical data can be realized. Through 
the shortcut menu, the parameters such as the center frequency, the sweep width, etc. can be 
quickly modified, and audio output and IQ capture function can also be quickly realized. 

 
 

All operations in this section are based on the premise of the selected 

signal analysis mode, which will not be described separately later. 

The main interface of the signal analysis measurement mode refers to the interference analysis 
waterfall chart measurement. It can be used to easily observe the periodic or hopping interference 
signals. A shortcut menu is specially designed for the signal analysis, so that the setting of the 
parameters such as the center frequency, the seep width can be quickly realized. At the same time, 
audio output and IQ capture can be turned on quickly, improving the ability of quickly analyzing 
interference signals. The main interface of signal analysis is as shown in Figure 14-1 below: 

 

Figure 14-1 Main Display Interface of Signal Analysis Measurement Mode 

Signal analysis is designed with a signal list switch menu, which can be used to easily check the 
parameters such as the frequency, the amplitude, the capture time, etc. of the captured 
interference signal. The display results are shown in Figure 14-2 below. 

 

Notice 
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Figure 14-2 Signal List Interface 

The IQ capture function can be used to directly store the IQ data of interference signals. The IQ 
capture interface is shown in Figure 14-3 below: 

 

Figure 14-3 Schematic Diagram of IQ Capture Function 

In the signal analysis mode, the current test task can be quickly stored, and the test task can be 
saved with an automatically generated file name according to the currently set intermediate 
frequency and sweep width and the current test time. 

The signal analysis storage task is shown in Figure 14-4 below: 
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Figure 10-4 Schematic Diagram of Signal Analysis Storage Tasks 
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14.2 Signal analysis menu structure 

信号标准
--

中心频率

频率
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起始频率
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Figure 14-5 Overall Menu Block Diagram of Signal Analysis 
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Figure 14-6 Overall Menu Block Diagram of Signal Analysis (Continued) 
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14.3 Description of signal analysis menu 

14.3.1 Frequency menu 

中心频率

频率

扫宽 

起始频率

终止频率

步进频率

自动 手动

信号标准
--

信道号
--

>

>

 

·[Center Frequency]: Press 【Freq】→[Center Freq], use the numeric 

keys on the front panel, select [GHz], [MHz], [kHz] and [Hz] in the 

frequency unit menu, or use the 【↑】【↓】 keys and the knob for setting.  

·[Special Notes]: When using the 【↑】【↓】 keys and the knob, the 

size of the frequency step is the same as the set value of the [Step 

Frequency]. After pressing the [Step Frequency Auto Man] to 

switch to [Step Frequency Auto Man], you can use the number 

keys or the 【↑】【↓】 keys and the knob to set the step frequency 

value.  

·[Sweep Width]： Press 【Freq】→[Span] to activate the span 

submenu. You can use the numeric keys, and then select the 

frequency unit to change. You can also use the 【↑】【↓】 keys and the 

knob to change the span. For the detailed information, please refer to 

the description of the [Span] menu.  

·[Special Notes]: Use the 【↑】【↓】 keys and the knob to change the 

span with a step of 1-2-5.  

·[Start Freq]: Press 【Freq】→[Start Freq], use the numeric keys on 

the front panel, select the frequency unit, or use the 【↑】【↓】 keys and 

the knob for setting.  

·[Stop Freq]: Press 【Freq】→[Stop Freq], use the numeric keys on the 

front panel, select the frequency unit, or use the 【↑】【↓】 keys and the 

knob for setting.  

·[Signal Standard]: Press 【Freq】→[Signal Standard], use the 【↑】

【↓】 keys and the knob to select the signal standard, and use the 

dialog box menu [Immediate Recall] or [OK] key  for recalling. Refer 

to the dialog box menu for details of the dialog box menu.  

·[Special Notes]: After the signal standard is loaded, the center 

frequency and the span are set to the center frequency and the 

span value defined in the signal standard.  

·[Channel No.]: Press 【Freq】→[Channel No.] to pop up the channel 

number setting dialog box, and use the numeric keys or the 【↑】【↓】 

keys and the knob to set the channel number.  

·[Special Notes]: The setting of the channel number shall be carried 

out under the premise of loading the signal standard, otherwise a 

prompt that it cannot be set will pop up.  
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14.3.2 Sweep width menu 

扫宽

扫宽

全扫宽

零扫宽

上次扫宽

< 返回

 

·[Span]: Press 【Freq】→[Span] to activate the span submenu. You 

can use the numeric keys, and then select the frequency unit to 

change. You can also use the 【↑】【↓】 keys and the knob to change 

the span. For the detailed information, please refer to the description of 

the [Span] menu.  

·[Special Notes]: Use the 【↑】【↓】 keys and the knob to change the 

span with a step of 1-2-5.  

·[Full Span]: Press [Span]→[Full Span] to set the current span to 

44.1GHz.  

·[Zero Sweep Width]: Press 【Freq】→[Span]→[Zero Span] to set the 

current span to 0Hz.  

·[Last Span]: Press 【Freq】→[Span]→[Last Span] to restore the span 

to the value set last time. 

·[Back]: Press 【Freq】→[Span]→[Back] to return to the 【Freq】 

menu.   

14.3.3  Amplitude menu 

参考电平
0.0dBm

幅度

参考位置

衰减器

自动 手动

刻度/格
20.0dB

幅度单位
dBm

前置放大器

关 开
 

·[Ref Level]: Press 【Amplitude】→[Ref Level], use the numeric keys on 

the front panel, and then select [dBuV], [-dBuV], [mV] and [uV], or use 

the 【↑】【↓】 keys and the knob to set it. 

·[Special Notes]: When the 【↑】【↓】 keys and the knob are used, the 

step is 10dB.  

·[Ref Pos]: Press 【Amplitude】→[Ref Pos], and use the numeric keys 

or the 【↑】【↓】 keys and the knob to change it.  

·[Atten Auto Man]: Press 【Amplitude】→[Atten Auto Man] to switch the 

automatic and manual switch of the attenuator through the menu. You 

can use the numeric keys or the 【↑】【↓】 keys and the knob to change 

it.  

·[Special Notes]:  The setting range of the attenuation value is 0 dB - 

50 dB, with the step value of 10 dB.  

·[Scale]: Press 【Amplitude】→[Scale], and use the numeric keys or the 

【↑】【↓】 keys and the knob to set the scale within the setting range of 

0.1dB - 20dB.  

·[Amp Unit]:  The amplitude unit is uniformly displayed in dBm.  

·[Pre Amp Off On]: Press 【Amplitude】→[Pre Amp Off On]  to turn the 

preamplifier on or off.  
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14.3.4 Bandwidth menu 

分辨率带宽

自动 手动

带宽

视频带宽

自动 手动

平均

关 开

SPAN/RBW
100

RBW/VBW
1

检波    

自动
>

视频类型

线性 对数

 

·[RBW Auto Man]: Press 【BW】→[RBW Auto Man], and use the 

numeric keys on the front panel or the 【↑】【↓】 keys and the knob to 

set it.  

·[Special Notes]: Since the resolution bandwidth is subject to the 

bandwidth of the IF filter, the shape of trace depends on the IF 

filter. This instrument supports variable resolution bandwidth 

settings, ranging from 1 Hz. ~10MHz, which can be changed with 

a step of 1-3-10.  

·[VBW Auto Man]: Press 【Amplitude】→[VBW Auto Man], and use 

the numeric keys or the 【↑】【↓】 keys and the knob to change it.  

·[Special Notes]: The video bandwidth filter is used to smooth the 

traces, aiming to improve the ability of detecting weak signals in 

noise signals. This instrument supports variable resolution 

bandwidth settings, ranging from 1Hz~10MHz, which can be 

changed with a step of 1-3-10.  

·[Video Type Linear Logarithm]:   Press 【BWh】→[Video Type 

Linear Logarithm] to set the video bandwidth filter data processing.  

·[Ave Off On]: Press 【BW】→[Ave Off On], the average function can 

smooth the display trace without changing the video bandwidth filter, 

and use the numeric keys or the 【↑】【↓】 keys and the knob to change 

it.  

·[SPAN/RBW]: Press 【BW】→[SPAN/RBW] to set the ratio of span to 

resolution bandwidth. In automatic mode, the resolution bandwidth will 

automatically change with the change of span. You can use numeric 

keys or the 【↑】【↓】 keys and the knob to change it.  

·[RBW/VBW]: Press 【BW】→[RBW/VBW]. In automatic mode, the 

video bandwidth will change with the change of resolution bandwidth. 

You can use numeric keys or the 【↑】【↓】 keys and the knob to change 

it.  

·[Detection]: Press 【BW】→[Detection] to open the detection function 

submenu. Please refer to the [Detection] menu for details.  
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·[Auto]: Press 【BW】→[Detection]→[Auto], the detection is the same 

as that in the spectrum analysis mode.  

·[Standard]: Press 【BW】→[Detection]→[Standard], the most 

commonly used detection method can see the signal and noise base at 

the same time without losing any signal.  

·[PosPeak]: Press 【BW】→[Detection]→[PosPeak] to ensure that no 

peak signal is missed and to measure the signals that are very close to 

the noise base.  

·[NegPeak]: Press 【BW】→[Detection]→[NegPeak], it is used in the 

self-inspection of the bandwidth millimeter wave RF analyzer in most 

cases, but it is rarely used in the test, and it can reproduce the 

modulation envelope of the AM signal very well.  

·[Sampling]: Press 【BW】→[Detection]→[Sampling], it is beneficial to 

measuring the noise signal, and can measure the noise better than the 

standard detection.  

·[Ave]: Press 【BW】→[Detection]→[Ave] to average the data in the 

sampling interval.  

·[Rms]: Press 【BW】→[Detection]→[Rms] to calculate the root mean 

square of the data in the sampling interval.  

14.3.5 Marker menu 

光标
1 2 3 4 5 6

光标

普通模式

差值模式

噪声光标

关 开

光标- >

光标关闭

全部关闭

>

 

·【Mkr】→[Mkr 1 2 3 4 5 6]: Press 【Mkr】→[Mkr 1 2 3 4 5 6] to switch 

between different marker displays, and the selected marker will be 
marked with an underline.  

·[Normal Mode]: Press 【Mkr】→[Normal Mode] to set the currently 

selected marker display mode to normal mode.  

·[Difference Mode]:  Press 【Mkr】→[Difference Mode], and set the 

currently selected marker display mode to be the difference mode. The 
difference mode displays the frequency difference and the amplitude 
difference (it is time difference at zero sweep width) between the 
difference marker and the reference marker, and the displayed 
amplitude value is dB.  

·[Noise Mkr Off On]:  Press 【Mkr】 → [Noise Marker Off On], the 

noise marker shows the noise power near the activation marker that is 
normalized to the 1 Hz bandwidth. At this time, the detector is in the 
sample detection mode. If the noise marker is turned on, the unit of the 
marker reading is automatically switched to dB/Hz. 

·[Mkr→]: Press 【Mkr】→[Mkr→] to open the marker function submenu, 

which allows users to use the marker as a reference to change the 
instrument display. Please refer to the [Mkr→] function menu for details.  

·[Mkr Off]: Press 【Mkr】→[Mkr Off] to turn off the currently activated 

marker.  

·[All Off]: Press 【Mkr】→[All Off] to turn off all markers that have been 

turned on.  

·[Special Notes]: There is no marker function in RSSI 
measurement mode.  
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·[Mkr→Center Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Center Freq], the 

marker will move to the center frequency, and the reading at the center 

frequency is displayed on the screen.  

·[Mkr→Step Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Step Freq] to set 

the stepping amount of the center frequency, that is, the value of the 

frequency step is equal to the marker frequency. If the difference 

marker function is activated, the frequency step value is equal to the 

frequency of the difference marker.  

·[Mkr→Start Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Start Freq] to set 

the start frequency equal to the marker frequency.  

·[Mkr→Stop Freq]: Press 【Mkr】→[Mkr→]→[Mkr→Stop Freq] to set 

the stop frequency equal to the marker frequency.  

·[Back]: Return to the previous menu 

(not available in RSSI measurement mode) 

14.3.6 Peak menu 

最大峰值

峰值

次峰值

左邻峰值

右邻峰值

最大值

最小值

光标->

中心频率
 

·[Max Peak]: Press 【Peak】→[Max Peak] to set the current active 

marker to the maximum peak point of the measurement trace and 

display the frequency and amplitude of the marker in the upper center 

of the screen.  

·[Sub Peak]: Press [Peak]→[Sub Peak] to move the active marker to 

the next highest point on the trace that is associated with the current 

marker position. 

·Left Peak]: Press 【Peak】→[Left Peak] to find the next peak to the 

left of the current frequency marker position.  

·[Right Peak]: Press 【Peak】→[Right Peak] to find the next peak to 

the right of the current frequency marker position.  

·[Max]: Place a marker at the highest point of the trace and display 

the frequency and amplitude of the marker in the upper right corner of 

the screen. Pressing this button will not change the activated 

functions. 

·[Min]: Press [Peak]→[Min] to place a marker at the lowest point of 

the trace and display the frequency and amplitude of the marker in the 

upper right corner of the screen. Pressing this button will not change 

the activated functions. 

·[Mkr→Center Freq]:  Press [Peak]→[Mkr → Center Freq] and set 

the center frequency equal to the marker frequency. This function 

quickly moves the signal to the center of the screen. 

(not available in RSSI measurement mode) 

  



4957B RF Analyzer User Manuals 

Signal analysis mode  

208 / 248 

14.3.7 Sweep menu 

扫描时间

自动 手动

扫描

扫描类型

连续 单次

重新扫描

扫描点数
1001

 

·[Swp Time Auto Man]: Press 【Swp】→[Swp Time Auto Man] to 

switch the sweep time between Auto and Manual. The underline marks 

the current state. If the sweep time is automatic, the RF analyzer 

automatically sets the sweep time to the fastest according to the 

current instrument status, and the screen displays the fastest sweep 

time under the current setting. If the sweep time is manually set, the 

sweep time value can be input at this time. Use the numeric keys to 

enter the sweep time value and select the time unit by pressing 

corresponding soft key to complete the setting. If the sweep time is 

automatic,  the sweep speed may change depending on the change 

of RBW and VBW. The larger the values of RBW and VBW, the faster 

the sweeping speed and vice versa. If the sweep time of the instrument 

of 4957 meet the minimum sweep time limit, the maximum non-zero 

sweep width can be set to 800 s, and the maximum zero sweep width 

can be set to be 600 s. 

·[Swp Type Cont Single]: Press 【Swp】→[Swp Type Cont Single]. 

The sweep type setting determines how the RF analyzer sweeps and 

when it stops to enter into the hold state. In the interference analysis 

mode, it provides two sweep modes: Continuous sweep and single 

sweep.  

·[Re-sweep]: Press 【Sweep】 →[Sweep Again] to restart the sweep.  

·[Number of Sweep Points]: Press 【Sweep】→[Number of Sweep 

Points], you can select the number of sweep points as [201], [501], 

[1001], [2001] and [4001]. 

14.3.8 Automatic storage menu 

扫描间隔
Auto

自动存储

扫宽时间
Auto

自动存储

关 开

时间光标
0 ns

重启测量

>

 

·[Swp Interval]: Press [Auto Save]→[Swp Interval Auto] to set the 

sweep interval. After setting the sweep time, the trace will be switched 

to the maximum hold state by default to ensure that all signals 

measured during the sweep interval can be recorded.  

·[Span Time]: Press [Auto Save]→[Span Time Auto], and the span 

time is the entire sweep time. After the sweep reaches the span time, it 

will stop recording.  

·[Auto Save Off On]: Press [Auto Save]→[Auto Save Off On], and 

press the menu to switch the automatic save switch.  

·[Special Notes]: The automatic save function cannot be turned 

on until the span time is set.  

·[Time Mkr]: Press [Auto Save]→[Time Mkr] to view the historical 

data.  

·[Special Notes]: It can only be used in the waterfall chart 

measurement mode.  

·[Re-measure]: Press [Auto Save]→[Re-measure] to restart the 

sweep.  
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14.3.9 Configuration menu 

音频解调 

配置

IQ捕获 

>

>

门限

关 开

门限
15.0

信号列表

详细 简洁
 

·[Audio Demodulation]: Press 【Configuration】→[Audio 

Demodulation] to turn on the audio demodulation function.   For the 

detailed introduction, you can refer to the description of the menu 

[Audio Demodulation].  

·[IQ Capture]:   Press 【Configuration】→[IQ Capture] to turn on the 

IQ capture function.   For the detailed introduction, you can refer to 

the description of the menu [IQ Capture].  

·[Threshold Off On]：  Press 【Configuration】→[Threshold Off On], 

and you can choose whether to turn on the threshold function.  

·[Threshold 15.0]:   Press 【Configuration】→[Threshold 15.0], and 

you can set the threshold value through the number keys, the knob or 

the up and down keys.  

·[Signal List Detailed Concise]:   Press 【Configuration】→[Signal 

List Detailed Concise] to select the signal list display mode by 

switching the menu. In the concise display mode, only the frequency, 

bandwidth and amplitude information of the captured interference 

signal are displayed, and in the detailed display mode, the information 

such as the capture time, the number of capture times, etc. of the 

signal can also be displayed.  

14.3.10 Audio demodulation menu 

音频解调

关        开

音频解调

解调类型

调频

解调时间
100.00ms

解调模式

间歇    连续

音量
95

<    返回

>

>

 

·[Audio Demodulation Off On]:  Press 【Configuration】→[Audio 

Demodulation]→[Audio Demodulation Off On] to turn on or off the 

audio demodulation function.  

·[Demodulation type]: Press 【Configuration】→[Audio 

Demodulation]→[Demodulation Type] to set the demodulation type. 

You can select the demodulation type of [FM], [AM], [Upper 

Sideband] or [Lower Sideband]. 

·[Demodulation Time]: Press 【Configuration】→[Audio 

Demodulation]→[Demodulation Time] to set the demodulation time.  

·[Demodulation Mode]: Press 【Configuration】→[Audio 

Demodulation]→[Demodulation Mode] to set the demodulation 

mode.  Set the demodulation mode. In intermittent mode, the data is 

swept for one screen and then demodulated for a period of time 

according to the demodulation time, and then the data is swept for 

one screen and then demodulated for a period of time according to 

the demodulation time, and that cycle repeats.  In continuous mode, 

the data is continuously demodulated after being swept for one 

screen, and then the data is no longer swept. 

·[Volume]: Press 【Configuration】→[Audio 

Demodulation]→[Volume] to set the speaker volume in the 

demodulation mode.  
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14.3.11 IQ capture menu 

IQ捕获

关 开

IQ捕获

开始捕获

捕获时间
1.000ms

捕获模式

单次 连续

采样率
5.000MHz

触发

[自由触发]

存储名称
IQCapture

 

·[IQ Capture Off  On]:  Press 【Configuration】→[IQ Capture]→[IQ 

Capture Off On] to turn on or off the IQ capture function.  

·[Start Capture]:  Press 【Configuration】→[IQ Capture]→[Start 

Capture] to start the IQ data capture and record functions.  

·[Capture Time]:  Press 【Configuration】→[IQ Capture]→[Capture 

Time] to set the IQ capture time. Note that the IQ capture time cannot 

exceed the sweep time.  

·[Capture Type]:  Press 【Configuration】→[IQ Capture]→[Capture 

Type] to set the IQ capture type as single or continuous.  

·[Sampling Rate]:  Press 【Configuration】→[IQ 

Capture]→[Sampling Rate], and press the sampling rate menu to 

pop up the sampling rate dialog box. The sampling rate that can be 

set for IQ capture will be 12.5 MHz, 5 MHz, 1.25 MHz, 500 kHz, 125 

kHz and 50 kHz.  

·[Trig]:   Press 【Configuration】→[IQ Capture]→[Trigger], you can 

choose [Free Trigger] and [External Trigger]. If you set an external 

trigger, you can set [Trigger Polarity] and [Trigger Delay].  

·[Save Name]:   Press 【Configuration】→[IQ Capture]→[Storage 

Name] to set the storage name of the IQ capture file.  
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14.3.12 Shortcut menu 
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关 开
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关 开
 

·[Center frequency]: Press 【Shortcut】 → [Center Frequency], 

press 【Freq】 → [Center Frequency], and through the number keys 

on the front panel, select [GHz], [MHz], [kHz] and [Hz] in the 

frequency unit menu, or use the 【↑】【↓】 keys and the knob to set.  

·[Span]: Press 【Shortcut】 → [Sweep Width], and press 【Freq】 → 

[Sweep Width] to activate the sweep width submenu. You can use the 

number keys, and then select the frequency unit to change. You can 

also use the 【↑】【↓】 keys and the knob to change.  

·[Audio Demodulation Off On]: Press 【Shortcut】→[Audio 

Demodulation Off On] to turn on or off the audio demodulation 

function.  

·[IQ Capture Off On]:  Press 【Shortcut】→[IQ Capture Off On] to 

turn on or off the IQ capture function.  

·[Start Capture]:  Press 【Shortcut】→[Start Capture] to start the IQ 

capture.  

·[Max Peak]:   Press 【Shortcut】→[Max Peak], you can set the 

current active marker to the maximum peak point of the measurement 

trace and display the frequency and amplitude of the marker in the 

upper center of the screen.  

·[Mkr -> Center Freq]:  Press 【Shortcut】→[Marker->Center 

Frequency], and set the center frequency to be equal to the marker 

frequency. This function can quickly move the signal to the center of 

the screen.  

·[Signal List Off On]:   Press 【Shortcut】→[Signal List Off On] to 

open or close the signal list.  
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15 Technical description 

15.1 Working principles 

The 4957B instrument is equipped with numerous functions such as vector network analysis, 
spectrum analysis, cable and antenna test, vector voltmeter, power measurement, etc., and it is a 
multifunctional multi-parameter test instrument. In terms of the overall hardware implementation 
plan, this tester focuses on the design concept of modularization and platform generalization, fully 
utilizes the existing technical foundation and determines the block diagram of implementation plan 
of the final project as shown in Figure 15-1. 

The system hardware can be divided into several large block pieces of a radio frequency channel 
board, a frequency synthesis board, in intermediate frequency channel board, a signal source 
board, signal separation and frequency conversion components, a CPU board, a display screen, a 
keyboard, a battery, etc. 

Among them, the radio frequency channel board includes two parts of a program-controlled step 
attenuator and a switch filtering and frequency conversion. The complete machine will 
automatically associate the attenuation value of the program-controlled step attenuator according 
to the reference level settings, or the user can manually set the attenuation value to provide 
suitable frequency mixer level. The switch filtering and frequency conversion part will complete the 
sub-band filtering and frequency conversion processing of the spectrum radio frequency input 
signal, and it will output the intermediate frequency signal to the intermediate frequency channel 
board. 

The intermediate frequency channel board will filter the intermediate frequency signal input by the 
radio frequency channel board, implement gain control for different bands to adjust the amplitude 
value of the AD sampled signal, and finally output the differential digital signal after AD conversion 
to the FPGA of the CPU board, so as to complete the functions of digital down conversion, 
intermediate frequency filtering, video filtering, etc. 

The frequency synthesis board will provide the local oscillator signal for the frequency mixer of the 
radio frequency channel board. It is related to the indicators such as the hardware sweep speed, 
phase noise, sideband stray, etc. for the spectrum part of the complete machine. At the same time, 
it will also provide the local oscillator signal for the vector network part of the complete machine, 
and output it to the signal separation and frequency conversion components. 

The signal source board will provide a 30 kHz ~ 6.5 GHz excitation signal for the vector network of 
the complete machine, and also provide the intermediate frequency processing function of the 
vector network part. It will carry out filtering and AD conversion for the intermediate frequency 
signal subjected to frequency conversion in the signal separation and frequency conversion 
components, and output the digital signal to the FPGA of the CPU board. 

The signal separation and frequency conversion components are responsible for dividing the 
power adjustment and switching power of the 30 k ~ 6.5 GHz excitation signal into two paths. One 
path will reach the test port 1 via the port 1 directional coupler, and the other path will reach the 
port 2 via the port 2 coupler; dividing the local oscillator signal into 4 channels and sending them to 
the local oscillator end of the 4-way frequency mixer respectively; and carrying out frequency 
mixing for the excitation signal with the local oscillator signal, down converting to the intermediate 
frequency that can be processed by the complete machine, and sending to the signal source 
board.  

The CPU board includes a power conversion and management circuit, an interface and display 
circuit, an FPGA/CPLD control and digital signal processing circuit, and an ARM core module, 
realizing the functions of DC/DC conversion, power work management, digital signal processing, 
logic circuit control, etc. for the power supply part of the complete machine, and finally outputting 
the test results to the LCD display.
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Figure 15-1 Functional Block Diagram of 4957B RF Analyzer
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15.2 Description of fault information 

The section introduces how to find problems and ask for after-sales services. It also includes an 

explanation of the error messages inside the instrument. 

If you purchase a 4957B instrument and encounter some problems during operation, or you want to buy 

relevant parts, options or accessories of 4957B, we will provide you with complete after-sales services. 

Generally, causes of problems are due to hardware, software or user maloperation. In case of any 

problem, please contact us in time. If the 4957B you purchased is within the warranty period, we will 

repair it for free as per the provisions specified in the warranty bill. Even if it is beyond the warranty 

period, we will only charge the cost price. 

 

Description 

This section introduces the way on how to judge and handle failures 

(if any) of the 4957B, and feed them back to the manufacturer as 

accurately as possible if necessary for quick solution. 

In case of any problem with 4957B you are using, you can check it by yourself according to the following 

tips. If the problem cannot be solved, please contact us. 

If 4957B cannot be started after pressing the start button, please check whether the power supply is 

normal and whether the adapter indicator is on or whether the battery level is normal. If there is nothing 

abnormal, instrument may be faulty, please contact us for repair. 

If the 4957B cannot enter the system or application program after startup, please press the 【Reset】 key 

to make 4957B return to a known state. If it still cannot work normally, it may be faulty, please contact us 

for repair. 

If the performance indicators of 4957B are abnormal, please check the test tools and test environment 

for compliance with the requirements, the test port connectors for any damages and the calibration piece 

for normal performance indicators; If everything above is normal, the instrument may be faulty, please 

contact us for repair. 

If the 4957B cannot realize communication via LAN, check the IP settings of the analyzer first, and check 

whether the yellow LED beside the LAN port on the top panel flashes. If no, check the LAN cable 

connection. If there are no problems for the above aspects, the instrument may be faulty, please contact 

us for repair.  
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15.3 Repair 

In case of any failure to 4957B that is difficult to be eliminated, contact us by phone or fax. If it is 

confirmed that the instrument needs to be repaired, please package the instrument according to the 

following steps: 

1) Write a paper document describing the instrument failure and put it in the package together with the  

analyzer; 

2) Pack it with the original packing materials, so as to minimize possible damage; 

3) Place cushions at the four corners of the outer packing carton, and place the instrument in the outer  

packing carton; 

4) Seal the opening of the packing carton with adhesive tape and reinforce the packing carton with  

nylon tape; 

5) Indicate ―Fragile‖ on the box body! Do not touch! Handle with care! and so on. 

6) ease check it as precision instrument, and keep a copy of all shipping documents. 
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16 Technical indicators and testing methods 

This section illustrates the recommended test methods for the main technical indicators of the 4957B 
instrument, and these indicators can fully reflect the performance and condition of the instrument. The 
instrument to be tested should be stored at the operating temperature for at least 2 hours, and then 
started and warmed up for 30 minutes before testing the following indicators without error. 

 

 
 

The specific operation steps for testing the following indicators are 

provided according to the testing instrument shown in the figure. When 

other testing instruments with the same performance characteristics are 

used for testing, please refer to the User‘s Manual of such instruments 

for the specific operation. The reset instrument mentioned in the test 

step refers to the factory reset mode. If the device is in the user-defined 

reset state, it shall be changed to the factory reset state and reset again, 

ensuring that the initial state of the device is in a known state. 

 

16.1 Vector network analysis performance indicator test 

Before the indicator test of this section, first press the 【Mode】 key on the instrument to select the 

working mode as the vector network analysis mode, and carry out the detailed test according to the 
method recommended in this section. 

16.1.1 Frequency range and accuracy 

Description:  Frequency range in this test refers to the range of the minimum frequency and the 
maximum frequency of the signal which can be set for the 4957B instrument (hereinafter referred to as 
the instrument) working at the port in the network analysis mode. Frequency accuracy refers to the 
difference between the measured frequency and the set frequency of the signal output at the port. Use a 
spectrum analyzer that is an order of magnitude higher than the frequency accuracy of the instrument to 
test the port 1 output frequency accuracy of the instrument.  

16.1.1.1 Testing Equipment 

Spectrum analyzer…………………………………………………………………………………….4036 

Test cable and adapter 

16.1.1.2 Test steps 

a) Set the working mode to be the vector network analysis mode, and  press 【Measure】[S11] to set  

the test port as Port 1. 

b) Press 【Freq】 [Start] to set the start frequency of the instrument as the minimum frequency of the  

corresponding model, and press [Stop] to set the stop frequency of the instrument as the maximum 
frequency of the corresponding model; and if they can be set to the minimum and the maximum 
frequencies, it indicates that the frequency range meets the requirements. 

Notice 
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Figure 16-1 Block Diagram of  Frequency Range and Frequency Accuracy Test 

 
c) Connect the instrument as shown in Figure 16-1; connect Port 1 (radio frequency output port) of the  

instrument to the RF input port of the spectrum analyzer, set the reference level of the spectrum 
analyzer to 10 dBm, and enable frequency counting; 

d) Press 【Freq】 [Center Frequency], 1GHz, [Sweep Width], 0Hz, and set the instrument to work at  

the point frequency of 1GHz; 
e) Set the center frequency of the spectrum analyzer to be the same as that of the instrument,  

appropriately change the sweep width of the spectrum analyzer, search the peak, and set it to the 
center; 

f) Read out the count value fo of the spectrum analyzer, and fill in the log sheet; 

16.1.2 Frequency resolution 

Description:  The frequency resolution of this test refers to the minimum frequency difference between 
two adjacent frequency point signals output by the port of the instrument. 

16.1.2.1 Testing Equipment 

Spectrum analyzer…………………………………………………………………………………….4036 

1 piece of N(m-m) cable (100 cm) 
1 piece of BNC(m-m) cable (120 cm) 

16.1.2.2 Test steps 

a) Connect the instrument as shown in Figure 16-2. Connect Port 1 of the instrument to the RF input 
port of the spectrum analyzer, which provides a 10 MHz frequency reference for the instrument. On the 

instrument, press 【System/Local】[Frequency Reference Internal External], and select the 10 MHz 

reference of the instrument as the external reference ;  
b) Set the instrument as follows (other items remain the default settings of the system at startup): 

Center frequency ...................................................................................................................... 2001MHz 

Sweep width .................................................................................................................................. 0 MHz 

Output power  ........................................................................................................................ high power 

Measurement  ................................................................................................................................... S11  

RF Analyzer 

Spectrum analyzer 
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Figure 16-2   Block Diagram of Frequency Resolution Test 
c) Press the reset key on the spectrum analyzer 4036 to make the following settings: 

Center frequency 2001MHz 
Frequency Bandwidth 100 Hz 
Reference Level 10 dBm 

d) On the spectrum analyzer4036, search the peak value, place the marker at the peak value 
and turn on the difference marker; 

e) Set the center frequency fs of instrument to be 2001.00001MHz;  
f) Search the peak value on the spectrum analyzer 4036 again, read out the reading FM of the  

different marker, and record in the 4957B RF Analyzer Record Sheet . 

16.1.3 Power level 

Description: The port output power of the instrument is divided into high, low and manually set. In this 
test, the power level is checked and tested based on its menu. 

The test steps are shown as follows: 

a) Press 【Reset】 on the instrument to set the working mode to vector network analysis mode and the 

test port to Port 1. 

b) Press 【Amplitude】→[Power]→[High] to set the port output power to high. 

c) Press 【Measure】→[Advance]→[A1], [Trace]→[Trace Math]→[Data→Mem]→[Data & Mem]. 

d) Press 【Amplitude】→[Power]→[Low] to set the port output power to low; 

e) Compare the data and the in-memory traces. If the distance is obviously about 20dB~30dB,  
the power range meets the requirements. 

f) Set certain output power manually within the specified range. If the test curve is below the  
high power output curve and relatively flat, the manually set power meets the requirements.  
Make a tick in corresponding place of the test log sheet if it meets the requirements; otherwise, 
make a cross. 

16.1.4 Port output power 

Description: It is to test the settable output power range for the vector network port of the instrument 
meeting a certain power accuracy requirement and the difference between the measured value and the 
actually set value of the port output power meter when the port output power is set to -15 dBm. The 
smaller the difference, the higher the power level accuracy. 

16.1.4.1 Testing Equipment 

Power meter ..................................................................................................................... ML2437A 

Power probe .................................................................................................................... MA2445D 

One 3.5mm (f)-N(m) adapter 

RF Analyzer 

Spectrum analyzer 

10MHz 

Reference 

input 

10MHz 

Reference 

output 

BNC cable 

N-type 

cable 
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Figure 16-3  Block Diagram of Power Level Accuracy Test 

16.1.4.2 Test steps 

a) Set  the instrument to work in the network analysis mode, and press 【Amplitude】 [Output Power] 

[Manual Power]. It can be set within the range of -35dBm~-5dBm. 

b) Connect the power meter ML2437A with the power probe MA2445D for zero calibration, as shown 

in Figure 16-3, and connect Port 1 of the instrument to the power probe through the adapter. 

c) Set the instrument to work in network analysis mode, the test port to Port 1, the output power level 

to -15dBm, and the point frequency to 100MHz. 

d) Set the calibration factor frequency of the power meter to be the same as the output frequency of 

the RF analyzer. 

e) Read the test value of the power meter, calculate the amplitude accuracy index (-15 - power meter 

reading), and record the result in corresponding column of the test form; 

f) Change the test frequency based on the test log sheet, and repeat c)～e) until all tests are 

completed. 

16.1.5 Effective directivity 

Description: The direction is defined as the ratio of the power that occurs at the auxiliary end of a signal 
when it travels in the positive direction to the power that occurs at the auxiliary end of a signal when it 
travels in the reverse direction, expressed in dB. It shows how well a directional device can separate the 
positive and reverse traveling waves. The larger the value of the directional index is, the better its ability 
to separate signals is. Ideally it is infinite. 

16.1.5.1 Testing Equipment 

Calibration kit………`…………………………………………………………………………….20201A/B 
N-type calibration cable 

16.1.5.2 Test steps 

 
Figure 16-4   Block Diagram Of Effective Directivity, Effective Source Matching And Reflection Tracking 
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Test 
a) Set the analyzer as follows (for the other items, keep the default settings at the startup): 

Start frequency .................................................................................................................... 300kHz 

Stop frequency .................................................................................................................... 6.5GHz 

Output power....................................................................................................................... -10dBm 

Intermediate frequency bandwidth ....................................................................................... 100Hz 

Points .......................................................................................................................................  401 

Port 1 effective directivity test 

b) Press 【Measure】[S11] to select the test port as Port 1. Then press 【Cal】[Cal Kit] to select the 

correct calibration kit, and press 【Cal】 [M Cal] [S11 Single Port], so as to complete the 

measurement of standard parts such as OPEN, SHORT and LOAD, and finally press [Done] to 
complete the calibration; 

c) Do not remove the LOAD used in the last step of calibration from the measurement port. Press 
[Sweep/Setup]→[Sweep Once], stop sweep after the instrument finishes the current sweep, and 

press 【Mkr】[Marker search][Max] to find and test the maximum value; 

d) Fill in the Record Sheet of 4957B RF Analyzer with the absolute value of the  
maximum value as the effective directivity index of Port 1; 

e) Remove the calibration kit from Port 1, and press 【[Sweep/Settings] → [Continuous Sweep] to 

make the instrument in the continuous sweep state; 
Port 2 Effective directivity test 

f) Press 【Measure】[S22] to select the test port as Port 2. Then press 【Cal】[M Cal] [S22 Single Port], 

so as to complete the measurement of standard parts such as OPEN, SHORT and LOAD, and 
finally press [Done] to complete the calibration; 

g) Repeat the step c), and fill in the Record Sheet of 4957B RF Analyzer with the absolute value of the 
maximum value as the effective directivity index of Port 2; 

16.1.6 Effective source matching 

Description: Source matching refers to the matching degree of the output impedance equivalent to the 
measurement port with the system standard impedance. In reflection measurement, the source 
matching error signal is the signal reflected by the measured part, then reflected back to the measured 
part by the signal source and finally reflected by the measured part. The source matching is expressed in 
dB. The larger the value is, the better the index is, and the smaller the measurement error is. Ideally it is 
infinite. 

16.1.6.1 Testing Equipment 

Calibration kit………`…………………………………………………………………………….20201A/B 
N-type calibration cable 

16.1.6.2 Test steps 

a) Set the analyzer as follows (for the other items, keep the default settings at the startup): 
Start frequency………………………………………………………………………………300kHz 
Stop frequency………………………………………………………………………………6.5GHz 
Output power………………………………………………………………………………-10dBm 
Intermediatefrequency bandwidth……………………………………………………… 100Hz 
Sweep points……………………………………………………………………………………401 

 

b) Press  【Measure】 [S11] to select the test port as Port 1, then press 【Cal】 [Cal Kit] to select the 

correct calibration kit, and press 【Cal】 [M Cal] [S11 One Port], complete the measurement of the 

standard kits such as OPEN, LOAD, SHORT, etc., and finally press [OK] key to complete the calibration; 
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c) Do not remove the SHORT used in the last step of calibration from the calibration port. Press 
[Sweep/Settings] →[Single Sweep], stop after the instrument finishes the current sweep, and press 
[Trace]→[Trace Operation]→[Data → Storage]; 
d) Remove the SHORT from the test port, connect the OPEN, press [Next Page], [Source Matching] to 
make the instrument stop after completing the current sweep, and change the scale to make the curve 
easier to read; 

e) Press 【Mkr】[Marker Search] [Max] to search for the maximum test value Amax on the trace at this 

time, take it as the source matching index of Port 1, and fill in the Record Sheet of 4957B RF Analyzer: 

f) Press 【Measure】[S22] to select the test port as Port 2. Then press 【Cal】[M Cal][S22 Single Port], 

so as to complete the measurement of standard parts such as OPEN, SHORT and LOAD, and finally 
press [Done] to complete the calibration; 
g)  Repeat the steps 3 to 5, and fill in the Record Sheet of 4957B RF Analyzer with the effective 
source matching index of Port 2; 

16.1.7 Load matching 

Description: This test is calibrated and error-corrected for load matching. The larger the value is, the 
better the index will be, and the smaller the measurement error will be. 

16.1.7.1 Testing Equipment 

Calibration kit………`…………………………………………………………………………….20201A/B 
N-type calibration cable 

16.1.7.2 Test steps 

a) Set the RF analyzer as follows (for the other items, keep the default settings at the startup): 

Start frequency  .................................................................................................................... 300 kHz 

Stop frequency ..................................................................................................................... 6.5 GHz 

Output power .......................................................................................................................... -10dBm 

Intermediate frequency bandwidth ........................................................................................... 100Hz 

Points ...........................................................................................................................................  401 

 

Figure 16-5  Block Diagram of Load Matching Test 

b) Press 【Cal】[Cal Kit] to select the correct calibration kit, then press 【Cal】[M Cal][Full 2 

Ports][Reflection], connect the N-type calibration cable at the test Port 1 as shown in Figure 16-5, 
connect the OPEN, SHORT and LOAD at the end of the cable successively to complete the 
measurement of the standard kits such as the OPEN, SHORT and LOAD of the port P1; connect the 
OPEN, SHORT and LOAD successively at the test Port 2, and complete the measurement of the 
standard kits such as the OPEN, SHORT and LOAD of the port P2; and finally, press the [OK] key to 
complete the reflection calibration of full 2 ports; 

c) Directly connect the test Port 1 and test Port 2 with an N-type calibration cable, press [Transmit] 
[Auto] to transmit the calibration, press [Back] [ISO] [Ignore Iso] to omit isolation calibration, and 

Open-circuit device 

RF Analyzer 

Short-circuit 

device 
Load 
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finally press the [Back] [OK] key to complete the calibration of full 2 ports; 
Port 1 Effective load matching test 

d) Press 【Measure】[S11], press [Sweep/Settings] →[Single Sweep], and stop after the instrument 

finishes the current sweep; 

e) Press 【Mkr】[Marker Search] [Max] to record the read out the maximum return loss value R1; 

f) Record the absolute value of R1 as the effective load matching index of Port 1 into the Record 
Sheet of 4957B RF Analyzer;  

Port 2 Effective load matching test 

g) Press  【Measure】 [S22], press [Sweep/Settings] →[Single Sweep], and stop after the instrument 

finishes the current sweep;  

h) Press 【Mkr】[Marker Search] [Max] , and record the absolute value of the maximum as the effective 

load matching index of Port 2 into the Record Sheet of 4957B RF Analyzer. 

16.1.8 Reflection tracking 

Description: Reflection tracking reflects the difference between the reflection test channel and the 
reference channel. For the reflection tracking error after calibration and error correction in this test, the 
smaller the value, the better the index, and the smaller the measurement error caused. 

16.1.8.1 Testing Equipment 

Calibration kit………`…………………………………………………………………………….20201A/B 
N-type calibration cable 

16.1.8.2 Test steps 

a) Set the RF analyzer as follows (for the other items, keep the default settings at the startup): 

Start frequency……………………………………………………………………………………300kHz 

Stop frequency…………………………………………………………………………………… 6.5GHz 

Output power………………………………………………………………………………………-10dBm 

Intermediate frequency bandwidth……………………………………………………………… 100Hz 

Sweep points………………………………………………………………………………………… 401 

Port 1 Reflection tracking test 

b) Press  【Measure】 [S11] to select the test port as Port 1, then press 【Cal】 [Cal Kit] to select the 

correct calibration kit, and press 【Cal】 [M Cal] [S11 One Port], complete the measurement of the 

standard kits such as OPEN, LOAD, SHORT, etc., and finally press [OK] key to complete the 
calibration; 

c) Do not remove the SHORT used in the last step of calibration from the calibration port. Press 
[Sweep/Settings] →[Single Sweep], and stop after the instrument finishes the current sweep; 

d) Press 【Mkr】[Marker Search][Max], record the read out maximum return loss value R1, press [Min], 

record the read out minimum return loss value R2, and compare |R1| and |R2|; 
e) e)   Fill in the Record Sheet of 4957B RF Analyzer with the value for which the absolute value is 

larger as the reflection tracking index of Port 1; 

f) Press 【Sweep】[Trigger] [Continuous Sweep] to make the instrument in the continuous sweep 

state; 
Port 2 Reflection tracking test 

g) Press 【Measure】[S22] to select the test port as Port 2, then press 【Cal】[M Cal] [S22 Single Port], 

complete the measurement of the standard kits such as OPEN, LOAD, SHORT, etc., and finally 
press the [OK] key to complete the calibration; 

h) Repeat the steps c) to d), and fill in the Record Sheet of 4957B RF Analyzer with the value for which 
the absolute value is larger as the reflection tracking index of Port 2. 
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16.1.9 transmission tracking 

Description: Transmission tracking reflects the difference between the transmission test channel and 
the reference channel. For the transmission tracking error after calibration and error correction in this 
test, the smaller the value, the better the index, and the smaller the measurement error caused. 

16.1.9.1 Testing Equipment 

Calibration kit………`…………………………………………………………………………….20201A/B 
N-type calibration cable 

16.1.9.2 Test steps 

 
Figure 16-6   Block Diagram of Dynamic Range and Transmission Tracking Test 

f) Set the instrument as follows (other items remain the default settings of the system when it is 
started): 

Start frequency  .................................................................................................................... 300 kHz 

Ending frequency ..................................................................................................................... 6 GHz 

Output power .......................................................................................................................... -10dBm 

Intermediate frequency bandwidth ........................................................................................... 100Hz 

Points ...........................................................................................................................................  401 

g) Press 【Cal】→[Cal Kit] to select the correct calibration kit, then press [M Cal]→[Response & 

Isolation S12]→[Isolation], as shown in Figure 16-6, connect the test cable to Port 1 or Port 2, 
connect the LOAD at the end of the cable to the other port, and finally press [Isolation] to complete 
isolation calibration. 

h) Remove the LOAD, directly connect the test Port 1 and the test Port 2. and press [Through] to 
complete S12 through measurement; 

Port 1 Transmission tracking test 

i) After the calibration is completed, wait for the end of single sweep, press 【Mkr】, [Marker Search], 

[Max], and record the read out maximum value R1; 
j) Press [Minimum Value] to record the read out the minimum value R2; 
k) Compare  |R1| and |R2|, and record the value for which the absolute value is larger as the 

transmission tracking index of Port 1 into the Record Sheet of 4957B RF Analyzer;  
Port 2 Transmission tracking test 

l) Press 【Measure】, [S21], repeat the steps 2 to 6, carry out S21 transmission and isolation 

calibration, and complete the test and record of transmission tracking indicators for Port 2.  

16.1.10 Dynamic range 

Description: Dynamic range refers to the difference between the maximum power output from the port 
of the instrument and the measurement sensitivity of the port. The unit of the dynamic range index for 
the port after calibration and error correction in the test is dB. The larger the value is, the better the index 
is. 

RF Analyzer 

Load 



4957B RF Analyzer User Manuals 

Technical indicators and testing methods 

224 / 248 

16.1.10.1 Testing Equipment 

Calibration kit………`…………………………………………………………………………….20201A/B 
N-type calibration cable 

16.1.10.2 Test steps 

a) Set the analyzer as follows (for the other items, keep the default settings at the startup): 

Start frequency ....................................................................................................................... 300kHz 

Stop frequency ....................................................................................................................... 6.5GHz 

Output power  .................................................................................................................  high power 

Intermediate frequency bandwidth  .......................................................................................... 10 Hz 

Points ...........................................................................................................................................  401 

b) Press 【Cal】→[Cal Kit] to select the correct calibration kit, then press [M Cal]→[Response & 

Isolation S12], as shown in Figure 6, use the cable to directly connect the test Port 1 with Port 2, and 
press [Trough] to complete the through measurement; 

c) Remove the cable from one of the ports, connect the load on the calibration end face, and press 
[Isolation] to complete the S12 isolation measurement; 

Port 1 Dynamic range test 

d) After the calibration is completed, wait for the end of single sweep, press 【Mkr】, [Marker Search], 

[Max], and record the read out maximum value; 
e)  Fill in the Record Sheet of 4957B RF Analyzer with the absolute value of the maximum value 

as the dynamic range index of Port 1; 

Port 2 Dynamic range test 

e) Press 【Measure】, [S21], repeat the steps 2 to 5, carry out S21 transmission and isolation 

calibration, and complete the dynamic range test for Port 2. 
 

16.2 Spectrum analysis performance indicator test 

Before the indicator test in this section, first press the 【Mode】 key on the instrument, select the working 

mode as the spectrum analysis mode, and carry out the detailed test according to the method 
recommended in this section. 

16.2.1 Frequency range 

Description: Test the frequency measurement range of the comprehensive by using a 9 kHz signal and 
a 6.5 GHz signal. Use a signal generator of high-frequency stability to produce signals within the nominal 
upper and lower limits of the 4957B instrument to check whether the spectrum frequency measurement 
capability of the 4957B is adequate. 

16.2.1.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

Several test cables and adapters 

16.2.1.2 Test steps 

a) Connect the test equipment by following the dotted line in Figure  16-7. The instrument is used to 
provide reference frequencies for the 1464C composite signal generator. The low-frequency output 
port of the composite signal generator is connected to the radio frequency input of the instrument. 

b) Set the Composite signal generator as follows: 【Freq】 [Set Low Frequency Generator] [Set 
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Frequency] 9 kHz, [Set Amplitude] -10 dBm, [Return], [Low Frequency Output On Off]. 

 
Figure 16-7   Frequency Range Test 

c) Set the instrument to be the spectrum analysis mode, and set the center frequency of the spectrum 
analyzer to 9 kHz, sweep width to 1 kHz, reference level to 0 dBm, and resolution bandwidth to 10 
Hz. For the other items, set them to be automatic. On the instrument, press Peak Value. At this time, 
the cursor points to the maximum signal response; the marker amplitude value has no obvious jitter; 
the signal can be clearly distinguished. Then, record the center frequency as the lower-limit 
measured value of the frequency span; otherwise, record Fail to meet the requirements. 

d) As shown in the solid line of Figure 16-7, connect the radio frequency output of the composite signal 
generator 1461 to the radio frequency input of the instrument with adapters and cables . Set the 
output frequency of the signal generator to 6.5 GHz, the modulation function to off, and the output 
power to -10 dBm.  

e) Set the center frequency of the instrument to the highest frequency of the corresponding model, 
sweep width to 1 kHz, reference level to 0 dBm, resolution bandwidth to 10 Hz, and other items 
automatic. On the instrument, press Peak Value. At this time, the marker points to the maximum 
signal response, the marker amplitude value has no obvious jitter; the signal can be clearly 
distinguished. Then, record the center frequency as the lower-limit measured value of the frequency 
range; otherwise, record Fail to meet the requirements. 

f) Record measurement results in corresponding test items of the Record Sheet of 4957B RF 
Analyzer. 

16.2.2 Frequency reading accuracy 

Description: This index is used to represent the proximity between the indicated value of frequency 
measurement on the instrument and the corresponding true value. The frequency measurement 
indicator value of the instrument is subject to the influence of some factors such as frequency reference, 
span and RBW. Use an input signal with known frequency to test the accuracy of the frequency read out 
from the instrument, which represents the degree of difference between the test indicator value and the 
true value. The smaller the difference, the higher the accuracy. 

16.2.2.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

Several test cables and adapters 

16.2.2.2 Test steps 

Figure 16-8  Block Diagram of Frequency Readout Accuracy Test 

BNC cable 

Signal Generator 

RF Analyzer 

Adapter 

10MHz IN 

Cables 

Adapter 
Adapter 

Adapter 

Signal Generator 
Adapter 

Cables 

Adapter 

RF Analyzer 

10 MHz output 



4957B RF Analyzer User Manuals 

Technical indicators and testing methods 

226 / 248 

a) Connect the test equipment according to Figure  16-8, in which the RF output of the signal 
generator is connected to the RF input of the spectrum analyzer.  

b) Press the Reset key on the signal generator; set the output frequency f0 of the signal generator 
according to the item of ―frequency readout accuracy‖ in the Record Sheet of 4957B RF Analyzer; 
set the power level to -10 dBm, and turn on the radio frequency output switch. 

c) Set the center frequency of the instrument to f0 for spectrum analysis, sweep width to 500 kHz, 
reference level to 0 dBm, and the resolution bandwidth and sweep time to automatic. 

d) Press 【Peak】 on the instrument, and read out the peak signal frequency fs through the marker. 

e) Calculate the error of frequency reading (Δf) by formula (1): 
Δf = fs- f0                                                                 (1)                                                          

f) Record Δf as the test result in the corresponding test item of Record Sheet of 4957B RF Analyzer. 
g) Repeat steps b) through f) to test all combinations of frequencies and sweep widths listed in the 

corresponding test items of the Record Sheet of 4957B RF Analyzer. 

16.2.3 Sweep width accuracy 

Description: Use two composite signal generators to send two signals of known frequency as the input 
of the instrument. Set the center frequency of the instrument to the middle value of the two frequencies. 
Measure the frequency difference between the two signals by using the marker. Calculate and record 
the percentage of the error between the measured difference marker and the span. Enable the two 
signal generators to share a reference frequency with the instrument. 

Note: You can also use one signal generator to perform the test. Firstly set the center frequency and the 

sweep width of the  instrument , enable the frequency value of the first signal generator on the  

instrument , and set the difference marker on the instrument; then enable the frequency value of the 

second signal generator on the instrument. Read the difference marker of the two signals on the  

instrument  and record it as the measured value. Enable the signal generator to share a reference 

frequency with the  instrument . 

16.2.3.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

Several test cables and adapters 

16.2.3.2 Test steps 

Figure 16-9   Block Diagram of Sweep Width Accuracy and Sweep Time Test 
a) Connect the test equipment as shown in Figure 16- 9, and the instrument is used to provide 

reference frequencies for the composite signal generator. 
b) Set the center frequency f0 of the instrument for spectrum analysis to 3.25 GHz, and reference level 

to 0 dBm; set the sweep width according to the item column of ― Sweep Width Accuracy‖ in the 
Record Sheet of 4957B RF Analyzer. 

c) Firstly set the output frequency of the signal generator to f1 (f1= f0-0.4×sweep width, the sweep width 
is the setting value of the instrument), the power to -10 dBm, and the state of radio frequency output 
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to on. 

d) Press 【Peak】, 【Mkr】, [Delta  Mode ] on the instrument.  

e) Set the output frequency of the signal generator to f2 (f2=f0+0.4×Sweep width), and the output power 
to -10 dBm; 

f) Press the 【Peak】 key on the instrument and move the difference marker to f2. After sweep is 

completed, read out the frequency difference Δf of the two signals through the instrument. 
g) Record the frequency difference Δf and calculate the sweep width accuracy by the following 

formula: 
Span accuracy = 100× [Δf-(0.8×span)] /(0.8×span)%    (2) 

h) Record the results in the corresponding test items of the Record Sheet of 4957B RF Analyzer. 
i) Turn off all frequency markers and set the sweep width of the instrument and the frequency of the 

signal generator respectively according to the sweep widths of the instrument in the record sheet. 
Repeat the steps c) to h) until all sweep width tests are completed. 

16.2.4 Sweep time 

Description:   Display the amplitude modulation signal on the instrument at the zero sweep width, 
and adjust the frequency of the modulation signal, enabling the peak intervals to be evenly distributed on 
the screen. Count the frequency of the modulation signal, calculate the actual sweep time, and then 
compare it with the specified time to obtain the sweep time accuracy. The sweep time accuracy is 
guaranteed by design. In order to reduce the test time, select a typical sweep time to test and verify. 

16.2.4.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

Several test cables and adapters 

16.2.4.2 Test steps 

a) Connect the test equipment as shown in Figure 16-9, connect the radio frequency output of the 

signal generator to the radio frequency input of the instrument, which is used to provide reference 

frequencies for the composite signal generator. 

b) Set the center frequency of the instrument to 3 GHz, the sweep width to 0 Hz, the resolution 

bandwidth and the video bandwidth to 10 MHz respectively, and the number of sweep points to 201, 

then the minimum settable sweep time is not higher than 10 μs, and the maximum settable sweep 

time is 600 s. If the above settings meet the requirements of the "Sweep Time Range (Zero Sweep 

Width)" item in the Record Sheet of 4957B RF Analyzer, it would be recorded as "√", otherwise it 

would be recorded as "×. ‖ 

c) After resetting the signal generator, set the frequency to 3 GHz, the power to -5 dBm, 【Modulation】

[Amplitude Modulation] [Amplitude Modulation Input], [Internal], 【Back】, [Amplitude Modulation On], 

[Modulation Rate], 10 kHz, [Modulation Depth], 100%, [Internal Modulation Waveform Selection], 

[Sawtooth Wave], [Modulation Type Linear], and turn on the amplitude modulation switch and the 

radio frequency output switch. 

d) Set the scale type of the instrument to linear, the peak detection method, set the number of sweep 

points to the default 1001 points, the resolution bandwidth to 3 MHz, and the video bandwidth to 3 

MHz. 

e) Set the instrument[Sweep Time], 1ms, [Sweep Type Continuous Single]. 

f) Set the instrument, press [Peak], and use [Left Peak] or [Right Peak] to place the marker on the first 

peak from the left. Press 【Mkr】[Delta Mode], press 【Peak】, and use [Left Peak] or [Right Peak] 

to place the marker on the ninth peak from the left. To read out the difference marker reading, 
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calculate as follows: 

Sweep time error=100 × ((Marker difference reading × 1.25 - set sweep time) / set sweep time) % 

(3) 

Record the results at the 1 ms sweep time in the corresponding test items of the Record Sheet of 

4957B RF Analyzer. 

g) Turn off the marker, and repeat the steps f) ~ g) for other sweep time listed in the table. Set the 

modulation rate (Frequency) in step f) according to the following formula: Modulation rate = 

10/sweep time settings  

16.2.5 Resolution bandwidth 

Description: Resolution bandwidth is used to represent the capability of the instrument to clearly 
separate two input signals. It is subject to the influence of some factors such as IF filter bandwidth, 
phase noise, and sweep time. Most spectrum analyzers can be used to test different resolution 
bandwidths by using the LC filter, crystal filter, SAW, digital filter, etc. 

Connect the output of the signal generator to the radio frequency input of the instrument. Set the 
bandwidth of the 4957B to approximately 2~3 times the current resolution bandwidth (facilitate the 
measurement of -3 dB bandwidth). Reduce the signal source output amplitude by 3 dB to determine the 
actual -3 dB point. After the marker reference is set, the output value of the signal source is increased by 
3 dB and is returned back to the previous level. Then sweep is started. The difference marker is taken as 
the measured value of 3 dB bandwidth. 

The reading value in the 4957B usable for 3 dB bandwidth test can be taken as the test value. The span 
error of Analyzer may cause an error to the resolution bandwidth accuracy. Compared with the error of 
resolution bandwidth, the span error can be neglected. 

16.2.5.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

Several test cables and adapters 

16.2.5.2 Test steps 

 

Figure 16-10   Settings for Resolution Bandwidth Accuracy Test 

a) Connect the test equipment as shown in Figure 16-10. The instrument is used to provide reference 

frequencies for the signal generator. 

b) Set the composite signal generator as follows: frequency is 100 MHz; power is -2 dBm; power step 

is 1 dB. 

c) Reset the instrument, press the 【Mode】 , [Frequency Analysis], [Measure] and [Occupied 

Signal Generator 
Adapter 

10MHz IN 

Cables 

Adapter 

BNC cable 
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Bandwidth] keys to open the function of measuring occupied bandwidths; select the measurement 

method XdB, and change X to -3.01 dB. 

d) Set the center frequency of the instrument to 100 MHz, sweep width to 30 MHz, amplitude scale to 1 

dB/graduation, and resolution bandwidth to 10 MHz. For the other items, keep the default values of 

system. 

e) Adjust the output power of the composite signal generator to make the signal be 2 to 3 scales below 

the reference level. 

f) f)   Use the instrument to search the peak value, record the 3 dB bandwidth marker difference 

Δf-3 dB that is read out at this time; calculate the resolution bandwidth accuracy δ by the following 

formula, and fill the calculation results in the corresponding test item of the Record Sheet of 4957B 

RF Analyzer. 

3 100%dBf RBW

RBW
  
 

             (5) 

g) Set the instrument according to the item column of ― Resolution Bandwidth Accuracy ‖ in the Record 

Sheet of 4957B RF Analyzer, with the frequency bandwidth close to three times of the resolution 

bandwidth. Repeat the steps f)~g) until all resolution bandwidth tests are completed. 

16.2.6 Noise sideband 

Description: Sideband noise is an indicator to represent the short-term stability of the local oscillator 
signal frequency of the instrument. 

Measure the sideband noises of the 1.0 GHz and 0 dBm reference signals at deviation points of 10 kHz, 
100 kHz, 1 MHz and 10 MHz of the carrier wave. Average the sideband noise at each frequency 
deviation point by using the noise marker and video averaging function. If there is a spurious response at 
the set frequency deviation point, deviate the cursor from the spurious response to ensure the 
measurement accuracy. 

16.2.6.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

Test cable and adapter 

16.2.6.2 Test steps 

Figure 16-11  Schematic Diagram of Sideband Noise Test 

a) Connect the test equipment as shown in Figure 16-11, and the instrument is used to provide 

reference frequencies for the composite signal generator. 

b) Set the output frequency of the signal generator to 1GHz and the output power to 0dBm; 

c) On the instrument, set 【Freq】 to 1 GHz, [Sweep Width] to 30 kHz, and 【Amplitude】 (Ref Level) 

BNC cable 
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to 0 dBm. 

d) Press 【Mkr】, [Peak], [Delta Mode] on the instrument to set the difference marker to 10 kHz, and 

turn on the noise marker. 

e) Set the resolution bandwidth and video bandwidth according to Table 4; enable the averaging 

function; and perform 10 times of averaging. 

f) Record the difference marker amplitude value as the sideband noise at +10 kHz deviation point in 

the corresponding measured value item of the Record Sheet of 4957B RF Analyzer. 

g) Press 【Mkr】  - 10 kHz] on the instrument and record the difference marker amplitude value as the 

sideband noise at the -10 kHz deviation point. 

h) Set the instrument according to Table 4; test the single sideband noise at the deviation points of 

±100 kHz, ±1 MHz and ±10 MHz successively; record the difference marker amplitude value in the 

corresponding test item of the Record Sheet of 4957B RF Analyzer. If there is a spurious response 

at the frequency deviation point under test, keep away from the spurious response when reading the 

cursor value in the test. 

 

Table 16-1 Sideband Noise Measurement Settings 

Offset frequency Δf Span RBW Video bandwidth and averaging 

±10 kHz 30 kHz 300 Hz Video bandwidth is 30Hz; 

averaging is On 

±100 kHz 300 kHz 3 kHz  Video Bandwidth 300 Hz Average 

On 

±1 MHz 2.2 MHz 10kHz Video Bandwidth 1 kHz Average On 

±10 MHz 25 MHz 100 kHz Video Bandwidth 10 kHz Average 

On 

16.2.7 Explicit average noise level 

Description:  The explicit average noise level refers to the background noise observed by the 
instrument when there is no additional noise or signal. The input port of the instrument is connected to a 

50 matcher. The normalized noise value observed when the input attenuation value is set to 0 dB is the 
measured value of the average noise level. 

16.2.7.1 Testing Equipment 

50Ω matcher 

16.2.7.2 Test steps 

 

 

 

 

Figure 16-12  Settings for Test of Explicit Average Noise Level 

a) Connect the 50 matcher to the radio frequency input port of the instrument according to Figure 

16-12. 

Explicit average noise; the preamplifier is on (2 MHz-10 MHz) 

50Ω matcher 

RF Analyzer 
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b) Set the instrument as follows:  

Starting frequency ....................................................................................................... 2MHz 

Ending frequency ...................................................................................................... 10MHz 

Reference level ....................................................................................................... -50 dBm 

Mkr .................................................................................................................. all marker Off 

Resolution Bandwidth .............................................................................................. 100kHz 

Video Bandwidth ....................................................................................................... 30 kHz 

Video type ............................................................................................................ Logarithm 

Preamplifier  .................................................................................................................... On 

Detection type .............................................................................................................. Mean 

c) Press [Cursor] -> [Noise cursor off on] -> [Peak] -> [Maximum]. 

d) Press [Bandwidth] -> [Averaging on off] -> ―5‖ -> [Confirm]; wait until ―averaging 5/5‖ is shown on the 

left side of the screen. 

e) Read the peak value of the marker as the explicit average noise level of the 2 MHz to 10 MHz 

frequency band in the case that the preamplifier is on, and record it in the corresponding test item of 

the Record Sheet of 4957B RF Analyzer. Turn off the noise cursor and the averaging function. 

Explicit average noise, the preamplifier is on (10 MHz-3 GHz) 

f) Set the start frequency of the instrument to 10 MHz, the stop frequency to 3 GHz, and make the 

others unchanged. 

g) Repeat the steps c) to d). 

h) h)   Read the peak value of the marker as the explicit average noise level of the 10 MHz to 3 GHz 

frequency band in the case that the preamplifier is on, and record it in the corresponding test item of 

the Record Sheet of 4957B RF Analyzer. Turn off the noise cursor and the averaging function. 

Explicit average noise; the preamplifier is on (3 GHz ~ 6.5 GHz) 

i) Set the start frequency of the instrument to 3 GHz, the stop frequency to 6.5 GHz; and make the 

others unchanged. 

j) Repeat the steps c) to d). 

k) Read the peak value of the marker as the explicit average noise level of the 3 GHz to 6.5 GHz 

frequency band in the case that the preamplifier is on, and record it in the corresponding test item of 

the Record Sheet of 4957B RF  RF  Analyzer. Turn off the noise cursor and the averaging 

function. 

Explicit average noise; the preamplifier is off (2 MHz-10 MHz) 

l) Set the start frequency of the instrument to 2 MHz, the stop frequency to 10 MHz, the reference 

level to -20dBm, the preamplifier to be off; and make the others unchanged. 

m) Repeat the steps c) to d). 

n) Read the peak value of the marker as the explicit average noise level of the 2 MHz to 10 MHz 

frequency band in the case that the preamplifier is off; record the value in the corresponding test 

item of the Record Sheet of 4957B RF Analyzer. Turn off the noise cursor and the averaging 

function. 

Explicit average noise; the preamplifier is off (10 MHz ~ 3 GHz) 

o) Set the start frequency of the instrument to 10 MHz, the stop frequency to 3 GHz, the reference 

level to -20dBm, the preamplifier to be off; and make the others unchanged. 

p) Repeat the steps c) to d). 
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q) Read the peak value of the marker as the explicit average noise level of the 10 MHz to 3 GHz 

frequency band in the case that the preamplifier is off; record the value in the corresponding test 

item of the Record Sheet of 4957B RF Analyzer. Turn off the noise cursor and the averaging 

function. 

Explicit average noise; the preamplifier is off (3 GHz ~ 6.5 GHz) 

r) Set the start frequency of the instrument to 3 GHz, the stop frequency to 6.5 GHz, the reference 

level to -20dBm, the preamplifier to be off; and make the others unchanged. 

s) Repeat the steps c) to d). 

t) Read the peak value of the marker as the explicit average noise level of the 3 GHz to 6.5 GHz 

frequency band in the case that the preamplifier is off; record the value in the corresponding test 

item of the Record Sheet of 4957B RF Analyzer. Turn off the noise cursor and the averaging 

function. 

16.2.8 Second harmonic distortion 

Description: When a signal is input to a nonlinear device (such as a mixer and amplifier, etc.), the 
nonlinear device will generate the harmonics of the input signal, and the unwanted second harmonic 
component attached to the signal is called For second harmonic distortion. 

The composite signal generator provides a signal to the instrument to measure the second harmonic 
distortion via a low-pass filter. The low pass filter removes any harmonic distortion from the signal source. 
The composite signal generator is locked to the 10 MHz reference of the instrument. 

16.2.8.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

One 1.0 GHz low-pass filter 

One 3.0 GHz low-pass filter 

One 3.5 mm (f)-3.5 mm (f) adapter 

One BNC (m-m) cable 

1 piece of 3.5 mm(m-m) cable 

16.2.8.2 Test steps 

Figure 16-13  Settings of Second Harmonic Distortion Test 

a) Connect the test instrument as shown in Figure 16-13. The instrument provides a 10 MHz frequency 

reference for the composite signal generator and selects a 1 GHz low-pass filter. 

b) Set the frequency of the signal generator to 900 MHz, the amplitude to -30dBm, and the radio 
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frequency output is on. 

c) Set the RF analyzer as follows (other items remain the default settings of the system): 

Center frequency  ..............................................................................................................  900 MHz 

Span ......................................................................................................................................... 10kHz 

Reference Level .................................................................................................................... -30 dBm 

d) Press 【Peak】 on the instrument. Adjust the power level of the signal generator so that the reading 

of the RF analyzer is -30dBm0.1dB. 

e) Press  【Mkr】[Delta Mode] to set the center frequency to 1.8 GHz. 

f) Press  【Peak】  after the instrument has completed a new sweep. Record the difference marker 

reading in the item of 0.9 GHz second harmonic distortion of the Record Sheet of 4957B RF 

Analyzer. 

g) Connect the test instrument as shown in Figure 14, and use the 3.0 GHz low-pass filter. 

h) Set the frequency of the signal generator to 2.5 GHz, and the amplitude to -30dBm. 

i) Set the instrument as follows (other items remain the default settings of the system): 

Center frequency  ................................................................................................................... 3 GHz 

Span ......................................................................................................................................... 10kHz 

Amplitude  .............................................................................................................................. -30dBm 

Mkr ................................................................................................................................. all marker Off 

j) Press 【Peak】 on the instrument. Adjust the power level of the signal generator so that the reading 

of the RF analyzer is -30dBm0.1dB. 

k) Press  【Mkr】[Delta Mode] to set the center frequency to 5 GHz. 

l) Wait for the new sweep to complete, then Press 【Peak】. Record the difference marker reading in 

the item of 2.5 GHz second harmonic distortion of the Record Sheet of 4957B RF Analyzer. 

16.2.9 Mirror, multiple and out-of-band responses 

Description: During frequency mixing, two input signals can generate the same IF signal with that of the 
LO signal with the same frequency, with one signal frequency one IF lower than the LO and another 
signal frequency one IF higher than the LO. In this case, one of the signal is called the mirror frequency 
of the other. Each frequency of the LO has a mirror frequency of corresponding input signal, with the 
difference of two IFs between the signal and frequency of the mirror frequency. 

Test image, multiple and out-of-band responses on all frequency bands. The signal is applied to the 
input port of the instrument for reference amplitude measurement. Then tune composite signal generator 
to a frequency that causes a mirror, multiple or out-of-band response, and measure and record the 
amplitude displayed on the instrument. 

16.2.9.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

Test cable and adapter 
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16.2.9.2 Test steps 

Figure 16-14  Settings of Mirror, Multiple and Out-of-band Responses 

a) Connect the test equipment as shown in Figure 16-14. The instrument is used to provide reference 

frequencies for the composite signal generator. 

b) Set the frequency of the signal generator to 2 GHz and the power to -10dBm. 

c) Set the instrument as follows: 

Center frequency  ....................................................................................................................  2GHz 

Span ......................................................................................................................................... 10kHz 

Reference Level .................................................................................................................... -10 dBm 

Resolution Bandwidth ................................................................................................................ 10 Hz 

Video bandwidth  ...................................................................................................................... 10 Hz 

d) Adjust the output power level of the composite signal generator, enabling the signal peak to be 

close to the reference level of the instrument. 

e) On the instrument, press 【Peak】【Mkr】[Delta mode]. 

f) Set the signal generator to each frequency point of   mirror, multiple and out-of-band response 

corresponding to 2 GHz listed in the test item of  the Record Sheet of 4957B RF Analyzer. Set the 

reference level of the instrument to -40dBm, press 【Peak】, and record the difference marker 

amplitude value as the response amplitude in the corresponding test item of the Record Sheet of 

4957B RF Analyzer. 

16.2.10 Residual response 

Description: It refers to the discrete response displayed on the display when the instrument is not 
connected to the input signal. 

16.2.10.1 Testing Equipment 

50 load matching 

BNC cable 

Signal Generator 
Adapter 

10MHz IN 

Cables 

10 MHz output 
Adapter 

RF Analyzer 



4957B RF Analyzer User Manuals 

Technical indicators and testing methods  

 235 / 248 

 

16.2.10.2 Test steps 

Figure 16-15  Setting of Residual Response Test 

Residual response, 10 MHz～6.5 GHz (Preamplifier On) 

a) Connect the 50  matcher on the spectrum input port of the instrument according to Figure 16-15, 

and set the instrument as follows: 

Center frequency ..................................................................................................................... 65MHz 

Frequency Stepping ............................................................................................................. 100MHz. 

Span ...................................................................................................................................... 110MHz 

Reference level...................................................................................................................... -50 dBm 

Preamplifier  ................................................................................................................................... On 

Resolution bandwidth ............................................................................................................... 10kHz 

Video bandwidth ......................................................................................................................... 3kHz 

b) Turn on the limit line function, and set the upper limit line to -95dBm, and the noise level shall be at 

least 5dB below the limit line. If not, it is necessary to decrease the resolution bandwidth and video 

bandwidth so as to decrease the noise level. 

c) Observe whether there is residual response on the noise baseline of the instrument. If yes, use the 

marker to read out the residual response amplitude and record the measurement result. The test 

should be such that the amplitude of the residual response signal is greater than the display 

average noise level by more than 10 dB. If the residual response signal amplitude is small, the 

resolution bandwidth should be further reduced to minimize the display average noise level. 

d) Press 【Freq】 [Center Frequency] 【↑】 to change the center frequency.  Repeat step 3 to check 

the residual response of the frequency up to 6.5 GHz, record the measured maximum value in the 

corresponding test item with the preamplifier on of the Record Sheet of 4957B RF Analyzer. 

      Residual response, 10 MHz～6.5 GHz (Preamplifier Off) 

e) Set the instrument as follows: 

Center frequency ..................................................................................................................... 65MHz 

Frequency Stepping ............................................................................................................. 100MHz. 

Span ...................................................................................................................................... 110MHz 

Reference Level .................................................................................................................... -20 dBm 

Preamplifier  ................................................................................................................................... Off 

Resolution bandwidth ............................................................................................................... 10kHz 

Video bandwidth ......................................................................................................................... 3kHz 

f) Turn on the limit line function, and set to -82dBm, and the noise level shall be at least 5dB below the 

50matcher 

RF Analyzer 
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limit line. If not, it is necessary to decrease the resolution bandwidth and video bandwidth so as to 

decrease the noise level. 

g) Observe whether there is residual response on the noise baseline of the instrument. If yes, use the 

marker to read out the residual response amplitude and record the measurement result. The test 

should be such that the amplitude of the residual response signal is greater than the display 

average noise level by more than 10 dB. If the residual response signal amplitude is small, the 

resolution bandwidth should be further reduced to minimize the display average noise level. 

h) Press 【Freq】 [Center Frequency] 【↑】 to change the center frequency.  Repeat step h) to check 

the residual response of the frequency up to 6.5 GHz, record the measured maximum value in the 

corresponding test item with the preamplifier off of the Record Sheet of 4957B RF Analyzer. 

16.2.11 Reference level 

Description: The vertical scale position that has been calibrated on the instrument screen is used as the 
reference of amplitude measurement. The reference level usually refers to the top scale line. Reference 
level switching may cause a linkage of gain/attenuation. The error of reference level conversion is used 
to assess the switching gain error of the instrument. 

Note: If the error is large when the power meter performs a measurement at -60 dBm, you can directly 
reduce the test result of -50 dBm by 10 dB, or connect a 10 dB attenuator that has been calibrated to the 
input port of the instrument for test. 

16.2.11.1 Testing Equipment 

Signal generator .............................................................................................................. 1464A/1461 

Power meter ........................................................................................................................ ML2437A 

Power probe ....................................................................................................................... MA2445D 

Power splitter ............................................................................................................................. 81313 

Test cable and adapter 

16.2.11.2 Test steps 

Figure 16-16 Settings for Test of Reference Level Uncertainty and Scale Fidelity 

a) Connect the power meter ML2437A to the power probe MA2445D, conduct zero calibration on them, 

and set the calibration factor frequency to 50 MHz. 

b) Connect the test equipment according to Figure 16-16. The instrument  is used to provide 

BNC cable 

Signal Generator 
Adapter 

10 MHz output 

10MHz IN 

Cables 

Power 

Probe 

Power 

RF Analyzer 



4957B RF Analyzer User Manuals 

Technical indicators and testing methods  

 237 / 248 

 

reference frequencies for the composite signal generator. The output ends of the signal generator 

are respectively connected to the  instrument  and the power probe via a power splitter.  

c) Set 【Amplitude】[Ref Level] on the instrument with the knob or the step key 【↑】【↓】. If the maximum 

and minimum reference levels can be set to +30 dBm and -120 dBm respectively, the indicator of 

reference level range meets the requirement, and mark in the corresponding result of the Record 

Sheet of 4957B RF Analyzer as ―√‖, otherwise mark as ―x‖. 

d) Set the output frequency of the composite signal generator to 50 MHz and adjust the output power 

to make the power meter reading be -3 dBm 0.05dB. 

e) Set the instrument as follows: 

Center frequency .................................................................................................................... 50 MHz 

Reference level......................................................................................................................... 0 dBm 

Sweep width .............................................................................................................................. 1 kHz 

Logarithmic scale dB/div ............................................................................................................. 1 dB 

Resolution Bandwidth ................................................................................................................ 10 Hz 

f) On the instrument, press 【Peak】【Mkr】 [Delta mode ].  

g) Adjust the output power of the signal generator to reduce the power meter reading by 10dB 

0.02dB. 

h) Set the reference level of the instrument to the reference level listed in the Record Sheet of 4957B 

RF Analyzer, wait until the sweep is completed and then press 【Peak】. 

i) Record the difference marker amplitude reading of the  instrument , make the following 

calculations (difference marker amplitude reading of the  instrument – currently set reference level, 

and record the calculated value as the uncertainty of current reference level in the  corresponding 

test item  of the Record Sheet of 4957B RF Analyzer. 

j) Repeat steps g) through i) to set the residual reference levels listed in the corresponding test items 

of the  Record Sheet of 4957B RF Analyzer. 

16.2.12 Scale fidelity 

Description: Scale fidelity is the error between the vertical scale and the theoretical value of the 
instrument screen, which is used to assess the linearity of the analog-to-digital converter of the 
instrument. 

Test the fidelity at 10 dB/div, for which the resolution bandwidth is set to 10 Hz, and the initial amplitude 

of the input signal is set at the 0 dBm reference level. When the signal amplitude is reduced, compare 

the displayed signal amplitude with the reference level. The instrument provides a 10 MHz reference for 

the signal generator. 

Note: If the error is large when the power meter performs a measurement at -60 dBm, you can directly 

reduce the test result of -50 dBm by 10dB, or connect a 10 dB attenuator that has been calibrated to the 

input port of the instrument for test. 

16.2.12.1 Testing Equipment 

Signal generator .............................................................................................................. 1464A/1461 

Power meter ........................................................................................................................ ML2437A 

Power probe ....................................................................................................................... MA2445D 

Power splitter ............................................................................................................................. 81313 
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Test cable and adapter 

16.2.12.2 Test steps 

Figure 16-17  Scale fidelity 

a) Connect the power meter to the power probe and perform zero calibration; set the calibration factor 

frequency to 50 MHz. 

b) Connect the test equipment as shown in Figure 16-17. The instrument is used to provide reference 

frequencies for the composite signal generator. The output ends of the signal source are 

respectively connected to the instrument and the power probe via a power splitter. 

c) Set the RF analyzer as follows (other items remain the default settings of the system): 

Center frequency .................................................................................................................... 50 MHz 

Reference level......................................................................................................................... 0 dBm 

Mkr  ................................................................................................................................................ Off 

Sweep width .............................................................................................................................. 1 kHz 

Resolution Bandwidth ................................................................................................................ 10 Hz 

d) Set the frequency of the signal generator to 50 MHz, the amplitude to 6 dBm, and the amplitude 

step to 0.05 dB. 

e) Press 【Peak】 on the instrument. 

f) Adjust the output amplitude of the signal generator until the power meter reads 0 dBm  0.05 dB. 

g) On the instrument, press 【Peak】【Mkr】 [Delta Mode]. 

h) Adjust the output signal amplitude of the signal emitter to reduce the power meter reading by 10 dB 

 0.05 dB. 

i) Make the following calculations (difference marker amplitude reading of the instrument - power 

variation value of the signal source), record the calculation data in the corresponding test item of the 

Record Sheet of 4957B RF Analyzer, and repeat steps h) to i). 

16.2.13 Overall level uncertainty 

Description: The overall level uncertainty means the difference between the power reading of the 
composite signal generator tested on the power meter and the reading of the signal generator tested on 
the instrument. Being affected by the front-end program-controlled step attenuator, this index is used to 
respectively test the amplitude accuracy index of each frequency point when the attenuation is set to 
different values and when the attenuation is 0 dB, so as to ensure the test comprehensiveness. 
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16.2.13.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

Power meter ........................................................................................................................ ML2437A 

Power probe ....................................................................................................................... MA2445D 

Power splitter ............................................................................................................................. 81313 

Test cable and adapter 

16.2.13.2 Test steps 

 

Figure 16-18  Test Settings for Overall Level Uncertainty 

a) Connect the power meter to the power probe, and conduct zero calibration on them. 

b) Connect the testing equipment as shown in Figure 16-18, and connect the SUM port of the power 

splitter, the port PORT1 and the port PORT2 to the radio frequency input port of the instrument and 

the power probe respectively. 

c) After resetting the signal generator, set the frequency to 10 MHz and amplitude to -15dBm. 

d) Set the instrument as follows: 

Center frequency  ................................................................................................................  10 MHz 

Sweep width  ......................................................................................................................  100 KHz 

Reference Level .................................................................................................................... -10 dBm 

Attenuation .................................................................................................................................. 0 dB 

Resolution bandwidth  .............................................................................................................  1 kHz 

Video bandwidth  ..................................................................................................................  100 Hz 

e) Adjust the output amplitude of the signal generator to make the power meter reading -25dBm. 

f) f)   Set the marker of the instrument to the peak value, read the level value L indicated by the 

marker of the instrument and the test reading Lpower meter of the power meter, and calculate the 

overall level uncertainty △L as follows: 

L L L   功率计                                        (8) 

g) Record the calculated △L in the Record Sheet of 4957B RF Analyzer as the test results of the 

overall level uncertainty. 
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h) Repeat step f) to test the overall level uncertainty index when the attenuation value of the internal 

attenuator for the instrument is 10 dB and 20 dB. 

i) Set the reference level of the instrument to 20dBm, and change the output power level of the signal 

generator to make the power meter reading -5dBm. 

j) Repeat step f) to test the overall level uncertainty index when the attenuation value of the attenuator 

is 30 dB. 

k) Change the frequency settings of the signal generator, the power meter and the instrument 

according to the Record Sheet of 4957B RF Analyzer, and repeat steps e) to i) until the test for all 

attenuations at all frequency points  is completed. 

Overall level uncertainty (frequency response test) 

l) For the signal generator, set the frequency to 500 MHz and output power to -15dBm. 

m) Set the calibration factor frequency of the power meter to be the same as that of the signal 

generator, and adjust the output power level of the signal generator to make the power meter 

reading close to -25dBm. 

n) Set the center frequency of the instrument to 500 MHz, reference level to -10dBm, and attenuation 

to 0dB, and repeat step f). 

o) Change the frequency settings of the signal generator, the power meter, and the instrument 

according to the Record Sheet of 4957B RF Analyzer, and repeat steps k) ~ m) for the test of all 

frequency points with attenuation being reduced to 0dB. 

16.2.14 Input attenuator 

Description: The test switches uncertainty between the measured attenuations of the input attenuator 
range within all bands. The reference input to the composite signal generator is provided by the 10 MHz 
reference of the instrument. Switch the uncertainty by referring to the settings of the 0 dB attenuator. 

16.2.14.1 Testing Equipment 

Composite Signal Generator ........................................................................................... 1464A/1461 

Test cable and adapter 

16.2.14.2 Test steps 

 

Figure 16-19  Settings for Test of Input Attenuator Conversion Uncertainty 

a) Connect the test equipment according to Figure 16-19, and the instrument is used to provide 

reference frequencies for the composite signal generator.  

b) Set the output power level of the signal generator to -13dBm and the output frequency to 50 MHz. 
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c) Press 【Reset】 on the instrument to set as the spectrum analysis mode, and set it as follows: 

Center frequency .................................................................................................................... 50 MHz 

Sweep width .............................................................................................................................. 1 kHz 

Reference Level .................................................................................................................... -10 dBm 

Attenuation .................................................................................................................................. 0 dB 

Resolution Bandwidth ................................................................................................................ 10 Hz 

Wait for the new sweep to complete, press 【Mkr】, [Peak], [ Delta Mode ], and take the attenuation value 

of 0dB for the attenuator as a reference.  

d) Set the instrument, press 【Amplitude】[Attenuation Auto Man], and set the attenuation value of the 

attenuator according to the test table. 

e) After the sweep is completed, press 【Peak】, the amplitude value of the current difference marker 

is the attenuator switching error . 

f) Repeat steps e) ~ f) until the attenuation values of all the attenuators in the table have been tested , 

and record the test results in the Record Sheet of 4957B RF Analyzer . 

16.2.15 Input voltage standing wave ratio test 

Description: The radio frequency input voltage standing wave ratio reflects the impedance matching 
degree of the radio frequency receiving front end of the instrument. This indicator is mainly affected by 
adapters, cables, attenuators, etc. The attenuation value of the attenuator is required to be greater than 
or equal to 10dB during the test. The 4957B adopts the scheme of the sub-band switch combined with 
electronic attenuator. Different electronic attenuators are used in the frequency bands of 9 kHz ~ 5.2 
GHz and 5.2 GHz ~ 6.5 GHz. In order to avoid influence between each other, the instrument shall be set 
to work in a suitable frequency range when testing the voltage standing wave ratio, so that only one 
attenuator works in the test frequency band. 

16.2.15.1 Testing Equipment 

Handheld antenna feeder tester  ............................................................................................. 3680B 

A set of 20201A calibration kit (including OPEN, SHORT and LOAD) 

One piece of N-type calibration cable 

16.2.15.2 Test steps 

Figure 16-20  Input Port Voltage Standing Wave Test 
a) Set the appropriate parameters such as the frequency range, the source output power, etc. of the 

antenna feeder tester, and select the VSWR display mode. 

Perform single-port measurement calibration (including OPEN, SHORT and LOAD calibration) on 

the antenna feeder tester at the end of the calibration cable. 

Antenna feeder 

N-type calibration 

RF Analyzer 
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b) After completing the calibration, remove the calibration kit from the end of the calibration cable and 
connect it to the spectrum radio frequency input port of the instrument, as shown in Figure 20. 

c) Press the 【Reset】 key on the instrument, wait for restart and enter the spectrum analysis and 

measurement interface, and set the frequency range of the complete machine to 10 MHz ~ 5.2 GHz 
and 5.2 GHz ~ 6.5 GHz respectively. 

d) Use the marker function to read out the maximum voltage standing wave ratio (VSWR) on the 
antenna feeder tester. 

e) Record the test result in the corresponding test item of Record Sheet of 4957B RF Analyzer. 
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Appendix A Performance and Property Inspection Results 

Appendix A Record Sheet of 4957B RF Analyzer 

Instrument No.:                                      Test Personnel:                         

Test Date:                                      Test Condition:                         

Record Sheet of 4957B RF Analyzer 

No. Item Unit Standard Requirement Results 

 Design and Structure 

 Structure: Handheld 

 

 Appearance color: Black 

 

The complete machine features neat and beautiful appearance, clear 
text display on the panel, flexible key and knob operation, and 
convenient and reliable connection of the connectors, and free of 
obvious mechanical damage and stains 

 Function 

 Spectrum measurement function  

 Measurement function of power kit  

 Audio frequency demodulation function  

 IQ capture function  

 Vector network analysis and measurement function  

 Options 

 Cable and Antenna Analyzer  

 Vector voltmeter  

 USB Power Meter  

 IA  

 Analog demodulation analysis  

 Channel sweep  

 Field Strength Meter  

 GPS function  

 Safety option  

 Directional analysis  

 Signal analysis  

 Signal generation  

Vector network analysis performance indicator 

 
Frequency range and 

accuracy 
 

30kHz~6.5GHz  

1GHz：                                   1GHz±1000Hz  

 Frequencyresolution  2001MHz:                                           10  

 Power level / Large, small and manual setting  

 Port output power dBm Power range: -35 dBm ~ -5dBm10 MHz~6.5 GHz)  

 Power level accuracy  

100MHz                                          ±2.5  

500MHz                                          ±2.5  

1.5GHz                                           ±2.5  

2.5GHz                                           ±2.5  

3.5GHz                                           ±2.5  

4.5GHz                                           ±2.5  

5.5GHz                                           ±2.5  

6.5GHz                                           ±2.5  
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Record Sheet of 4957B RF Analyzer (continued 1) 

No. Item Unit Standard Requirement Results 

 Effective directivity  ≥40              300kHz~6.5GHz 

Test port 1  

Test port 2  

 
Effective source 

matching 
 ≥33              300kHz~6.5GHz 

Test port 1  

Test port 2  

 Load matching  ≥37              300kHz~6.5GHz 
Test port 1  

Test port 2  

 Reflected tracking  ±0.06            300kHz~6.5GHz 

Test port 1  

Test port 2  

 
Transmission 

tracking 
 ±0.08              300kHz~6.5Hz 

Test port 1  

Test port 2  

 Dynamic range  ≥95dB           300kHz~6.5GHz 
Test port 1  

Test port 2  

Spectrum analysis performance indicator 

 Frequency range 
 9kHz                                 9kHz±21Hz  

 6.5GHz                            6.5GHz±21Hz  

 
Frequency reading 

accuracy 

 1.0GHz(bandwidth 500kHz):                ±11.10  

 1.0 GHz (bandwidth 50 MHz):                ±1.03  

 1.0 GHz(bandwidth 500 MHz)：              ±10.30  

 3.0 GHz (bandwidth 500 kHz):               ±12.70  

 3.0 GHz (bandwidth 50 MHz):                ±1.03  

 3.0 GHz(bandwidth 500 MHz)：              ±10.30  

 4.5 GHz (bandwidth 500 kHz):               ±13.90  

 4.5 GHz (bandwidth 50 MHz):                ±1.03  

 4.5 GHz(bandwidth 500 MHz)：              ±10.30  

 6.0 GHz (bandwidth 500 kHz):               ±15.10  

 6.0 GHz (bandwidth 50 MHz):                ±1.03  

 6.0 GHz(bandwidth 500 MHz)：              ±10.30  

 
Sweep width 

accuracy 

 1kHz  ±2.0%  

 10kHz ±2.0%  

 100kHz ±2.0%  

 1MHz ±2.0%  

 10MHz ±2.0%  

 100MHz ±2.0%  

 1GHz ±2.0%  

 
Swp 

Time 

Range  10 μs ~ 600 s (zero sweep width)  

Accuracy 

 1ms ±2.0%  

 10ms ±2.0%  

 100ms ±2.0%  

 1s ±2.0%  

 1s ±2.0%  

Record Sheet of 4957B RF Analyzer (continued 2) 
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No. Item Unit Standard Requirement Results 

 RBW Accuracy 

/ 10MHz ±10.0%  

/ 3MHz ±10.0%  

/ 1MHz ±10.0%  

/ 300kHz ±10.0%  

/ 100kHz ±10.0%  

/ 30kHz ±10.0%  

/ 10kHz ±10.0%  

/ 3kHz ±10.0%  

/ 1kHz ±10.0%  

 
Sideband noise (carrier 

frequency 1GHz) 

dBc/Hz 

 

+10kHz                              ≤-108  

-10kHz                          ≤-108  

+100kHz                            ≤-112  

-100kHz                             ≤-112  

+1MHz                              ≤-118  

-1MHz ≤-118  

+10MHz                            ≤-129  

-10MHz                             ≤-129  

 
Explicit average noise 

level 
dBm 

2 MHz ~ 10 MHz (Preamplifier On) ≤-150  

10 MHz ~ 3 GHz (Preamplifier On) ≤-160  

3 GHz ~ 6.5 GHz (Preamplifier On) ≤-157  

2 MHz ~ 10 MHz (Preamplifier Off) ≤-135  

10 MHz ~ 3 GHz (Preamplifier Off) ≤-140  

3 GHz ~ 6.5 GHz (Preamplifier Off) ≤-138  

 
Second harmonic 

distortion 
dBc 

0.9GHz <-65  

2.5GHz <-65  

 

Mirror, 

multiple 

and 

out-of-band 

responses 

2GHz 

dBc 

Image frequency 2280.5 MHz <-65  

3.5 GHz Image frequency 3780.5 MHz <-65  

5 GHz Image frequency 5280.5 MHz <-65  

 Residual response dBm 
10 MHz ~ 6.5 GHz (Preamplifier On)  ≤-95  

10 MHz ~ 6.5 GHz (Preamplifier Off) ≤-82  

 Ref Level 

Range / 
Logarithm scale: -120 dBm ~ +30 dBm, with step of 1 

dB  
 

Conversion 

error 

/ 0 dBm Reference  

dB -10 dBm ±1.20  

dB -20dBm ±1.20  

dB -30 dBm ±1.20  

dB -40 dBm ±1.20  

dB -50 dBm ±1.20  

dB -60 dBm ±1.20  
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Record Sheet of 4957B RF Analyzer (continued 3) 

No. Item Unit Standard Requirement Results 

 Scale fidelity dB 

-10dBm ±1.00  

-20dBm ±1.00  

-30dBm ±1.00  

-40dBm ±1.00  

-50dBm ±1.00  

-60dBm ±1.00  

 
Overall level 

uncertainty 
dB 

50 MHz (Attenuation 0 dB, input -25 dBm): ±1.80  

50 MHz (Attenuation 10 dB, input -25 dBm): ±1.80  

50 MHz (Attenuation 20 dB, input -25 dBm): ±1.80  

50 MHz (Attenuation 30 dB, input -5 dBm): ±1.80  

2000 MHz (Attenuation 0 dB, input -25 dBm): ±1.80  

2000 MHz (Attenuation 10 dB, input -25 dBm): ±1.80  

2000 MHz (Attenuation 20 dB, input -25 dBm): ±1.80  

2000 MHz (Attenuation 30 dB, input -5 dBm): ±1.80  

3000 MHz (Attenuation 0 dB, input -25 dBm): ±1.80  

3000 MHz (Attenuation 10 dB, input -25 dBm): ±1.80  

3000 MHz (Attenuation 20 dB, input -25 dBm): ±1.80  

3000 MHz (Attenuation 30 dB, input -5 dBm): ±1.80  

4000 MHz (Attenuation 0 dB, input -25 dBm): ±1.80  

4000 MHz (Attenuation 10 dB, input -25 dBm): ±1.80  

4000 MHz (Attenuation 20 dB, input -25 dBm): ±1.80  

4000 MHz (Attenuation 30 dB, input -5 dBm): ±1.80  

5000 MHz (Attenuation 0 dB, input -25 dBm): ±1.80  

5000 MHz (Attenuation 10 dB, input -25 dBm): ±1.80  

5000 MHz (Attenuation 20 dB, input -25 dBm): ±1.80  

5000 MHz (Attenuation 30 dB, input -5 dBm): ±1.80  

6000 MHz (Attenuation 0 dB, input -25 dBm): ±1.80  

6000 MHz (Attenuation 10 dB, input -25 dBm): ±1.80  

6000 MHz (Attenuation 20 dB, input -25 dBm): ±1.80  

6000 MHz (Attenuation 30 dB, input -5 dBm): ±1.80  

350 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

650 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

950 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

1250 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

1550 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

1850 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

2150 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

2450 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

2750 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

3050 MHz (Attenuation0 dB, input -25 dBm): ±1.80  

3350 MHz (Attenuation0 dB, input -25 dBm): ±1.80  
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Record Sheet of 4957B RF Analyzer (continued 4) 

No. Item Unit Standard Requirement Results 

 Overall level uncertainty dB 

3650 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

3850 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

4150 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

4450 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

4750 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

5050 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

5350 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

5650 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

5850 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

6150 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

6450 MHz (Attenuation0 dB, input -25 

dBm): 

±1.80  

 Attenuator 

Range / 0 ~ 30 dB, with step of 5 dB   

Conversion 

uncertainty 

(50 MHz) 

/ Attenuation0 dB Reference / 

dB Attenuation 5dB ±1.20  

dB Attenuation 10dB ±1.20  

dB Attenuation 15dB ±1.20  

dB Attenuation 20dB ±1.20  

dB Attenuation 25dB ±1.20  

dB Attenuation 30dB ±1.20  

Conversion 

uncertainty 

(6 GHz) 

/ Attenuation0 dB Reference / 

dB Attenuation 5dB ±1.20  

dB Attenuation 10dB ±1.20  

dB Attenuation 15dB ±1.20  

dB Attenuation 20dB ±1.20  

dB Attenuation 25dB ±1.20  

dB Attenuation 30dB ±1.20  

 
Input port voltage standing 

wave ratio 

/ 
10 MHz ~ 6.5 GHz                             ≤2.00：1  

 Maximum safe input level / +27dBm (continuous wave, input attenuator is 

automatically coupled) 

 

 Scale display / 0.1 ~ 10 dB per graduation, with minimum step of 

0.1 dB (10 graduations displayed) 

 

 VBW / Bandwidth range: 1 Hz10 MHz (with step of 1-3)  

 interface 

RF interface / N type adapter (female)  

Communication 

Interface 

/ USB interface: Type A, two   

/ USB interface: mini type, one   

/ LAN Interface: RJ45 type   

Frequency 

reference 

/ Reference input/output, BNC 

female type 

  

Other interface 
/ GPS antenna interface: BNC 

female-type 

  

/ External trigger input interface: 

BNC female-type 
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Record Sheet of 4957B RF Analyzer (continued 5) 

No. Item Unit Standard Requirement Results 

 Safety 

/ Dielectric Strength requires AC 

1500V, 10mA/min; no 

breakdown, no arcing. 

  

/ Voltage 242 V, leakage current: ≤3.5 mA, 1min.  

 The insulation resistance between the power input end 

and the casing should not be less than 100 MΩ under 

standard atmospheric conditions for testing. 

 

/ 

The insulation resistance between the power input end 

and the casing should not be less than 2 MΩ in humid 

environment. 

 

Remarks 

1. ―√‖indicates normal function or meet the requirements; ―X‖ indicates that the function is abnormal or 

does not meet the requirements; 

2.  "/" indicates that there is no such test item on this device. 

 Comprehensive judgment: Pass□ Fail□ 

 

 


